First Edition (June 2007)

This documentation and any related computer software help programs (hereinafter referred to as the “Documentation”) is for the end user's informational purposes only and is subject to change or withdrawal by CA at any time.

This Documentation may not be copied, transferred, reproduced, disclosed, modified or duplicated, in whole or in part, without the prior written consent of CA. This Documentation is confidential and proprietary information of CA and protected by the copyright laws of the United States and international treaties.

Notwithstanding the foregoing, licensed users may print a reasonable number of copies of the documentation for their own internal use, and may make one copy of the related software as reasonably required for back-up and disaster recovery purposes, provided that all CA copyright notices and legends are affixed to each reproduced copy. Only authorized employees, consultants, or agents of the user who are bound by the provisions of the license for the product are permitted to have access to such copies.

The right to print copies of the documentation and to make a copy of the related software is limited to the period during which the applicable license for the Product remains in full force and effect. Should the license terminate for any reason, it shall be the user's responsibility to certify in writing to CA that all copies and partial copies of the Documentation have been returned to CA or destroyed.

EXCEPT AS OTHERWISE STATED IN THE APPLICABLE LICENSE AGREEMENT, TO THE EXTENT PERMITTED BY APPLICABLE LAW, CA PROVIDES THIS DOCUMENTATION “AS IS” WITHOUT WARRANTY OF ANY KIND, INCLUDING WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NONINFRINGEMENT. IN NO EVENT WILL CA BE LIABLE TO THE END USER OR ANY THIRD PARTY FOR ANY LOSS OR DAMAGE, DIRECT OR INDIRECT, FROM THE USE OF THIS DOCUMENTATION, INCLUDING WITHOUT LIMITATION, LOST PROFITS, BUSINESS INTERRUPTION, GOODWILL, OR LOST DATA, EVEN IF CA IS EXPRESSLY ADVISED OF SUCH LOSS OR DAMAGE.

The use of any product referenced in the Documentation is governed by the end user’s applicable license agreement.

The manufacturer of this Documentation is CA.

Provided with “Restricted Rights.” Use, duplication or disclosure by the United States Government is subject to the restrictions set forth in FAR Sections 12.212, 52.227-14, and 52.227-19(c)(1) - (2) and DFARS Section 252.227-7014(b)(3), as applicable, or their successors.

All trademarks, trade names, service marks, and logos referenced herein belong to their respective companies.

Copyright © 2007 CA. All rights reserved.
# Contents

Acknowledgements ........................................................... ix  
About this guide ............................................................. xi  
Summary of changes ....................................................... xiii  
Documentation .................................................................. xv  
Conventions and terminology ......................................... xvii

## 1 Installing and Connecting Workstation .......... 1
About Installing Workstation .............................................. 2  
About the Workstation Toolkit ........................................... 4  
Connecting Workstation and ESP Workload Manager .... 10

## 2 Quick Start to Creating and Running Workload . . 21
Overview Flowchart .......................................................... 22  
Sample Scenario ............................................................... 23  
Opening the Workload Editor ........................................... 24  
Setting Default Values ...................................................... 25  
Creating a Workflow Diagram .......................................... 27  
Creating Job Dependencies ............................................. 29  
Setting Job Details ............................................................ 34  
Saving the Application ...................................................... 36  
Running your Application ................................................ 38  
Simulating an Event .......................................................... 43  
Triggering an Event .......................................................... 45  
Viewing your Jobs ............................................................ 46

## 3 The Workload Editor............................................... 51
Opening the Workload Editor ........................................... 52  
Workload Editor Screen Overview .................................... 53  
Summary of Creating an Application ............................... 65  
Setting Workload Definition Defaults ............................. 66  
Specifying Defaults and Details for all Workload .......... 93  
Adding Release Conditions to Job Dependencies .......... 325  
Uploading and Downloading Applications ................. 327
Portions copyright (c) Marcel Scherpenisse, 2000. The DynDialogEx.cpp software is distributed in accordance with the following license agreement.

DynDialogEx.cpp : implementation file

Written by Marcel Scherpenisse

mailto:Marcel_Scherpenisse@insad.nl

This code may be used in compiled form in any way you desire. This file may be redistributed unmodified by any means PROVIDING it is not sold for profit without the authors written consent, and providing that this notice and the authors name and all copyright notices remains intact. If the source code in this file is used in any commercial application then a statement along the lines of "Portions copyright (c) Marcel Scherpenisse, 2000" must be included in the startup banner, "About" box or printed documentation. An email letting me know that you are using it would be nice as well.

This file is provided "as is" with no expressed or implied warranty. The author accepts no liability for any damage/loss of business that this product may cause.

This product includes software developed by the University of California, Berkeley and its contributors and is distributed under the following license agreement.

==================== Berkeley YACC (BYACC) =====================

Copyright (c) 1990 The Regents of the University of California. All rights reserved.

This code is derived from software contributed to Berkeley by Vern Paxson.

The United States Government has rights in this work pursuant to contract no. DE-AC03-76SF00098 between the United States Department of Energy and the University of California.

Redistribution and use in source and binary forms are permitted provided that: (1) source distributions retain this entire copyright notice and comment, and (2) distributions including binaries display the following acknowledgement: “This product includes software developed by the University of California, Berkeley and its contributors” in the documentation or other materials provided with the distribution and in all advertising materials mentioning features or use of this software. Neither the name of the University nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission. THIS SOFTWARE IS PROVIDED “AS IS” AND WITHOUT ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.

This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/).

Portions of this product include software developed by the University of California, Berkeley and Henry Spencer and is distributed in accordance with the following license agreement.

This code has been derived from work by Henry Spencer.

The main changes are

1. All char variables and functions have been changed to TCHAR counterparts
2. Added GetFindLen() & GetReplaceString() to enable search and replace operations.
3. And of course, added the C++ Wrapper

The original copyright notice follows:

Copyright (c) 1986, 1993, 1995 by University of Toronto.

Written by Henry Spencer. Not derived from licensed software.

Permission is granted to anyone to use this software for any purpose on any computer system, and to redistribute it in any way, subject to the following restrictions:

1. The author is not responsible for the consequences of use of this software, no matter how awful, even if they arise from defects in it.
2. The origin of this software must not be misrepresented, either by explicit claim or by omission.
3. Altered versions must be plainly marked as such, and must not be misrepresented (by explicit claim or omission) as being the original software.
4. This notice must not be removed or altered.
About this guide

This introduction provides information to help you get the most out of this guide. It contains an overview of each chapter, provides a summary of the new content with links, and it describes the syntax conventions and terminology used in the guide.

Who should use this guide

This guide is intended for operators or persons assigned to use ESP Workstation for scheduling and monitoring workload.

This guide assumes you are familiar with Windows-based applications and terminology, and have a basic knowledge of workload scheduling.

How this guide is structured

**Chapter 1 Installing and Connecting Workstation**

This chapter describes how to install ESP Workstation on your local computer, and how to connect ESP Workstation to ESP Workload Manager using the Connection Manager.

**Chapter 2 Quick Start to Creating and Running Workload**

This chapter gives you a quick and streamlined procedure for creating an Application, scheduling when your Application is to run, and viewing your Application running. It provides an opportunity to use the Workload Editor, Event Manager, and Workload Director components of ESP Workstation.

**Chapter 3 The Workload Editor**

This chapter describes the Workload Editor interface and presents an overview of Workload Editor concepts and terms. It explains the workload defaults and job-level details you can use in your Applications. It also describes the different job types you can schedule with Workstation.

**Chapter 4 The Calendar Manager**

This chapter describes the Calendar Manager interface and presents an overview of Calendar Manager concepts and terms. It explains how to create new calendars, modify existing ones, and how to customize holidays and special days.
Chapter 5 The Event Manager
This chapter describes the Event Manager interface and presents an overview of Event Manager concepts and terms. It explains how to create, simulate, test, and trigger Events.

Chapter 6 The Workload Director
This chapter describes the Workload Director interface and presents an overview of Workload Director concepts and terms. You are shown how to access and view your workload using Graphical and Custom Views. Job commands are documented for the different job types available. This chapter also describes job attributes, how to set options, and how to print.

Chapter 7 The Report Manager
This chapter explains how to use the Report Manager to create history reports in ESP Workstation.
Summary of changes

This guide contains terminology, maintenance, and editorial changes. A vertical line to the left of text denotes new technical information in this guide.

The changes listed here have a link to the corresponding topic for quick reference. ESP Workstation release v.4.5.1 contains usability and installation changes not documented in this User’s Guide.

**Hint:** For a complete list of changes and enhancements to ESP Workstation release v.5.5, download the **Release Notes** from your web portal, document number WS-5.5-RN_01.pdf.

### Workload Director changes

- The current subscription filter now displays on the tool bar for graphical and custom views. The display updates automatically whenever you click on an item with a different subscription filter. For more information, see “View the current filter” on page 410.

- When creating custom views, a new option flashes the Workload Director icon when workload updates are received. When the default user profile is loaded, the Failures and Overdue predefined custom views automatically flash the Workload Director icon. For more information, see “Creating a Custom View” on page 518.

- The following new commands are available at the job level:
  - **Trigger Event**
    The Trigger Event command enables you to trigger the Event associated with the Application of the jobs you are viewing. For more information, see “Trigger Event” on page 475.
  - **List Job History**
    The List Job History command displays the job number, submission date and time, current status, and completion code. For more information, see “List Job History” on page 456.

- The following job-level commands are enhanced:
  - **Edit and Browse JCL**
    In an active Application, you can edit or browse JCL prior to job submission. Previously, the JCL was retrieved only after JES processed the job. For more information, see “Edit or Browse JCL” on page 454.
  - **Job Details**
    The Job Details command displays the file names of File and Data set trigger jobs. For more information, see “Viewing Details of a Job” on page 443.
• Update User Status
You can paste information from a z/OS system into the User Status field. For more information, see “Updating the User Status Field of a Job” on page 467.

• Hold
You can paste information from a z/OS system into the Reason field. For more information, see “Holding and Releasing jobs” on page 456.

**Workload Editor changes**

• A new user profile option prevents an Application from overriding a previously stored Application with the same name. For more information, see “User Profile Options” on page 58.

**Event Manager changes**

• Cache memory is now available for Procedures. You can indicate a Procedure is to use cache memory. Cache memory improves CPU usage and processing speed for Procedures that include over 400 jobs. For more information, see “Defining the Run ESP Procedure(s) dialog” on page 285.

• You now have an option when defining an Event and that Event already exists. You can indicate the Event definition is to replace an existing Event with the same name. For more information, see “Defining the Event Properties dialog” on page 350.

• You can copy an Event to the same system or copy an Event from one system to another system. Copying an Event saves time because it eliminates the process of defining a new Event. The Event copy function was previously an undocumented feature. For more information, see “Copying an Event” on page 345.
Documentation

Documentation for ESP Workstation is provided in the following formats:

- Adobe Portable Document Format (User’s Guide)
- Field-level Help
- Online Help

Field-level Help

Access the field-level Help by positioning your cursor in the field you require information for, then press the F1 key. A window pops open and a description of what is required in the field is displayed.

Online Help

You can access online Help while you are using ESP Workstation. The Help opens in a separate window, which you can either close or leave open and minimize as you continue working.

To view the online Help

From the menu bar, select Help > ESP Workstation Help.

Alternatively, click the Help button on any dialog.

Contents

The Contents tab organizes topics like the Table of Contents in a book. A book icon represents a topic that has one or more topics.

1. To expand the topics, double-click the book icon.
2. To expand the subtopics, click the plus sign (+).

Index

The Index tab is used to generate a list of all occurrences of a keyword in the User’s Guide.

1. In the Workstation Help, select the Index tab.
2. In the text field, enter a keyword.

The topics that contain the keyword are listed in the window.
3. Select a **topic** and click **Display**.
The topic displays in the right-hand pane.

**Search**

The Search tab enables you to search for all occurrences of a keyword within all the Help topics.
1. In the **Workstation Help**, select the **Search** tab.
2. In the **text** field, enter the **keyword** you want to search for.
3. Click **List Topics**.
   The topics that contain the keyword are listed in the **Select Topic to display** window.
4. Select a **topic** and click **Display**.
The topic displays in the right-hand pane.

**Favorites**

Create a favorites list of topics you reference frequently.
1. In the **Workstation Help**, select the **Favorites** tab.
   The topic title in the right-hand pane appears in the **Current Topic** window.
2. Click **Add**.
   An entry is added to the **Topics** window.

**Related documentation**

This guide references the following documents:

- **ESP Workload Manager User’s Guide**
- **ESP Workload Manager Advanced User’s Guide**
- **ESP Workload Manager Reference Guide**
- **ESP Workload Manager Installation Guide**
- **ESP Workload Manager Security Guide**
This guide uses standard Microsoft Windows terminology and conventions to describe the Workstation interface and actions to perform.

The following conventions are used:

<table>
<thead>
<tr>
<th>Note</th>
<th>Provides additional advice about a specific topic or points you to further information.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hint</td>
<td>Provides time-saving tips or alternative ways of completing steps or tasks.</td>
</tr>
<tr>
<td>Bold Text</td>
<td>Indicates items such as buttons and menu options that you press, click or select. For example, click <strong>OK</strong> means click the left-mouse button once on the OK button.</td>
</tr>
</tbody>
</table>

The following short names are used in place of their respective full names:

<table>
<thead>
<tr>
<th>Short Name</th>
<th>Full Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>ESP</td>
<td>Enterprise System Platform</td>
</tr>
<tr>
<td>Workstation</td>
<td>ESP Workstation</td>
</tr>
<tr>
<td>Event</td>
<td>ESP Event</td>
</tr>
<tr>
<td>Procedure</td>
<td>ESP Procedure</td>
</tr>
<tr>
<td>Application</td>
<td>ESP Application</td>
</tr>
</tbody>
</table>

**Supported Characters**

We use the UTF-8 character encoding scheme from Unicode, limited to characters that translate to a codepoint less than 256. For more information about the UTF-8 codepage, refer to www.unicode.org.

**Syntax**

ESP Workload Manager is not case-sensitive. ESP Workload Manager commands are shown in uppercase in this guide, but you do not need to enter them in uppercase.

Syntax diagrams and examples are provided throughout this guide. The diagrams define the format of statements and commands, and the examples support the text. The syntax diagrams use the following conventions:

<table>
<thead>
<tr>
<th>Notation</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quote marks &quot; or '</td>
<td>Must be entered as shown.</td>
</tr>
<tr>
<td>Comma ,</td>
<td>Must be entered as shown.</td>
</tr>
<tr>
<td>Notation</td>
<td>Meaning</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Ellipsis …</td>
<td>The parameter can be repeated. Do not enter ellipsis.</td>
</tr>
<tr>
<td>Lower Case Italics operand</td>
<td>User-supplied variable or character string. You must substitute a parameter.</td>
</tr>
<tr>
<td>Uppercase command or parameter</td>
<td>The command must be spelled as shown. It is not case-sensitive.</td>
</tr>
<tr>
<td>OR-bar (</td>
<td>)</td>
</tr>
<tr>
<td>Underline ________</td>
<td>Default parameter. If you do not enter a parameter, the system supplies the underlined parameter.</td>
</tr>
<tr>
<td>Single parameter in square</td>
<td>Optional parameter.</td>
</tr>
<tr>
<td>brackets [ ]</td>
<td></td>
</tr>
<tr>
<td>Stacked parameters in braces</td>
<td>Mandatory parameter. You must enter one of the parameters. You cannot enter more than one.</td>
</tr>
<tr>
<td>{ }</td>
<td></td>
</tr>
<tr>
<td>}</td>
<td></td>
</tr>
<tr>
<td>Stacked parameters in square</td>
<td>Optional parameters. You can enter one, all or none.</td>
</tr>
<tr>
<td>brackets [ ]</td>
<td></td>
</tr>
<tr>
<td>]</td>
<td></td>
</tr>
<tr>
<td>]</td>
<td></td>
</tr>
<tr>
<td>Parameters with OR-bars (</td>
<td>) and square brackets [ ]</td>
</tr>
<tr>
<td>Stacked parameters in square</td>
<td>Mandatory parameter. You must enter one of these parameters. You can enter more than one.</td>
</tr>
<tr>
<td>brackets within braces { [ ]}</td>
<td></td>
</tr>
<tr>
<td>Plus (+) or minus (-) symbol at</td>
<td>Found only in syntax examples, this indicates that the following lines are added to the first line and the syntax is evaluated as one expression. Any characters after the symbol on the same line are not evaluated.</td>
</tr>
<tr>
<td>the end of a line of syntax</td>
<td></td>
</tr>
</tbody>
</table>
This chapter describes how to install Workstation on your local computer, and how to connect Workstation to ESP Workload Manager using the Connection Manager.

This section contains the following topics:

- About Installing Workstation
- About the Workstation Toolkit
- Connecting Workstation and ESP Workload Manager
About Installing Workstation

Workstation connects to ESP Workload Manager through a started task called Workstation Server. You need to define and start the Workstation Server on the mainframe. For Workstation Server information, see the ESP Workload Manager Installation Guide.

Workstation installs on your local computer. For install instructions, see “Install from product CD” on page 2.

System Requirements

To install Workstation, your system must meet the following software and hardware level requirements:

<table>
<thead>
<tr>
<th>Component</th>
<th>Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recommended operating systems</td>
<td>Windows 2000—any supported version</td>
</tr>
<tr>
<td></td>
<td>Windows XP Professional—any supported version</td>
</tr>
<tr>
<td>Processor</td>
<td>Intel Pentium, 1.0 GHz or higher</td>
</tr>
<tr>
<td>Memory</td>
<td>512 MB RAM or higher</td>
</tr>
<tr>
<td>Monitor</td>
<td>Video support for a minimum 256 colors at 800 x 600 resolution</td>
</tr>
<tr>
<td>Network</td>
<td>Active IP connection to your ESP Workload Manager environment, and a user ID that has authority to access it.</td>
</tr>
</tbody>
</table>

Note: Running other applications with Workstation may adversely affect performance and memory.

Install from product CD

1. Insert the Workstation CD into your CD-ROM drive. If auto-install is enabled on your computer, the installation process starts automatically. If this occurs, go to step 5.
2. From the Windows task bar, select Start > Run. The Run dialog appears.
3. In the Open field, enter: `<cdrom drive>:\Setup.exe`
4. Click **OK**.
   The Setup program starts.

5. Follow the instructions on the screen.

**CA Support website**

You can access the CA Support website using the ESP Workstation Help menu.
About the Workstation Toolkit

The Workstation Toolkit appears when you launch Workstation from the Microsoft Windows Start menu or double-click the Workstation icon on your desktop. The Workstation Toolkit features a menu bar and buttons that represent shortcuts to the Workstation components. To start and access any Workstation component, you must use the Workstation Toolkit.

Once a connection has been established, the Workstation Toolkit appears with all of the installed components available.

On the Workstation Toolkit, you click **Connection Manager** to establish a connection between Workstation and ESP Workload Manager. This is documented in “Connect to ESP Workload Manager” on page 10.

**Menu Bar**

The Workstation Toolkit menu bar contains these menus:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>• Exit Workstation</td>
</tr>
<tr>
<td>Connection Manager</td>
<td>• Open Connection Manager and connect to a server</td>
</tr>
<tr>
<td></td>
<td>• Add, change, and delete server connections</td>
</tr>
<tr>
<td>ESP Tools</td>
<td>To open a Workstation component:</td>
</tr>
<tr>
<td></td>
<td>• Calendar Manager</td>
</tr>
<tr>
<td></td>
<td>• Event Manager</td>
</tr>
<tr>
<td></td>
<td>• Report Manager</td>
</tr>
<tr>
<td></td>
<td>• Workload Director</td>
</tr>
<tr>
<td></td>
<td>• Workload Editor</td>
</tr>
<tr>
<td></td>
<td>• SAP Tools</td>
</tr>
</tbody>
</table>
### Shortcut Buttons

The Workstation Toolkit contains the following shortcut buttons:

<table>
<thead>
<tr>
<th>Button</th>
<th>Component</th>
<th>Use</th>
</tr>
</thead>
</table>
| ![Calendar](calendar.png) | Calendar Manager | To perform the following calendar tasks:  
  - List calendars  
  - Define, copy, delete, and view a calendar  
  - Edit an existing calendar to define or delete holidays or special days or change characteristics of the calendar |
| ![Event](event.png) | Event Manager      | To perform the following Event tasks:  
  - List, define, and delete Events  
  - View and edit Event definitions  
  - Trigger and simulate Events  
  - Display next scheduled execution of an Event  
  - Hold, release, resume, and suspend Events |
| ![Report](report.png) | Report Manager     | To perform the following report tasks:  
  - Open, create, generate, print, and save history reports  
  - Define, save, and open report definitions |

### Options

- Set how the Workstation Toolkit appears on the desktop
- Set, start, and stop a trace file
- Save a user profile
- Set server login timeouts
- Establish a SAP GUI connection

### Help

- Search for task-based help
- Open a PDF of the ESP Workload Manager Reference guide
- Link to the CA support website
- View Workstation specifications
- Link to the CA website
<table>
<thead>
<tr>
<th>Button</th>
<th>Component</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>SAP Tools</td>
<td>To perform the following SAP tasks:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• List and trigger SAP events</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• List all intercepted jobs</td>
</tr>
<tr>
<td></td>
<td>Workload Editor</td>
<td>To perform the following workload tasks:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Define, copy, edit, and save Applications</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Upload and download Applications from a central location (host)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Define symbolic variables</td>
</tr>
<tr>
<td></td>
<td>Workload Director</td>
<td>To perform tasks that monitor and control workload:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Hold and release jobs and Applications</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Mark jobs and Applications as complete</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Remove Applications from APPLWAIT</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Run jobs on demand</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Bypass and unbypass jobs</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Drop job predecessors</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Locate jobs</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• View the details of a job</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Modify resources</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Reset job time dependencies</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Ready and resubmit jobs</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Insert jobs into Applications</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Manage subApplications</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Update user status</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Edit or browse z/OS data sets, Procedures, Job Documentation, JCL,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>and CopyJCL</td>
</tr>
</tbody>
</table>
Trace File

Set a trace file that stores all the commands sent to and received from ESP Workload Manager. Use the trace file as a troubleshooting tool.

To set a trace file

1. On the **Workstation Toolkit**, select **Options > Trace > Set trace file**.
   
   The Set Trace File dialog appears.

2. In the **Look in** field, select the path where you want to store the trace file.
   
   **Note:** If you have already set up a trace file, select the file and skip to step 5.

3. In the **File name** field, enter a name for the trace file.

4. If you want to create a new trace file using an existing file name, place a check mark in the **Create a new file** check box. The new trace file will overwrite the existing file.

5. To hide your connection password in the trace file, make sure the **Hide password** check box is checked.

6. Click **Set file**. A dialog appears asking whether you want to start the trace now.

7. To start the trace immediately, click **Yes**. To start the trace later, click **No**.

To start or stop a trace file

1. On the **Workstation Toolkit**, select **Options > Trace > Start trace file** or **Stop Trace**.

   **Hint:** If you are unsure whether your trace is active or not, display the Trace drop-down menu. When the trace is active, stop trace is the only available option.
The user profile enables you to save Workstation settings. Save your settings as a profile, and open the profile each time you start Workstation to restore your work environment. The user profile is a useful feature if you share your Workstation with others or if you monitor and control workload for different situations. Save as many user profiles as you need.

ESP Workstation saves user profiles in the C:\Documents and Settings\All Users\Application Data\Cybermation\ESP Workstation\User Profiles directory.

**Hint:** To view the full path to the User Profiles folder, you may need to change your Windows folder options. Open Windows Explorer and select **Tools > Folder Options > View.** Under the Hidden files and folders option, select **Show hidden files and folders.**

**To save a user profile**

1. On the **Workstation Toolkit**, select **Options > Save the User Profile As.** The Save the User Profile as dialog appears.

2. In the User profile name field, enter a meaningful name for your profile. The name must be alphanumeric, and it must start with an alpha character. Use up to 44 characters.

3. Click **Save.** The Save the User Profile as dialog closes.

   Once a user profile is saved, the next time you open Workstation, the Load the User Profile dialog appears.

**To use an existing user profile**

1. On the Load the User Profile dialog, select the profile you want to use.
2. Click **Load**.

   **Hint:** If you want to change user profiles while you are working, close Workstation and load a different profile.

---

**SAP GUI Connection**

SAP GUI is required to add or edit a SAP variant. SAP GUI is invoked from Workstation after the SAP GUI connection parameters have established a connection to the SAP system.

1. On the **Workstation Toolkit**, select **Options > SAP GUI Connection Parameters**.

   The SAP GUI Connection Parameters dialog appears.

   ![SAP GUI Connection Parameters](image)

2. In the **User ID** field, enter a user ID for the SAP system.

3. In the **Password** field, enter a password for the SAP system.

4. In the **Client** field, enter a three-digit client number that identifies the client within the SAP system for the RFC connection.

5. In the **System ID** field, enter the name of the server (host) where SAP is installed.

6. In the **Language** field, enter the language used to log on to the SAP system. For example: EN=English, DE=Deutsche, RU=Russian. The default is the SAP system language.

7. In the **Executable Full Name** field, enter the executable file name (with the entire path) from the SAP GUI.

8. Click **OK**. These settings are preserved for future use.
Connecting Workstation and ESP Workload Manager

The Connection Manager is the component of Workstation you use to connect to ESP Workload Manager. You must connect Workstation to ESP Workload Manager before you can use five of Workstation’s six components. They are the Calendar Manager, Event Manager, Report Manager, SAP Tools, and Workload Director. You can use the Workload Editor offline without connecting, but you must connect to upload definitions to the host.

Use Connection Manager to perform these tasks:

- Connect to ESP Workload Manager
- Connect to multiple ESP Workload Manager systems
- Import and Export a Connections File
- Disconnect from ESP Workload Manager
- Change Your Connection Password
- Set the Server Login Timeout

Connect to ESP Workload Manager

If you are using the Connection Manager for the first time, you must add a server connection to Connection Manager. You can add a server connection as part of the connection process or as a separate step.

If you have already set up one or more connections, see the following topics:

- To connect to a single ESP Workload Manager system, see “Connect after first-time connection” on page 12.
- To connect to multiple ESP Workload Manager systems, see “Connect to multiple ESP Workload Manager systems” on page 12.

First-time connection

To establish a first-time connection, obtain the following details for the server you want to connect:

- TCP/IP server address or DNS name
- Port number of the Workstation Server
- Your mainframe user ID
- Your mainframe password
Note: Depending on how your servers have been set up during installation, you may connect to ESP Workload Manager using different paths. You may connect through one or through several servers. See your System Administrator for details.

To connect Workstation to ESP Workload Manager

1. On the **Workstation Toolkit**, select **Connection Manager > Connection Manager**.
   
The Connect dialog appears with no data in the fields.

2. In the **Address** field, enter the TCP/IP address or alternatively the DNS name of the server you want to connect.

3. In the **Port** field, enter the port number of the Workstation Server you want to connect.

4. In the **User Name** field, enter your mainframe user ID.

5. In the **Password** field, enter your mainframe password required to authenticate the user name you entered in step 4.

6. Click **Connect**. An information dialog appears informing you whether or not you are connected. If your connection attempt failed, confirm your server details and repeat steps 1 through 6.

7. Click **OK**. The Connection Manager dialog appears. The server you are connected to is listed in the servers list box.

Once you connect, the address, port, and user name you entered is saved for your next connection to this server.
Connect after first-time connection

1. On the Workstation Toolkit, select Connection Manager > Connection Manager. The Connection Manager dialog appears.
   Your previous server connection appears in the list of servers Connection Manager displays.

2. On the Connection Manager menu, select Connection > Connect. The Connect dialog appears.

   ![Connection Manager dialog](image1)

   The address, port, and user name fields are filled in from your previous connection to this server.

3. In the Password field, enter your password.

   ![Connect dialog](image2)

   **Note:** If you want to connect to a different server not listed, you must add the server connection. See “Add a Server Connection” on page 13.

4. Click Connect. An information dialog appears telling you whether or not you are connected.

5. Click OK. The Connection Manager dialog appears. Notice the red X no longer appears on the server connection icon.

Connect to multiple ESP Workload Manager systems

You can use a single logon dialog to connect to multiple ESP Workload Manager systems.
**Note:** To use a single logon for multiple systems, the user ID and password combination must be the same on each system you are connecting to.

1. **Open the Connection Manager dialog.**
2. **Select the systems you want to connect to.**
   - To select consecutive server connections, hold down the **Shift** key while you select.
   - To select specific server connections, hold down the **Ctrl** key while you select.
3. **Right-click the selected connections and select **Connect**.**
   The Multiple Server Connection dialog appears.
4. **Enter your password and click **Connect**.**
   As Workstation connects to each server, the connection status appears beside each server in the Multiple Server Connection dialog.

### Automatically display Connection Manager

Automatically display the Connection Manager dialog when you open Workstation.

On the **Workstation Toolkit**, select **Options > Run Connection Manager automatically**.

A check mark appears beside this option. The next time you open Workstation, the Connection Manager dialog appears.

### Add a Server Connection

You can add server connections to the list of servers in Connection Manager at any time.

**To add a server connection**

1. **On the **Workstation Toolkit**, select **Connection Manager > Connection Manager**.**
   The Connection Manager dialog appears.
2. **Open the Add a new connection dialog using one of these methods:**
   - From the **Connection** menu, select **Add**.
   - In the servers list box right-click any server, and select **Add** from the shortcut menu.
   The Add a new connection dialog appears.
3. In the **Address** field, enter the TCP/IP address or alternatively the DNS name of the server you want to connect.

4. In the **Port** field, enter the port number of the Workstation Server.

5. In the **User Name** field, enter your mainframe user ID.

6. To save the connection properties, click **OK**. The Connection Manager dialog appears showing the server connection you added.

   **Note:** When you add a server connection, you are defining the connection only. To connect to ESP Workload Manager, see “Connect to ESP Workload Manager” on page 10.

### Modify a Server Connection

You can modify the properties of a server connection such as the TCP/IP address, port number or user ID. You have two methods to modify a server connection:

- Using the Connect dialog when you connect
- Using the Connection properties dialog

**Note:** You cannot modify properties while you are connected to the server.

### To modify a server connection

1. On the **Workstation Toolkit**, select **Connection Manager > Connection Manager**.

   The Connection Manager dialog appears.

2. In the Connection Manager dialog, right-click the server connection you want to modify, and select one of these options from the shortcut menu:

   - **Connect** - Use this option if you want to connect immediately. The Connect dialog appears.
• **Properties** - Use this option if you do not want to connect immediately. The Connection properties dialog appears.

3. Make the desired changes to the **Address**, **Port**, and **User Name** fields, as required.

4. Click **OK**.

**Delete a Server Connection**

You can delete a server connection from the list of available servers in Connection Manager.

**To delete a server connection**

1. On the **Workstation Toolkit**, select **Connection Manager** > **Connection Manager**.
   
The Connection Manager dialog appears.

2. From the servers list box, select the server connection you want to delete.

   **Note:** You must be disconnected from the server you want to delete. To disconnect, see “Disconnect from ESP Workload Manager” on page 17.

3. Delete the server connection using one of the following methods:
   • Right-click the server, then select **Delete** from the shortcut menu.
   • Highlight the server, then from the **Connection** menu select **Delete**.

   The server connection is removed from the list of servers.
Import and Export a Connections File

ESP Workstation stores your server connection definitions in the connections.txt file located in the C:\Documents and Settings\All Users\Application Data\Cybermation\ESP Workstation\User Profiles directory. You can import and export server connection definitions using this file.

You can use the connections file to store, distribute and maintain server connections that may be shared by different Workstation users. For example, if you have a common ESP Workload Manager login profile that multiple users require, you can define the connections in a local file and export them to a network directory that your Workstation users can access.

**Hint:** To view the full path to the connections.txt file, you may need to change your Windows folder options. Open Windows Explorer and select **Tools > Folder Options > View**. Under the Hidden files and folders option, select **Show hidden files and folders**.

**To import a connections file**

1. On the **Workstation Toolkit**, select **Connection Manager > Connection Manager**.
   The Connection Manager dialog appears.

2. From the **Connection** menu, select **Import Connections**.
   The Import Connections File dialog appears.

3. In the **Look in** field, display the folder containing the file you want to import, for example the connections.txt file.

4. To replace the existing inactive connections, place a check mark in the **Replace inactive connections** check box.
5. Click **Import**.

**To export a connections file**

1. On the **Workstation Toolkit**, select **Connection Manager > Connection Manager**.
   The Connection Manager dialog appears.

2. From the **Connection** menu, select **Export Connections**.
   The Export Connections File dialog appears.

3. In the **Look in** field, display the folder where you want to store the connections file.

4. Select the file you want to export from the list box.

5. Click **Export**.

**Disconnect from ESP Workload Manager**

To disconnect from ESP Workload Manager, close the active connection with the server.

**To disconnect from ESP Workload Manager**

1. On the **Workstation Toolkit**, select **Connection Manager > Connection Manager**.
   The Connection Manager dialog appears.
2. In the servers list box, select the server you want to disconnect from.

3. Disconnect using one of these methods:
   - Right-click the server, then select **Disconnect** from the shortcut menu.
   - Highlight the server, then from the **Connection** menu select **Disconnect**.

   Connection Manager displays a dialog confirming that you have disconnected from the server.

4. Click **OK**.

**To disconnect from multiple ESP Workload Manager systems**

1. Open the Connection Manager dialog.

2. Select the systems you want to disconnect from.
   - To select consecutive server connections, hold down the **Shift** key while you select.
   - To select specific server connections, hold down the **Ctrl** key while you select.

3. Right-click the selected connections and select **Disconnect**.

---

**Change Your Connection Password**

You can change your connection password anytime you are connected.

**To change your connection password**

1. On the **Workstation Toolkit**, select **Connection Manager > Connection Manager**.
   
The Connection Manager dialog appears.

2. Connect to ESP Workload Manager. See “Connect to ESP Workload Manager” on page 10.

3. Open the Change Password dialog using one of these methods:
   - Right-click the server, then select **Change Password** from the shortcut menu.
   - Highlight the server, then from the **Connection** menu select **Change Password**.
4. Complete the following fields:
   • **Old password** - enter your old password here.
   • **New password** - enter your new password here.
   • **Confirm new password** - enter your new password again to confirm the correct password.

5. Click **OK**. The Change Password dialog closes, and a message appears informing you the password was changed. Click **OK**. The Connection Manager dialog appears.

### Closing Connection Manager

To close Connection Manager use one of the following methods
   • Click the **Close** button (x) on the dialog.
   • From the **Connection** menu, select **Close**.

   **Note:** When you close, you do not lose your Connection to the server. To disconnect, see “Disconnect from ESP Workload Manager” on page 17.

### Set the Server Login Timeout

You can set the server login timeouts Connection Manager uses for a single connection and for multiple connections.

On the Workstation toolkit, select **Options > Server Login Timeout Parameters**.

The **Server Login Timeout** dialog appears.

**Single Server Login Timeout**

Enter the amount of time, in seconds, you want Connection Manager to wait for a server response. If Connection Manager does not receive a server response within this time limit, it displays a timeout message. The valid range is 10 to 1200 seconds. The default value is 300 seconds.
Multiple Server Login Timeout
Enter the amount of time, in seconds, you want Connection Manager to wait for each server to respond. If Connection Manager does not receive a server response within this time limit, it will try to log in to the next server. The valid range is 10 to 1200 seconds. The default value is 30 seconds.
Quick Start to Creating and Running Workload

This chapter gives you a quick and streamlined procedure for creating an Application, scheduling when your Application is to run, and viewing your Application running.

It provides an opportunity to use the Workload Editor, Event Manager, and Workload Director components of Workstation.

This section contains the following topics:

• Overview Flowchart
• Sample Scenario
• Setting Default Values
• Creating a Workflow Diagram
• Creating Job Dependencies
• Setting Job Details
• Saving the Application
• Running your Application
• Simulating an Event
• Triggering an Event
• Viewing your Jobs
Overview Flowchart

The following flowchart gives you an overview of the steps involved in scheduling your workload with Workstation.

1. Connect to ESP Workstation with the Connection Manager.

2. Create an Application in the Workload Editor.
   - Specify workload definition defaults
   - Drag and drop icons
   - Create dependencies
   - Specify job details
   - Save Application
   - Upload Application

3. Schedule an Application to run in the Event Manager.
   - Define the Event
   - Upload the Event
   - Simulate the Event
   - Trigger the Event

4. View the Application running in the Workload Director.
An Application consists of one or more (usually related) jobs. An Application may contain jobs that all run on the same operating system or it may have jobs that run on different operating systems. You define jobs for your Application in the Workload Editor component of Workstation. In this sample scenario, all jobs run on the z/OS operating system.

To introduce you to this concept, consider the following example. You want to schedule six jobs where:

- The Application begins processing with job A. Job A runs daily.
- When job A completes, ESP Workload Manager releases job B and C to run. They also run daily.
- When job B and C complete, job D is released. Job D also runs daily.
- Then, if it is a Friday, job E is released.
- Then, if it is the last workday of the month, job F is released.

To set up and run this Application, you must have JCL available. The names of the jobs in this scenario are A, B, C, D, E, and F.

**Note:** You may want to substitute the names of these jobs with your own names.

The following flowchart depicts the relationship among the six jobs.
Opening the Workload Editor

The Workload Editor button is located on the Workstation Toolkit:

Open the Workload Editor using one of these methods

- On the Workstation Toolkit, click the Editor button.
- On the Workstation Toolkit menu bar, select ESP Tools > Workload Editor.

The Workload Editor appears. The left-hand pane is referred to as the workspace. This is where you drop the icons from the job palette, to create workflow diagrams (known as Applications). The right-hand pane is where the statements that form the Application are displayed.
Before creating an Application, you can specify some common defaults at the Application level, referred to as workload definition defaults. These defaults apply to all the jobs that you define within your Application.

For this example, do the following:

1. On the Workload Editor menu bar, select **Options > Workload Definition Defaults**.
   
The Workload Definition Defaults dialog appears.

2. Give your Application a name, see “Naming the Application” on page 25.

3. Identify the Job Control Language (JCL) library where the z/OS jobs in the Application reside, see “Identify the JCL library” on page 26.

For more information about all the optional Application defaults, see “Setting Workload Definition Defaults” on page 66.

### Naming the Application

In the Application name field, enter **QUICK**. An Application name can be up to eight alphanumeric or national characters ($,#,@). The first character must be alphabetic.
Identify the JCL library

The example on the following pages is for the z/OS operating system. For z/OS, you identify the JCL library. The JCL library contains the JCL for the jobs in your Application. This statement in your Application specifies the default JCL library you want to use throughout an Application. This saves you the task of repeatedly specifying the same information as part of each job’s details if all the jobs reside in the same library.

If the jobs do not reside in the same library, then you must specify the library for each job at the job level. This is done in the job details. See “z/OS Details” on page 95.

To specify the JCL library for the complete Application

1. On the Workload Definition Defaults dialog, click the Libraries tab.
2. In the Library name field, enter the name of your JCL Library.
   Quotation marks are not required.
3. Click OK.
Creating a Workflow Diagram

The workspace on the Workload Editor provides a menu of icons across the bottom, one for each type of job that you can define in an Application. This menu is called the job palette. You use it to create a workflow diagram that shows you a graphical representation of your workload.

For this example, the z/OS icon is used to create a workflow diagram of six jobs.

Place icons onto the workspace

The first step in creating a workflow diagram is to place an icon for each job in your Application onto the workspace.

To place icons onto the workspace

1. Ensure you are in dialog editing mode by checking to see that your job palette is active.
   
   If your job palette is grayed out, from the Actions menu, click Switch Editing Mode.

2. Select the z/OS icon from the job palette to represent your job.

3. Move the box onto the workspace. Left-click the mouse. The box changes to the icon selected from the job palette and is dropped into position.

4. Place five more z/OS icons on the workspace.
   
   See the illustration on the next page.
**Hint:** When you need to use the same icon multiple times, you do not need to click the icon on the job palette repeatedly. Simply click the icon once then left-click the mouse as many times as you need on the workspace, and the same icon is placed there until you choose another type of icon. In this Application, you could left-click five more times because there are six jobs to schedule.

Notice as you place an icon on the workspace, each job is represented by descriptive text in the right-hand pane. This represents the code that ESP Workload Manager needs to run your Application.
Creating Job Dependencies

Once your job icons are on the workspace, you can graphically illustrate the job dependencies in your Application.

**Use one of the following methods to change your cursor**

- On the Workload Editor menu bar, select **Actions > Create Dependencies**.
- On the toolbar, click the **Create Dependencies** icon.

- Use the keyboard shortcut **Ctrl+Shift+E**.
  
  Your cursor displays as a wand-like pointer.

**To create dependencies between jobs**

1. Click and hold the left mouse button down on the first job you want to schedule.
2. Drag the mouse between the first job scheduled and the next job to be released (its successor). A line indicates the job’s dependency.
3. Release the left mouse button. A line appears between the two jobs.
4. Move to the next icon and click and hold the left mouse button down, and drag to the next job.
5. Click and drag the mouse to draw lines from the jobs to their successors. Repeat this step until all dependencies are drawn.

Note: Release statements have been added to the text in the right hand pane.

Organize the layout of your workflow diagram

Now that you have created your workflow with job dependencies, you can view your layout in an orderly sequence.

Activate Layout using one of these methods

- On the Workload Editor menu bar, select View > Layout.
- On the toolbar, click the Layout icon.
- Use the keyboard shortcut CTRL+I.
Your Application and its job dependencies are visually represented in an organized way.

**Release conditions**

ESP Workload Manager releases a job after its predecessor job completes normally; this is the default. You may change this setting so a job can release after the predecessor job completes abnormally, when any predecessor terminates, or when certain release conditions are met. For this option to appear, the job icons must be on the workspace and the job dependencies must be drawn.
Workload Editor displays different dependency lines depending on the release condition you specify between jobs. Each release condition option has a different dependency line type. In the example below, JobE is dependent on a conditional release of JobE. The conditional release is indicated by the thick solid line between JobD and JobE.

To change the release conditions

1. In your workflow diagram, right-click the job dependency line.
2. From the drop-down menu, select **Release Condition**.

   The Release Condition dialog appears. The **Normal completion of the predecessor** is the default release condition.

3. Choose one of the release condition options.
   - Abnormal completion of the predecessor
   - Any completion of the predecessor
   - Normal completion of the predecessor
   - Conditional Release
For more details, see “Adding Release Conditions to Job Dependencies” on page 325.

4. Click **OK**.

**Find from node**

You may want to highlight any job’s predecessor or successor jobs in an Application, particularly when you have a very large Application that requires you to scroll to see all of it.

**To find out what jobs a predecessor job releases**

1. In your workflow diagram, right-click the job dependency line that runs from the job whose successors you want to identify.

2. From the drop-down menu, select **Find To Node**.
   
   The successor jobs’ names are highlighted.

   **Note:** The Find from node feature works back up the workflow diagram and highlights the job names of those jobs that are predecessors.
By default, the jobs on the workspace are labelled with the operating system name and a sequential number. To change the job name to a more meaningful name, you specify this in the job details.

For more information about all the details you can set at the job level, see “Specifying Defaults and Details for all Workload” on page 93.

To change the job name

1. Right-click the icon that represents the first job in your workflow diagram.
   A shortcut menu appears.
2. From the shortcut menu, click Job Details.
   The Job Details dialog appears.
3. On the General tab, in the Name field, enter A as the name of the job.
   This example uses A, B, C, D, E, and F for the six jobs. Job names must be unique within an Application.
   **Note:** The JCL library specified on page 26, should have JCL for six jobs with these names.
Specify when a job is to run

In an Application, you must specify when each job is to run. This is known as a job’s run frequency. You can define a single condition or you can create a list of conditions under which a job is to run or not run.

For information on Run Frequency, see the “Run Frequency tab” on page 114.

To specify when a job is to run

1. On the Job Details dialog, click the Run Frequency tab.
2. On the Specify Run Frequency box, click the Run button.
3. In the text field provided, enter DAILY. This information is not case-sensitive.
4. Click Add. The run frequency condition is added to the List of Run Frequency Conditions box.
5. Click OK.
6. Right-click the second icon in your workflow diagram. Change the job name to 'B' and set a run frequency for it.

Use the following job frequencies for the remaining jobs:

B, C, D - daily
E - friday
F - last workday of month
7. Right-click the third icon and so on, until all six icons have been renamed and a run frequency is specified.
Saving the Application

When you have finished specifying the job details, you must save your Application. You do not need to be connected to ESP Workload Manager to define and save Applications locally. Once the Application is saved, you can upload it to the host where ESP Workload Manager resides. You must be connected to ESP Workload Manager to upload your Application.

To save your Application locally
1. On the Workload Editor menu bar, select File > Save As.
   The Save As dialog appears.
2. Browse to the directory where you want to save your Application.
3. In the File name field, enter QUICK as your Application name and click Save.

Uploading an Application

Once you save your Application locally, upload it to the mainframe. You must be connected to ESP Workload Manager to upload your Application.

To upload an Application to ESP Workload Manager
1. On the Workload Editor menu bar, select File > Upload Workload Definition.
   The Upload to Procedure Library dialog appears.
2. In the Name field, enter the name of the data set where you want to store your Procedures and Applications. This data set would have been previously allocated.
3. In the Member field, enter QUICK as the name of your Application. Your Application will be stored in the data set and member specified.
4. In the Do not override if member exists field, check-mark this box if a member with the same name already exists, and you don’t want to replace it.
5. In the ESP Workload Manager field, click the arrow to choose the server.
6. Click OK. A confirmation message appears.
7. Click **OK**. The Application is uploaded.
Running your Application

Once you create an Application, you must inform ESP Workload Manager when to run it and where the definition is stored. To do this, you create an Event. Events are created in the Event Manager. The following instructions step you through the process of running your Application.

The Event Manager button is located on the Workstation Toolkit:

Open the Event Manager using one of these methods

- On the Workstation Toolkit, click the Event button.
- On the Workstation Toolkit menu bar, select ESP Tools > Event Manager.

The Event Manager appears.

To load the Event Manager

Click the server name.

To create an Event

1. On the Event Manager toolbar, click New.

The Event Properties dialog appears.
2. Name the Event. An Event name has two parts, a prefix and a descriptive name. In the Specify Event Properties dialog, in the **Prefix** field, enter a prefix. The prefix can contain up to eight alphanumeric characters, including the national characters. The prefix corresponds to a user ID or a group ID set up on your security system, for example, the user ID you used to connect to Workstation.

In the **Name** field, enter a name for the Event you want to create. Event names can contain up to 16 characters, including the national characters and the underscore. Event names must be unique from each other. It is a good idea to name your Event the same name as the Procedure or Application it invokes. For this example, enter the name **QUICK**.

3. Click **Next** until the Run ESP Procedure dialog appears.

**Note**: An Application is a type of Procedure.

**Specify the Application to run**

1. In the Specify ESP Procedure to Run dialog, in the **Data set name** field, enter the name of the data set on the host you have allocated for storing Procedures and Applications. This is the same data set specified in the Upload to Procedure Library dialog, used to upload the Application from Workload Editor to the mainframe.

2. In the **Member name** field, enter the name of the data set member. In this example, the member has the same name as the Application, enter **QUICK**.
3. Click **Add**.

The data set name and member name are added to the List of Procedures to Run dialog.

4. Click **Next** until the Schedule Definition dialog appears.

**Specify when to run the Application**

1. In the Specify Schedule Criteria section of the dialog, ensure the Schedule button is selected, if not, select **Schedule**. In the text field, enter **4 PM DAILY**.

2. Click **Add**.

The information appears in the Resulting Schedule Criteria box.
Upload your Event to ESP Workload Manager

1. Click Next on the dialogs until the Comments dialog appears. Click Finish. The Event Properties dialog appears.

2. In the Event Properties tab, click Upload. This uploads the current Event definition to ESP Workload Manager. A message appears telling you when the Event named QUICK will execute.

3. Click OK.
In the left-hand pane, the tree view now includes the Event QUICK.
In the Event Manager, use the simulation feature to see a graphical representation of an Application. You can simulate the next execution of the Event, a future execution or a past execution.

For this example, the Event named QUICK is simulated.

**To simulate an Event**

1. In the tree view, select the Event.
2. Open the Simulate Event dialog using one of these methods:
   - In the left-hand pane, right-click the QUICK Event. From the shortcut menu, click Simulate.
   - On the Event Manager menu bar, select Actions > Simulate.
   - On the toolbar, click the Simulate icon.

The Simulate Event dialog appears.

For this example, you will simulate the following schedule criteria:
- Next execution of the Event
- Friday
- Last workday of month
Next execution of the Event

To simulate the next execution of the Event, you do not have to fill in any of the fields on the Simulate Event dialog. The default is the next scheduled execution or NOW if the Event is not scheduled.

1. Click OK. A message appears asking you to wait while Workstation simulates the Event. A graphical representation of the Application is displayed.
   
   If it is prior to 4pm, you will see what jobs are selected today. Otherwise, you will see what jobs will be selected the next day.

2. On the toolbar, click CloseGraph.
   
   The main Event screen appears.

Friday

1. Open the Simulate Event dialog again.

2. In the Schedule Criteria field, enter friday.

3. Click OK. A message appears asking you to wait while Workstation simulates the Event. A graphical representation of the Application is displayed.
   
   Job E is added to the graph because it is scheduled to run on Fridays.

4. On the toolbar, click CloseGraph.
   
   The main Event screen appears.

Last workday of month

1. Open the Simulate Event dialog again.

2. In the Schedule Criteria field, enter last workday of month.

3. Click OK. A message appears asking you to wait while Workstation simulates the Event. A graphical representation of the Application is displayed.
   
   Job F is added to the graph because it is scheduled to run the last workday of the month. By default, when ESP Workload Manager selects jobs for submission, it automatically checks to see if any relationships among jobs should be inherited. For example, if the last workday of the month is a Friday, job F must wait for job E to complete before it can run. Also, if the last workday of the month is not a Friday, job D automatically releases job F.

4. On the toolbar, click CloseGraph.
Your Event is scheduled to run at 4 PM each day. If you want to run the Event immediately, you can manually trigger the Event.

**To manually trigger an Event**

1. Select the Event.

2. Open the Trigger the Event dialog using one of these methods:
   - In the left-hand pane, right-click the QUICK Event. From the shortcut menu, click **Trigger**.
   - On the Event Manager menu bar, select **Actions > Trigger**.
   - On the toolbar, click the **Trigger** icon.

   ![Trigger Icon]

   The Trigger the Event dialog appears.

   ![Trigger Event Dialog]

3. Leave the Schedule Criteria field blank on the Options tab, because you want to trigger the Event immediately.

4. On the **Options** tab, click **Add new scheduled Event**.

5. Click **OK**. A message appears confirming the Event is triggered. The Event submits the Application immediately, as well as at 4 PM.

6. Click **OK**.
Viewing your Jobs

The Workload Director component of Workstation is used to monitor and control your Applications or individual jobs, as they run. You can view workload that has recently completed, is currently running or is scheduled to run. Workload Director provides a Graphical View of the workload or you can create a text-based Custom View.

The Workload Director button is located on the Workstation Toolkit:

![Workload Director Button](image)

### Open the Workload Director using one of these methods

- On the Workstation Toolkit, click the **Director** button.
- On the Workstation Toolkit menu bar, select **ESP Tools > Workload Director**.
- Use the keyboard shortcut **Ctrl+N**.

The Workload Director appears.

### Graphical View

The Graphical View organizes and displays the Applications and their generations. Each Application is represented by a folder labelled with the Application name and the number of generations of the Application.

#### To view generations of an Application

1. Click the **Graphical View** tab. Tabs that control which view is active are located on the bottom left side of the Workload Director interface.

   ![Graphical View](image)

2. Right-click the **address** in the tree view. A shortcut menu appears.
3. On the shortcut menu, click **Subscribe No Filter**. The folder beside the address appears with a plus (+) sign.

4. Click the **plus (+) sign**.

5. Scroll down until you find the QUICK Application. The Applications are listed alphabetically.

6. Double-click the **QUICK** folder. The QUICK folder expands, and a folder for each generation of the Application is displayed.

7. Double-click the **generation** of the Application you want to view. In the right-hand pane of the Workload Director, a Graphical View of your Application is displayed.

   As the jobs in the Application pass through different states, the job label indicates the job’s state and the border surrounding the job icon changes color.

   In addition to viewing your Applications you can take actions against a job.

**To view a list of actions to take for a job**

1. Right-click one of the jobs in the Graphical View.

2. On the shortcut list that appears, select an action to take.
   
   You can also take action against an Application by right-clicking the Application folder and choosing an action from the shortcut list.

**Custom Views**

A Custom View is a textual display you can create to monitor your workload. For example, you might create a Custom View to display all Applications that contain failed jobs. You can create and save Custom Views to display only the information you want, in the format you want. You can also use a Custom View to control jobs within Applications, the same way you control jobs using the Graphical View.
Default Custom Views

Workstation provides default Custom Views. The Custom View tab of the Workload Director provides a list of Custom Views to choose from. The following example shows the Waiting Custom View.

User-defined Custom Views

To create a Custom View

Open the Custom View Configuration dialog using one of these methods:

- On the Workload Director menu bar, select Custom View > New.
- Click the Custom View tab at the bottom of the Workload Director interface. In the left-hand pane, right-click any existing Custom View. On the shortcut menu, click New.
The Presentation tab of the Custom View Configuration dialog appears.

![Custom View Configuration Dialog](image)

1. Move the fields you want to appear in the Custom View from the **Available Fields** list box into the **Selected Fields** list box. To move a field, select the field, and then click the right arrow (>). To move all the fields, click the double right arrow (>>). For this example, click the double right arrow.

   **Note:** To move a field back from the Selected Fields list box, use the left arrows (<) and (<<).

2. In the **Custom View Name** field, enter a name for the Custom View. Choose a meaningful name that identifies the types of information the Custom View displays. For this example, enter **QUICK**. This name will appear in the title bar for the Custom View.

3. To sort the information, click the **Sort** tab.
   - In the Sort By dialog, click the **down arrow** to select the field you want to sort by, for example, select Job Name.
   - Click **Ascending**.

   **Note:** Ascending sorts from A to Z, lowest to highest number or by earliest date. The second and third Then By fields are optional.

4. To set up the filter to display only the QUICK Application, select the **Filter** tab.
   a. Click in the **Field Name** box. A down arrow appears indicating a drop-down list.
   b. Click **Application Name**. Application Name is added to the Resulting Filter Criteria box at the bottom of the dialog.
c. Click in the **Relationship** box, and select **IS** from the drop-down list.
d. Click in the **Value** box, and enter **QUICK**.

5. Click **OK**. The Custom View is now saved and appears in the left-hand pane.

   Optionally, you can select the display colors and the type of display font used in the Custom View. You use the Colors Fonts tab of the Custom View Configuration dialog.

### Change a Custom View

**To change a custom view**

1. In the tree view, right-click on the custom view you want to change.
   
   A shortcut menu appears.

2. Click **Change Definition**.

   The Presentation tab of the Custom View Configuration dialog appears.

3. Repeat steps two through five, making the changes you want.

### Display Custom Views

**To view your Application**

In the tree view, double-click the **QUICK** Custom View.

The Custom View for the **QUICK** Application appears.

### Close Custom Views

**To close a Custom View**

Click the **Close** button (X) in the upper-right corner of the Custom View window.

**Hint:** If you click the Close button at the end of the Workload Director title bar, you close Workload Director.
The Workload Editor

This chapter describes the Workload Editor interface and presents an overview of Workload Editor concepts and terms. It explains the workload defaults and job-level details you can use in your Applications. It also describes the different job types you can schedule with Workstation.

The editor contains workload defaults, Application-level defaults, job-level defaults, and job-level details that can be specified in your Applications. The dialogs that comprise the defaults and details allow for ESP Workload Manager’s many features. It is not necessary to enter data in all the dialogs to create an Application.

For a quick and streamlined approach to creating a new Application, see “Quick Start to Creating and Running Workload” on page 21.

This section contains the following topics:

- Opening the Workload Editor
- Workload Editor Screen Overview
- Summary of Creating an Application
- Setting Workload Definition Defaults
- Specifying Defaults and Details for all Workload
- Uploading and Downloading Applications
The Workload Editor component of Workstation is where you create a graphical workflow of your workload. This graphical workflow represents an ESP Workload Manager Application. This is made easy by dragging and dropping icons that represent jobs for your operating system.

There is also an editing panel that allows for extra statements and conditions you may want to include in your Application.

The Workload Editor button is located on the Workstation Toolkit. You can use the editor without being connected to ESP Workload Manager. Applications can be saved locally. You must be connected to upload Applications to the host.

Open the Workload Editor using one of these methods

- On the Workstation Toolkit, click the Editor button.
- On the Workstation Toolkit menu bar, select ESP Tools > Workload Editor.

The Workload Editor appears. The left-hand pane is referred to as the workspace. This is where you drop the icons from the job palette, to create workflow diagrams (known as Applications). The right-hand pane is where the statements that form the Application are displayed.
The Workload Editor screen contains the following components:

- Menu bar
- Toolbar
- Job palette
- Status Bar
- Left-hand pane (referred to as the workspace)
- Right-hand pane (where the Application statements are displayed)

**Menu bar**

The Workload Editor menu bar contains these menu items:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Use</th>
</tr>
</thead>
</table>
| File | • open a new document  
|      | • open an existing workload definition file  
|      | • close the Workload Editor  
|      | • save your work  
|      | • download, upload workload definitions  
|      | • change print setup options  
|      | • view a print preview  
|      | • print  
|      | • change postscript setup options  
<p>|      | • exit the Workload Editor |</p>
<table>
<thead>
<tr>
<th>Menu</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit</td>
<td>The following actions are for jobs/icons on the workspace:</td>
</tr>
<tr>
<td></td>
<td>• cut</td>
</tr>
<tr>
<td></td>
<td>• copy</td>
</tr>
<tr>
<td></td>
<td>• paste</td>
</tr>
<tr>
<td></td>
<td>• clear all</td>
</tr>
<tr>
<td></td>
<td>• delete</td>
</tr>
<tr>
<td></td>
<td>• select all</td>
</tr>
<tr>
<td>Edit Text</td>
<td>The following actions are available for editing text in the right-hand pane. The ‘switch editing mode’ button must be selected:</td>
</tr>
<tr>
<td></td>
<td>• cut</td>
</tr>
<tr>
<td></td>
<td>• copy</td>
</tr>
<tr>
<td></td>
<td>• paste</td>
</tr>
<tr>
<td></td>
<td>• find</td>
</tr>
<tr>
<td></td>
<td>• replace</td>
</tr>
<tr>
<td></td>
<td>• clear</td>
</tr>
<tr>
<td></td>
<td>• remove</td>
</tr>
<tr>
<td></td>
<td>• refresh view of the graph on the workspace</td>
</tr>
<tr>
<td>View</td>
<td>• overview window - displays a small version of the workspace</td>
</tr>
<tr>
<td></td>
<td>• layout - neatly organizes the layout of the jobs in your Application</td>
</tr>
<tr>
<td></td>
<td>• toolbar, job palette, and status bar - select or deselect for viewing</td>
</tr>
<tr>
<td></td>
<td>• graph properties - use to tailor graphical properties</td>
</tr>
<tr>
<td></td>
<td>• zoom - use this feature to set size preferences</td>
</tr>
<tr>
<td>Menu</td>
<td>Use</td>
</tr>
<tr>
<td>----------</td>
<td>----------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Options  | • user profile options - autosave, backup files, editing mode options, placement of comments after download, job name display options, and do not override option  
|          | • global defaults - workload definition and job                      
|          | • workload definition defaults                                       
|          | • job defaults                                                       |
| Actions  | • create job                                                         
|          | • create dependencies                                                
|          | • locate job in graph                                                
|          | • switch editing mode                                                |
| Tools    | • job definition inspector - provides a correlation between jobs/icons on the workspace and text in the right-hand pane  
|          | • find free form text down - searches down for the next occurrence of free form text in the right-hand pane  
|          | • find free form text up - searches up for the next occurrence of free form text in the right-hand pane |
| Window   | • cascade                                                            
|          | • tile                                                               
|          | • arrange icons                                                      
|          | • close all                                                          
|          | • list of currently open documents                                   |
| Help     | • ESP Workstation Help - search for task-based help                  
|          | • CA Support - connects to CA support website                        
|          | • About ESP Workstation - product specifications                     
|          | • CA Online - connects to CA website                                  |
# Toolbar

The toolbar contains buttons that provide shortcut access to the most commonly used features. The Workload Editor toolbar contains these buttons:

<table>
<thead>
<tr>
<th>Button</th>
<th>Name</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="File" /></td>
<td>New</td>
<td>Create a new workspace.</td>
</tr>
<tr>
<td><img src="image" alt="File" /></td>
<td>Open</td>
<td>Open a file from a directory.</td>
</tr>
<tr>
<td><img src="image" alt="File" /></td>
<td>Save</td>
<td>Save a file.</td>
</tr>
<tr>
<td><img src="image" alt="Download" /></td>
<td>Download procedure</td>
<td>Download a procedure from the host.</td>
</tr>
<tr>
<td><img src="image" alt="Upload" /></td>
<td>Upload procedure</td>
<td>Upload a procedure from the host.</td>
</tr>
<tr>
<td><img src="image" alt="SAP Filter" /></td>
<td>SAP Filter</td>
<td>Display the SAP Filter Panel to create and update SAP job filters.</td>
</tr>
<tr>
<td><img src="image" alt=" BWIP jobs panel" /></td>
<td>BWIP jobs panel</td>
<td>Display or hide the dockable Business Warehouse InfoPackage job panel.</td>
</tr>
<tr>
<td><img src="image" alt=" BWPC jobs panel" /></td>
<td>BWPC jobs panel</td>
<td>Display or hide the dockable Business Warehouse Process Chains job panel.</td>
</tr>
<tr>
<td><img src="image" alt=" BDC jobs panel" /></td>
<td>BDC jobs panel</td>
<td>Display or hide the dockable Batch Input Sessions job panel.</td>
</tr>
<tr>
<td><img src="image" alt="Print" /></td>
<td>Print</td>
<td>Print an Application.</td>
</tr>
<tr>
<td><img src="image" alt="Print preview" /></td>
<td>Print preview</td>
<td>View a preview of how your printed Application will look.</td>
</tr>
<tr>
<td><img src="image" alt="Cut" /></td>
<td>Cut</td>
<td>Remove a selected job.</td>
</tr>
<tr>
<td>Button</td>
<td>Name</td>
<td>Use</td>
</tr>
<tr>
<td>--------</td>
<td>-------------------------------------------</td>
<td>---------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><img src="image" alt="Copy" /></td>
<td>Copy</td>
<td>Copy a selected job.</td>
</tr>
<tr>
<td><img src="image" alt="Paste" /></td>
<td>Paste</td>
<td>Paste a selected job into another document or window.</td>
</tr>
<tr>
<td><img src="image" alt="Select" /></td>
<td>Select</td>
<td>Select one or more jobs.</td>
</tr>
<tr>
<td><img src="image" alt="Job definition inspector" /></td>
<td>Job definition inspector</td>
<td>Determine a job’s Application coding on the right-hand pane.</td>
</tr>
<tr>
<td><img src="image" alt="Overview Window" /></td>
<td>Overview Window</td>
<td>See a secondary window that displays an overview of your whole Application.</td>
</tr>
<tr>
<td><img src="image" alt="Create jobs" /></td>
<td>Create jobs</td>
<td>Drop jobs from the previously selected icon, on the workspace.</td>
</tr>
<tr>
<td><img src="image" alt="Create dependencies" /></td>
<td>Create dependencies</td>
<td>Turn the cursor into a line to draw dependencies between jobs.</td>
</tr>
<tr>
<td><img src="image" alt="Layout" /></td>
<td>Layout</td>
<td>Neatly organize the layout of the jobs in your Application.</td>
</tr>
<tr>
<td><img src="image" alt="Locate job in graph" /></td>
<td>Locate job in graph</td>
<td>Locate a specific job in your Application.</td>
</tr>
<tr>
<td><img src="image" alt="Find free form text down" /></td>
<td>Find free form text down</td>
<td>Search down for the next occurrence of free form text in the right-hand pane.</td>
</tr>
<tr>
<td><img src="image" alt="Find free form text up" /></td>
<td>Find free form text up</td>
<td>Search up for the next occurrence of free form text in the right-hand pane.</td>
</tr>
<tr>
<td><img src="image" alt="User profile options" /></td>
<td>User profile options</td>
<td>Specify autosave, backup files, editing mode options, placement of comments after download, and job name display options.</td>
</tr>
<tr>
<td><img src="image" alt="Switch editing mode" /></td>
<td>Switch editing mode</td>
<td>Switch between editing and non-editing mode on the right-hand pane.</td>
</tr>
</tbody>
</table>
User Profile Options

In the User Profile Options dialog you can set options that apply to the Workload Editor. The available options are described below.

Use one of these methods to open the User Profile Options dialog
- On the menu bar, select Options > User Profile Options.
- On the toolbar, click the User Profile Options icon.

The User Profile Options dialog appears.

<table>
<thead>
<tr>
<th>Button</th>
<th>Name</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Refresh views</td>
<td>In text editing mode, refresh the graphical view on the workspace to reflect text changes.</td>
</tr>
</tbody>
</table>
**Autosave**
To set Workload Editor to automatically save your open files:
1. Select the **Enable** check box.
2. Enter or select the number of minutes between automatic saves.

**Backup Files**
To set Workload Editor to automatically create a backup file when your file is opened:
1. Select the **Enable** check box.
2. Set the folder where you want the backup file saved. You can either enter a path or click the ellipsis button to browse for a folder.

**Choose Editing Mode**
To set the default editing mode for Workload Editor, select one of the two editing mode options:

- **Use Workload Editor dialogs**
  Panel editing is using the fields on the tabs to specify statements and options. In this mode, Free Form Text statements can be entered through the Free Form Text panel. For more information, see “Panel editing with Free Form Text” on page 137.

- **As text only**
  Text editing means you can enter text directly into the right-hand pane. In this mode, Free Form Text statements can be entered through the Free Form Text panel or directly into the right-hand pane. For more information, see “Text editing with Free Form Text” on page 139.

**Note:** The statements entered through Free Form Text must be valid, otherwise run-time errors are generated. The statements you should enter in Free Form Text are statements that cannot be entered in any of the panels in the Job Details. An example of these statements are:

- REXX
- TEMPLATE
- IF, DO/ENDDO blocks
- labels
- New statements that are not supported by ESP Workstation

**Placement of Comments after Download**
There are two options available in Workload Editor regarding how you view job comments in an Application:

- Preserve placement of comments
- Global comments placed within job definition
Preserve placement of comments
Workstation will move job comments when an Application is downloaded from the host. Job comments are moved from within the scope of the job to outside the scope of the job. To keep job comments displayed within the scope of the job, select this option.

Global comments placed within job definition
Workstation considers comments placed outside of a job definition global comments and they are not displayed inside the following job definition. To display comments placed before the JOB statement as part of the job definition, select this option. This option refers only to comments placed immediately before a job definition, not to other global statements.

Display in the Graphical View
You have the ability to specify which variation of a job name you would like to see displayed. You can display the 64-character-long job name, the typical eight-character job name or both.

Do not override if member exists
When you upload a Procedure to the mainframe, this option prevents a Procedure from overriding a previously stored Procedure with the same name. When enabled, it sets the default and affects all Procedures when you upload.

Job palette
The job palette is a menu of icons on the Workload Editor screen.

The defaults and details related to each icon are described. See “Specifying Defaults and Details for all Workload” on page 93.

The job palette contains the following job types:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="z/OS icon" /></td>
<td>Represents a z/OS job</td>
</tr>
<tr>
<td><img src="image" alt="Link icon" /></td>
<td>Represents a Link job</td>
</tr>
<tr>
<td>Icon</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="image1.png" alt="Task Job Icon" /></td>
<td>Represents a Task job</td>
</tr>
<tr>
<td><img src="image2.png" alt="Data Set Trigger Job Icon" /></td>
<td>Represents the Data Set Trigger job</td>
</tr>
<tr>
<td><img src="image3.png" alt="File Trigger Job Icon" /></td>
<td>Represents the File Trigger job</td>
</tr>
<tr>
<td><img src="image4.png" alt="Generic UNIX Job Icon" /></td>
<td>Represents a Generic UNIX job</td>
</tr>
<tr>
<td><img src="image5.png" alt="AIX Job Icon" /></td>
<td>Represents an AIX job</td>
</tr>
<tr>
<td><img src="image6.png" alt="HP-UX Job Icon" /></td>
<td>Represents an HP-UX job</td>
</tr>
<tr>
<td><img src="image7.png" alt="NCR Job Icon" /></td>
<td>Represents an NCR job</td>
</tr>
<tr>
<td><img src="image8.png" alt="Sequent Job Icon" /></td>
<td>Represents a Sequent job</td>
</tr>
<tr>
<td><img src="image9.png" alt="Sun-Solaris Job Icon" /></td>
<td>Represents a Sun-Solaris job</td>
</tr>
<tr>
<td><img src="image10.png" alt="LINUX Job Icon" /></td>
<td>Represents a LINUX job</td>
</tr>
<tr>
<td><img src="image11.png" alt="OS/400 Job Icon" /></td>
<td>Represents an OS/400 job</td>
</tr>
<tr>
<td><img src="image12.png" alt="Windows NT/2000 Job Icon" /></td>
<td>Represents a Windows NT/2000 job</td>
</tr>
<tr>
<td><img src="image13.png" alt="SAP and SAP Job Copy Job Icon" /></td>
<td>Represents an SAP and SAP Job Copy job</td>
</tr>
<tr>
<td>Icon</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="image1" alt="Icon" /></td>
<td>Represents a Business Warehouse InfoPackage job</td>
</tr>
<tr>
<td><img src="image2" alt="Icon" /></td>
<td>Represents a Business Warehouse Process Chain job</td>
</tr>
<tr>
<td><img src="image3" alt="Icon" /></td>
<td>Represents a Batch Input Session job</td>
</tr>
<tr>
<td><img src="image4" alt="Icon" /></td>
<td>Represents a Data Archiving job</td>
</tr>
<tr>
<td><img src="image5" alt="Icon" /></td>
<td>Represents a Process Monitor job</td>
</tr>
<tr>
<td><img src="image6" alt="Icon" /></td>
<td>Represents an Event Monitor job</td>
</tr>
<tr>
<td><img src="image7" alt="Icon" /></td>
<td>Represents an OpenVMS job</td>
</tr>
<tr>
<td><img src="image8" alt="Icon" /></td>
<td>Represents a DataObject job</td>
</tr>
<tr>
<td><img src="image9" alt="Icon" /></td>
<td>Represents a Tandem job</td>
</tr>
<tr>
<td><img src="image10" alt="Icon" /></td>
<td>Represents an Agent Monitor job</td>
</tr>
<tr>
<td><img src="image11" alt="Icon" /></td>
<td>Represents an Applend job</td>
</tr>
<tr>
<td><img src="image12" alt="Icon" /></td>
<td>Represents a PeopleSoft job</td>
</tr>
<tr>
<td><img src="image13" alt="Icon" /></td>
<td>Represents an FTP job</td>
</tr>
<tr>
<td>Icon</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="image" alt="Database" /></td>
<td>Represents a Database job</td>
</tr>
<tr>
<td><img src="image" alt="Windows Event Log Monitor" /></td>
<td>Represents a Windows Event Log Monitor job</td>
</tr>
<tr>
<td><img src="image" alt="Process Monitor" /></td>
<td>Represents a Process Monitor job</td>
</tr>
<tr>
<td><img src="image" alt="Service Monitor" /></td>
<td>Represents a Service Monitor job</td>
</tr>
<tr>
<td><img src="image" alt="Text File Reading and Monitoring" /></td>
<td>Represents a Text File Reading and Monitoring job</td>
</tr>
<tr>
<td><img src="image" alt="IP Monitor" /></td>
<td>Represents an IP Monitor job</td>
</tr>
<tr>
<td><img src="image" alt="CPU Monitor" /></td>
<td>Represents a CPU Monitor job</td>
</tr>
<tr>
<td><img src="image" alt="Disk Monitor" /></td>
<td>Represents a Disk Monitor job</td>
</tr>
<tr>
<td><img src="image" alt="J2EE EJB" /></td>
<td>Represents a J2EE EJB job</td>
</tr>
<tr>
<td><img src="image" alt="J2EE JMS Publish" /></td>
<td>Represents a J2EE JMS Publish job</td>
</tr>
<tr>
<td><img src="image" alt="J2EE JMS Subscribe" /></td>
<td>Represents a J2EE JMS Subscribe job</td>
</tr>
<tr>
<td><img src="image" alt="Oracle Apps Single Request" /></td>
<td>Represents an Oracle Apps Single Request job</td>
</tr>
<tr>
<td><img src="image" alt="Oracle Apps Request Set" /></td>
<td>Represents an Oracle Apps Request Set job</td>
</tr>
</tbody>
</table>
The Connect to FTP dialog appears when any command from Workstation requests a large amount of data from the Workstation Server. For example, in Workload Editor defining an SAP job and requesting SAP ABAP or Variant information typically generates the Connect to FTP dialog.

The Connect to FTP dialog contains the same fields as the Connect dialog in Connection Manager:

- Address
- Port
- User Name
- Password

**Hint:** Click F1 in any field for Help information specific to that field.

---

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Icon" /></td>
<td>Represents the following External jobs: z/OS, UNIX (all types), Linux, OS/400, Windows NT/2000, SAP (all types), OpenVMS, Tandem, Agent Monitor, Applend, PeopleSoft, Scheduler, FTP, Database, Monitoring (all types), Oracle Apps, and J2EE.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Icon" /></td>
<td>Represents an SQL job</td>
</tr>
<tr>
<td><img src="image3.png" alt="Icon" /></td>
<td>Represents a DB Stored Procedure job</td>
</tr>
<tr>
<td><img src="image4.png" alt="Icon" /></td>
<td>Represents a DB Trigger job</td>
</tr>
<tr>
<td><img src="image5.png" alt="Icon" /></td>
<td>Represents a DB Monitor job</td>
</tr>
</tbody>
</table>
Summary of Creating an Application

The following are the basic steps involved in creating an Application:

1. Specify workload definition defaults, for example, naming the Application. For information on Application defaults, see “Setting Workload Definition Defaults” on page 66. For the minimal default settings, see “Setting Default Values” on page 25.

2. Create a workflow diagram by dragging and dropping icons from the job palette to the workspace. See “Creating a Workflow Diagram” on page 27.

3. Create dependencies between the jobs. See “Creating Job Dependencies” on page 29.

4. Specify job details, for example, naming the jobs and indicating when they are to run. For information on job details, see “Specifying Defaults and Details for all Workload” on page 93. For the minimal job detail settings, see “Setting Job Details” on page 34.

5. Save the Application, see “Saving the Application” on page 36.

There are workload definition defaults, Application-level defaults, job-level defaults, and job-level details that can be specified in your workload. These are discussed on the following pages. This chapter documents all the scheduling options available.

Sample Application

Chapter 2 provides an overview flowchart and a sample scenario to follow on creating, running, and viewing an Application, see “Overview Flowchart” on page 22.
Setting Workload Definition Defaults

Workload definition defaults are characteristics that are common to all the Applications you define. Setting workload definition defaults saves you time entering the same information over and over again, for example, a library name where all the jobs for all future Applications are going to reside.

To set Workload Definition defaults for all Applications
On the Workload Editor menu bar, select Options > Global Defaults > Workload Definition.

The Universal Workload Definition Defaults dialog appears.

Notice the Application name field is grayed out. It is grayed out because the defaults you are setting are for all Applications. You can’t set a name for all future Applications.

Application-level defaults

To set default values for all jobs in an Application
On the Workload Editor menu bar, select Options > Workload Definition Defaults.
The Workload Definition Defaults dialog appears.

Notice the Application name field is not grayed out. This is where you name your Application. The Application name entered here applies to the workflow diagram created on the workspace.

This is the only difference between all the tabs and all the fields on the two sets of default dialogs. The following section walks you through the six tabs that comprise the workload definition defaults, for all jobs in an Application.

For the minimal default settings, see “Setting Default Values” on page 25.

Application tab

Define an Application

Application name
Enter a name in the Application name field.

An Application name can be up to eight alphanumeric or national characters ($,#,@). The first character must be alphabetic.

Application tag
Enter a character string up to 16 characters in length.

This string can contain ESP Workload Manager symbolic variables. This is used to tag jobs in an Application, so you can then filter jobs with a common characteristic.

The TAG string can be job specific or can apply to all jobs in an Application.
**Owner**
Enter a valid Distributed Manager name. This can be up to 16 alphanumeric characters in length. The first character must be alpha or a national character.

**Agent name**
Enter the name of the Agent where the jobs in the Application are to run. This field adds an AGENT statement to your Application definition. You can override the Application-level Agent name at the job default and job details level.

**Wait for previous generation**
Select the check box to indicate each generation of the Application waits until its previous generation is complete.

Indicates that concurrent processing of different generations of an Application is not permitted. Each time an Application runs, a unique instance is created. This is called a generation. When this field is disabled, one generation does not need to complete before the next one starts. Several generations of the Application can run concurrently.

**Hold on submission**
Select the check box to indicate the Application is to be generated on hold.

The only time you specify hold on submission is if you want to manually release an Application.

**Notify when subApplication completes**
Select the check box to indicate that ESP Workload Manager should generate a console message when a subApplication completes.

**Retain xx generations on the APPL file**
Click the up and down arrows to indicate the number of generations of the Application to be retained on the ESP Workload Manager Application(APPL) file.

The APPL file contains data about each Application generation. The default is 20. The maximum allowed is 99. For information about the APPL file, see the *ESP Workload Manager Installation Guide*.

**Posting options**
Select the check box to enable the following posting options:

- **Prevent job from being posted COMPLETE until job has been readied**

  When enabled, this prevents each job in this Application from being marked complete until the job has been readied.

- **Post external and manual jobs COMPLETE in oldest active generation of Application**

  When an external or manual job completes and multiple generations of the Application exist, ESP Workload Manager must decide which generation of the Application to post the job complete in.
• Post external and manual jobs COMPLETE while Application is in WAIT state
  Indicates that external and manual jobs within the Application are posted complete even if the Application is in an APPLWAIT state.

  **Hint:** The following describes a three state check box:
  1. A check box with a check mark indicates the option is enabled.
  2. A check box without a check mark indicates the option is disabled.
  3. A grayed out check box with a check mark indicates the option is ignored.

**Using SAF, jobs within the Application are protected by**
Click a button to enable one of the following options, they are mutually exclusive:

• **APPL.applname.jobname and APPLX.applname.jobname resources**
  Indicates that jobs within the Application are to be protected by the APPL.applname.jobname and APPLX.applname.jobname resources.

• **GROUP.groupname and GROUPX.groupname resources**
  Indicates that jobs within the Application are to be protected by the GROUP.groupname and GROUPX.groupname resources.

**Prevent job with the same name running at the same time**
Click a button to prevent two jobs with the same name running at the same time. Choose between:

• **With previous generation only**
  Indicates that a job is not eligible for submission if the same job in the previous generation of the Application has not completed successfully. ESP Workload Manager only looks at the -1 generation.

  ![APPL PAYROLL JOB ANCESTOR WAIT(LAST)](image)

• **With all previous generations**
  Indicates that a job is not eligible for submission if the same job in any previous generation of the Application has not completed successfully.

  ![APPL PAYROLL JOB ANCESTOR WAIT(ANY)](image)
The following is an example of a complete Application tab:

Click **OK**.

The following are the corresponding statements that display in the right-hand pane for the options selected.

```
APLX PAYROLL WAIT INDEX(2)
NOREQ UNTIL READY
SAF_PROF_APLX
APLX ANCESTRAL WAIT ANY
TAG IMPORTANT
```
Options tab

This tab allows you to select different options for your Application. The fields contain a three state check box. The following describes a three state check box:

1. A check box with a check mark indicates the option is enabled.
2. A check box without a check mark indicates the option is disabled.
3. A grayed out check box with a check mark indicates the option is ignored.

If the option is ignored, no OPTION statement appears in the right-hand pane. If no OPTION statement is displayed, then the ESP Workload Manager defaults for these options will take effect when the Application is running.

**Use Critical Path Analysis**

Select the check box to enable Critical Path Analysis. The CRITPATH statement appears in the right-hand pane.

Critical-path analysis, combined with the ability to set time dependencies and trigger Events automatically, provides the framework for advanced due out notification when mission critical workload does not complete within the designated time frame or window.

ESP Workload Manager allows you to identify a job within an Application that represents a critical point of that Application. The longest path to that job, based on historical execution time, is a critical path.

For more information about critical path analysis, refer to the *ESP Workload Manager User’s Guide*. 
Use Encore
Select the check box to indicate you use ESP Encore. The OPTIONS RESTARTSTEP statement appears in the right-hand pane.

Inherit Dependencies
Select the check box to indicate you want ESP Workload Manager to check to see if any relationships among jobs should be inherited. The OPTIONS INHERIT statement appears in the right-hand pane.

Generate DJC/JES 3 NET control cards
Select the check box to indicate you would like DJC JES 3 net cards produced. The OPTIONS GENNET statement appears in the right-hand pane.

For more information, see “Using ESP with DJC/JES3 Job Networks” in the ESP Workload Manager Advanced User’s Guide.

Submit all jobs manually
Select the check box to indicate you want all jobs submitted manually. The OPTIONS MANUALSUBMIT statement appears in the right-hand pane.

For more information, see the “OPTIONS statement” in the ESP Workload Manager Reference Guide.

Track all jobs manually
Select the check box to indicate you want all jobs tracked manually. The OPTIONS TRACKMANUAL statement appears in the right-hand pane.

For more information, see the “OPTIONS statement” in the ESP Workload Manager Reference Guide.

Allow automatic variable insertion
Select the check box to indicate you want automatic variable insertion. The OPTIONS AUTOVARS statement appears in the right-hand pane.

For more information, see the “OPTIONS statement” in the ESP Workload Manager Reference Guide.

Due out propagation
Select the check box to enable the propagation of due out times for all Applications.

Use temporary ESP procedure library
In an Event definition, you can specify a temporary ESP procedure library. For more information, see “Defining the Run ESP Procedure(s) dialog” on page 355.

You can restrict when ESP Workload Manager uses the temporary ESP procedure library by entering a start time and end time in the From and To fields. You can enter a start time only, an end time only, or both a start time and an end time.

From
Optional. Enter a starting time when a temporary ESP Procedure library is in effect. Use a free format starting time or any valid scheduled criteria, for example MIDNIGHT JANUARY 15, 2008.
For more information, see the “USETIME statement” in the ESP Workload Manager Reference Guide.

**To**
Optional. Enter an end time when a temporary ESP Procedure library is in effect. Use a free format end time or any valid scheduled criteria, for example AUGUST 31, 2008.

For more information, see the “USETIME statement” in the ESP Workload Manager Reference Guide.
Job profiling allows you to distinguish the job history information ESP Workload Manager stores and uses in its time calculations. Use job profiles to gain more accurate information for critical path, anticipated end time, and dueout propagation calculations. When ESP Workload Manager generates an Application, it records the job information under the job’s profile name and stores it in the jobstats data set. By default, ESP Workload Manager keeps the latest ten entries for each profile. You can specify profile names at the Application level and at the job level.

Suppose you have Job B that run workdays for ten minutes and also runs Saturdays for 40 minutes. You can assign a profile to Job B for workdays and a different profile for Saturdays. When ESP Workload Manager generates the Application containing job B on Saturdays for example, it only uses the job information from Saturday’s profile to determine the anticipated end time.

**Job Profile Definition**

**Name**

Enter a name for job profile data. The profile name can be up to 104 characters long and can include symbolic variables. ESP Workload Manager stores the job information for each job in the Application under this profile name. You can override this profile name at the job level.

For more information, see the JOBPROF statement in the *ESP Workload Manager Reference Guide*. 
Criteria
Enter when you want ESP Workload Manager to store data in the job profile record for the job. Use any valid ESP Workload Manager schedule criteria.

For more information, see the JOBPROF statement in the *ESP Workload Manager Reference Guide*.

**Note:** In Workload Director, the Criteria field is disabled when you insert a job.

Libraries tab

### Specify JCL Source

#### Library name
Enter your Job Control Language (JCL) library name.

The JCL library or JCLLIB, contains the JCL for the z/OS jobs in your Application. This statement in your Application specifies the default JCL library you want to use throughout an Application. This saves you the task of repeatedly specifying the same information as part of each job’s definition.

The scope of a global statement extends from the point at which you specify it to either the end of the Application or to the point at which you specify a corresponding global statement. This way you can change or override job defaults several times during an Application, if necessary.

You can specify any of the following, a JCL library, a temporary JCL library, and a COPYJCL library at a global level. You can override the JCL library, member name or COPYJCL library at the job level.
**Temporary Library name**

Enter your temporary library name.

Identifies the temporary or override JCL library you want to use as the default for all jobs following a TEMPLIB statement. ESP Workload Manager uses JCL from this library for job submission if it exists. Otherwise, it uses JCL from the most recent JCLLIB statement. If a MEMBER statement is not used for a job, by default the member name is the same as the job name. You can use the USEMEM statement to override this action.

Select one of the two buttons:

- **Use member name**
  Requests the temporary library name indicated be searched for a member with a different name from the job being submitted.

- **Use job name**
  Requests the temporary library name indicated be searched for a member with the same name as the job being submitted.

**Identify Copy JCL Library**

**Library name**

Enter your COPYJCL library name.

Specifies a library where you can store a copy of the JCL. When specified, it indicates you want to generate a copy of the JCL for every job, as ESP Workload Manager submits it.

This copy is written to a member of a partitioned data set, providing a working copy of the JCL with, where applicable, all symbolic variables resolved. This JCL can be used for job re-submission. ESP Workload Manager keeps track of where the job was submitted from and the JCL that was used. ESP Workload Manager can store the copy of the JCL either by job name or by job ID.

Select one of the two buttons to indicate how you want the JCL stored:

- **Save Job by name**
  Requests ESP Workload Manager to store the copy of the JCL with the same name used for the job. Each submission of a particular job overwrites the previous copy of that job’s JCL.

- **Save Job by ID**
  Requests ESP Workload Manager to store the copy of the JCL by job ID. A member is not overwritten until the job number reoccurs.

**Specify generation number**

Click the up and down arrows to indicate the generation number of the data set.
With either the job name or the job ID method, you can write the JCL to a generation data group. If the Copy JCL data set is a member of a generation data group, then select this check box. A new generation can be created each day to maintain several generations of JCL.

**Specify Job Documentation Library**

**Library name**
Enter your job documentation library name.

The job documentation library contains members of a partitioned data set. Each member consists of control information and/or user description information about a job.

The following is an example of a complete Libraries tab:

![Workload Definition Defaults](image)

The following are the corresponding statements that display in the right-hand pane:

```
APPL PAYROLL
JCLIB CYBER.PROD.JCL
COPY JCL CYBER.JCL.COPY.JCL GENERATION(0) JOBNAME
TEMPLIB CYBER.PROD.TEMPLIB JOBNAME
DOCLIB CYBER.PROD.DOCLIB
```
This tab is used to detect condition codes. You can immediately stop a failing job, without running any subsequent steps regardless of the condition parameters.

**Define Condition Code Interpretation**

**Return code**
Specify a condition code of $num$, where $num$ is an integer between 0 and 4095 inclusively.

You can also specify:

- A condition code between $num1$ and $num2$ inclusively. The value of $num2$ must not be smaller than $num1$.
- A system abend code, (S$ccc$), such as SOC1 or SB37. The $ccc$ must be three hexadecimal digits.
- A user abend code, ($unnm$), such as U0001 or U0462. The $nnm$ must be exactly four decimal digits, and cannot exceed 4095.

**Job name**
This field is disabled, it cannot be edited.

**Step name**
This field is optional. Enter a step within the job. You can use the asterisk and hyphen as wildcard characters.

- An asterisk (*) indicates that any character in the asterisk location acts as a match.
• A hyphen (-) indicates that any character in that or subsequent character positions is considered a match. You can only use the hyphen at the end of a character string.

If you omit this field, ESP Workload Manager condition code checking (CCCHK) matches any procstep name. This field corresponds to the STEP operand in the CCCHK statement.

For more information about CCCHK, see the CCCHK statement in the *ESP Workload Manager Reference Guide*.

**Procedure step**
This field is optional. Enter a particular step within a catalogue or instream procedure. Specifically, it refers to the label on the EXEC statement inside the instream procedure. Procedure step does not refer to the name of the procedure. You must use this field in conjunction with the ‘Step name’ field. You can use the asterisk and hyphen as wildcard characters.

• An asterisk (*) indicates that any character in the asterisk location acts as a match.

• A hyphen (-) indicates that any character in that or subsequent character positions is considered a match. You can only use the hyphen at the end of a character string.

If you omit this field, ESP Workload Manager condition code checking (CCCHK) matches any procstep name. This field corresponds to the PROC operand in the CCCHK statement.

For more information about CCCHK, see the CCCHK statement in the *ESP Workload Manager Reference Guide*.

**Program**
This field is optional. Enter the name of the program that the step executes, as found in the PGM operand on the job’s EXEC statement. You can use the asterisk and hyphen as wildcard characters.

• An asterisk (*) indicates that any character in the asterisk location acts as a match.

• A hyphen (-) indicates that any character in that or subsequent character positions is considered a match. You can only use the hyphen at the end of a character string.

If you omit this field, ESP Workload Manager condition code checking (CCCHK) matches any program name. This field corresponds to the PROGRAM operand in the CCCHK statement.

For more information about CCCHK, see the CCCHK statement in the *ESP Workload Manager Reference Guide*.

**Interpret as**
Select the Success or Failure buttons according to the action you want, as you enter return codes.
In the following example, return codes 4, 8, and 12 are OK and the workflow is to continue running.

- **Success**
  Indicates the job has not failed. This is the default.

- **Failure**
  Indicates the job should be considered failed. When the job has failed, it may or may not continue, depending upon the value of CONTINUE/STOP.

**Choose Action**
Select the Continue or Stop buttons according to the action you want, as you enter return codes.

- **Continue**
  Indicates the job should continue processing with the next step, whether or not the job was deemed to have failed. This is the default.

- **Stop**
  Indicates the job should be stopped immediately. No other steps should be executed.

Click **Add**.

The condition codes are added to the List of Condition Codes field.

The following is an example of a complete Condition Codes tab:
The following are the corresponding statements that display in the right-hand pane:

**List of Condition Codes**

**To update a return code**
1. Click on the return code in the List of Condition Codes to highlight it.
2. Change the above fields.
3. Click **Update**.
4. Click **OK**.

**To delete a return code**
1. Click on the return code in the List of Condition Codes to highlight it.
2. Click **Delete**.
3. Click **OK**.
Use this tab to specify the default connection used when information is required from an Agent through ESP Workload Manager. Agent information is requested through the use of a Refresh button, that appears on all of the SAP job types.

This connection is also used when testing schedule criteria in the Schedule Criteria Editor.
This tab is used to notify users or consoles, when certain workload conditions are met.

**Notify when Workload ...**
Select the check box to indicate you want a notification when this condition occurs.

- **Is submitted**
  Indicates notification should take place at job submit time.
- **Starts running**
  Indicates notification should take place at job start time.
- **Is resubmitted**
  Indicates notification should take place when a job resubmitted through ESP Workload Manager ends.
- **Is overdue**
  Indicates notification should take place when a job becomes overdue from any processing node.
- **ABENDs**
  Indicates notification should take place when a job ABENDs. This excludes condition code failures.
• Fails
Indicates notification should take place when a job fails. This includes condition code failures caused by either the CCCHK or CCFAIL statements.

• Ends
Indicates notification should take place when a job ends. This includes any job end (successful or unsuccessful).

• Premature end
Indicates notification should take place when a job successfully finishes early.

• Mailbox
Enter a mailbox name. The mailbox becomes the destination for messages coming from Events or from this Notification dialog. When a new message arrives in a mailbox, it is distributed to all defined subscribers. Subscriptions are supported for TSO users and email addresses. For information on how to define subscribers, see the LOADNL command in the ESP Workload Manager Reference Guide v.5.4, volume 2.

Specify TSO User(s) to Notify
Enter the user ID that is to receive the notification.

Click Add. The user ID is added to the list box. In the example, user ID PROD will receive the notification.

To delete a user ID, select the user ID in the list box to highlight, then click Delete.

Specify Delivery Options

Routing code
Enter a routing code value between 1 and 128. Separate each routing code with a comma.

The routing code option is added to the notify statement. In the example, all consoles with routing code 2 will receive the notification.

Description code
Enter a description code value between 1 and 16. Separate each description code with a comma.

The description code option is added to the notify statement. In the example, description code 2 is used to highlight the message.

z/OS system name
Enter the name of a Sysplex member.

This is not the ESP Workload Manager system name. It is the name by which z/OS knows the member of the Sysplex. Can be used to route a NOTIFY command in a Sysplex environment to wherever the user is logged on. Use an asterisk to indicate the message goes wherever ESP Workload Manager is running.
**Trigger**

**ESP Alert ID**
Enter an alert ID.

Indicates an Event associated with a logical alert identifier should be triggered. This logical identifier must have been previously specified using an alert definition. For more information on alerts, see “Job Monitoring and Alert Processing” in the *ESP Workload Manager Advanced User’s Guide*.

**Event**
Enter an Event name. Events can be triggered directly or in association with a logical alert identifier.

**List of notifications**

**To update a notification**
1. Click on the notification in the List of notifications to highlight it.
2. Change the above fields.
3. Click Update.
4. Click OK.

**To delete a notification**
1. Click on the notification in the List of notifications to highlight it.
2. Click Delete.
3. Click OK.
Use the Workload Definition Defaults Resources tab to specify resources required by an Application.

Use the Job Details Resources tab to add or remove resources required by a job.

To define a resource

1. In the Name field, enter a resource name. A resource name can be up to 44 alphanumeric characters or a symbolic variable name. The first character must be alphabetical or a national character (@, #, and $).

2. In the Quantity field, use the arrows or enter a number to indicate the quantity of the resource required by the Application.

   **Note:** Use Inverse check box to specify a negative resource. A negative resource appears with NOT in the Quantity field. In the RESOURCE statement, the negative resource appears with the ^ sign in front of the resource name.

3. In the Operation field, click the down arrow and select **ADD** from the drop-down list.

4. Optionally, you can select the Hold check box. This indicates the Application holds the resource until the Application completes successfully.

5. Click Add.

   The resource and quantity is added to the Global level resources list box.
6. Click **OK**.

   The Resource statement showing the resource and quantity is added to the statements in the right-hand pane.

   ![Resource Statement](image)

   To **update a specified resource**
   1. Select the resource in the Global level resources list box to highlight it.
   2. Change the appropriate field.
   3. Click **Update**.
   4. Click **OK**.

   To **delete a resource**
   1. Select the resource in the Global level resources list box to highlight it.
   2. Click **Delete**.
   3. Click **OK**.
The Free Format Text dialog is used to edit free form text into any job in your Application. At the Application level, you can specify a value that is to be resolved in all Applications.

**To set a default value**
1. Enter the value you want to specify in the text field.
2. Click **Add**.
   
The value appears in the Free Form Text field.
3. Click **OK**.
   
The following is the corresponding statement that displays in the right-hand pane:

To **update a default value**
1. Click the value in the Free Form Text field to highlight it. The value appears in the text field for editing.
2. Change the value.
3. Click **Update**.
4. Click **OK**.
To delete a default value
1. Click the value in the Free Form Text field to highlight it.
2. Click Delete.
3. Click OK.

Editing Modes

There are two types of editing modes available:

- Panel editing
  Panel editing is using the fields on the tabs to specify statements and options. In this mode, Free Form Text statements can be entered through the Free Form Text panel. See “Panel editing with Free Form Text” on page 137.

- Text editing
  Text editing means you can enter text directly into the right-hand pane. In this mode, Free Form Text statements can be entered through the Free Form Text panel or directly into the right-hand pane. See “Text editing with Free Form Text” on page 139.

Note: The statements entered through Free Form Text must be valid, otherwise run-time errors are generated. The statements you should enter in Free Form Text are statements that cannot be entered in any of the panels in the Job Details. An example of these statements are:

- REXX
- TEMPLATE
- IF, DO/ENDDO blocks
- labels
- New statements that are not supported by ESP Workstation

To switch between panel editing and text editing modes, do one of the following:

- On the toolbar, click the Switch Editing Mode button
- From the Actions menu, click Switch Editing Mode

If the job palette displays colors after you click in the left-hand pane, then you are in panel editing mode.

The job palette will turn gray when you are in text editing mode.
Panel editing with Free Form Text

In panel editing mode when you right-click a job and click **Job Details**, all the job detail tabs appear.

**To add a statement in panel editing and text editing mode**

1. Ensure you are in panel editing mode.
2. Right-click a job and select **Job Details**.
3. Select the **Free Form Text** tab.
4. Enter a statement in the text field.
5. Click **Add**. The statement displays in the Free Form Text list box.

   In this example, three statements were individually added.

6. Click **OK**.

   The statements display in the right-hand pane:
To update a statement
1. Select the statement in the Free Form Text list box to highlight it. The statement appears in the text field.
2. Change the statement.
3. Click Update.
4. When you are finished editing, click OK.

To delete a statement
1. Select the statement in the Free Form Text list box to highlight it.
2. Click Delete.
3. Click OK.

To move statements up or down
1. Select the statement in the Free Form Text list box to highlight it.
2. Click Move Up or Move Down according to where you want the statement to appear.
3. When you are finished editing, click OK.

Text editing with Free Form Text
In text editing mode, when you right-click a job and click Job Details only the Free Form Text tab displays. All the statements are available for editing as Free Form Text.

This is an alternate method of editing statements.
To edit statements in text editing mode

1. Ensure you are in text editing mode.
2. Click on the job that you want to edit in the right-hand pane. Your cursor changes to an ‘I’ beam.
3. Position your cursor where you want to make a change. You have full editing functionality.
4. When you are finished editing, click the Switch Editing Mode button.

Comment tab

This text field is used to enter comments into the statements that apply to the complete Application. Comments entered in this dialog appear above the individual jobs in the Application. To enter comments at the job level, see “Comment tab” on page 140.
The job palette is a menu of icons on the Workload Editor screen.

The icons represent the different job types and object types you can use in your Application.

**About Specifying Defaults**

You can specify defaults at the global, Application, and job level. Global defaults apply to all Applications defined. Workload definition defaults (Application) apply to the current Application you are defining. Job defaults can apply to all the jobs for a specific job type that you want to define in an Application. For example, you can specify notification defaults that apply to just the UNIX jobs in your Application. Subsequently, you can specify individual notification characteristics for one of those UNIX jobs, at the job detail level.

Job defaults specified are used to pre-fill the job details dialogs.

If you specify some defaults at the Application level, you can override these at both the job default level and at the individual job detail level. You can change these defaults at any time. When you change them, the change affects all future job definitions, not the current or existing definitions.

Specify global defaults prior to creating a graphical workflow.

Specify Application and job defaults after you have a workflow on the workspace.

**About Specifying Details**

You can specify characteristics that apply to individual jobs in your Application. These characteristics are called job details.

Specify job details after you have:

- Completed a graphical workflow that represents your Application, by dragging and dropping icons, see “Creating a Workflow Diagram” on page 27.
- Created job dependencies between the icons on the workspace, see “Creating Job Dependencies” on page 29.

The next step is to rename the jobs on the workspace, this is done in the Job Details.
You will notice that some fields at the job detail level are pre-filled based on defaults you may have specified. When you are specifying details for each individual job, you can override these previously specified defaults.

**Important Note:**

Every job type represented on the job palette has job details you can specify. The tabs do vary between job types, but most of the tabs are used in the z/OS job type, therefore, the z/OS job details are explained in the following pages. This guide makes reference to them when describing the other job types on the job palette to eliminate duplication of information.

Tabs and fields that are unique to a job type are documented in their respective topic.

**z/OS Workload Object**

You can specify defaults and details for the z/OS job type.

**z/OS Defaults**

The same dialogs are used for defaults and details. The level you select under **Options**, determines whether the tab is used as a default or as a job detail.

**To set global defaults for the z/OS object**

On the Workload Editor menu bar, click **Options > Global Defaults > Job > z/OS**.

**To set job defaults for the z/OS object**

On the Workload Editor menu bar, click **Options > Job Defaults > z/OS**.

The JCL Requirements, Condition Codes, Notification, Resources and Free Form Text tabs appear. These are the defaults available for the z/OS job type, at the global and job level.

All of these tabs are documented on the following pages:

- “JCL Requirements tab” on page 99
- “Condition Codes tab” on page 102
- “Notification tab” on page 125
- “Resources tab” on page 128
- “Free Format Text tab” on page 88
z/OS Details

Before you can specify z/OS details, you must have the z/OS icon on the workspace.

To specify job details for the z/OS object
1. On the workspace, right-click the z/OS icon. A shortcut menu appears.
2. On the shortcut menu, click Job Details.
   The Job Details dialog appears. By default, the Name field shows the object name and a number. The icons dropped on the workspace are numbered sequentially by job type until you optionally rename them.

All the job detail tabs available are documented on the following pages:
- “General tab” on page 96
- “JCL Requirements tab” on page 99
- “Condition Codes tab” on page 102
- “Step-End Resource Release tab” on page 134
- “Send Message tab” on page 106
- “Issue Command tab” on page 108
- “Options tab” on page 110
- “Run Frequency tab” on page 114
- “Time Dependencies tab” on page 120
- “Notification tab” on page 125
- “Resources tab” on page 128
- “Resource Specifications tab” on page 131
- “Free Format Text tab” on page 136
- “Comment tab” on page 140
General tab

![Image of the Workload Editor]
Specify workload characteristics

Name
Enter a job name 1 to 64 characters long. The first character must be alphabetic. The remaining characters can contain alphanumeric characters, national characters (#, $, @), underscores, and periods. Periods cannot be consecutive or at the end of the job name.

For z/OS jobs, the name must match the MVS job name, which is eight characters or less. To use a z/OS job name longer than eight characters, a period must follow the MVS job name.

If the Name field has more than eight characters, then it is mutually exclusive with the Long name field.

Qualifier
If the job name is less than eight characters, then you can use a qualifier consisting of up to eight characters or a symbolic variable. Valid qualifier characters are alphanumeric characters, national characters (@, #, $), and underscores. You can use a qualifier, for example, to distinguish a job from other jobs with the same job name, give a more descriptive name to a job, or to pass symbolic variables.

Long name
In ESP Workstation 5.5, you can enter a job name up to 64 characters long in the Name field.

Note: The Long name field exists for Applications created prior to ESP Workstation 5.5 and is mutually exclusive with the Name and Qualifier fields if either field has more than eight characters.

Tag
Enter a character string of up to 16 characters in length.

Owner
Specify a valid Distributed Manager name, up to 16 alphanumeric characters in length, where the first character must be alpha or a national character.

Indicates the name of the owning ESP Workload Manager for Links and Tasks in this Application, if you are using Distributed Manager.

If you do not specify OWNER, the central ESP Workload Manager is the default. The owning Manager is the only one with authority to update the status of the Application.

Documentation library member
Enter the name of the job’s documentation library member. You can reference a job documentation member with a name other than the job name. The default is to reference a member name the same as the job name. Just the member name is entered here, the documentation library is specified in the Libraries tab of the workload definition defaults.

Member of subApplication
Enter the subApplication name this job belongs to. This can be up to eight alphanumeric characters. The first character cannot be numeric.
The name of the subApplication must be different from any job within the Application.

**Self-completing**

**Note:** This option applies to Task jobs only.

Select the Self-completing check box if you want the job to complete automatically when its dependencies are met and its statements are processed.

**Wait for previous generation of subApplication**

Select the check box if concurrent processing of different generations of the same subApplication is not permitted.

ESP Workload Manager ensures that a subApplication waits for the previous generation of the same subApplication to complete. The default is concurrent processing of different generations of the same subApplication is permitted.

The following is an example of a complete General tab:

Click **OK**. The following are the corresponding statements that display in the right-hand pane:
The Job Control Language (JCL) library or JCLLIB, contains the JCL for the z/OS jobs in your Application.

These fields can be specified as a workload definition default if the same data set is used for all jobs.

If you specify the JCL library, member name or COPYJCL library in this dialog, then you are overriding the libraries previously specified. This job will use the libraries indicated in this dialog.

**Specify JCL Requirements for this Job**

**Library**
Enter your JCL library name in this field.

**Member**
Enter the member name the JCL resides in for this job.

In the following example, job J1 and J3 use the CYBER.PROD.JCL library for job submission, because this is the global JCL library specification.
Job J2 uses the CYBER.ALT.JCL library for submission because of the presence of the DATASET statement.

<table>
<thead>
<tr>
<th>JCLLIB CYBER PROD.JCL</th>
</tr>
</thead>
<tbody>
<tr>
<td>JOB J1</td>
</tr>
<tr>
<td>RUN DAILY</td>
</tr>
<tr>
<td>RELEASE J2</td>
</tr>
<tr>
<td>ENDJOB</td>
</tr>
<tr>
<td>JOB J2</td>
</tr>
<tr>
<td>DATASET 'CYBER.ALT.JCL'</td>
</tr>
<tr>
<td>RUN DAILY</td>
</tr>
<tr>
<td>RELEASE J3</td>
</tr>
<tr>
<td>ENDJOB</td>
</tr>
<tr>
<td>JOB J3</td>
</tr>
<tr>
<td>RUN DAILY</td>
</tr>
<tr>
<td>ENDJOB</td>
</tr>
</tbody>
</table>

**Specify Copy JCL Library**

**Do not copy JCL for this Job**
Select the check box to indicate you do not want a copy of the JCL for this job.

**Data set name**
Enter a COPYJCL library name in this field.

This copy is written to a member of a partitioned data set, providing a working copy of the JCL with, where applicable, all symbolic variables resolved. This JCL can be used for job re-submission. ESP Workload Manager keeps track of where the job was submitted from and the JCL that was used.

**Save by**
Select the **Save by Job name** or **Save by Job ID** button to indicate how you want the JCL stored:

- **Save by Job name**
  Requests the member name used for storing the JCL for a job is the same as the job name. Each submission of a particular job overwrites the previous copy of that job’s JCL.

- **Save by Job ID**
  Requests ESP Workload Manager to store the copy of the JCL by job ID. A member is not overwritten until the job number reoccurs.

**Is a GDG**
Select the check box if the Copy JCL data set is a member of a generation data group.

**Generation**
Click the up and down arrows to indicate the generation number of the data set.
The following is an example of a complete JCL Requirements tab:

The following are the corresponding statements that display in the right-hand pane:
Condition Codes tab

This tab is used to detect condition codes. You can immediately stop a failing job, without running any subsequent steps regardless of the condition parameters. These fields can be specified as a workload definition default if the return codes are the same for all the jobs in the Application.

Define Condition Code Interpretation

Return code
Specify a condition code of $num$, where $num$ is an integer between 0 and 4095 inclusive.

You can also specify:

- A condition code between $num1$ and $num2$ inclusively. The value of $num2$ must not be smaller than $num1$.
- A system abend code, (S$ccc$), such as SOC1 or SB37. The $ccc$ must be three hexadecimal digits.
- A user abend code, (U$nnnn$), such as U0001 or U0462. The $nnnn$ must be exactly four decimal digits, and cannot exceed 4095.

Job name
This field is disabled, it cannot be edited.

Step name
This field is optional. Enter a step within the job. You can use the asterisk and hyphen as wildcard characters.

- An asterisk (*) indicates that any character in the asterisk location acts as a match.
• A hyphen (-) indicates that any character in that or subsequent character positions is considered a match. You can only use the hyphen at the end of a character string.

If you omit this field, ESP Workload Manager condition code checking (CCCHK) matches any procstep name. This field corresponds to the STEP operand in the CCCHK statement.

For more information about CCCHK, see the CCCHK statement in the ESP Workload Manager Reference Guide.

Procedure step
This field is optional. Enter a particular step within a catalogue or instream procedure. Specifically, it refers to the label on the EXEC statement inside the instream procedure. Procedure step does not refer to the name of the procedure. You must use this field in conjunction with the ‘Step name’ field. You can use the asterisk and hyphen as wildcard characters.

• An asterisk (*) indicates that any character in the asterisk location acts as a match.
• A hyphen (-) indicates that any character in that or subsequent character positions is considered a match. You can only use the hyphen at the end of a character string.

If you omit this field, ESP Workload Manager condition code checking (CCCHK) matches any procstep name. This field corresponds to the PROC operand in the CCCHK statement.

For more information about CCCHK, see the CCCHK statement in the ESP Workload Manager Reference Guide.

Program
This field is optional. Enter the name of the program that the step executes, as found in the PGM operand on the job’s EXEC statement. You can use the asterisk and hyphen as wildcard characters.

• An asterisk (*) indicates that any character in the asterisk location acts as a match.
• A hyphen (-) indicates that any character in that or subsequent character positions is considered a match. You can only use the hyphen at the end of a character string.

If you omit this field, ESP Workload Manager condition code checking (CCCHK) matches any program name. This field corresponds to the PROGRAM operand in the CCCHK statement.

For more information about CCCHK, see the CCCHK statement in the ESP Workload Manager Reference Guide.

Interpret as
Select the Success or Failure buttons according to the action you want, as you enter return codes.
In the following example, return codes 4, 8, and 12 are OK and the workflow is to continue running.

- Success
  Indicates the job has not failed. This is the default.
- Failure
  Indicates the job should be considered failed. When the job has failed, it may or may not continue, depending upon the value of CONTINUE/STOP.

**Choose Action**
Select the Continue or Stop button according to the action you want, as you enter return codes.

- Continue
  Indicates the job should continue processing with the next step, whether or not the job was deemed to have failed. This is the default.
- Stop
  Indicates the job should be stopped immediately. No other steps should be executed.

Click **Add**.

The condition codes are added to the List of Condition Codes field.

The following is an example of a complete Condition Codes tab:
The following are the corresponding statements that display in the right-hand pane:

List of Condition Codes

To update a return code
1. Click on the return code in the List of Condition Codes to highlight it.
2. Change the above fields.
3. Click Update.
4. Click OK.

To delete a return code
1. Click on the return code in the List of Condition Codes to highlight it.
2. Click Delete.
3. Click OK.

Note: The next tab in the Job Details is the Step-End Resource Release tab. This tab is dependent upon a Resource being defined. Resources are defined in the Resources tab. All the tabs related to Resources are covered in “Resources tab” on page 86.
Send Message tab

Use this dialog to send a message to yourself, another user, a group of users or an operator console.

**Specify Message to Send**

**Recipient(s)**
Enter the user ID of the person who is to receive the message.

**Console ID**
Enter the UCM ID or the console name of the system console that is to receive the message.

**Routing code**
Enter the MCS routing code for a message to be sent to one or more operator consoles. This is a value between 1 and 128.

**Keep on console**
Select the check box if the message is to be marked as non-roll-deletable.

**Message text**
Enter the message to be sent.

Click **Add**. The message is added to the List of Messages to Send box.
The following is an example of a complete Send tab:

Click **OK**.

The following are the corresponding statements that display in the right-hand pane:

### List of Messages to Send

**To delete a message**

1. Click on the message to highlight it.
2. Click **Delete**.
3. Click **OK**.
As part of an Application, you may want to issue ESP Workload Manager or operating system commands. Use this dialog to issue these commands.

**Specify ESP Command**

**Command text**
Enter the ESP Workload Manager command you would like to issue.

Click **Add**. The command is added to the List of Commands to Issue field.

**Suppress response**
Select the check box if responses from the command are to be suppressed.

**List of Commands to Issue**

**To delete an ESP command**
1. Click on the command to highlight it.
2. Click **Delete**.

**Specify z/OS Command**

**Command text**
Enter the operating system command you would like to issue.

**Console ID**
Enter the console number (UCMID) that is to receive output from the command.

Click **Add**. The command is added to the List of Commands to Issue field.
The following is an example of a complete Issue Command tab:

![Diagram of Issue Command tab]

Click **OK**.

The following are the corresponding statements that display in the right-hand pane:

```
<table>
<thead>
<tr>
<th>Issue z/OS Command</th>
<th>Command text</th>
<th>Console ID</th>
<th>List of Commands to Issue</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>$111-5:CM-A</td>
<td>1</td>
<td></td>
</tr>
</tbody>
</table>

**List of Commands to Issue**

**To delete a z/OS command**

1. Click on the command to highlight it.
2. Click **Delete**.
3. Click **OK**.
### Options tab

<table>
<thead>
<tr>
<th>Time Dependencies</th>
<th>Notification</th>
<th>Resources</th>
<th>Resource Specifications</th>
<th>Free Form Text</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>JCL Requirements</td>
<td>Condition Codes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Step-End Resource Release</td>
<td>Send Message</td>
<td>Issue Command</td>
<td>Options</td>
<td>Job Executing</td>
<td>Run Frequency</td>
</tr>
</tbody>
</table>

- **Inherit Dependencies**: Select the check box to indicate you want ESP Workload Manager to check to see if any relationships among jobs should be inherited. The OPTIONS INHERIT statement appears in the right-hand pane.

- **Use Encore**: Select the check box to indicate you use ESP Encore. The OPTIONS RESTARTSTEP statement appears in the right-hand pane.

- **Include in Critical Path**: Select the check box to indicate the job represents a critical point in the Application. The longest path to this job, in terms of execution time (based on history), is identified as the critical path. The CRITICAL statement appears in the right-hand pane.

- **Job is a node for inheriting relationships**: Select the check box to indicate the job is a node for inheriting job relationships. The NODE statement appears in the right-hand pane.

This tab allows you to select different options for your job. The fields contain a three state check box. The following describes a three state check box:

1. A check box with a check mark indicates the option is enabled.
2. A check box without a check mark indicates the option is disabled.
3. A grayed out check box with a check mark indicates the option is ignored.

If the option is ignored, no OPTION statement appears in the right-hand pane. If no OPTION statement is displayed, then the ESP Workload Manager defaults for these options will take effect when the Application is running.

**Inherit Dependencies**
Select the check box to indicate you want ESP Workload Manager to check to see if any relationships among jobs should be inherited. The OPTIONS INHERIT statement appears in the right-hand pane.

**Use Encore**
Select the check box to indicate you use ESP Encore. The OPTIONS RESTARTSTEP statement appears in the right-hand pane.

**Include in Critical Path**
Select the check box to indicate the job represents a critical point in the Application. The longest path to this job, in terms of execution time (based on history), is identified as the critical path. The CRITICAL statement appears in the right-hand pane.

**Job is a node for inheriting relationships**
Select the check box to indicate the job is a node for inheriting job relationships. The NODE statement appears in the right-hand pane.
The following statements display for the Hold on submission and Use Encore options:

Submit

Only on request
Select the check box if this job is to run only if it is requested.

You can identify certain jobs as on-request and define their relationships to other jobs. The on-request jobs take their place in the schedule when they are selected. From the time you generate the Application up to the time of job submission, you can use the Workload Director component to request the job. If you have not explicitly requested the job, ESP Workload Manager bypasses it and treats it as a normal completion, releasing its successor jobs.

In the following example, if job J2 is not requested by the time J1 completes, ESP Workload Manager bypasses it and submits job J3.

Conditionally
Select the check box if the job may or may not be completed, to complete an Application.

Normally, all jobs in an Application must complete or be bypassed, for the Application to complete. In some situations, you could have some optional jobs (other than on-request jobs) that may or may not run as part of the Application. These jobs are referred to as conditional jobs. ESP Workload Manager completes an Application when all non-conditional jobs are complete and bypasses any incomplete conditional jobs.

For example, you might have a recovery job that only runs when another job in the Application abends. In this case, the recovery job is a conditional job. The recovery job may or may not run. If all other jobs in the Application are complete then you want ESP Workload Manager to complete the Application.
In the following example, the conditional option defines job RECOVER as a conditional job.

**Hold on submission**
Select the check box to indicate the job is to be placed on manual hold when ESP Workload Manager generates the Application. You can use the Workload Director component to release a job from manual hold. The HOLD statement appears in the right-hand pane.

**Hold reason**
When you select **Hold on submission**, you can enter a reason for the hold. Enter text up to 28 characters long. In Workload Director, the hold reason appears in the **Job Details** dialog under **User Status**.

**Release job when x predecessors remain**
Click the up and down arrows to indicate the number of predecessors. Use this field when you want the job to release when x predecessors remain.

**Specify Manual Job**

**Manual Job**
Select the check box to indicate the job is manually submitted, outside of ESP Workload Manager.

When the check mark exists, the MANUAL keyword is used as part of the JOB statement. As a result, ESP Workload Manager does not look for JCL, nor does it try to submit the job. The job can be submitted by a person, an operator command, an Event or another scheduling product.

**Note:** When defining a MANUAL job in an Application, keep the following in mind:

- You must define a manual job as a tracked job if you want to use it in an Application. Check with your administrator to find out about tracked jobs.
- You cannot use a job qualifier for a manual job.

In the following example, job BB runs after the manually submitted job AA on Mondays, Wednesdays, and Fridays. On other days job BB does not wait for job AA.
Authorization string
Enter an authorization string. You can specify that ESP Workload Manager checks an authorization string for manual jobs so that it tracks and posts the correct job. The authorization string is the field you use at your site to identify job ownership, such as a user ID or an account field. For example, ESP Workload Manager only marks the following job as complete when the job is run with an authorization string of CYBER.

JOB ABC MANUAL AUTHSTR(CYBER)

Search backward
Enter a number of hours ESP Workload Manager is to do a backward search in the scheduled activity data set for a manual job.

Search forward
Enter a number of hours ESP Workload Manager is to do a forward search in the scheduled activity data set for a manual job.

The following is an example of selecting a Manual job, specifying an authorization string, and a search backward:

The following are the corresponding statements that display in the right-hand pane:

Job profiling tab

Job profiling allows you to distinguish the job history information ESP Workload Manager stores and uses in its time calculations. Use job profiles to gain more accurate information for critical path, anticipated end time, and dueout propagation calculations. When ESP Workload Manager generates an Application, it records the job information under the job’s profile name and stores it in the jobstats data set. By default, ESP Workload Manager keeps the latest ten entries for each profile. You can specify profile names at the Application level and at the job level.

Suppose you have Job B that run workdays for ten minutes and also runs Saturdays for 40 minutes. You can assign a profile to Job B for workdays and a different profile for Saturdays. When ESP Workload Manager generates the Application containing job B on Saturdays for example, it only uses the job information from Saturday’s profile to determine the anticipated end time.
Job Profile Definition

Name
Enter a name for job profile data. The profile name can be up to 104 characters long and can include symbolic variables. ESP Workload Manager stores the job information under this profile name. This profile name overrides the profile name set at the Application level.

For more information, see the JOBPROF statement in the ESP Workload Manager Reference Guide.

Criteria
Enter when you want ESP Workload Manager to store data in the job profile record for the job. Use any valid ESP Workload Manager schedule criteria.

For more information, see the JOBPROF statement in the ESP Workload Manager Reference Guide.

Note: In Workload Director, the Criteria field is disabled when you insert a job.

Run Frequency tab

This tab is used to define schedule criteria for when a job is to run or when a job is not to run. There are two ways you can specify schedule criteria:

- Enter a text string in the text field.
- Select criteria from the Schedule Criteria Editor.

To use the Schedule Criteria Editor, you select the ellipsis button ( ... ) to the right of the text field. For examples of how the Schedule Criteria Editor works, see “Schedule Criteria Editor” on page 115.
To create a run statement using the text field
1. Select the Run button.
2. Enter schedule criteria in the text field. For example, enter Last Workday of Month.
3. Click Add. The run frequency is added to the List of Run Frequency Conditions list box.
4. Click OK. The run frequency statement appears in the right-hand pane.

To update a run statement
1. In the List of Run Frequency Conditions list box, click on the statement to highlight it.
2. In the text field, change the statement.
3. Click Update.
4. Click OK.

To delete a run statement
1. In the List of Run Frequency Conditions list box, click on the statement to highlight it.
2. Click Delete.
3. Click OK.

Schedule Criteria Editor
The Schedule Criteria Editor allows you to build a schedule statement by selecting the schedule criteria displayed in a dialog. The Schedule Criteria Editor contains basic scheduling terms you click, buttons you select for days of the week and months, drop-down lists you choose from for the time of day and time zones, and a calendar where you select holidays and special days.

You can also test your schedule statement by specifying a certain number of cycles and viewing the days the job runs. For more information, see “Testing the schedule criteria” on page 117.

You must have an active connection for the test feature to work.

Example 1

To schedule when a job is to run
1. Select a job in your workflow.
2. Right-click the job and select Job Details.
3. Select the Run Frequency tab.
4. On the **Run Frequency** tab, select the **Run** button.

5. Click the ellipsis button (…) to the right of the text field. The Schedule Criteria Editor appears.

6. In the **Basic Scheduling Terms** window, scroll down and select **Every**. The **Count** field activates.

7. In the **Count** field, click the up arrow until the number 4 appears. Click the > sign.

8. Leave **Days** as the field entry. Click the > sign again. The schedule term **every 4 days** appears in the **Schedule Criteria** window.

9. In the **Time** field, click the down arrow and select **01:00**.

10. In the **Time Zone** field, click the down arrow and select **est**.

11. Click in the **Schedule Criteria** window to refresh the window with the new scheduling terms selected.

12. Click **OK**. The Run Frequency tab reappears.

13. Click **Add**.

14. Click **OK**. The schedule statement appears in the right-hand pane.
Example 2

To schedule when a job is not to run
1. Select a different job in your workflow.
2. Right-click the job and select Job Details.
3. Select the Run Frequency tab.
4. On the Run Frequency tab, select the Do not run button.
5. Click the ellipsis button ( ...) to the right of the text field.
   The Schedule Criteria Editor appears.
6. In the Basic Scheduling Terms window, scroll down and double-click First.
7. In the Days field, click Monday.
8. In the Basic Scheduling Terms window, scroll down and double-click Monthly.
   The dialog should appear as follows:

At this point you can click OK to return to the Run Frequency tab. Alternatively, you can test the schedule criteria selected.

Testing the schedule criteria
This procedure continues on from step 8 in example 2.
If the Test button is disabled, it means you do not have an active connection or the active connection is not selected in the Workload Definition Defaults, Connection tab. From the Menu, select Options > Workload Definition Defaults > Connection > and choose your connection from the drop-down list.

Return to the Run Frequency tab Schedule Criteria Editor. Select your schedule criteria again. The Test button should be enabled.

1. In the Schedule Criteria Editor, click Test.
   The Test Schedule Criteria dialog appears.

   ![Test Schedule Criteria dialog](image)

2. In the Number of cycles field, click the up arrow to indicate how many cycles of the schedule criteria you would like to see resolved. In this example, 6 is selected.

3. Click Test.
   The Results window shows the next 6 first Mondays of the month when the job
will not run.

Optionally, you can specify a calendar defined to your environment to test the schedule criteria against. By default, the schedule criteria tests against the system calendar. In the Calendar 1 field, click the down arrow to reveal a list of calendars other than the default system calendar. Repeat step #8.

4. Click **Done**. The Schedule Criteria Editor re-appears.

5. Click **OK**. The Run Frequency tab appears with your selected criteria in the text field.

6. Click **Add**. The NORUN statement is added to the List of Run Frequency Conditions.
7. Click OK.

The following is the corresponding statement that display in the right-hand pane:

**Time Dependencies tab**

<table>
<thead>
<tr>
<th>Resources</th>
<th>Resource Specifications</th>
<th>Free Format Text</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>JCL Requirements</td>
<td>Sh E R R E S E Q</td>
<td></td>
</tr>
<tr>
<td>Issue Command</td>
<td>Options</td>
<td>Run Frequency</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Time Dependencies</td>
<td></td>
</tr>
</tbody>
</table>

**Specify a Time to Abandon Submission**

Enter valid schedule criteria that resolves to a single date and time when the Application builds. Use abandon submission in a job to bypass the job’s submission if the job predecessor is not complete by a certain time.

In the following example, ESP Workload Manager does not submit job ZOS1 at 9 pm if the predecessor job is not complete by 9 pm.
In the following example, ESP Workload Manager does not submit job ZOS2 2 hours from the time the Application was scheduled if the predecessor job is not complete by that time.

### Predecessor dependencies
Enter valid schedule criteria that resolves to a single date and time when the Application builds. Use abandon dependencies to submit a job without its predecessor dependencies when it meets a specified time. Abandon dependencies does not override the job’s manual hold, another time dependency or resource dependency.

In the following example, job ZOS3 submits at 22:00 or when its predecessor completes, whichever comes first.

### Resource dependencies
Enter valid schedule criteria that resolves to a single date and time when the Application builds. Use abandon resources to submit a job without its resource dependencies at a specified time. Abandon resources does not override the job’s manual hold or time dependency.

In the following example, ESP Workload Manager submits job ZOS6 at 19:00 pm or when one unit of a resource called T3480 is available, whichever comes first.
In the following example, ESP Workload Manager submits job ZOS7 one hour from the time the Application was scheduled or when one unit of a resource called CICSUP is available, whichever comes first.

Do Not Submit Before
Use the Earlysub statement to specify a job for early submission relative to the Event’s scheduled time. If the Event is not scheduled, the submission time is relative to the time the Application is generated.

In the following example, job ZOS8 has an earliest submission time of 10 pm relative to the time the CYBER Application was generated.

In the following example, job ZOS9 has an earliest submission time of
- 20:00 on weekdays
- 17:00 on weekends

The following scheduling statement sets the earliest submission time to 9 pm two workdays from the scheduled time of the Event:

EARLYSUB 9PM TODAY PLUS 2 WORKDAYS

The following scheduling statement sets the earliest submission time to 10 minutes after the Event’s trigger time:

EARLYSUB REALNOW PLUS 10 MINUTES

Mark as Overdue When
Not submitted by
Enter valid schedule criteria that resolves to a single date and time when the Application builds. The Latesub statement indicates a late submission time for a job. This is the latest acceptable submission time before the job is flagged overdue.
ESP Workload Manager can provide notification when a job exceeds its late submission time. For example, you may want ESP Workload Manager to send a message or trigger an Event when a job exceeds its late submission time.

In the following example, job ZOS10 has a late submission time of 21:00. If the job has not been submitted by 21:00, the job is flagged overdue.

```
JOB ZOS10
RUN DAILY
LATESUB 21:00
ENDJOB
```

In the following example, job ZOS11 is flagged overdue if ESP Workload Manager has not submitted it by 6 pm every day except Monday, when the late submission time is 4 pm.

```
JOB ZOS11
RUN DAILY
IF TODAY (MONDAY) THEN LATESUB 4 PM
ELSE LATESUB 6 PM
ENDJOB
```

**Not started by**
Enter valid schedule criteria that resolves to a single date and time when the Application builds. The Dueout Input statement indicates the time when a job should start executing. The time can request any time relative to the time the Application was generated.

In the following example, job ZOS11 is flagged overdue if the job has not started executing by 23:00.

```
JOB ZOS11
RUN DAILY
DUEOUT INPUT 23:00
ENDJOB
```

**Not completed by**
Enter valid schedule criteria that resolves to a single date and time when the Application builds. The Dueout Exec statement indicates the time when a job should complete. The time can request any time relative to the time the Application was generated.

In the following example, job ZOS12 is flagged overdue if the job has not successfully completed executing by 3 am. In this example, if the Event is scheduled at 2 am but is held until 4 am, ZOS12 is overdue when the Application builds.

```
JOB ZOS12
RUN DAILY
DUEOUT ENDC 3 AM
ENDJOB
```
In the following example, if job ZOS13 has not completed successfully 30 minutes after the corresponding Event’s trigger time, it is flagged overdue.

![Diagram of ZOS13 job]

In the following example, if the task WAIT4.TAPE is not marked complete 2 hours after the Event’s scheduled time, it is flagged overdue.

![Diagram of WAIT4.TAPE task]

**Delay Submission When Eligible by**

Use the Reldelay statement to delay job submission at the time that a job becomes eligible for submission. Click the up and down arrows to indicate a positive integer representing the number of minutes to delay submission. The maximum value allowed is 255.

When a job becomes eligible for submission, ESP Workload Manager delays submission by the number of minutes specified. If a job requires an ESP Workload Manager resource, the delay takes effect before the check for resource availability.

In the following example, when job ZOS14 completes successfully, ZOS15 becomes eligible for submission and the Reldelay statement delays ZOS15 by 5 minutes.

![Diagram showing delay submission for ZOS15]
This tab is used to notify users or consoles, when certain workload conditions are met.

**Notify when Workload ...**
Select the check box to indicate you want a notification when this condition occurs.

- **Is submitted**
  Indicates notification should take place at job submit time.

- **Starts running**
  Indicates notification should take place at job start time.

- **Is resubmitted**
  Indicates notification should take place when a job resubmitted through ESP Workload Manager ends.

- **Is overdue**
  Indicates notification should take place when a job becomes overdue from any processing node.

- **ABENDs**
  Indicates notification should take place when a job ABENDs. This excludes condition code failures.

- **Fails**
  Indicates notification should take place when a job fails. This includes condition code failures caused by either the CCCHK or CCFAIL statements.
- **Ends**
  Indicates notification should take place when a job ends. This includes any job end (successful or unsuccessful).
- **Premature end**
  Indicates notification should take place when a job successfully finishes early.
- **Mailbox**
  Enter a mailbox name. The mailbox becomes the destination for messages coming from Events or from this Notification dialog. When a new message arrives in a mailbox, it is distributed to all defined subscribers. Subscriptions are supported for TSO users and email addresses. For information on how to define subscribers, see the LOADNL command in the *ESP Workload Manager Reference Guide* v.5.4.

### Specify TSO User(s) to Notify
Enter the user ID that is to receive the notification.

Click **Add**. The user ID is added to the list box. In the example, user ID **PROD** will receive the notification.

To delete a user ID, select the user ID in the list box to highlight, then click **Delete**.

### Specify Delivery Options

#### Routing code
Enter a routing code value between 1 and 128. Separate each routing code with a comma.

The routing code option is added to the notify statement. In the example, all consoles with routing code 2 will receive the notification.

#### Description code
Enter a description code value between 1 and 16. Separate each description code with a comma.

The description code option is added to the notify statement. In the example, description code 2 is used to highlight the message.

#### z/OS system name
Enter the name of a Sysplex member.

This is not the ESP Workload Manager system name. It is the name by which z/OS knows the member of the Sysplex. Can be used to route a NOTIFY command in a Sysplex environment to wherever the user is logged on. Use an asterisk to indicate the message goes wherever ESP Workload Manager is running.
**Trigger**

**ESP Alert ID**
Enter an alert ID.
Indicates an Event associated with a logical alert identifier should be triggered. This logical identifier must have been previously specified using an alert definition. For more information on alerts, see “Job Monitoring and Alert Processing” in the ESP Workload Manager Advanced User’s Guide.

**Event**
Enter an Event name. Events can be triggered directly or in association with a logical alert identifier.

**List of notifications**

**To update a notification**
1. Click on the notification in the List of notifications to highlight it.
2. Change the above fields.
3. Click Update.
4. Click OK.

**To delete a notification**
1. Click on the notification in the List of notifications to highlight it.
2. Click Delete.
3. Click OK.
Use this tab to add or remove resources required by a job. You can allocate any number of resources for a job. Resources can be allocated for any job type except Links.

Specify Resource(s) Required

Operation
Specify whether the resource is to be added or dropped.

Hold
Indicates the Application holds the resource until the Application completes successfully.

Inverse
Use this check box to specify a negative resource. A negative resource appears with NOT in the Quantity field. In the RESOURCE statement, the negative resource appears with the ^ sign in front of the resource name.

In the following statement, ^SCRATCH means the job will run when no units of the SCRATCH resource are available.

RESOURCE ADD (^SCRATCH)

To add a resource

1. Right-click the job that requires the resource and select Job Details > Resources.

2. In the Name field, enter the resource name. A resource name can be up to 44 alphanumeric characters or a symbolic variable name. The first character must be alphabetical or a national character (@, #, and $).
3. In the **Quantity** field, use the arrows or enter a number to indicate the quantity of the resource required by the job.

4. In the **Operation** field, click the down arrow and select **Add**.

   The resources required for the job are added to the Job level resources field. The resources defined at the Application level appear in the Global resources field.

5. Optionally, you can select the **Hold** check box. This indicates the job holds the resource until the job runs successfully.

   The following is an example of a complete Resource tab:

   ![Resource Tab Example](image)

6. Click **OK**.

   The corresponding statements display in the right-hand pane:
To drop a resource in the successor job
1. Right-click the successor job from where the resource is defined. In the example, it is the third job.
2. Click Job Details > Resources.
3. In the Name field, click the down arrow to select the defined resource for the predecessor job.
4. In the Operation field, click the down arrow and select Drop.
The Drop operation drops all the resource quantities that were added.
5. Click Add.
6. Click OK.
The previously requested resource requirement is dropped:

To update a resource definition
1. Right-click the job that requires the resource definition be changed and click Job Details > Resources.
1. In the Job level resources field, select the resource name to highlight it.
2. Change the appropriate field.
3. Click Update.
4. Click OK.
The resource statement is updated to reflect the change.

To delete a resource definition
1. Right-click the job that requires the resource definition be removed and click Job Details > Resources.
2. In the Job level resources field, select the resource name to highlight it.
3. Click Delete.
4. Click **OK**.

   The resource statement is removed from the job.

**Reserve resources**

Check-mark this field to reserve a quantity of resources for jobs that require a large resource count.

The ABSORB statement will appear in the right-hand pane. Resource Absorption reserves the resources that are available at the time the job is next in the queue, and holds them while waiting to accumulate the remainder of resources required for the job. The ABSORB statement prevents jobs with large resource requirements from incurring a processing delay.

A job with a higher priority and the same resource requirements takes the resources and runs before a lower priority job with the ABSORB statement.

**Job Priority**

Click the up and down arrow keys to indicate the priority of this job.

The following shows 6 T3480 tape drives required for JOB C with a priority 10:

```
JOB PAYJOBIC
   RESOURCE (6,T3480)
   PRIORITY 10
   ABSORB
   RELEASE (PAYJOBIC,PAYJOBE)
END JOB
```

**Resource Specifications tab**

![Resource Specifications tab](image_url)
The fields on this tab use the NOTWITH and ENQUEUE statements. They specify jobs that are mutually exclusive with the current job. NOTWITH uses the ESP Workload Manager ENQUEUE statement to request certain explicitly specified jobs not be executed concurrently.

**NOTWITH**
The NOTWITH statement is used to inform ESP Workload Manager the job currently being defined is mutually exclusive with jobname.QUAL in applname.

**To define a NOTWITH statement**
1. In the **Name** field, enter the name of the job that is mutually exclusive with the job being defined. In this example, PAYDAY is entered. The job being defined is PAYJOBC.
2. Optionally, in the **Qualifier** field, enter a job qualifier. In this example, MONTHEND is entered.
3. Optionally, in the **Application name** field, enter the Application name. If omitted, it means any Application.
4. Click **Add**.
   The NOTWITH definition is added to the list field.
5. Click **OK**.
   The following statements appear in the right-hand pane.

   JOB PAYJOBC
   NOTWITH PAYDAY.MEEND
   RELEASE (PAYJOBD, PAYJOBE)
   ENJOBC

   This means PAYJOBC and PAYDAY.MEEND won’t run together.

**To update a NOTWITH statement**
1. Click on the definition in the list field to highlight it.
2. Change the above fields.
3. Click **Update**.

**To delete a NOTWITH statement**
1. Click on the definition in the text field to highlight it.
2. Click **Delete**.

**ENQUEUE**
The following fields use the ENQUEUE statement. This statement specifies a resource name that a job must enqueue on, and it adds resources to the enqueue list.
To define an ENQUEUE statement

1. In the **Resource name** field, enter a resource name.
   
   A resource name can be up to 44 alphanumeric characters. The first character must be alphabetical or a national character (@, #, and $).

2. In the **Shared** field, select this button to request shared use of the specified resource.
   
   If one or more jobs request shared use of a resource, they are granted the use of that resource provided no other job has that same resource held exclusively.

3. In the **Exclusive** field, select this button to request exclusive use of the specified resource.
   
   If a job requires exclusive use of a resource, it will be granted use of that resource provided the resource is not used by any other job.

4. Optionally, you can select the **Hold** check box. This indicates the job holds the resource until the job runs successfully. In this example, the job holds the resource.

5. Click **Add**.
   
   The resource is added to the enqueue list field.

   The following is an example of a complete Resource Specifications tab:

   ![Resource Specifications Tab]

6. Click **OK**.
   
   The following are the corresponding statements that display in the right-hand pane. In this example, PAYJOBC and PAYDAY.MONTHEMD won’t run together. PAYJOBC has exclusive use of a T3480 tape drive until PAYJOBC completes
successfully.

To update a resource definition
1. In the list field, click on the definition to highlight it.
2. Change the above fields.
3. Click Update.
4. Click OK.

To delete a resource definition
1. In the text field, click on the definition to highlight it.
2. Click Delete.
3. Click OK.

Step-End Resource Release tab

These fields are used to release resources back to the resource pool at job step-end. You may release part or all of the resources back to the resource pool. You can have more than one STEPEND statement in one job.
Specify Resource Release Conditions

Job step name
Enter the name of the job step where the job is finished with the resources.

Procedure step name
Enter the name of the proc step, if applicable, where the job is finished with the resources.

Click Specify Resources. The Resources to Release dialog appears.

Use the arrows to indicate the name of the resource and quantity that can be released to the resource pool.

Click Add.

The resource and quantity is added to the List of Resource(s) to Release field.

Click OK.

Click Add. The resource and quantity appears in the List of Resource Release Conditions.

Click OK.
The following shows the corresponding STEPEND statement that appears in the right-hand pane.

```
JOE PAY JOB CG
RESOURCE (6, T3480)
PRIORITY 10
ABSORB
STEPEIND STENAME(STEP 4) RELURES(5, T3480)
RELEASE (PAYJOB, PAYJOBS)
ENDJOB
```

When step 4 completes, all 6 units of T3480 are released back to the pool, and are available to other jobs.

**Free Format Text tab**

The Free Format Text dialog is used to edit free form text into any job in your Application.

There are two types of editing modes available:

- **Panel editing**
  
  Panel editing is using the fields on the tabs to specify statements and options. In this mode, Free Form Text statements can be entered through the Free Form Text panel. See “Panel editing with Free Form Text” on page 137.

- **Text editing**
  
  Text editing means you can enter text directly into the right-hand pane.

  In this mode, Free Form Text statements can be entered through the Free Form Text panel or directly into the right-hand pane. See “Text editing with Free Form Text” on page 137.
Note: The statements entered through Free Form Text must be valid, otherwise run-time errors are generated. The statements you should enter in Free Form Text are statements that cannot be entered in any of the panels in the Job Details. An example of these statements are:

- REXX
- TEMPLATE
- IF, DO/ENDDO blocks
- labels
- New statements that are not supported by ESP Workstation

To switch between panel editing and text editing modes, do one of the following:

- On the toolbar, click the Switch Editing Mode button
- From the Actions menu, click Switch Editing Mode

If the job palette displays colors after you click in the left-hand pane, then you are in panel editing mode.

The job palette will turn gray when you are in text editing mode.

Panel editing with Free Form Text

In panel editing mode when you right-click a job and click Job Details, all the job detail tabs appear.

To add a statement in panel editing and text editing mode

1. Ensure you are in panel editing mode.
2. Right-click a job and click Job Details.
3. Select the Free Form Text tab.
4. Enter a statement in the text field.
5. Click **Add**. The statement displays in the Free Form Text list box.
   In this example, three statements were individually added.

6. Click **OK**.
   The statements display in the right-hand pane:

   ![Image of the Workload Editor interface showing a Free Form Text list box with statements added.]

   **To update a statement**
   1. Select the statement in the Free Form Text list box to highlight it.
      The statement appears in the text field.
   2. Change the statement.
   3. Click **Update**.
   4. When you are finished editing, click **OK**.

   **To delete a statement**
   1. Select the statement in the Free Form Text list box to highlight it.
   2. Click **Delete**.
   3. Click **OK**.
To move statements up or down
1. Select the statement in the Free Form Text list box to highlight it.
2. Click Move Up or Move Down according to where you want the statement to appear.
3. When you are finished editing, click OK.

Text editing with Free Form Text
In text editing mode, when you right-click a job and click Job Details only the Free Form Text tab displays. All the statements are available for editing as Free Form Text.

This is an alternate method of editing statements.

To edit statements in text editing mode
1. Ensure you are in text editing mode.
2. Click on the job that you want to edit in the right-hand pane. Your cursor changes to an ‘I’ beam.
3. Position your cursor where you want to make a change. You have full editing functionality.
4. When you are finished editing, click the Switch Editing Mode button.
Comment tab

This text field is used to enter comments into the statements that apply to the job.

**To add comments to a job**

1. Right-click the job that you want to add comments to.
2. Click the **Comment** tab.
3. Enter the comments in the text field.
4. Click **Add**.
5. Click **OK**. The comments appear in the job statements in the right-hand pane.

Link Workload Object

Links are used in an Application when you need to take an action (for example, issuing a command or sending a message), but the Application does not need to wait for you to notify ESP Workload Manager that the action has been completed. ESP Workload Manager automatically marks a link as complete as soon as its dependencies are met.

You define relationships and other dependencies for a link the same way you do for a job that ESP Workload Manager would submit. A link has a schedule frequency, and it can have a time dependency. ESP Workload Manager does not submit JCL for a link.
**Example**

In the following illustration, a link is used as a dependency node to simplify complex dependencies.

![Diagram of a link dependency node](image)

**Link Defaults**

**To set global defaults for the Link workload object**

On the Workload Editor menu bar, click **Options > Global Defaults > Job > Link.**

**To set job defaults for the Link workload object**

On the Workload Editor menu bar, click **Options > Job Defaults > Link.**

The Notification and Free Format Text tabs appear. These are the defaults available for the Link workload object, at the global and job level. They are documented on the following pages:

- “Notification tab” on page 83
- “Free Format Text tab” on page 88
Link Details

Before you can specify Link details, you must have the icon on the workspace.

To specify job details for the Link workload object
1. On the workspace, right-click the Link icon. A shortcut menu appears.
2. On the shortcut menu, click Job Details.
   The Job Details dialog appears. By default, the Name field shows the object name and a number. The icons dropped on the workspace are numbered sequentially by job type until you optionally rename them.

   All the available job detail tabs are documented on the following pages:
   - “General tab” on page 96
   - “Send Message tab” on page 106
   - “Issue Command tab” on page 108
   - “Options tab” on page 110
   - “Run Frequency tab” on page 114
   - “Time Dependencies tab” on page 120
   - “Notification tab” on page 125
   - “Free Format Text tab” on page 136
   - “Comment tab” on page 140

Task Workload Object

You can define tasks in an Application and establish dependencies between them and other tasks and jobs. A task can represent a manual process, such as balancing a report or an automated process such as a step in a job completing.

ESP Workload Manager does not submit JCL for a task. You define relationships and other dependencies for a task the same way you do for a job that ESP Workload Manager would submit.

A task has a schedule frequency and may have a time dependency. It can be on-request, conditional, defined on hold, and can be inserted into an active Application.

When you mark a job as a TASK and select it for execution, ESP Workload Manager builds it as part of the Application. The task has to be completed, either manually or automatically.
**Example**

In the following illustration, a report needs to be checked on workdays after job PAYJOB1 completes successfully.

![Diagram showing job sequence]

**Task Defaults**

**To set global defaults for the Task workload object**

On the Workload Editor menu bar, click **Options > Global Defaults > Job > Task**.

**To set job defaults for the Task workload object**

On the Workload Editor menu bar, select **Options > Job Defaults > Task**.

The Notification, Resources and Free Format Text tabs appear. These are the defaults available for the Task workload object, at the global and job level. They are documented on the following pages:

- “Notification tab” on page 125
- “Resources tab” on page 128
- “Free Format Text tab” on page 88

**Task Details**

Before you can specify Task details, you must have the icon on the workspace.

**To specify job details for the Task workload object**

1. On the workspace, right-click the Task icon. A shortcut menu appears.

2. On the shortcut menu, click **Job Details**.

   The Job Details dialog appears. By default, the Name field shows the object name and a number. The icons dropped on the workspace are numbered sequentially by job type until you optionally rename them.

   All the available job detail tabs are documented on the following pages:

   - “General tab” on page 96
Data Set Trigger Workload Object

You can use ESP Workload Manager’s data set-triggering facility at the Event level or at the job level. This section describes how to use this facility at the job level.

A data set-trigger workload object can be completed by the successful creation, closure or renaming of a data set by another job, by a started task or by a TSO user. This activity can be restricted to data sets created by a specific job or group of job names.

You can also define a data set-trigger workload object that can be completed by the successful transfer or renaming of a data set through FTP transfer.

Related documentation
For more information about data set triggers, see the *ESP Workload Manager User’s Guide*.

For more information about the DSTRIG command, see the *ESP Workload Manager Reference Guide*.

Data Set Trigger Defaults

**To set global defaults for the data set-trigger workload object**
On the Workload Editor menu bar, select **Options > Global Defaults > Job > Data Set Trigger**.

**To set job defaults for the data set-trigger workload object**
On the Workload Editor menu bar, select **Options > Job Defaults > Data Set Trigger**.
The Notification, Resources and Free Format Text tabs appear. These are the defaults available for the data set trigger at the global and job level. They are documented on the following pages:

- “Notification tab” on page 125
- “Resources tab” on page 128
- “Free Format Text tab” on page 88

Data Set Trigger Details

Before you can specify data set trigger details, you must have the icon on the workspace.

To specify job details for the data set trigger workload object

1. On the workspace, right-click the Data Set Trigger icon. A shortcut menu appears.
2. On the shortcut menu, click Job Details.

The Job Details dialog appears. By default, the Name field shows the object name and a number. The icons dropped on the workspace are numbered sequentially by job type until you optionally rename them.

The data set trigger has one tab that is unique, the Trigger Conditions tab.

All the available job detail tabs are documented on the following pages:

- “General tab” on page 96
- “Trigger Conditions tab, Data Set” on page 146
- “Send Message tab” on page 106
- “Issue Command tab” on page 108
- “Options tab” on page 110
- “Run Frequency tab” on page 114
- “Time Dependencies tab” on page 120
- “Notification tab” on page 125
- “Resources tab” on page 128
- “Resource Specifications tab” on page 131
- “Free Format Text tab” on page 136
- “Comment tab” on page 140
A data set trigger can be used on:

- The creation of a data set
- The closure of a data set after an update
- The renaming of a data set
- The successful completion of an FTP file transfer
- The explicit notification of a data set activity (used when the data set activity does not generate an SMF record)

Data set triggering can be restricted to data sets created by a specific job, a group of jobs or a user ID.

**Example**

In the following example, once PROD.CICS.FILE1602 is created, PAYJOB1 is submitted:

```
JOB PAYJOB1
RUN DAILY
END JOB

DISTFILE

2/05

PAYJOB1
```

**Data set name**

Enter the full name of a data set. This is the data set ESP Workload Manager monitors, for its creation.
FTP data-set trigger
Indicates the data set trigger is activated following the successful completion of a File Transfer Protocol (FTP) transmission.

Receive
Click this button if the FTP transfer is from the remote FTP partner to the local mainframe FTP partner.

Send
Click this button if the FTP transfer is from a local mainframe FTP partner to the remote FTP partner.

Host
Enter a host name to restrict the activation of the data set trigger to transfers to or from the specified remote host.

This is valid only within the context of an FTP trigger. The specified remote host is either a DNS host name or a TCP/IP address. The maximum length for a DNS host name is 100 characters.

Logon
Enter a logon ID to restrict the activation of the data set trigger to transfers to or from a specific user. You can use wildcard characters.

This is valid only within the context of an FTP trigger. The logon ID represents the user ID the FTP client uses to logon to the FTP server. The following example accepts any user whose user ID starts with abc:

LOGON (abc-)
If the FTP client is the remote partner, then logon ID is the user ID of the local FTP partner.
If the FTP client is the local partner, then logon ID is the user ID of the remote FTP partner.

Note: For more information about FTP data set triggers, see the ESP Workload Manager User’s Guide.

Explicit data-set trigger
Select the check box when the data set trigger is to be activated upon the explicit notification of the specified data set being updated.

Note: The explicit notification is accomplished by the ESP Workload Manager program CYBESDT1. For more information about explicit data set triggering, see the ESP Workload Manager Operator’s Guide.

Updated
Select the check box when the data set trigger is to be activated upon the update or creation of the data set specified.

Renamed
Select the check box if the data set trigger should occur if a data set is renamed to the data set name specified.
**Trigger when action is performed by**

The **Job name** and **User ID** fields can be used to restrict the activation of the data set trigger, to action originating from a specific job or user.

The two fields are mutually exclusive.

1. Click the **Job name** or **User ID** button.
2. Enter the job name or user ID name in the text field.

**Trigger on x occurrence(s) of action(s) specified**

1. Select the check box to indicate you want to specify the number of occurrences.
2. Use the arrows to indicate the number of occurrences that are to occur before the data set trigger is to be activated.
3. Click **OK**.

**File Trigger Workload Object**

The File Trigger workload object can be used to monitor file activity. When used, the FILENAME statement appears in the right-hand pane. This statement specifies the name of the file whose activity will trigger the release of the job named in the File Trigger statement.

**Related documentation**

For more information about file triggers, see the *ESP Workload Manager Reference Guide, FILENAME and FILE TRIGGER statements*.

For more information about file triggers related to your operating system, see the *Agent User’s Guide* for that operating system.

**File Trigger Defaults**

**To set global defaults for the file trigger workload object**

On the Workload Editor menu bar, select **Options > Global Defaults > Job > File Trigger**.

**To set job defaults for the file trigger workload object**

On the Workload Editor menu bar, select **Options > Job Defaults > File Trigger**.

The Notification, Resources and Free Format Text tabs appear. These are the defaults available for the file trigger, at the global and job level. They are documented on the following pages:

- “Notification tab” on page 125
- “Resources tab” on page 128
- “Free Format Text tab” on page 88
File Trigger Details

Before you can specify file trigger details, you must have the icon on the workspace.

To specify job details for the file trigger workload object
1. On the workspace, right-click the File Trigger icon. A shortcut menu appears.
2. On the shortcut menu, click Job Details.
   The Job Details dialog appears. By default, the Name field shows the object name and a number. The icons dropped on the workspace are numbered sequentially by job type until you optionally rename them.

   The file trigger has one tab that is unique, the Trigger Conditions tab.

   All the available job detail tabs are documented on the following pages:
   • “General tab” on page 96
   • “Trigger Conditions tab, File Trigger” on page 150
   • “Send Message tab” on page 106
   • “Issue Command tab” on page 108
   • “Options tab” on page 110
   • “Run Frequency tab” on page 114
   • “Time Dependencies tab” on page 120
   • “Notification tab” on page 125
   • “Resources tab” on page 128
   • “Resource Specifications tab” on page 131
   • “Free Format Text tab” on page 136
   • “Comment tab” on page 140
Agent name
Enter the name of the Agent. The Agent name identifies the system where the file is to be monitored.

File name
Enter the name of the file to be monitored. Specify the full path and file name up to 128 alphanumeric characters.

You must fill in a file name to activate the other fields on the Trigger Conditions tab. When the specified condition is met, for the file name indicated, it triggers the release of the job.

Recursive
Select the check box to indicate you want to monitor file activity in a directory and all of its subdirectories.

This option applies to all trigger conditions. This feature requires Release 5 of the ESP System Agent.

Trigger When File Is ...
Created
Click this button to indicate you want this job to complete when the specified file is created. Optionally, you can select:

- When file reaches \( x \) bytes. The default is 0 (bytes)
- No change for \( x \) minutes. The default is 0 (minutes)
Updated
Click this button to indicate you want this job to complete when the specified file is updated. Optionally, you can select:

- No change for $x$ minutes. The default is 0 (minutes)

Deleted
Click this button to indicate you want this job to complete when the specified file is deleted. There are no options for this condition.

Expanded
Click this button to indicate you want this job to complete when the specified file expands. Specify by how much the file should expand before this job is marked complete. You must select one of the following:

- Change in bytes
- Percent change
- When file reaches $x$ bytes

In addition, you can specify no change for $x$ minutes.

Shrunk
Click this button to indicate you want this job to complete when the specified file shrinks. Specify by how much the file should shrink before this job is marked complete. You must select one of the following:

- Change in bytes
- Percent change
- When file reaches $x$ bytes

In addition, you can specify no change for $x$ minutes.

Existing
Click this button to indicate you want this job to complete when the specified file already exists. There are no options for this condition.

Non-existent
Click this button to indicate you want this job to complete if the specified file does not exist. There are no options for this condition.

By How Much?
Change in bytes
Click this button to specify the number of bytes in the input field.

Enter the number of bytes or click the up or down arrows until the correct number is displayed. If the file expands or shrinks by a greater number of bytes than specified, the trigger occurs.

Percent change
Click this button to specify the percentage in the input field.
Enter the percentage or click the up or down arrows until the correct percentage is displayed. If the file expands or shrinks by a greater percentage than specified, the trigger occurs.

**When file reaches x bytes**
Click this button to specify the number of bytes in the input field.

Enter the number of bytes or click the up or down arrows until the correct number is displayed. If the file expands or shrinks by a greater number of bytes than specified, the trigger occurs.

**Alert or Event ID**
Enter an Alert or Event ID to trigger an ESP Workload Manager Alert or Event when the file trigger occurs.

**No change for x minutes**
Enter the number of minutes to indicate how many minutes the file should remain unchanged before this job is marked complete.

This is used when transmitting files and you want to ensure the file transfer is complete.

**Owner User ID**
Enter the user ID that owns the file to be monitored. Specify up to 32 alphanumeric characters for a UNIX user ID.

If this is a UNIX user ID, you can also specify the owning group. If this is a Windows NT/2000 file trigger, you cannot specify either user or group.

**Group**
Enter the group that owns the file to be monitored. Specify up to 32 alphanumeric characters for a UNIX group.

If this is a Windows NT/2000 file trigger, you cannot specify either user or group.

**User ID**
Enter the user ID the job runs under.

For more information, refer to the USER statement in the *ESP Workload Manager Reference Guide.*
Example: Monitoring for file creation
The following illustration shows job FILETRIG.FROMUNIX is triggered when file /export/home/user01/payfile is created.

Example: Monitoring for file size
A File Trigger job is triggered if the /data/test file has a file size of 1 byte or more.

Example: Triggering if a file expands by a certain size
A File Trigger job is triggered if the /credit/record file expands by 2500 bytes or more.

Example: Triggering if a file shrinks by a certain percentage
A File Trigger job is triggered if the /amount/test file shrinks in size by 35% or more.
Example: Triggering if a file shrinks to a certain size
A File Trigger job is triggered if the /cash/items/distribute file shrinks to less than 1000 bytes.

```
FILE_TRIGGER ITEMS
AGENT AGENT
FILENAME '/cash/items/distribute' SHRINK SIZE(1000)
ENDJOB
```

Example: Triggering if a file shrinks by a certain amount
A File Trigger job is triggered if the /cost/cash file shrinks by 10 bytes.

```
FILE_TRIGGER CASH
AGENT AGENT
FILENAME '/cost/cash' SHRINK DELTA(10)
ENDJOB
```

Example: Triggering if a file reaches a certain size and remains unchanged for a certain number of minutes
Dependency: ESP System Agent Release 5 and higher
A File Trigger job is triggered if the /research/analysis file reaches a size of 100 bytes or more, provided that the file size remains unchanged for five minutes or more.

```
FILE_TRIGGER RESEARCH
AGENT AGENT
FILENAME '/research/analysis' EXPAND NOCHANGE(5) DELTA(10)
ENDJOB
```

Example: Monitoring the same file with multiple file triggers
Dependency: ESP System Agent Release 5 and higher
Two File Trigger jobs continuously monitor the size of the same file, data/totals. The first job (SURVEY.EXPAND) triggers an Alert named MGT every time the file expands by 10k or more from its initial size.

The size must be entered in bytes (10 x 1024 bytes).
The second job (SURVEY.SHRINK) triggers an Alert named MGT every time the file shrinks by 10k or more from its initial size.

If the initial size of the data/totals file is 100k and it changes as follows (80k, 90k, 110k, 50k, 60k), then the following triggers will occur.

<table>
<thead>
<tr>
<th>File size</th>
<th>SURVEY.EXPAND</th>
<th>SURVEY.SHRINK</th>
</tr>
</thead>
<tbody>
<tr>
<td>80k</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>File size is less than its initial size</td>
<td>File size has decreased 20k from its initial size</td>
</tr>
<tr>
<td>90k</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>File size remains less than its initial size</td>
<td>File size has increased</td>
</tr>
<tr>
<td>110k</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>File size has increased 10k from its initial size</td>
<td>File size has increased</td>
</tr>
<tr>
<td>50k</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>File size is less than its initial size</td>
<td>File size has decreased 50k from its initial size</td>
</tr>
<tr>
<td>60k</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>File size remains less than its initial size</td>
<td>File size has increased</td>
</tr>
</tbody>
</table>

Example: Monitoring for the existence of a file
The File Trigger job in this example checks for the existence of the /bank/account/money file. If the file exists, the job completes successfully. If the file doesn’t exist, the job fails.

Example: Monitoring for the non existence of a file
The File Trigger job in this example checks for the non existence of the /start/term/vacation file. If the file does not exist, the job completes successfully. If the file exists, the job fails.
Example: Monitoring for an update to a file on a remote Windows computer

Dependency: ESP System Agent Release 7

A File Trigger job (PAYDATA) monitors for an update to the payroll.dat file on a remote Windows computer named CYBNT.

To run a File Trigger job that monitors a file on a remote Windows computer, you must do the following:

• Ask your ESP Workload Manager administrator to define a user id and password that has access to the file on the remote Windows machine.
• Specify the file name using UNC (Universal Naming Convention) in the job definition.
• Specify the user ID in the job definition.

jsmith is a user ID on CYBNT that has access to the AccountingFiles directory and is defined in ESP Workload Manager.

Example: Monitoring for the creation of a file that is owned by a specified UNIX user ID

A File Trigger job (PAYDATA) is triggered if a /data/payroll.dat file is created on a UNIX machine and the file is owned by jdoe.

• If the file does not exist when the job is readied, the trigger does not occur until the file is created.
• If the file exists and the owner of the file is jdoe when the job is readied, the trigger occurs immediately.
• If the file exists or is created, but the owner of the file is not jdoe, the file trigger does not complete. It waits until all specified criteria are satisfied, including the Owner user ID criteria. If the owner of the file is changed to jdoe, the file trigger completes.
Example: Monitoring for the existence of a file that is owned by a specified UNIX group

A File Trigger job (PAYDATA) is triggered if a /data/payroll.dat file exists on a UNIX machine and the file is owned by the group accts.

If the file exists and the file is owned by the group accts when the job is readied, the trigger completes successfully.

If the file exists and the file is not owned by the group accts when the job is readied, the file trigger fails.

Monitoring file activity on an i5 system

You can use the File Trigger job to monitor file activity on an i5 system and release jobs based on that activity.

The File Trigger job can monitor when a file is created, updated, deleted, expanded or shrunk, and when a file exists or doesn’t exist.

Example: Using wildcards to specify a file name on the root file system

In this example, the job continuously monitors for files that are created in the /home/cybesp/ directory in the root file system. A File Trigger job (JOBDATA) is triggered and an Alert named A123 is issued if a file is created with a file name that matches the following criteria:

- Starts with PID
- Ends with four characters
- Has any extension

APPL NEWFILE
FILE_TRIGGER JOBDATA
  AGENT I5AGENT
  FILENAME '/home/cybesp/PID????.*' CREATE CONTINUOUS(A123)
  RUN DAILY
ENDJOB

Alternatively, if an Event name is specified in the CONTINUOUS operand, the Event is triggered when the file is created.
Example: Using a generic name to specify a QSYS.LIB file object

In this example, a File Trigger job (JOBDATA) is triggered when any file object with a file name that starts with PAY and ends with any characters is created in the QSYS.LIB file system. Note that the file name is enclosed in single quotation marks so that the text following */ is not interpreted as a comment.

```
APPL NEWFILE
FILE_TRIGGER JOBDATA
   AGENT I5AGENT
   FILENAME 'LIB/PAY*/FILE' CREATE
   RUN DAILY
ENDJOB
```

Example: Monitoring the size of a QSYS.LIB file object

In this example, a File Trigger job (EXPMON) is triggered when the EXPOBJ file object in the QSYS.LIB file system increases by 10 bytes or more. Since no member is specified in the file name, the job monitors the entire object size. The entire object size includes the size of the file object itself and the total size of the file object’s members.

```
FILE_TRIGGER EXPMON
   AGENT I5AGENT
   FILENAME 'LIB/EXPOBJ/*FILE' EXPAND SIZE(10)
   RUN DAILY
ENDJOB
```

Note:

- The file name is enclosed in single quotation marks so that the text following */ is not interpreted as a comment.
- To only monitor the total size of the file object’s members, specify *ALL as the member name.

UNIX Workload Objects

The UNIX icon has a pop-up menu containing all the different UNIX operating systems you can schedule workload on. You can specify workload defaults and details for the following UNIX operating systems:

- Generic
- AIX
- HP-UX
- NCR
- Sequent
- Sun-Solaris
UNIX Defaults

These defaults apply to all UNIX operating systems.

To set global defaults for the UNIX workload object
On the Workload Editor menu bar, select Options > Global Defaults > Job > UNIX.

To set job defaults for the UNIX workload object
On the Workload Editor menu bar, select Options > Job Defaults > UNIX.

The Agent Specifications, Environment Variables, Exit Codes, Notification, Resources and Free Format Text tabs appear. These are the defaults available for the UNIX job type, at the global and job level. They are documented on the following pages:

- “Agent Specifications tab - UNIX” on page 160
- “Environment Variables tab - UNIX” on page 166
- “Exit Codes tab” on page 169
- “Notification tab” on page 125
- “Resources tab” on page 128
- “Free Format Text tab” on page 88

UNIX Details

Before you can specify UNIX details, you must have the icon on the workspace.

To specify job details for the UNIX workload object
1. On the workspace, right-click the UNIX icon. A shortcut menu appears.
2. On the shortcut menu, click Job Details.

The Job Details dialog appears. By default, the Name field shows the job type name and a number. The icons dropped on the workspace are numbered sequentially by job type until you optionally rename them.

The UNIX job type has three tabs that are unique, the Agent Specifications, Environment Variables, and Exit Codes tabs.

All the available job detail tabs are documented on the following pages:

- “General tab” on page 96
- “Agent Specifications tab - UNIX” on page 160
- “Environment Variables tab - UNIX” on page 166
- “Exit Codes tab” on page 169
- “Send Message tab” on page 106
Agent Specifications tab - UNIX

The values shown above are for one job (Payjob1) in the example on page 167. The Agent Specifications tab is completed for each job in the example because each job is running a different script and passing different arguments.

Specify Agent
Name
Enter the name of the Agent where the job is to run.
Routing
Select the check box to enable the routing option. This is an enhancement in ESP Workload Manager v.5.4 called load balancing. This feature requires the High Performance Option (HPO) and the ESP System Agent for UNIX or Microsoft Windows, Release 6, Service Pack 1 or higher.

Load balancing uses Agents and their associated CPUs that are grouped into a node to handle workload. The purpose of this grouping is to give the Resource Manager a selection of CPUs to choose from.

Previously, using an AGENT statement for a particular job meant the job would be sent to that Agent even if the associated CPU was incapable of handling the job.

With load balancing, the AGENT statement has a new operand called ROUTING. This operand informs the Resource Manager to send the job to the Agent CPU in the node that is most capable of handling the job. The benefit of load balancing is the Resource Manager matches jobs with CPUs with more available capacity. Load balancing reduces job run time and uses CPU capacity more efficiently.

In conjunction with the routing option, a resource statement must be present in the UNIX_Job. In the following example, the relevant statements are:

- **AGENT TOR01 ROUTING** — The Resource Manager selects the Agent CPU with the most free CPU capacity. Without the ROUTING operand specified, the job goes to Agent TOR01 and no load balancing is performed.
- **RESOURCE (10,RESUNIX)** — This statement specifies the UNIX job SUNSOL1 must run on an Agent CPU that has at least 10 percent CPU capacity free.

If no CPU is available that has more than 10 percent free capacity, the job goes into a resource wait condition and waits until sufficient CPU capacity is available.

For information on how to use load balancing, see the *Guide to Scheduling Workload, ESP System Agent, Release 6 Service Pack 2*.

Specify UNIX User

**User ID**
Enter the UNIX user ID that has the authority to run the job on the ESP Agent machine. You must specify a user ID if the job runs a command. If the job runs a script, the default is the owner of the script. The user ID is case-sensitive.

If you specify a user ID and ESP Agent runs
- Under the root account, the job runs under the specified user ID. The user ID must have the authority to run the script or command, otherwise the job fails.
• Under another account, the job runs under the same account that runs ESP Agent. The user ID specified in the job definition must have the authority to run the script or command, otherwise the job fails.

Specify Action to Take and Parameters to Pass

Run a script
Click this button and enter the full path of the UNIX script to execute. You can browse for the path to, and name of, the script or command using the **Script/Command Browser** button.

**Note:** To use the **Script/Command Browser** button, you must be connected to ESP Workload Manager, and ESP Agent defined for the job must be running. This feature is only available for ESP System Agent Release 7.

Issue a command
Click this button and enter the full path, and name of the UNIX command file to execute. You can browse for the path to, and name of, the script or command using the **Script/Command Browser** button.

**Note:** To use the **Script/Command Browser** button, you must be connected to ESP Workload Manager and ESP Agent defined for the job must be running. This feature is only available for ESP System Agent Release 7.

Arguments to pass
Enter an argument string of positional parameter to be passed. Arguments can be numeric or alphabetic strings of data, up to 133 characters. Specify each parameter in the order it is expected in the script, separating each parameter with a blank space. Multiple strings can be passed as a single parameter by enclosing them in double quotes. For example, "p1 p7".

Name of shell to use
Select the shell to use to execute the script or command file. The default for most ESP Agents is the Korn shell (/bin/ksh). However, you can choose one of the following shells:

- /bin/ksh (Korn shell)
- /bin/sh (Bourne shell)
- /bin/bash = (Bourne again shell)
- /bin/csh (C shell)

To run a UNIX script, ESP Agent uses, in the following order, the shell specified in:

- The **Name of shell to use** field
- The first line of the script (if the shell is not specified in the **Name of shell to use** field)
- The *oscomponent.defaultshell* parameter in ESP Agent’s *agentparm.txt* file (if the shell is not specified in the Shell field or in the script)
• The user default shell defined in the user profile (if not specified in one of the previous three locations)

Note: The ESP Agent administrator must define all shells ESP Agent uses using the oscomponent.validshell parameter in the agentparm.txt file, unless the oscomponent.checkvalidshell parameter is set to false.

Process priority

Dependency: ESP System Agent Release 7

You can set a UNIX job’s process priority. Process priority determines the order in which processes are scheduled on the processor. Depending on the priority level, process priority can speed up or slow down a process.

In the Process Priority field, select a priority for the job:

• **High** — Processes that must be executed immediately. These processes can use nearly all available CPU time.
• **Below normal** — Processes that have priority above the Idle level, but below the Normal level
• **Normal** — Processes without special scheduling needs
• **Above normal** — Processes that have priority above the Normal level, but below the High level
• **Idle** — Processes that will run only when the system is idle

Note: You can only set a UNIX job’s process priority to a level above normal if the job runs on a machine with ESP Agent started by the root account. If ESP Agent is not started by root and you set the process priority to a level above normal, the job runs with the normal process priority.

ESP Expedite policy

Use the ESP Expedite policy field to associate an ESP Expedite policy with the job. Enter a one to eight character Expedite policy name.

For more information, see the EXPEDITE statement in the ESP Workload Manager Reference Guide.

**Off**

Indicates no ESP Expedite policy will be associated with the job.

For more information, see the EXPEDITE statement in the ESP Workload Manager Reference Guide.
Example: Running a script that is located in a path set in the PATH environment variable

In this example, the job runs a script called `procscript.sh`. The job runs under the user ID `jsmith`, who has the authority to run the script. The path to `procscript.sh` is set in the `PATH` system environment variable for `jsmith` on the ESP Agent machine.

Example: Running a script that is located in a path set in a user environment variable

In this example, the job runs a script called `myscript.sh`. The job runs under the user ID `jsmith`, who has the authority to run the script. The path to `myscript.sh` is set in the user environment variable `$MY_PATH`, which is defined in the profile file for `jsmith`.
Example: Running a PERL script

To schedule PERL scripts, specify the path to the PERL executable in the Run a script or Issue a command field and the path to the PERL script in the Arguments to pass field. In the User ID field, you must specify a user ID that has access to the PERL executable and PERL script.

The following job definition runs the PERL script located at /home/espuser/esptest/esptest.pl. The PERL executable is located at /usr/contrib/bin/perl. The job runs under the user jsmith, who has access to the PERL executable and the authority to run the PERL script.
UNIX-specific environment variables further define the local environment. They define system-specific information. ESP Workload Manager environment variables are used with UNIX to define the local environment for the running of a script. Any ESP Workload Manager environment variable can be passed to a script. You can use UNIX environment variables or define your own.

**Define Environment Variables**

**Name**
Enter the name of the environment variable to be passed. Specify a name in alphanumeric characters or choose a name from the list provided.

**Value**
Enter the value for the environment variable.

Click **Add**. The variable name and value are added to the List of Environment Variables field.

Click **OK**.

**List of Environment Variables**

To update an environment variable

1. In the List of Environment Variables, click on the environment variable to highlight it.

2. Change the value field.
3. Click **Update**.
4. Click **OK**.

**To delete an environment variable**

1. In the List of Environment Variables, click on the environment variable to highlight it.
2. Click **Delete**.
3. Click **OK**.

**Example**

```
Example

Specifying environment variables

Environment variables define system-specific information. Using environment variables, you define the local environment where ESP Agent runs the script, command or batch file. You can modify existing environment variables or create your own.

You must specify both a name and a value for each variable. ESP Server passes the name and the value together to the script, command or batch file.

**Note:** When passing multiple environment variables to an ESP Agent, the maximum size is 4K.

**To specify environment variables**

In the **Environment Variables** dialog of the job definition, specify the job’s environment variables. For each variable, you must enter a name and a value.
```
Example: Define alternative input and output sources

All UNIX programs run by a shell are connected to the following input and output streams:

<table>
<thead>
<tr>
<th>Stream</th>
<th>Default Source</th>
<th>Environment Variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard input stream</td>
<td>Keyboard</td>
<td>STDIN</td>
</tr>
<tr>
<td>Standard output stream</td>
<td>Screen</td>
<td>STDOUT</td>
</tr>
<tr>
<td>Standard error output stream</td>
<td>Screen</td>
<td>STDERR</td>
</tr>
</tbody>
</table>

To specify alternative input and output sources
1. In the Environment Variables dialog, click Add.
2. In the Name field for the first row, type STDIN, and in the Value field, type the full path of an alternative input stream.
3. Click Add.
4. In the Name field for the second row, type STDOUT, and in the Value field, type the full path of an alternative output stream.
5. Click Add.
6. In the Name field for the third row, type STDERR, and in the Value field, type the full path of an alternative error stream.

Example: Set an environment variable to an empty value

Dependency: ESP System Agent Release 7

To set an environment variable to an empty value, enter two quotation marks without spaces (""") in the Value field.

In this example, the job runs a script under the user ID jdoe. The script uses an environment variable called VAR1, which is set in the profile file for jdoe. ESP Server passes VAR1 and its empty value to the script.

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>VAR1</td>
<td>&quot;&quot;</td>
</tr>
</tbody>
</table>

Using environment variables

In UNIX, you use environment variables to define the local environment to run a script. You can pass any ESP environment variables to a script. You can use UNIX environment variables or define your own. You can add or update UNIX environment variables.

You can pass the following UNIX environment variables to a script:
• HOME — Name of the user’s initial working directory, used to find .profile, .cshrc, and .login scripts. HOME defaults to the home directory of the user for whom the script is running (if this value is not overwritten).
• LANG — Name of the predefined setting for locale
• LC_ALL — Default locale to use if any of the following five LC_ symbols are not defined
• LC_COLLATE — Name of the predefined setting for locale
• LC_CTYPE — Name of the locale for character classification
• LC_MONETARY — Name of the locale for money-related information
• LC_NUMERIC — Name of the locale for numeric editing
• LC_TIME — Name of the locale for date- and time-formatting information
• LOGNAME — Name of the user’s login account
• PATH — The sequence of path prefixes used by execvp() in locating programs to run
• PWD — Present Working Directory. ESP Agent changes to this directory prior to executing the script.
• TERM — User’s terminal type
• TZ — Time zone information

Examples

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>HOME</td>
<td>/user/user1</td>
</tr>
<tr>
<td>INPUT</td>
<td>/home/test</td>
</tr>
<tr>
<td>PWD</td>
<td>/usr/scripts/dailyrun</td>
</tr>
</tbody>
</table>

Exit Codes tab

Exit codes are used to indicate the success or failure of a job. You must indicate whether to interpret this code or any code within a range, as a successful completion or as a failed completion of the job. If an exit code is not specified, a job is considered to have completed successfully only when a return code of zero(0) is issued.

Multiple exit codes can be used.
In the following example, an exit code of 12 is a failure. Anything else is treated as a success, until exit code 9 is added to the List of Exit Codes. Then 9 will also be treated as a failure.

Define Exit Code Interpretation

Exit Code
Enter the exit code number or range of numbers. Specify up to four numeric characters for each exit code. Click Success or Failure to specify the interpretation for the exit code.

Click Add. The exit code and type appear in the List of Exit Codes.

Click OK.

List of Exit Codes

To update an exit code
1. Click the exit code in the List of Exit Codes box to highlight it.
2. Click Success or Failure to change the interpretation for the exit code or change the exit code.
3. Click Update.
4. Click OK.
To delete an exit code
1. Click the exit code in the List of Exit Codes box to highlight it.
2. Click Delete.
3. Click OK.

Note: For more information about UNIX distributed workload, related to your UNIX operating system, see the Agent User’s Guide for that operating system.

Linux Workload Object

You can specify workload defaults and details for the Linux job type.

Linux Defaults

To set global defaults for the Linux workload object
On the Workload Editor menu bar, select Options > Global Defaults > Job > Linux.

To set job defaults for the Linux workload object
On the Workload Editor menu bar, select Options > Job Defaults > Linux.

The Agent Specifications, Environment Variables, Exit Codes, Notification, Resources and Free Format Text tabs appear. These are the defaults available for the Linux job type, at the global and job level. They are documented on the following pages:

- “Agent Specifications tab - UNIX” on page 160. Linux uses the UNIX tabs.
- “Environment Variables tab - UNIX” on page 166. Linux uses the UNIX tabs.
- “Exit Codes tab” on page 169
- “Notification tab” on page 125
- “Resources tab” on page 128
- “Free Format Text tab” on page 88

Linux Details

Before you can specify Linux details, you must have the icon on the workspace.

To specify job details for the Linux workload object
1. On the workspace, right-click the Linux icon. A shortcut menu appears.
2. On the shortcut menu, click Job Details.

The Job Details dialog appears. By default, the Name field shows the job type name and a number. The icons dropped on the workspace are numbered
sequentially by job type until you optionally rename them.

All the available job detail tabs are documented on the following pages:

- “General tab” on page 96
- “Agent Specifications tab - UNIX” on page 160. Linux uses the UNIX tabs.
- “Environment Variables tab - UNIX” on page 166. Linux uses the UNIX tabs.
- “Exit Codes tab” on page 169
- “Send Message tab” on page 106
- “Issue Command tab” on page 108
- “Options tab” on page 110
- “Run Frequency tab” on page 114
- “Time Dependencies tab” on page 120
- “Notification tab” on page 125
- “Resources tab” on page 128
- “Resource Specifications tab” on page 131
- “Free Format Text tab” on page 136
- “Comment tab” on page 140

**OS/400 Jobs**

**Dependency:** ESP System Agent for i5/OS, Release 7

Use the OS/400 job to schedule i5/OS workload.

For more information about scheduling i5/OS workload, see the *ESP System Agent for i5/OS Guide to Scheduling Workload*.

**Running UNIX workload on a System i5 computer**

You can schedule most UNIX workload, such as UNIX scripts, in the PASE environment on the i5/OS operating system. However, workload that requires UNIX kernel services might not run properly in the PASE environment because PASE does not run with a full UNIX kernel. For more information on PASE and application compatibility, see the IBM documentation.

To ensure UNIX workload runs properly on a System i5 computer, install ESP System Agent for IBM AIX on an AIX partition and use that ESP Agent instead.
i5/OS naming conventions

This section describes the naming conventions you can use when specifying i5/OS paths and names in your workload. The naming conventions depend on where the file is located on the i5/OS system. You can specify paths and files in the following file systems:

- root file system
- Open systems file system (QOpenSys)
- Library file system (QSYS.LIB)

i5/OS root file system naming convention
To specify a file in the root file system, use UNIX path and file formats.

i5/OS Open systems file system (QOpenSys) naming convention
To specify a file in QOpenSys, use UNIX path and file formats. QOpenSys file names are case sensitive.

i5/OS Library file system (QSYS.LIB) naming convention
To specify an object in QSYS.LIB, use one of the following formats (unless described differently in the ESP statement syntax):

Path format
/QSYS.LIB/libraryname.LIB/objectname.type/
To specify *FILE objects, use the following format:
/QSYS.LIB/libraryname.LIB/objectname.FILE/membername.MBR

i5/OS standard format
libraryname/objectname/type
To specify *FILE objects, use the following format:
libraryname/objectname/*FILE(<membername>)
Note: *FILE is optional when membername is specified.

ESP Agent Version 2 format
objectname.libraryname.type
To specify *FILE objects, use the following format:
objectname.libraryname.FILE.membername
Note:
- libraryname, objectname, type, and membername can be up to 10 characters long each.
- You can use *ALL to match any name.
- You can use *FIRST for membername.
You can use generic names for *libraryname* and *objectname*.

**i5/OS Open systems file system (QOpenSys) naming convention**
To specify a file in QOpenSys, use UNIX path and file formats. QOpenSys file names are case sensitive.

**OS/400 Defaults**

To set global defaults for the OS/400 workload object
On the Workload Editor menu bar, select **Options > Global Defaults > Job > OS/400**.

To set job defaults for the OS/400 workload object
On the Workload Editor menu bar, select **Options > Job Defaults > OS/400**.

The Agent Specifications, Environment, Notification, Resources, and Free Format Text tabs appear. These are the defaults available for the OS/400 job type, at the global and job level. They are documented on the following pages:

- “Agent Specifications tab - OS/400” on page 175
- “Environment tab - OS/400” on page 178
- “Notification tab” on page 125
- “Resources tab” on page 128
- “Free Format Text tab” on page 88

**OS/400 Details**

Before you can specify OS/400 details, you must have the icon on the workspace.

To specify job details for the OS/400 workload object
1. On the workspace, right-click the OS/400 icon. A shortcut menu appears.
2. On the shortcut menu, click **Job Details**.
   
   The Job Details dialog appears. By default, the Name field shows the job type name and a number. The icons dropped on the workspace are numbered sequentially by job type until you optionally rename them.

   All the available job detail tabs are documented on the following pages:

   - “General tab” on page 96
   - “Agent Specifications tab - OS/400” on page 175
   - “Environment tab - OS/400” on page 178
   - “Send Message tab” on page 106
Agent Specifications tab - OS/400

Agent name
Enter the name of the Agent where the job is to run.

Specify Action to Take and Parameters to Pass

Run program
Enter the name of the i5/OS program you want to run. For more information, refer to the CPLNAME statement in the *ESP System Agent for i5/OS Guide to Scheduling Workload*. 
Note: If you type the program to run, you must follow the path rules. For path rules, see “i5/OS naming conventions” on page 173.

Run program in file
Enter the source file name that contains the CL source for the i5/OS program you want to run. The source file name must be a valid i5/OS file name. Use this option when the i5/OS job is a database application. For more information, refer to the AS400FILE statement in the ESP System Agent for i5/OS Guide to Scheduling Workload.

Note: If you type the source file name, you must follow the path rules. For path rules, see “i5/OS naming conventions” on page 173.

Issue command
Enter a valid i5/OS command to run. For more information, refer to the COMMAND statement in the ESP System Agent for i5/OS Guide to Scheduling Workload.

Note: If you type the command to run, you must follow the path rules. For path rules, see “i5/OS naming conventions” on page 173.

Positional parameters
Positional parameters are variables that can be passed to a program at the time the program is invoked. The parameters are assigned in the order they are passed.

Enter one or more positional parameters you want to pass to the i5/OS program. Specify each parameter in the order it is expected in the program, enclosing each parameter with single quotation marks and separating each parameter with a blank space, for example

'PAYROLL' '*LIBL' 'ABC' '01' '1' 'P' 'TAP02' '0'

To pass spaces in a parameter, enclose the value to be passed in double quotation marks, for example

"user 1" "user 2"

For more information, refer to the PARAM statement in the ESP System Agent for i5/OS Guide to Scheduling Workload.

Keyword Parameters
Keyword parameters are additional parameters to be passed to the OS/400 SBMJOB command. You can specify any valid SBMJOB command keyword and value combination. You can also specify multiple combinations. Any keyword and value combinations you specify are added to the SBMJOB command.

Keyword
Enter a valid SBMJOB command keyword, such as PRTDEV, OUTQ, USER and so on. The total maximum length of the multiple keyword and value pairs is 60 characters.

Value
Enter a value that corresponds to the keyword. This is a valid SBMJOB value. Do not enclose the value in brackets.
**Process priority**
You can set an OS/400 job’s process priority. Process priority determines the order in which processes are scheduled on the processor. Depending on the priority level, process priority can speed up or slow down a process.

In the **Process Priority** field, select a priority for the job:

- **High** — Processes that must be executed immediately. These processes can use nearly all available CPU time.
- **Below normal** — Processes that have priority above the Idle level, but below the Normal level
- **Normal** — Processes without special scheduling needs
- **Above normal** — Processes that have priority above the Normal level, but below the High level
- **Idle** — Processes that will run only when the system is idle

**ESP Expedite policy**
Use the ESP Expedite policy field to associate an ESP Expedite policy with the job. Enter a one to eight character Expedite policy name.

For more information, see the EXPEDITE statement in the *ESP Workload Manager Reference Guide*.

**Off**
Indicates no ESP Expedite policy will be associated with the job.

For more information, see the EXPEDITE statement in the *ESP Workload Manager Reference Guide*. 

OS/400 User ID
Enter the user ID the job runs under. The user ID represents the authority the job is to use. The user ID can be up to 10 characters long.

For more information, refer to the USER statement in the *ESP System Agent for i5/OS Guide to Scheduling Workload*.

Specify OS/400 Libraries
Name
Enter the library name that contains the i5/OS program, the CL source for the i5/OS program, or the command you want to run.

For more information, refer to the AS400LIB statement in the *ESP System Agent for i5/OS Guide to Scheduling Workload*.

Library list
Enter the name of the library or libraries the job uses. You can specify up to 25 libraries. Separate each library name with a space. Each name can be up to 10 characters long.

**Note:** The Agent searches the libraries in the order they are listed.

For more information, refer to the LIBBL statement in the *ESP System Agent for i5/OS Guide to Scheduling Workload*. 
Current library
Enter the current library for the i5/OS job.

If you do not specify a current library, the Agent uses the current library of the user profile ESP Agent runs under.

For more information, refer to the CURLIB statement in the *ESP System Agent for i5/OS Guide to Scheduling Workload*.

Specify OS/400 Job

Name
Enter the name for the i5/OS job. The name can be up to 10 characters long.

For more information, refer to the JOBNAME statement in the *ESP System Agent for i5/OS Guide to Scheduling Workload*.

Job Description
Enter the i5/OS job description for the program submitted. The job description can be up to 60 characters long in total. The job description should be in one of the following formats:

- `libraryname/descriptionname`
- `libraryname.descriptionname`
- `descriptionname`

**Note:** If you do not specify the library name, ESP Agent uses the job's library list.

For more information, refer to the JOBD statement in the *ESP System Agent for i5/OS Guide to Scheduling Workload*.

Job Queue
Enter the i5/OS job queue for the submitted program. The job queue can be up to 60 characters long in total. The job queue should be in one of the following formats:

- `libraryname/jobqueuename`
- `libraryname.jobqueuename`
- `jobqueuename`

**Note:** If you do not specify the library name, ESP Agent uses the job's library list.

For more information, refer to the JOBQ statement in the *ESP System Agent for i5/OS Guide to Scheduling Workload*.

OS/400 exit program
Enter the type of exit code returned by an i5/OS job. The exit code can be a high-level language program’s return code, the job’s ending severity code or the return code of a program that is not written in a high-level language.

For more information, refer to the CCEXIT statement in the *ESP System Agent for i5/OS Guide to Scheduling Workload*. 
Windows NT/2000 Workload Object

You can specify workload defaults and details for the Windows NT/2000 job type.

Windows NT/2000 Defaults

To set global defaults for the Windows NT/2000 workload object

To set job defaults for the Windows NT/2000 workload object
On the Workload Editor menu bar, select Options > Job Defaults > Windows NT/2000.

The Agent Specifications, Environment Variables, Exit Codes, Notification, Resources and Free Format Text tabs appear. These are the defaults available for the Windows NT/2000 job type, at the global and job level. They are documented on the following pages:

- “Agent Specifications tab - Windows NT/2000” on page 181
- “Environment Variables tab - Windows NT/2000” on page 184
- “Exit Codes tab” on page 169
- “Notification tab” on page 125
- “Resources tab” on page 128
- “Free Format Text tab” on page 88

Windows NT/2000 Details

Before you can specify Windows NT/2000 details, you must have the icon on the workspace.

To specify job details for the Windows NT/2000 workload object
2. On the shortcut menu, click Job Details.

The Job Details dialog appears. By default, the Name field shows the job type name and a number. The icons dropped on the workspace are numbered sequentially by job type until you optionally rename them.

All the available job detail tabs are documented on the following pages:

- “General tab” on page 96
- “Agent Specifications tab - Windows NT/2000” on page 181
Agent Specifications tab - Windows NT/2000
Specify Agent

Name
Enter the name of the Agent where the job is to run.

Routing
Check-mark this field to enable the routing option. This is an enhancement in ESP Workload Manager v.5.4 called load balancing. This feature requires the High Performance Option (HPO) and the ESP System Agent for UNIX or Microsoft Windows, Release 6, Service Pack 1 or higher.

Load balancing uses Agents and their associated CPUs that are grouped into a node to handle workload. The purpose of this grouping is to give the Resource Manager a selection of CPUs to choose from.

Previously, using an AGENT statement for a particular job meant the job would be sent to that Agent even if the associated CPU was incapable of handling the job.

With load balancing, the AGENT statement has a new operand called ROUTING. This operand informs the Resource Manager to send the job to the Agent CPU in the node that is most capable of handling the job. The benefit of load balancing is the Resource Manager matches jobs with CPUs with more available capacity. Load balancing reduces job run time and uses CPU capacity more efficiently.

In conjunction with the routing option, a resource statement must be present in the WINNT_Job. In the following example, the relevant statements are:

- AGENT ESPNT01 ROUTING — The Resource Manager selects the Agent CPU with the most free CPU capacity. Without the ROUTING operand specified, the job goes to Agent ESPNT01 and no load balancing is performed.
- RESOURCE (10,RESWNT) — This statement specifies the WINNT job WINNT1 must run on an Agent CPU that has at least 10 percent CPU capacity free.

If no CPU is available that has more than 10 percent free capacity, the job goes into a resource wait condition and waits until sufficient CPU capacity is available.

For information on how to use load balancing, see the ESP System Agent, Release 6, Service Pack 2 Guide to Scheduling Workload.

Specify Win NT User

User ID
Enter the name of the Windows NT/2000 user ID. The user ID must be a valid Windows NT/2000 user ID. The user ID represents the authority the job is to use.
Specify Command File to Run

Name
Enter the full path and name of the command file to run. This field is mandatory.

The maximum length of the command name is 255 characters. It must be a legal executable NT file name. In the following example, sort is the name of the command and c:\payroll\test is the path.

\c:\payroll\test\sort

Note: You can browse for the path to, and name of, the command file using the Script/Command Browser icon. To use the Script/Command Browser, you must be connected to ESP Workload Manager and ESP Agent must be running. The Script/Command Browser is only available with ESP System Agent Release 7.

Arguments to pass
Enter an argument string of positional parameters. Arguments can be numerical or alphabetical strings of data, up to 133 characters.

Specify each parameter in the order it is expected in the script, separating each parameter with a blank space. Multiple strings can be passed as a single parameter by enclosing them in double quotes. For example, "p2 p3".

ESP Expedite policy
Use the ESP Expedite policy field to associate an ESP Expedite policy with the job. Enter a one to eight character Expedite policy name.

For more information, see the EXPEDITE statement in the ESP Workload Manager Reference Guide.

Off
Indicates no ESP Expedite policy will be associated with the job.

For more information, see the EXPEDITE statement in the ESP Workload Manager Reference Guide.
Environment variables define system-specific information. ESP Workload Manager uses environment variables with Windows NT/2000 to define the local environment for the running of a command. You can pass any ESP Workload Manager environment variable to a command.

Define Environment Variables

**Name**
Enter the name of the environment variable to be passed. Specify a name in alphanumeric characters or choose a name from the list provided.

**Value**
Enter the value for the environment variable. The value is case-sensitive.

The following are the corresponding statements that appear in the right-hand pane:

List of Environment Variables

To update an environment variable

1. In the List of Environment Variables, click on the environment variable to highlight it.
2. Change the above fields.
3. Click **Update**.
4. Click **OK**.

**To delete an environment variable**

1. In the List of Environment Variables, click on the environment variable to highlight it.
2. Click **Delete**.
3. Click **OK**.

**Using environment variables**

In Windows, you use environment variables to define the local environment the command runs in. You can pass any ESP Workload Manager environment variable to a command. You can add, update, and delete Windows environment variables.
Examples

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>INPUT</td>
<td>C:\run.bat</td>
</tr>
<tr>
<td>NAME</td>
<td>Jane Doe</td>
</tr>
<tr>
<td>JOB</td>
<td>PAY</td>
</tr>
<tr>
<td>HOME</td>
<td>c:\export\u1</td>
</tr>
</tbody>
</table>

Job Object tab - WindowsNT/2000

Dependency: ESP System Agent Release 7

A Windows job object enables you to group processes together and control their attributes as a single entity. You can use a Windows job object to manage processing properties for a group of jobs such as processor usage, memory usage, and process priority.

You create a new Windows job object and associate a job with it or you can associate a job with an existing job object. After all processes associated with a job object complete, the job object no longer exists.

Define a Windows Job Object
In the Job Object dialog, enter one of the following:
Create job object
Name of the new job object. This name must be unique; there cannot be an existing job object with the same name.

Assign job object
Name of an existing job object to which you want to add this job.

Note: If you specify both Create job object and Assign job object, the value in Assign job object is ignored and the new job object is created.

Job object name
Enter the name of the new Windows job object or of an existing Windows job object you want to add this job to. The name can be up to 256 characters long and is case sensitive. You can use any characters. If the job object name exceeds 256 characters, ESP issues error message 4819.

If you are creating a new Windows job object, the name must be unique; there cannot be an existing Windows job object with the same name.

Job memory
Maximum virtual memory in bytes allocated to all processes associated with the job object. If the total memory used for all processes associated with the job object exceeds this limit, the job that is trying to use memory fails. Select a unit, for example MEGABYTES.

Process memory
Maximum virtual memory in bytes allocated to each process associated with the job object. If the memory used for a single process exceeds this limit, the job fails. Select a unit, for example MEGABYTES.

Job time [ms]
Maximum CPU time in milliseconds allocated to all processes associated with the job object. If the total CPU time for all processes associated with the job object exceeds this limit, all jobs associated with the job object fail.

Process time [ms]
Maximum CPU time in milliseconds allocated to each process associated with the job object. If the CPU time used for a single process exceeds this limit, the job fails.

Priority class
Process priority for all processes in the job object

- **High** — Processes that must be executed immediately. These processes can use nearly all available CPU time.
- **Above normal** — Processes that have priority above the Normal level, but below the High level
- **Normal** — Processes without special scheduling needs
- **Below normal** — Processes that have priority above the Idle level, but below the Normal level
- **Idle** — Processes that will run only when the system is idle
**Active process limit**
Maximum number of simultaneously active processes allowed in the job object

**Note:** If you create a new job object and you do not specify a value for a job object property, that property has an unlimited value. If you assign an existing job object and you do not specify a value for a property, that property keeps the existing value.

**Example: Creating a Windows job object**
The following job definition creates a Windows job object called PayJobsObject. The Create job object value overrides the Assign job object value and creates a new job object. PayJobsObject can use a total of 40 MB of memory (41943040 bytes) and 1 hour of CPU time (4000000 milliseconds) for all processes it contains. Each process associated with PayJobsObject can use a maximum of 500 KB of memory (512000 bytes) and 3 minutes of CPU time (180000 milliseconds). PayJobsObject can have a maximum of 10 simultaneously active processes.

**SAP Workload Objects**
There are two starting points when creating SAP jobs. Make your choice based on the type of SAP workload you are defining and how much prior knowledge you have of that workload. For example, if you know the name of the job, Business Warehouse (BW) Information Package, BW Process Chain or Batch Input Session (BDC) job, you can create a filter and list the jobs, then drag and drop them to the workspace. For more information, see “Add SAP jobs from a list” on page 189.
To create a new job, you would start from the job palette and specify defaults and details for the SAP job type. For more information, see “Schedule SAP jobs from the job palette” on page 194.

**Add SAP jobs from a list**

Filters are used when creating the list of previously defined SAP jobs. The SAP system may contain thousands of individual jobs. Filtering your jobs will allow your system to return the requested jobs quickly. For example, you can create a filter for jobs with specific names, created by specific users. The first time you open the pane, it is empty because no filter is created. If you have displayed a list before, the previously cached list is displayed.

This saves you the time of defining the job definition parameters required for each individual SAP job. All required ESP Workload Manager definitions are automatically built for you. Once the job definition exists on the Workload Editor workspace, you can modify its characteristics, if required.

You can filter and list existing:

- SAP jobs
- BW InfoPackages
- BW Process Chains
- BDC jobs

Use this method when both of the following are true:

- An SAP job, BW InfoPackage, BW Process Chain or BDC job exists on the SAP system.
- You are unsure of some details regarding an SAP job, BW InfoPackage, BW Process Chain or BDC but would recognize it in a list.

**Note:** When defining a new SAP job, try to limit the number of steps (ABAPs) to one per job. This will help if a job fails. If you are adding SAP jobs from a list, however, your jobs might contain multiple ABAPs. ESP Workload Manager supports multiple ABAPs per job, but if you run a job and one of the ABAPs fails, the job is marked as failed. You cannot re-run an individual ABAP. You need to re-run the whole job.

**Displaying the filter panel**

Access the SAP filter panel by clicking the SAP icon on the toolbar:

![SAP icon](image)

Access the BW InfoPackages filter panel by clicking the BWIP icon on the toolbar:

![BWIP icon](image)
Access the BW Process Chains filter panel by clicking the BWPC icon on the toolbar:

![BWPC Icon]

Access the Batch Input Sessions filter panel by clicking the BDC icon on the toolbar:

![BDC Icon]

The following filter panel appears to the right of the right-hand pane. It is the same for all four SAP job types.

![Filter Panel]

**Adding a filter**

1. On the filter panel, click the **List Filters** button.

   The List of Filters dialog displays a list of all current filters for the SAP job type selected, if there are any. From this dialog a filter can be added.

   ![List of Filters]

   ![Add Button]
2. Click the **Add** button.

For the purpose of this example, the SAP and BDC Create a new filter dialog is explained. The Create a new filter dialog for BWIP and BWPC are a little different. Remember you can click **F1** in any field for Help information specific to that field when working with any dialog.

**Filter Name**
Enter the name of the new filter.

**SAP Agent Name**
Enter the name of the SAP Agent.

**User Name**
Enter the name of the SAP user, under which the SAP Agent will log onto the SAP system. Specify a valid SAP alphanumeric user name up to 32 characters in length. This field is optional if the user name is defined in the properties file for the RFC Destination. A user name specified here, will override the defined default.

**Client**
Enter a three-digit, numeric number that identifies the client within the SAP system for the RFC connection. This field is optional if the client is defined in the properties file for the RFC Destination. A client specified here, will override the defined default.

**RFC Destination**
Enter the destination value for the RFC connection. This field is optional if you have a default setting on the Agent system.

**SAP Job Name**
Enter the criteria to use to search the Job Names of the SAP system. A wildcard may be used in this field. For example, ABCDE*.

**SAP User Name**
Enter the criteria to use to search the User Names of the SAP system. A wildcard may be used in this field. For example, John*. 
3. Click **Save**.

   The filter properties are saved. If you are adding a filter, a new tab with the filter name is visible on the filter panel of the Workload Editor dialog.

4. Click the **Refresh** button on the filter panel (above the tab with the filter name).

   If the Refresh button is disabled, it means you do not have an active connection or the active connection is not selected in the Global Defaults. On the Workload Editor menu bar, select **Options > Global Defaults > Workload Definition > Connection** > and choose your connection from the drop-down list.

   The Refresh button should now be available.

   You can also click **Save As** to save the filter properties with a new filter name.

   To have the list of jobs refreshed when a new filter is added, select the **Refresh List of Jobs** check box.

### Advanced filtering

On the **Create a new filter** dialog, click the **Advanced** button to set more filtering options. The Advanced Filter Criteria dialog box appears.

All the fields on this dialog are optional.

<table>
<thead>
<tr>
<th>Field</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Job Count</strong></td>
<td>Enter the unique identification number assigned to the SAP job.</td>
</tr>
<tr>
<td><strong>Job Group</strong></td>
<td>Enter the name of the group the job has been associated with.</td>
</tr>
<tr>
<td><strong>From Date</strong></td>
<td>Select the earliest date in the range for the criteria to be filtered. Select the check box to enable this field during the search or clear the check box to disable this field during the search.</td>
</tr>
<tr>
<td><strong>To Date</strong></td>
<td></td>
</tr>
<tr>
<td><strong>From Time</strong></td>
<td></td>
</tr>
<tr>
<td><strong>To Time</strong></td>
<td></td>
</tr>
<tr>
<td><strong>No Date</strong></td>
<td></td>
</tr>
<tr>
<td><strong>With Predecessors</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Event ID</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Event Param</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Scheduled</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Released</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Ready</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Running</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Finished</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Aborted</strong></td>
<td></td>
</tr>
</tbody>
</table>

**Job Count**

Enter the unique identification number assigned to the SAP job.

**Job Group**

Enter the name of the group the job has been associated with.

**From Date**

Select the earliest date in the range for the criteria to be filtered. Select the check box to enable this field during the search or clear the check box to disable this field during the search.
From Time
Select the earliest time of day for the search criteria to be filtered. Select the check box to enable this field during the search or clear the check box to disable this field during the search. If From Date is not selected, this field is ignored.

To Date
Select the last date in the range for the criteria to be filtered. Select the check box to enable this field during the search or clear the check box to disable this field during the search.

To Time
Select the latest time of day for the search criteria to be filtered. Select the check box to enable this field during the search or clear the check box to disable this field during the search. If To Date is not selected, this field is ignored.

No Date
Select this field if no date is to be associated with the filter.

With Predecessors
Select one of the following options:

- Yes—To return jobs that have predecessors.
- No—To return jobs that do not have predecessors.
- Blank—To return all jobs regardless of whether the jobs have predecessors. This is the default setting.

Event ID
Enter the event ID number for the event associated with a specific SAP job.

Event Param
Enter the name of the event the job is associated with.

Scheduled, Released, Ready, Running, Finished, and Aborted fields
Select one of the following options:

- Yes—To return jobs that are scheduled to be run.
- No—To return jobs that are not scheduled to be run.
- Blank—To return all jobs regardless of whether the jobs are scheduled to be run. This is the default setting.

Note: If you are filtering based on scheduled jobs, it is recommended that you select the No Date field.

Click OK.

The advanced filter criteria is saved. If you previously specified defaults that apply to all your SAP jobs, some of the fields on the job details dialogs will already be filled in.
To refresh the jobs list
Click the **Refresh** button on the SAP filter panel on the Workload Editor.

**Hint:** To update or delete an existing filter, you can right-click on the filter name and choose **Update** or **Delete** from the drop-down menu.

**Schedule SAP jobs from the job palette**
You can define all scheduling and processing details for the following SAP job types:

- SAP job
- SAP Job Copy
- BW InfoPackage
- BW Process Chain
- BDC job
- Data Archiving
- Process Monitor
- Event Monitor

Use this method when one or more of the following fits your need:

- You already know all required SAP job-related details such as ABAP name, SAP user ID or InfoPackage name.
- You need to create a new job that does not already exist on the SAP system.

**To start a job definition from the Workload Editor job palette**
1. On the job palette, click the SAP icon.
   A shortcut menu appears.
   
   ![SAP Job Palette](image)

2. From the shortcut menu, select the SAP job type you require.
3. Complete the tabs common to SAP jobs. See “SAP Details” on page 195.
   
   Job names must be unique within an Application. If a job needs to be defined more than once, it must be qualified. Use a qualifier to make a job name more meaningful.
SAP Defaults

To set global defaults for an SAP workload object
On the Workload Editor menu bar, select Options > Global Defaults > Job > SAP > select the SAP job type you require.

To set job defaults for an SAP workload object
On the Workload Editor menu bar, select Options > Job Defaults > SAP > select the SAP job type you require.

The Agent Specifications, Step Specifications, Notification, Resources and Free Format Text tabs appear. These are the defaults available for the SAP job type, at the global and job level. They are documented on the following pages:
- “Agent Specifications tab - SAP” on page 196
- “Step Specifications tab - SAP” on page 200
- “Notification tab” on page 125
- “Resources tab” on page 128
- “Free Format Text tab” on page 88

SAP Details

Before you can specify SAP details, you must drag and drop an SAP job type icon onto the workspace.

To specify job details for the SAP workload object
1. On the workspace, right-click the SAP job type icon. A shortcut menu appears.
2. On the shortcut menu, click Job Details.
   The Job Details dialog appears. By default, the Name field shows the job type name and a number. The icons dropped on the workspace are numbered sequentially by job type until you optionally rename them.

All the available job detail tabs are documented on the following pages:
- “General tab” on page 96
- “Agent Specifications tab - SAP” on page 196
- “Step Specifications tab - SAP” on page 200
- “Additional Attributes, SAP Step Attributes tab” on page 207
- “Additional Attributes, SAP Print Parameters tab” on page 208
- “Additional Attributes, SAP Archive Parameters tab” on page 210
- “Agent Specifications tab - SAP Job Copy” on page 212
- “Agent Specifications tab - Business Warehouse InfoPackage” on page 213
Agent Specifications tab - SAP
Agent name
Enter the name of the SAP Agent.

SAP Logon Information
User name
Enter the name of the SAP user, under which the SAP Agent will log onto the SAP system. Specify a valid SAP alphanumeric user name up to 32 characters in length. This field is optional if the user name is defined in the properties file for the RFC Destination. A user name specified here, will override the defined default.

Client
Enter a three-digit, numeric number that identifies the client within the SAP system for the RFC connection. This field is optional if the client is defined in the properties file for the RFC Destination. A client specified here, will override the defined default.

RFC Destination
Enter or click the down arrow to select the destination value for the Remote Function Call connection.
This field is optional if you have a default setting on the Agent system.

Language
Enter or click the down arrow to select the language used to log on to the SAP system. For example: E=English, D=Deutshe, R=Russian. The default is the SAP system language.

Specify SAP Job Environment
Job name
Enter the name of the SAP job.
This is the SAP system job name. This can be up to 32 alphanumeric characters in length and can include the national characters @, #, and $.

Job Class
Enter an alpha character to represent the job class this job will run under. This field is optional.

Target SAP system
Enter the name of the SAP system to target. The target system identifies the name of the host server where the SAP runs. This can be up to 32 alphanumeric characters in length.

Refresh
The Refresh button is used when Agent information is required. If the Refresh button is disabled, it means you do not have an active connection or the active connection is not selected in the Workload Definition Defaults.

On the Workload Editor menu, select Options > Workload Definition Defaults > Connection > and choose your connection from the drop-down list.
The Refresh button should now be available.
**Success Message**
Enter text that signifies a successful job for the scheduling system, in case of a failed job on the SAP system. For example, if the success message is ‘Data not found’ then the job will be marked as completed, even though it failed on the SAP system. The next ESP Workload Manager job is released. This field is optional.

**Failure Message**
Enter text that signifies a failed job for the scheduling system, in case of a successful job on the SAP system. For example, if the failure message is ‘Data not found’ then the job will be marked as failed, even though it is successful on the SAP system. The next ESP Workload Manager job is not released. This field is optional.

**Monitor Children**
Select the check box to indicate the job’s children be monitored.

**Web Posting**
Select the check box to indicate web posting be done of the SAP job log and spool.

**Hint:** The following applies to the Monitor Children and Web Posting fields:
- A check box with a check mark indicates the option is enabled
- A check box without a check mark indicates the option is disabled
- A grayed out check box with a check mark indicates the option is ignored

**Release immediately**
Click this button to indicate the job is defined in the SAP system and is to release immediately. If no free background processing is available, the job is not released and stays in the SAP job state Scheduled.

**Release as soon as possible**
Click this button to indicate the job is defined in the SAP system and is released as soon as possible.

**Do not release**
Click this button to indicate the job is defined in the SAP system but is not released. This option requires a manual process to release the job.
Spool List Recipients

Use this dialog to specify an email address, SAPoffice user or SAPoffice distribution list for this job’s output. This dialog applies to SAP R/3, SAP Job Copy, and Batch Input Session jobs only.

![Spool List Recipients dialog](image)

Save outgoing document to my SAPoffice outbox
If checked with a black check mark (not a gray check mark), ESP Workload Manager delivers output from this job to the outbox of the user name in the SAP Logon Information panel on the Agent Specifications tab.

Recipient Type
Recipient Type is mandatory only when you want to direct output to certain individuals or groups using the Spool List Recipients dialog.

Specify the **Recipient Type** and click **Refresh** to populate the drop-down list of recipients.

**Note:** If the Refresh button is disabled, it means you do not have an active connection or the active connection is not selected in the Workload Definition Defaults. From the **Menu**, select **Options > Workload Definition Defaults > Connection** > and choose your connection from the drop-down list.

- **Get Distribution List** — Use this dialog to find an SAPoffice Distribution List on your SAP system. You can search by type of distribution list, for example, Private.

- **Get SAP User List** — Use this dialog to find an SAPoffice User on your SAP system.

  **Hint:** Click **F1** in any field for help information specific to that field.

**Recipients**
Select **BCC** (blind copy), **CC** (carbon copy) or **To**. BCC recipients receive a copy and their email addresses are only visible to the recipient. CC recipients receive a copy. To is the default.
Express
If recipients are online, ESP Workload Manager sends a message informing them they have an express message. ESP Workload Manager sends the document immediately. Express is only available if SAPoffice distribution list or SAPoffice user is selected in the recipient field.

No Forwarding
The recipient cannot forward the document. Leave this box unchecked to allow the recipient to forward the document. No Forwarding is only available if SAPoffice distribution list or SAPoffice user is selected in the recipient field.

No Printing
The recipient cannot print the document. Leave this box unchecked to allow the recipient to print the document. No Printing is only available if SAPoffice distribution list or SAPoffice user is selected in the recipient field.

Step Specifications tab - SAP

Specify ABAP to Run
Name
Enter the SAP program to be run. Specify an alphanumeric name up to 40 characters, then click Add. Alternatively, you can click the View ABAPs button to select from a list of ABAPs on the SAP system. For more information, see “View ABAPs” on page 201.
**Variant to pass**
Enter the name of the variant to pass. Specify an alphanumeric name up to 14 characters, then click Add. Alternatively, you can click the View Variants button to select from a list of variants on the SAP system. For more information, see “View Variants” on page 203.

**Step user name**
Enter the name of the SAP system user under whose authorization the ABAP program runs. This can be up to 16 alphanumeric characters in length and can contain the special characters @, #, and $.

This field is optional. If the user name is not specified, the user name in the SAPUSER statement is the default value.

**Language**
Enter an alphabetic character to represent the language to be used to log on to the SAP system. This is an optional parameter. The default is the SAP System language. For example, E=English, D=Deutshe, R=Russian.

**View ABAPs**
To use the View ABAPs button you must have:

- An Agent Name on the Agent Specifications tab
- A View ABAPs button that is enabled

If the View ABAPs button is not enabled, it means you do not have an active connection or the active connection is not selected in the Workload Definition Defaults, Connection tab.

To activate the Connection tab—from the Menu, select Options > Workload Definition Defaults > Connection > and choose your connection from the drop-down list.
To select an ABAP to run

1. On the Step Specifications tab, click the View ABAPs button. The List of ABAPs dialog appears.

   ![List of ABAPs dialog](image)

   The Agent Name field is filled in with the information entered on the Agent Specifications tab.

2. In the ABAP Name Filter field, enter search criteria. Wildcard characters * and ? can be used, for example, ABC*.

3. Click the Refresh button. The Connect to FTP dialog appears.

4. Enter your User Name and Password for the FTP connection.

5. Click OK. The list of ABAPs matching the search criteria appear in the List of ABAPs list box.

6. Click on the ABAP to select it.

7. Click OK. The List of ABAPs dialog disappears. The selected ABAP appears in the Name field of the Step Specifications tab.

**Note:** Optionally, you can click Additional Attributes to specify Status Messages, Print Parameters, and Archive Parameters for the ABAP. For more information, see “Additional Attributes, SAP Step Attributes tab” on page 207.

To update an ABAP

1. On the Step Specifications tab, in the List of SAP steps list box, select the ABAP to highlight it. The ABAP information appears in the fields above the list box.

2. Change the fields above the list box.
3. Click **Update**.
4. Click **OK**.

**To delete an ABAP**
1. On the Step Specifications tab, in the List of SAP steps list box, select the ABAP to highlight it.
2. Click **Delete**.
   The selected ABAP is deleted from the list box.

**View Variants**

**To add a variant for the selected ABAP**
1. On the Step Specifications tab, ensure the ABAP name is filled in. The ABAP name must be in uppercase.

2. Click the **View Variants** button.
   The List of Variants for ABAP [ABAP name displays here] dialog appears.
   The Agent Name field is filled with the information entered on the Agent Specifications tab.
3. Click the **Refresh** button.

   The List of Variants list box is populated with Variant Names for the ABAP indicated.

4. Select a variant and click **OK**.

   On the Step Specifications tab, the variant name appears in the Variant to pass field.

5. Click **Add**.

6. Click **OK**.

**Modify Variants**

**To modify a variant**

1. On the Step Specifications tab, in the List of SAP steps list box, select the ABAP and variant to highlight them.

2. Click **View Variants**.

   The List of Variants for ABAP [ABAP name] dialog appears.

3. In the List of Variants list box, select the variant to be updated.

   **Note:** To add or modify a variant you must have access to SAP GUI. If any SAP GUI connection parameters are not defined you will be prompted. For information on how to connect SAP GUI, see “SAP GUI Connection” on page 9.
4. Click **Edit Variant**.
   The Edit a Variant dialog appears.

![Edit a Variant dialog](image.png)

The following are the field descriptions for the Edit a Variant dialog:

**Text**
Enter a brief description of the variant. This can be up to 40 characters.

**Only for background processing**
Select this check box if you want the variant only executed in the background as a batch process. Otherwise, the variant will run in the background or online depending on the SAP system configuration.

**Protect variant**
Select this check box if you want to limit changes to the variant made only by the person who created the variant or last changed it.

**Only display in catalog**
Select this check box if you want the variant name to appear in the directory, but not in the general input help.

5. In the List of Variants fields list box, select the Variant field name to highlight it.
6. Click **Edit**.

The Edit variant content dialog appears.

![](image)

The following are the field descriptions for the Edit variant content dialog:

**Value from/to**
The **Value from** field specifies the start point of the range of values that are processed for the ABAP. This field is mandatory.

The **to** field specifies the end point of the range of values that are processed for the ABAP. If no value is specified, all values are processed to the end of the records.

**Required field**
Select this check box to run a report or submit a screen for online processing.

**Save field without value**
Select this check box if the field contents are ignored when the variant is imported. The original value is still available after the import.

**Hide field**
Select this check box if you want the field flagged as 'invisible.' As a result, the selected field is hidden when you start the program with a variant or when you change the values.

When you display the variant, these selection criteria are displayed under Invisible parameters/select options, provided they contain values.

**Protect field**
Select this check box if you want this field flagged as "Protected". As a result, the selected field is protected against changes at runtime (when you start the program with a variant).
Hide field ‘BIS’
Select this check box if you want to fill the fields of the variant using SPA/GPA.

Additional Attributes, SAP Step Attributes tab

Email addresses to send spool list results

To specify email addresses
1. Enter a valid email address where a copy of the spool file is to be sent upon job completion or job failure.
2. Click Add. The email address appears in the list field. Repeat for other email addresses as required.

To delete email addresses
1. In the list field, select the email address to highlight it.
2. Click Delete. The email address is removed from the list.

Specify Status Messages

Success Message
Enter text that signifies a successful job for the scheduling system, in case of a failed job on the SAP system. For example, if the success message is ‘Data not found’ then the job will be marked as completed, even though it failed on the SAP system. The next ESP Workload Manager job is released. This field is optional.
**Failure Message**
Enter text that signifies a failed job for the scheduling system, in case of a successful job on the SAP system. For example, if the failure message is ‘Data not found’ then the job will be marked as failed, even though it is successful on the SAP system. The next ESP Workload Manager job is not released. This field is optional.

**Additional Attributes, SAP Print Parameters tab**

**Printing Parameters**

**Output Device**
Click the down arrow to specify an output device where the print output is to be sent. Specify up to four alphanumeric characters.

Alternatively, click the **Refresh** button to download a list of printers that are applicable to your environment.

**Authorization**
Enter the password to view the print spool list, if it is required. Specify up to 12 alphanumeric characters. This is an optional parameter.

**Number of copies**
Click the up and down arrows or enter the number of copies for any report associated with this ABAP, up to 255 numeric characters. The default value is 1.
Specify Output Format

Number of lines
Click the up and down arrows to optionally indicate the number of lines per list page, for example, 65. The report will print 65 lines per list page.

The length of the list is determined by its content. Zero or blank may only be used when viewing the list online. Zero or blank may not be used to format a list to be printed.

Number of columns
Click the up and down arrows to optionally indicate the number of columns.

Format
Specify an SAP format for the output. This can be up to 16 characters in length.

Spool Control
For options Print immediately, Delete after printing, and New Spool Request the following applies:

- A check box with a check mark indicates the option is enabled
- A check box without a check mark indicates the option is disabled
- A grayed out check box with a check mark indicates the option is ignored

Print priority
Use the up and down arrows to indicate the priority of the print.

Spool retention period
Use the up and down arrows to optionally indicate the number of days a spool request is to remain in the spool system before it is deleted.

Recipient
Enter the target recipient or choose one from the list. You can direct output to certain individuals or groups using the Spool List Recipients dialog. Specify an SAPoffice user name or choose one from the list.

Department
Enter a department name. This can be up to 12 characters in length.

Spool Name
Enter a name to identify the spool output. This can be up to 12 characters in length.

Title
Enter text for a cover page to be used by the spool output. This can be up to 68 characters in length.

Data set
Enter the name of the spool data set. This can be up to 6 characters in length.

Request type
Click the down arrow to select a request type.
Print SAP Cover Sheet
Click the down arrow to select the SAP cover sheet.

Print OperSys Cover Sheet
Click the down arrow to select the opersys cover sheet.

For options Print Selection Cover Sheet and Print Footer the following applies:
- A check box with a check mark indicates the option is enabled
- A check box without a check mark indicates the option is disabled
- A grayed out check box with a check mark indicates the option is ignored

Additional Attributes, SAP Archive Parameters tab

Archiving Parameters
Object type
Enter the external system archive used by the SAP system. Specify up to 10 alphanumeric characters. For example, obj1. This archive parameter is used only when the Archive facility option is selected.

Document type
Enter the document type used by the external system archive. Specify up to 10 alphanumeric characters (not case-sensitive). This archive parameter is used only when the Archive facility option is selected.
Information
Enter the archive link information for the external archive system. Specify up to 3 characters. This archive parameter is used only when the Archive facility option is selected.

Text
Enter text information up to 40 characters.

Archiving Mode
Select the check box to indicate your print requirements:
- Printer device — Indicates the printing of spool output. This is the default.
- Archive only — Indicates the archiving of spool output.

Advanced Parameters
Target Storage System
Indicate the target storage system ID with a two character identifier.

Document class
Enter a document class up to 20 characters, for example, fax, otf, pdf, alf, reo, bin or doc.

RPC Host
Enter an RPC host link up to 32 characters.

RPC Service/RFC Destination
Enter an RPC service or RFC destination up to 32 characters.

Connection Component Name
Enter the name of the communication connection component. Specify up to 14 characters.

Client
Enter a three character client identifier, for example, 800.

Report Name
Enter a report name (ABAP) up to 40 characters.

Standard Archive Path
Enter the standard archive path up to 70 characters.

Storage Connection Protocol
Enter the storage connection protocol up to 8 characters.

Version Number
Enter a version number for the archive up to 4 characters.

Format
Enter the output format up to 16 characters.

Date
Enter an archiving date up to 8 characters, for example, YYYYMMDD.
User
Enter a user name up to 12 characters.

Printer
Enter the target printer up to 4 characters, for example, LP01.

Agent Specifications tab - SAP Job Copy

The SAP Job Copy allows you to schedule an SAP R/3 job that will make a copy of an existing SAP R/3 job and then release it.

To schedule an SAP Job Copy

1. From the Workload Editor job palette, click the SAP icon. From the shortcut menu, select SAP Job Copy. Complete the tabs common to SAP jobs. For more information, see “SAP Details” on page 195.

2. Complete the Agent Specifications tab.

   Hint: Click F1 in any field for Help information specific to that field.

Usage notes
The Job Count or Job Name parameter must be specified. All other parameters are optional.

Job Count
Enter the ID of the job to be copied.

Job Name
Enter the name of the job to be copied.
**Start from step**
Specify the number of the first step to start copying job data from. This field is optional. By default, zero is used.

---

**Agent Specifications tab - Business Warehouse InfoPackage**

A BW InfoPackage is a container with properties that are referred to as data selection criteria. Data selection criteria define the information (for example, European Sales, this quarter) that a BW InfoPackage will import from one or more R/3 Source Systems into a Data Source (also known as a Cube). An InfoSource defines the characteristics of the data (for example, character string and language dependant). BW InfoPackages are created on the SAP system.

You can:

- Schedule a BW InfoPackage as you would any job using Workstation
- Get a list of BW InfoPackages
- View the data selection criteria of the BW InfoPackage
- Modify the value of the data selection criteria

**To schedule a BW InfoPackage job**

1. From the Workload Editor job palette, click the SAP icon. From the shortcut menu, select **BW InfoPackage**. Complete the tabs common to SAP jobs. For more information, see “SAP Details” on page 195.

2. Complete the Agent Specifications tab.

   The Select InfoPackage field is mandatory.

   **Hint:** Click F1 in any field for Help information specific to that field.

   You can enter an InfoPackage or click **Refresh** to get the latest InfoPackages on the SAP system added to the list. When Refresh is selected, the Get InfoPackage List dialog appears. For more information on this dialog, see “Get InfoPackage list” on page 215.

   **Note:** If the Refresh button is disabled, it means you do not have an active connection or the active connection is not selected in the Workload Definition Defaults. From the **Menu**, select **Options > Workload Definition Defaults > Connection** > and choose your connection from the drop-down list.

   You can also click **Details** on the Agent Specifications tab to modify the data selection criteria in the InfoPackage.
Usage notes
The job name you specify on the General tab is the job name Workstation will track and report on. Workstation will not track and report on the InfoPackage name.

Update a BW InfoPackage job
1. On the Agent Specifications tab, select an **InfoPackage** from the list or click **Refresh** to get the latest InfoPackages on the SAP system added to the list.
2. Click **Details**.
   The Update Business Warehouse InfoPackage dialog appears.
3. Change values in any cell.
4. Click **OK** to save your changes and return to the Agent Specifications tab or click **Cancel** to clear any changes that have not been updated and return to the Agent Specifications tab.

The InfoPackage modifications will take place when the InfoPackage job runs.

**Get InfoPackage list**

Use this dialog to get the latest InfoPackages on the SAP system added to the Select InfoPackage field on the Agent Specifications tab.

![Get InfoPackage list dialog](image)

**Usage notes**

The Description From field is mandatory. This field can be used alone or in a range using the Description To field, wildcards are allowed. You can use the Description information (descriptive keywords) that were entered when the InfoPackage was created. The name that will be displayed in the dialog and in the BW filter panel will be the SAP Technical Name, which is the name SAP gives to an InfoPackage when it is created.

**Hint:** Click **F1** in any field for Help information specific to that field.

**Agent Specifications tab - Business Warehouse Process Chain**

An SAP BW Process Chain is a sequence of processes that are executed in the background on the SAP system. Some SAP processes trigger a separate event that can start other processes.

BW Process Chains are created on the SAP system. You can create BW Process Chain jobs that identify and run BW Process Chains on the SAP system. A Workstation BW Process Chain job treats the individual processes in the chain as job steps.
To schedule a BW Process Chain job

1. From the Workload Editor job palette, click the SAP icon. From the shortcut menu, select **BW Process Chain**. Complete the tabs common to SAP jobs. For more information, see “SAP Details” on page 195.

2. Complete the Agent Specification tab.

   The Chain Identifier field is mandatory. This is the SAP Process Chain name.

   **Hint**: Click **F1** in any field for Help information specific to that field.

   You can select a Process Chain from the list or to get the latest Process Chains on the SAP system added to the list click **Refresh**. The Get Business Warehouse Process Chain List dialog appears.

   ![Business Warehouse Process Chain Job: BWPC1](image)

   **Usage notes**

   The job name you specify on the General tab is the job name Workstation will track and report on. Workstation will not track and report on the SAP Process Chain name. If one process within the SAP Process Chain fails, the entire Workstation Process Chain job will fail. A BW Process Chain cannot be modified or created from within Workstation. It must be created first on the SAP system.

   **Agent Specifications tab - Batch Input Sessions**

   Batch Input Sessions (BDCs) are a means of importing large amounts of data from external systems to the SAP system. An ABAP that creates a session is defined on the SAP system. When this session is processed, the data is transferred. You schedule a BDC job on Workstation to execute a BDC ABAP on the SAP system.
To schedule a BDC job

1. From the Workload Editor job palette, click the SAP icon. From the shortcut menu, select **Batch Input Session**. Complete the tabs common to SAP jobs. For more information, see “SAP Details” on page 195.

2. Complete the Agent Specifications tab.

   **Hint:** Click F1 in any field for Help information specific to that field.

   Specify a Job name that will be used on the SAP system. This names the SAP job that runs the ABAP specified on the Step Specifications tab. This is the job name you would view with the Job Overview screen on the SAP system.

   You can specify the minimum number of transactions the session must process to be considered successful. This number is expressed as a percentage of the total number of transactions.

   You can specify a maximum acceptable error rate. This number is expressed as a percentage of the number of transactions.

3. Complete the Step Specifications tab.

   Specify the BDC ABAP that will create a session on the SAP system.

**Usage notes**

Workstation does not check the ABAP to ensure it creates a BDC session.

Any BDC job with more than one step is automatically rejected and will not run.

Once the SAP job that creates the Batch Input Session finishes, the Name and Queue ID of the Batch Input Session are determined and the session (the data transfer) is started. The Queue ID can be viewed on Workload Director in job details.

You can search for printers using filter criteria to determine where to print the output for this job.
To search for printers
1. On the Step Specifications tab, click Additional Attributes.
2. Select the Print Parameters tab.
3. Click the Refresh button beside the Output Device field.
   The Printer List dialog appears.
4. Using wildcards, specify a Long Device Name Filter or a Short Device Name Filter (this is the SAP technical name for the device), for example, LLa*.
5. Click Refresh.
   The Printer List is populated with printer names that match your filter criteria.
6. Highlight a printer in the list and click OK.
   The Print Parameters tab appears with the Output Device field populated.

Agent Specifications tab - Data Archiving

Data Archiving jobs put information as described in an SAP Archiving Object into an SAP data archive. Use this dialog to search for an Archiving Object on your SAP system. An Archiving Object represents a set of related business data to be archived.

To schedule a Data Archiving job:
1. From the Workload Editor job palette, click the SAP icon. From the shortcut menu, select Data Archiving. Complete the tabs common to SAP jobs. For more information, see “SAP Details” on page 195.
2. Complete the Agent Specifications tab.
   The Archiving Object and Archiving Object Variant fields are mandatory.

   **Hint:** Click F1 in any field for Help information specific to that field.

   **Note:** You can select an Archiving Object and an Archiving Object Variant from the list. If the Archiving Object or Object Variant is not listed, click Refresh to get the latest Archiving Objects or Archiving Object Variants on the SAP system added to the list. The Get Archiving Objects or the Get Archiving Objects Variants dialog appears.
3. Complete the Print Parameters tab. This tab is documented on page 208 or you can click F1 in any field for Help information specific to that field.

   **Note:** The Archiving Mode and Output Device fields are mandatory.

4. Click **Refresh** to receive the Get Printer List dialog and find a printer. See “To search for printers” on page 219 for more details.

5. You can further describe the spool parameters with Archive Parameters. Complete the Archive Parameters tab. This tab is documented on page 210 or you can click F1 in any field for Help information specific to that field.

### Usage notes

SAP assigns Data Archiving job names when the job is defined on the SAP system. Data Archiving jobs can only be started immediately. You cannot start ASAP or wait for a manual start as with other SAP jobs. You can search for printers using filter criteria to determine where to print the output for this job.

#### To search for printers

1. On the Print Parameters tab, click **Refresh**. The Printer List dialog appears.

2. Using wildcards, specify a Long Device Name Filter or a Short Device Name Filter (this is the SAP technical name for the device), for example, LLa*.

3. Click **Refresh**. The Printer List is populated with printer names that match your filter criteria.

4. Select a printer in the list and click **OK**. The Print Parameters tab appears with the Output Device field populated.
Agent Specifications tab - Process Monitor

The SAP Process Monitor job monitors for a specific SAP process status. You can specify that a Process Monitor job monitor continuously or end after a process is detected once.

Use an SAP Process Monitor job to set up predecessor or successor relationships with other scheduled jobs (whether scheduled by Workstation or another scheduling product) or other SAP processes. For example, you can schedule ESP Workload Manager jobs based on the monitoring of SAP jobs and processes.

To schedule a Process Monitor job

1. From the Workload Editor job palette, click the SAP icon. From the shortcut menu, select Process Monitor. Complete the tabs common to SAP jobs. For more information, see “SAP Details” on page 195.

2. Complete the Agent Specifications tab.

   The Agent name and Process Status field are mandatory.

   **Hint:** Click F1 in any field for Help information specific to that field.

3. Choose one of the following SAP process statuses to monitor:
   - Waiting
   - Running
   - Stopped

Usage notes

If the Process Status of Waiting is selected, the Client, User Name, and ABAP Name fields will not be available.
Agent Specifications tab - Event Monitor

The term ‘raising an event’ in SAP means the same as triggering an Event in Workstation. Events are usually triggered automatically based on schedule criteria.

Use the SAP Event Monitor jobs in your schedule to:

- Schedule jobs and activities based on SAP event activity
- Trigger an SAP event based on ESP Workload Manager activities

Monitoring SAP Events

When you schedule an SAP Event Monitor job, Workstation monitors on behalf of this job until the named SAP event is raised.

When Workstation detects the SAP event has triggered, the SAP Event Monitor job:

- Completes
- Its successors are released

To schedule an Event Monitor job

1. From the Workload Editor job palette, click the SAP icon. From the shortcut menu, select Event Monitor. Complete the tabs common to SAP jobs. For more information, see “SAP Details” on page 195.

2. Complete the Agent Specifications tab.

   The Agent Name, SAP Event Name, and Action to perform fields are mandatory.
   
   **Hint:** Click F1 in any field for Help information specific to that field.

3. In the Action to perform field, select Monitor for SAP Event.

   You can select an SAP event from the list provided. Click Refresh to refresh the list of SAP events.
Usage notes
You can schedule an SAP Event Monitor job like other Workstation jobs to construct predecessor and successor relationships based on the triggering of SAP events.

You can specify an SAP event parameter. Event parameter is optional.

Event names with different event parameters are considered to be different events by both ESP Workload Manager and SAP systems.

Event Parameter is optional but a parameter may be required to trigger this event.

Triggering SAP Events
To trigger SAP events using a job in Workstation, you use the SAP Event Monitor job and specify Trigger SAP Event.

When the schedule criteria for an SAP Event Monitor trigger job is met:
- Workstation issues a command to trigger (raise) the named SAP event.
- The SAP Event Monitor trigger job completes.

To define or insert a job to trigger an SAP event
1. From the Workload Editor job palette, click the SAP icon. From the shortcut menu, select Event Monitor. Complete the tabs common to SAP jobs. For more information, see “SAP Details” on page 195.

2. Complete the Agent Specifications tab.
   The Agent Name, SAP Event Name, and Action to perform fields are mandatory.
   
   Hint: Click F1 in any field for Help information specific to that field.

3. In the Action to perform field, select Trigger SAP Event.
   You can select an SAP event from the list provided. If the event you want is not in the list, click Refresh to refresh the list of SAP events.

Usage notes
An SAP Event Monitor job can give you more flexibility when triggering SAP events.

You can specify an SAP event parameter. Event parameter is optional.

Event names with different event parameters are considered to be different events by both ESP Workload Manager and SAP systems.
Example
The following are some SAP statements that appear in the right-hand pane:

OpenVMS Workload Object
You can specify workload defaults and details for the OpenVMS job type.

OpenVMS Defaults

To set global defaults for the OpenVMS workload object
On the Workload Editor menu bar, select Options > Global Defaults > Job > OpenVMS.

To set job defaults for the OpenVMS workload object
On the Workload Editor menu bar, select Options > Job Defaults > OpenVMS.

The Agent Specifications, Environment Variables, Exit Codes, Notification, Resources and Free Format Text dialogs appear. These are the defaults available for the OpenVMS job type, at the global and job level. They are documented on the following pages:

- “Agent Specifications tab - OpenVMS” on page 225
- “Environment Variables tab - OpenVMS” on page 226
- “Exit Codes tab” on page 169
OpenVMS Details

Before you can specify OpenVMS details, you must have the icon on the workspace.

To specify job details for the OpenVMS workload object

1. On the workspace, right-click the OpenVMS icon. A shortcut menu appears.
2. On the shortcut menu, click **Job Details**.
   The Job Details dialog appears. By default, the Name field shows the job type name and a number. The icons dropped on the workspace are numbered sequentially by job type until you optionally rename them.

All the available job detail tabs are documented on the following pages:

- “General tab” on page 96
- “Agent Specifications tab - OpenVMS” on page 225
- “Environment Variables tab - OpenVMS” on page 226
- “Exit Codes tab” on page 169
- “Send Message tab” on page 106
- “Issue Command tab” on page 108
- “Options tab” on page 110
- “Run Frequency tab” on page 114
- “Time Dependencies tab” on page 120
- “Notification tab” on page 125
- “Resources tab” on page 128
- “Resource Specifications tab” on page 131
- “Free Format Text tab” on page 136
- “Comment tab” on page 140
**Name**
Enter the name of the Agent where the job is to run.

**User ID**
Enter the name of the OpenVMS user ID.

This can be up to 32 alphanumeric characters in length. The user ID represents the authority the job is to use.

**Specify Command File to Run**

**Name**
Enter the full path and name of the command file to run, when this job is executing. This field is mandatory.

You can specify an absolute path or just the logical name. You can use valid syntax, where the file extension and file version are optional. If you specify the file version, you must also specify the file extension. For example, "RUN SAMPLE.EXE;25".

**Arguments to pass**
Enter an argument string of positional parameters to be passed. Arguments can be numerical or alphabetical strings of data, up to 133 characters.

Specify each parameter in the order it is expected in the script, separating each parameter with a blank space. Multiple strings can be passed as a single parameter by enclosing them in double quotes. For example, "p2 p3".
Environment variables define system-specific information. ESP Workload Manager environment variables are used with OpenVMS to define the local environment for the running of a command. Any of the ESP Workload Manager environment variables can be passed to a command.

When passing multiple environment variables to an Agent, the maximum size is 4k. Program files can access environment variables using the getenv() function. Batch files can access environment variables by specifying the variable name and training percent sign.

**Define Environment Variables**

**Name**
Enter the name of the environment variable to be passed. Specify a name in alphanumeric characters or choose a name from the list provided. The name is case-sensitive.

**Value**
Enter the value for the environment variable. The value is case-sensitive.

Click **Add**. The variable name and value are added to the List of Environment Variables field.

Click **OK**.
Example

<table>
<thead>
<tr>
<th>OPENVMS_JOB</th>
<th>OPENVMS1</th>
</tr>
</thead>
<tbody>
<tr>
<td>AGENT TOKM</td>
<td>COMMAND: @SCRIPT: etc/1.com</td>
</tr>
<tr>
<td>USER RROD</td>
<td>ARGOS pt 4</td>
</tr>
<tr>
<td>ENVAR WDOR: alpha7/aka2/01 export/df1</td>
<td>RN DAILY</td>
</tr>
<tr>
<td>RN DUB</td>
<td></td>
</tr>
</tbody>
</table>

List of Environment Variables

To update an environment variable
1. In the List of Environment Variables, click on the environment variable to highlight it.
2. Change the above fields.
3. Click **Update**.
4. Click **OK**.

To delete an environment variable
1. In the List of Environment Variables, click on the environment variable to highlight it.
2. Click **Delete**.
3. Click **OK**.

Data Object Workload Object

There are no workload defaults for data objects, only details.

About Data Objects

Data Object jobs serve as a data repository. They are coded in an Application as any other job. Data can be stored in a data object at generate time. Data can also be stored, updated or deleted at run time, by sending an automation framework message to the object. All data is stored in the Application tracking record, so it is preserved across restarts.

Data is retrieved, at process time, from a data object by using the WOBDATA statement. Data can also be retrieved:

- From a data object in another Application
- From a completed Application as long as the Application tracking record has not been overwritten.
The List Application (LAP) command will display variables currently stored in the data object. The LAP command can be entered through the Line Mode Interface in the Workload Director component.

A data object does not require any statements to operate. It is always selected by default. As well, it acts as a conditional job, completing automatically when the rest of the Application completes.

**Note:** The alternative method to using Data Objects is Global-Variable Tables. These can be defined using the Line Mode Interface in the Workload Director component of Workstation. For information on using Global-Variable Tables, see “Appendix C: Using Global-Variable Tables” on page 601.

**Data Object Details**

Before you can specify Data Object details, you must have the icon on the workspace.

**To specify job details for the Data Object workload object**

1. On the workspace, right-click the Data Object icon. A shortcut menu appears.
2. On the shortcut menu, click **Job Details**.

   The Job Details dialog appears. By default, the Name field shows the job type name and a number. The icons dropped on the workspace are numbered sequentially by job type until you optionally rename them.

All the available job detail tabs are documented on the following pages:

- “General tab” on page 96
- “Variables tab - Data Object” on page 229
- “Send Message tab” on page 106
- “Issue Command tab” on page 108
- “Options tab” on page 110
- “Run Frequency tab” on page 114
- “Time Dependencies tab” on page 120
- “Notification tab” on page 125
- “Resources tab” on page 128
- “Resource Specifications tab” on page 131
- “Free Format Text tab” on page 136
- “Comment tab” on page 140
Variables tab - Data Object

**Name**
Enter the name of the variable. In this example, three variables are defined using VAR as a prefix.

**Value**
Enter a character string or a numeric value.

Click **Add**.

Click **OK**.

**Example**

**List of Variables**

**To update a variable**
1. In the List of Variables, click on the variable to highlight it.
2. Change the above fields.
3. Click **Update**.
4. Click **OK**.
To delete a variable
1. In the List of Variables, click on the variable to highlight it.
2. Click Delete.
3. Click OK.

**WOBDATA Statement**
The WOBDATA statement retrieves variables from the data object. You enter the WOBDATA statement into the job that is to use the variable.

The syntax of the WOBDATA statement is:

```
VAR = WOBDATA('data object','variable')
```

In the following example, the value of variable VAR2, retrieved from the data object DATA2 is assigned to ABC:

```
ABC = WOBDATA('DATA2','VAR2')
```

**To retrieve a variable from a Data Object**
1. Right-click the job that is to use the variable. The Free Form text dialog appears. This dialog appears once the workflow is set (that is, the right-hand pane shows the Application coding for the jobs on the workspace).
2. Enter the WOBDATA statement into the text field on the Free Form text dialog.
3. Click OK.

The following statements appear in the right-hand pane for the variables defined for data object DATA1:
Tandem Workload Object

You can specify workload defaults and details for the Tandem job type.

Tandem Defaults

To set global defaults for the Tandem workload object
On the Workload Editor menu bar, select Options > Global Defaults > Job > Tandem.

To set job defaults for the Tandem workload object
On the Workload Editor menu bar, select Options > Job Defaults > Tandem.

The Agent Specifications, Environment Variables, Exit Codes, Notification, Resources and Free Format Text tabs appear. These are the defaults available for the Tandem job type, at the global and job level. They are documented on the following pages:

- “Agent Specifications tab - Tandem” on page 232
- “Environment Variables tab - Tandem” on page 233
- “Exit Codes tab” on page 169
- “Notification tab” on page 125
- “Resources tab” on page 128
- “Free Format Text tab” on page 88

Tandem Details

Before you can specify Tandem details, you must have the icon on the workspace.

To specify job details for the Tandem workload object
1. On the workspace, right-click the Tandem icon. A shortcut menu appears.
2. On the shortcut menu, click Job Details.

The Job Details dialog appears. By default, the Name field shows the job type name and a number. The icons dropped on the workspace are numbered sequentially by job type until you optionally rename them.

All the available job detail tabs are documented on the following pages:

- “General tab” on page 96
- “Agent Specifications tab - Tandem” on page 232
- “Environment Variables tab - Tandem” on page 233
- “Send Message tab” on page 106
Agent Specifications tab - Tandem

Name
Enter the name of the Agent where the job is to run.

User ID
Enter the name of the user ID to use when running the job. Must be a valid Tandem user ID.

Specify Command File to Run
Name
Enter the full path and name of the command file, it must be a valid executable. For example:
Specifying Defaults and Details for all Workload

- The name of the file containing the macro
  
  \system$volume.subvolume.filename

- The name of the preloaded macro or routine
  
  macro name

- The name of an obey file
  
  obey file name

**Arguments to pass**

Enter an argument string of positional parameters to be passed to the batch file or program. Multiple arguments can be passed by separating them with blanks, but the ARG S statement must fit on one line. Multiple arguments can be passed as a single parameter by enclosing them in double quotes. For example, "p7 p11".

Environment Variables tab - Tandem

![Environment Variables tab](image)

**Understanding the TACLENV keyword**

The ENVAR statement for the Tandem ESP Workload Manager is generalized so that any valid TACL command can be executed. Use TACL to set up an appropriate environment on the Tandem dialog before running the command.

Use the TACL ENV (x) keyword to pass an arbitrary sequence of TACL commands. Each TACL ENV (x) keyword has to be unique (for example, TACL ENV 1, TACL ENV 145, TACL ENV 76) but not necessarily in sequence. If the command is successful, the system will not return anything.

**Name**

Enter the name of the TACL ENV variable to be passed.
Value
Enter the value for the TACLENV variable.
Click Add. The TACLENV variable name and value are added to the List of Environment Variables field.
Click OK.

Example

List of Environment Variables

To update an environment variable
1. In the List of Environment Variables, click on the TACLENV variable to highlight it.
2. Change the above fields.
3. Click Update.

To delete an environment variable
1. In the List of Environment Variables, click on the TACLENV variable to highlight it.
2. Click Delete.

Agent Monitor Workload Object

The Agent Monitor statement defines a workload object that monitors the status of an ESP Workload Manager Agent. You can specify workload defaults and details for the Agent Monitor workload object.

Agent Monitor Defaults

To set global defaults for the Agent Monitor workload object
On the Workload Editor menu bar, select Options > Global Defaults > Job > Agent Monitor.
To set job defaults for the Agent Monitor workload object
On the Workload Editor menu bar, select **Options > Job Defaults > Agent Monitor**.

The Agent Specifications, AM Notification, Notification, Resources, and Free Format Text dialogs appear. These are the defaults available for the Agent Monitor job type, at the global and job level. They are documented on the following pages:

- “Agent Specifications tab - Agent Monitor” on page 236
- “AMNotification tab” on page 237
- “Notification tab” on page 125
- “Resources tab” on page 128
- “Free Format Text tab” on page 88

**Agent Monitor Details**

Before you can specify Agent Monitor details, you must have the icon on the workspace.

**To specify job details for the Agent Monitor workload object**

1. On the workspace, right-click the Agent Monitor icon. A shortcut menu appears.
2. On the shortcut menu, click **Job Details**.

The Job Details dialog appears. By default, the Name field shows the job type name and a number. The icons dropped on the workspace are numbered sequentially by job type until you optionally rename them.

All the available job detail tabs are documented on the following pages:

- “General tab” on page 96
- “Agent Specifications tab - Agent Monitor” on page 236
- “AMNotification tab” on page 237
- “Send Message tab” on page 106
- “Issue Command tab” on page 108
- “Options tab” on page 110
- “Run Frequency tab” on page 114
- “Time Dependencies tab” on page 120
- “Notification tab” on page 125
- “Resources tab” on page 128
- “Resource Specifications tab” on page 131
- “Free Format Text tab” on page 136
- “Comment tab” on page 140
**Agent Specifications tab - Agent Monitor**

![Agent Monitor Job: TORONTO](image)

<table>
<thead>
<tr>
<th>Specify Agent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
</tr>
<tr>
<td>Status Interval</td>
</tr>
<tr>
<td>Messages</td>
</tr>
</tbody>
</table>

**Name**

Enter the name of the Agent that is to receive the monitoring.

**Status Interval**

Enter a number to indicate how often status checks are to occur on the Agent.

**Messages**

Enter a number to indicate how many messages the Agent Monitor workload object will store.

The following are the corresponding statements that appear in the right-hand pane:

![Corresponding Statements](image)
AMNotification tab

Use this tab to generate a notification when an Agent becomes inactive. With AMNotification you can:

- Trigger an Event directly without using a logical alert identifier
- Trigger an alert
- Send a message to a mailbox
- Send a message to a user
- Specify a routing code
- Specify a description code
- Specify a z/OS system name

**Trigger**

**Event**
Enter an Event name. Events can be triggered directly or in association with a logical alert identifier.

**ESP Alert ID**
Enter an alert ID.

Indicates an Event associated with a logical alert identifier should be triggered. This logical identifier must have been previously specified using an alert definition. For more information on alerts, see “Job Monitoring and Alert Processing” in the *ESP Workload Manager Advanced User’s Guide*. 
Mailbox
Enter a mailbox name. The mailbox becomes the destination for messages coming from Events or from this Notification dialog. When a new message arrives in a mailbox, it is distributed to all defined subscribers. Subscriptions are supported for TSO users and email addresses.

For information on how to define subscribers, see the LOADNL command in the ESP Workload Manager Reference Guide v.5.4, volume 2.

Specify TSO User(s) to Notify
1. Enter a user ID that is to receive the notification.
2. Click Add.
   The user ID is added to the list box.
3. Click Delete after selecting a user ID from the list box.
   The user ID is deleted.

Specify Delivery Options
Routing code
Enter a routing code value between 1 and 128. Separate each routing code with a comma. The routing code option is added to the notify statement.

Description code
Enter a description code value between 1 and 16. Separate each description code with a comma. The description code option is added to the notify statement.

z/OS system name
Enter the name of a Sysplex member.

This is not the ESP Workload Manager system name. It is the name by which z/OS knows the member of the Sysplex. Can be used to route a NOTIFY command in a Sysplex environment to wherever the user is logged on.

Use an asterisk to indicate the message goes wherever ESP Workload Manager is running.

Click Add.

The notification is added to the List of notifications box.

Example
**Applend Workload Object**

There are no workload defaults for the Applend workload object.

**About Applend**

The Applend workload object is a self-completing workload object. You can use Applend to automatically perform processing at the end of an Application.

The Applend object automatically succeeds any object in the Application that does not have a successor or is not a successor to the Applend object itself. Applend executes automatically after all other workload objects have completed, other than workload objects that are defined as successors to it.

The Applend object also detects any objects inserted into an active Application, and if they do not have successors or are not themselves successors to the Applend object, the Applend object is again made a successor to it.

Only one Applend workload object can exist in an Application.

**Example**

**Applend Details**

Before you can specify Applend details, you must have the icon on the workspace.
To specify job details for the Applend workload object

1. On the workspace, right-click the Applend icon. A shortcut menu appears.

2. On the shortcut menu, click **Job Details**.
   
   The Job Details dialog appears. By default, the Name field shows the job type name and a number. The icons dropped on the workspace are numbered sequentially by job type until you optionally rename them.

All the available job detail tabs are documented on the following pages:

- “General tab” on page 96
- “Send Message tab” on page 106
- “Issue Command tab” on page 108
- “Options tab” on page 110
- “Run Frequency tab” on page 114
- “Time Dependencies tab” on page 120
- “Notification tab” on page 125
- “Resources tab” on page 128
- “Resource Specifications tab” on page 131
- “Free Format Text tab” on page 136
- “Comment tab” on page 140

**PeopleSoft Workload Object**

You can specify workload defaults and details for the PeopleSoft job type.

**PeopleSoft Defaults**

**To set global defaults for the PeopleSoft workload object**

On the Workload Editor menu bar, select **Options > Global Defaults > Job > PeopleSoft**.

**To set job defaults for the PeopleSoft workload object**

On the Workload Editor menu bar, select **Options > Job Defaults > PeopleSoft**.

The Agent Specifications, Notification, Resources, and Free Format Text dialogs appear. These are the defaults available for the PeopleSoft job type, at the global and job level. They are documented on the following pages:

- “Agent Specifications tab - PeopleSoft” on page 242
- “Notification tab” on page 125
PeopleSoft Details

Before you can specify PeopleSoft details, you must have the icon on the workspace.

To specify job details for the PeopleSoft workload object

1. On the workspace, right-click the PeopleSoft icon. A shortcut menu appears.
2. On the shortcut menu, click Job Details.
   The Job Details dialog appears. By default, the Name field shows the job type name and a number. The icons dropped on the workspace are numbered sequentially by job type until you optionally rename them.

All the available job detail tabs are documented on the following pages:

- “General tab” on page 96
- “Agent Specifications tab - PeopleSoft” on page 242
- “Send Message tab” on page 106
- “Issue Command tab” on page 108
- “Options tab” on page 110
- “Run Frequency tab” on page 114
- “Time Dependencies tab” on page 120
- “Notification tab” on page 125
- “Resources tab” on page 128
- “Resource Specifications tab” on page 131
- “Free Format Text tab” on page 136
- “Comment tab” on page 140
Agent Specifications tab - PeopleSoft

Agent name
Enter the name of the Agent where the job is to run.

PS Operator ID
Enter the operator ID under whose authority the reports are run. This can be up to 32 characters in length.

The operator ID performs the same function as the USER statement in other jobs. When this value is specified, ESP Workload Manager will supply the corresponding password from its password facility.

The operator ID is validated against the corresponding value in the PeopleSoft database.

Run control ID
Enter the value assigned to the run control identifier. This is optional, and can be up to 32 characters in length.

This parameter identifies a set of PeopleSoft run parameters for a given PeopleSoft process.

Process Name
Enter the name of the PeopleSoft report to be run. This is mandatory, and can be up to 12 characters in length.

A list of all process names that is stored in PeopleSoft in the PS PRCSDEFN table. It must be a valid PeopleSoft report.
**Process Type**
Click the down arrow to select the type of PeopleSoft report being run. This is mandatory, and can be up to 32 characters in length.

Supported types include:
- SQR
- COBOL
- Application Engine
- Crystal reports
- n/Vision

The list of process types can be obtained from the table PS PRCSTYPDEFN.

**Server name**
Enter the name of the target server executing the PeopleSoft job. This is optional, and can be up to eight characters in length.

The server name has to exist in the PS SERVERDEFN table in PeopleSoft.

**Output destination type**
Click the down arrow to select the output destination format in a job definition. This is optional, and can be up to eight characters in length.

A listing of all output destination formats can be found in the table PSXLATITEM.

Select one of the following formats:
- (none)
- FILE
- PRINTER
- EMAIL - activates the DISTRIBUTION button
- WEB - activates the DISTRIBUTION button

Click the **Distribution** button, the Distribution Detail dialog appears.

Complete the following fields on the Distribution Detail dialog.

**Folder Name**
Enter a folder name to represent the contents of this distribution list. This can be up to 18 characters in length.

**Users distribution List**
Enter an operator ID. This can be up to 256 characters in length for the entire list.

Optionally, you can create a distribution list of operator IDs for an output report. By default, PeopleSoft sets the value of the parameter to PSOPRID.

Also, having no distribution list of users may be useful if you specify distribution through roles.
Click **Add**.

To delete a User entry, click the **User entry** to highlight it, then click **Delete**.

**Roles distribution List**

Enter a name to represent the role of the individual who is receiving the report. This can be up to 256 characters in length for the entire list.

Optionally, you can create a distribution list of roles for an output report.

Click **Add**.

To delete a Role entry, click the **Role entry** to highlight it, then click **Delete**.

**Email With Log**

Check-mark this box to optionally specify that job logs are e-mailed as well to a recipient on a distribution list.

**Email Web Report**

Check-mark this box to optionally specify the web report is e-mailed to a recipient on a distribution list.

**Email Subject**

Optionally, enter a subject title, in this text field. This can be up to 256 characters in length.

**Message text**

Optionally, enter the text of the e-mail body text. This can be up to 1024 characters in length.

**Email Address List**

Optionally, enter the e-mail address for a recipient on a distribution list. This can be up to 256 characters in length for the entire list.

Click **Add**.

To delete an e-mail address, click the **e-mail address** to highlight it, then click **Delete**.

Click **OK**.
Example of the Distribution Detail dialog complete:

![Distribution Detail Dialog]

Click **OK**.

The Agent Specifications tab reappears. The following fields continue completing the Agent Specifications tab.

**Output destination format**
Enter the output destination format in a job definition. This is optional, and can be up to eight characters in length.

A listing of all output destination formats can be found in the table PSXLATITEM.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Any</td>
</tr>
<tr>
<td>None</td>
<td>(None)</td>
</tr>
<tr>
<td>PDF</td>
<td>Acrobat (*.pdf)</td>
</tr>
<tr>
<td>CSV</td>
<td>Comma delimited (*.csv)</td>
</tr>
<tr>
<td>HP</td>
<td>HP Format (*.lis)</td>
</tr>
<tr>
<td>HTM</td>
<td>HTML Documents (*.htm)</td>
</tr>
<tr>
<td>WKS</td>
<td>Lotus 1-2-3 files</td>
</tr>
<tr>
<td>XLS</td>
<td>Microsoft Excel files (*.xls)</td>
</tr>
<tr>
<td>DOC</td>
<td>Microsoft Word (*.doc)</td>
</tr>
<tr>
<td>PS</td>
<td>Postscript (*.lis)</td>
</tr>
<tr>
<td>RPT</td>
<td>Crystal Report (*.rpt)</td>
</tr>
<tr>
<td>RTF</td>
<td>Rich Text File (*.rtf)</td>
</tr>
<tr>
<td>SPF</td>
<td>SQR Portable Format (*.spf)</td>
</tr>
<tr>
<td>TXT</td>
<td>Text Files (*.txt)</td>
</tr>
</tbody>
</table>
### Output destination path

Enter the path to the output directory. This is optional, and can be up to 127 characters in length.

Indicates the name of the directory where the output report is sent. Used only when FILE or PRINTER is specified as an output destination. A default value is stored in the configuration file psprcs.cfg as Log/Output directory.

### Timezone

Enter a time zone other than the current one. This is optional, and can be up to nine characters in length.

### Arguments

Enter an argument string of positional parameters to be appended to the PeopleSoft database. Multiple parameters are specified by separating them with blank spaces. To pass spaces in a parameter, enclose the parameter in double quotation marks.

**Note:** When passing multiple parameters, note the following:
- You can use continuation characters, such as the hyphen (-).
- The maximum message size is four Kilobytes.
- A second ARGS statement within the job definition overrides the first, with the exception of a blank character string, which is ignored.

Most parameters for a particular PeopleSoft job are specified in a parameter list in two database tables:
- PS PRCSTYDEFN - template for a process type
- PS PRCSDEFN - additional parameters for a particular process name

Additional arguments that are specified using the ARG statement are appended to this parameter list.

If you set the statement SKIPPARMUPDATES to YES, then the parameters in PS PRCSDEFN will be ignored.

### Disable Restart

Select the check box to disable a restart feature for previously-failed jobs from the point where the job failed.

This applies to application engine jobs that previously failed.

By default, when a previously-failed job is re-submitted, it will restart from where it was stopped.
The following applies to the **Disable Restart** field:

1. A check box with a check mark indicates the option is enabled.
2. A check box without a check mark indicates the option is disabled.
3. A grayed out check box with a check mark indicates the option is ignored.

**Skip param updates**

Select the check box to indicate the Agent will not update job parameters with data in the table PS PRCSDEFN.

The recommended use for this parameter is for those cases where some bind variables in the table PS PRCSDEFN may not be suitably defined. If you set the statement SKIPPARMUPDATES to YES, then the parameters in PS PRCSDEFN will be ignored.

If you have set the value to YES, you can use the ARGs statement to pass any additional PS job argument values.

**Example**

```
PS_JOB PPLSOFT1
AGENT PS_TOR
PSOPOID VPI
PROCESSNAME Payroll
PROCESSSTEP PPLOA Application Engine
RUNCONTROLD FLOOR\COLOR
SERVERNAME PSNT
OUTDESTTYPE WEB
OUTDESTFORMAT TXT
OUTDESTPATH TXT
TIMEZONE CST
DISABLE_RESTART NO
EMAILLOG YES
EMAILREPORT YES
ARGs -nnvariable "share"
SKIPPARMUPDATES YES
DISTRIBOLE: Month-end Recipients
DISTRIBSTORES: "user1, user2, user3"
DISTRIBSTORES: *desk1, desk2
EMAILSUBJECT Month-end report
EMAILTEXT: The report is available for distribution.
RUN DAILY
ENDJOB
```

**FTP Workload Object**

**Dependency:** ESP System Agent Release 6 or higher, or the ESP System Agent for i5/OS

Using your ESP System Agent, you can automate FTP transfers with an FTP job. The job can use an existing FTP server or ESP System Agent as an FTP server.

Use an FTP job to automate

- Downloading an ASCII, binary or EBCDIC file from a remote FTP server to your ESP System Agent machine
- Uploading an ASCII, binary or EBCDIC file from your ESP System Agent machine to a remote FTP server
You can set up ESP System Agent to run as an FTP client or as an FTP server and client.

**Note:**
- The EBCDIC transfer type applies to ESP System Agent for i5/OS only.
- For the QSYS.LIB file system on i5/OS systems, you can only transfer members of FILE objects. For more information on FTP restrictions on i5/OS systems, see the IBM documentation.

**ESP System Agent as FTP client**

If ESP System Agent runs as an FTP client, ESP System Agent can log into remote FTP servers, download files from those servers, and upload files to those servers.

The following diagram shows the relationships between ESP System Agent running as an FTP client, ESP Server, and an FTP server.

![Diagram showing relationships between ESP System Agent as FTP client, ESP Server, and FTP server]

**Note:** The FTP user ID used to connect to the FTP server must be defined on ESP Server (ESP Workload Manager).

When ESP System Agent runs as an FTP client only, other FTP clients (such as other ESP Agents) cannot log into ESP System Agent to FTP files. To allow other FTP clients to log in and FTP files, you need to also set up ESP System Agent to run as an FTP server.

**ESP System Agent as FTP server**

ESP System Agent (Release 6 and higher) supports a built-in FTP server capability. You can enable ESP System Agent to act as a generic FTP server in addition to its other roles. This server comes under the security rules established for ESP System Agent.

If ESP System Agent runs as an FTP server, clients can log into ESP System Agent and FTP files.
The following diagram shows the relationships between ESP System Agent running as an FTP server, ESP Server (ESP Workload Manager), and another ESP System Agent running as an FTP client.

Note: The FTP user ID used to connect to ESP System Agent running as an FTP server must be defined on that ESP System Agent and ESP Server.

If you configure ESP System Agent as an FTP server, ESP System Agent can handle ASCII and binary file transfers, wildcard requests, simple GET and PUT requests for single files, and MGET and MPUT requests for multiple files.

ESP System Agent has a secure store of FTP-server user IDs and associated passwords. The ftpusers.txt file, located in the directory ESP System Agent is installed in, stores these user IDs and their corresponding hashed passwords.

ESP System Agent running as an FTP server does not support anonymous FTP requests. For audit purposes, ESP System Agent provides a detailed log of all FTP requests.

FTP Defaults

You can specify workload defaults and details for the FTP job type. You require Release 6 or higher of ESP Workload Manager Agents to perform FTP transfers.

To set global defaults for the FTP workload object
On the Workload Editor menu bar, select Options > Global Defaults > Job > FTP.

To set job defaults for the FTP workload object
On the Workload Editor menu bar, select Options > Job Defaults > FTP.

The Agent Specifications, Notification, Resources, and Free Format Text dialogs appear. These are the defaults available for the FTP job type, at the global and job level. They are documented on the following pages:
FTP Details

Before you can specify FTP details, you must have the icon on the workspace.

To specify job details for the FTP workload object
1. On the workspace, right-click the FTP icon. A shortcut menu appears.
2. On the shortcut menu, click **Job Details**.
The Job Details dialog appears. By default, the Name field shows the job type name and a number. The icons dropped on the workspace are numbered sequentially by job type until you optionally rename them.

All the available job detail tabs are documented on the following pages:
- “General tab” on page 96
- “Agent Specifications tab - FTP” on page 251
- “Send Message tab” on page 106
- “Issue Command tab” on page 108
- “Options tab” on page 110
- “Run Frequency tab” on page 114
- “Time Dependencies tab” on page 120
- “Notification tab” on page 125
- “Resources tab” on page 128
- “Resource Specifications tab” on page 131
- “Free Format Text tab” on page 136
- “Comment tab” on page 140
Agent Specifications tab - FTP

**Agent name**
Enter the name of the Agent where the job is to run.

**Job Class**
Enter an alpha character to represent the job class this job will run under. This field is optional.

**Server Address**
Specify the FTP server name. This can be up to 100 characters and is case-sensitive.

**Server Port**
Enter the FTP server port number. This can be up to 5 numeric characters.

**User**
Enter the user ID the job is to use when running.

**Remote File Name**
Specify the location of the files to be transferred. This can be up to 256 characters, and is case-sensitive.

**Local File Name**
Specify the location of where files are to be transferred. This can be up to 256 characters, and is case-sensitive. This is a mandatory statement.

**Transfer Direction -- Download or Upload**
Select the appropriate button to indicate the direction of the transfer.
Transfer Code Type -- Binary, Ascii, EBCDIC or Auto-detect
Select the code type of the transfer or select auto-detect.

Notes:
- EBCDIC applies to jobs running on System i5 only.
- Auto-detect is only available for uploads. If you select auto-detect for downloads, the request will be ignored.

Compression Level
Select a compression level from zero (0) to nine where 0 is no data compression and 9 is the best data compression.
If you do not specify a value, the data is compressed using the default compression level set on the ESP System Agent FTP client.

Note: To use Compression level, both FTP client and FTP server must run on ESP System Agent Release 7 software. If this value is specified and the FTP server or the FTP client does not run on ESP System Agent, the data will be transferred without compression.

Use SSL
Dependency: ESP System Agent Release 7
To transfer data using Secure Sockets Layer (SSL) communication, select YES.

Note: To transfer data using SSL
- The FTP server must have SSL FTP enabled
- The FTP client must have SSL FTP configured (SSL FTP can be enabled or disabled)

The ESP System Agent administrator can enable or disable SSL on the ESP System Agent FTP client using the ftp.client.ssl parameter in the ESP System Agent parameter file (agentparm.txt).
- If the ESP System Agent FTP client has SSL FTP enabled, all FTP jobs on that ESP System Agent machine automatically use SSL FTP.
- If the ESP System Agent FTP client does not have SSL FTP enabled, all FTP jobs on that ESP System Agent automatically use regular FTP.

The Use SSL value for an individual job overrides this default FTP setting on the ESP System Agent FTP client.
- If you set Use SSL to YES, the data is transferred using SSL FTP.
- If you set Use SSL to NO, the data is transferred using regular FTP.
- If you leave Use SSL blank, the data is transferred using the default FTP setting (regular FTP or SSL FTP).

Note: If the FTP client has SSL FTP enabled but the FTP server does not, you must set Use SSL to NO. Otherwise, the job will fail.
**Example: Uploading a file from a local machine to a remote Windows server using SSL FTP**

In this example, ESP System Agent Release 7 runs on a local machine as an FTP client and has SSL FTP configured, but not enabled. The remote Windows server has SSL FTP configured and enabled.

To securely upload a file from the ESP System Agent FTP client to the remote Windows FTP server, set **Use SSL to YES** in the FTP job definition. Although the ESP System Agent FTP client does not have SSL FTP enabled, the file will be uploaded using SSL FTP because the ESP System Agent FTP client has SSL FTP configured and the FTP server has SSL FTP enabled.

The following FTP job uploads the file `filename.txt` from the ESP System Agent FTP client to the `c:\uploaded_files` directory on a remote Windows server. Since the FTP client has SSL configured but not enabled, **Use SSL** is set to **YES** to transfer the file securely.

```
FTP_JOB FTP_UPLOAD
  AGENT R7AGENT
  USER user1
  SERVERADDR winserver
  TRANSFERDIRECTION UPLOAD
  FTPFORMAT U SSL(YES)
  REMOTENAME 'c:\uploaded_files\filename.txt'
  LOCALNAME 'd:\files_to_upload\filename.txt'
ENDJOB
```

**Example: Downloading a file from a remote UNIX server that does not support SSL FTP to a local machine that supports SSL FTP**

In this example, ESP System Agent Release 7 runs on a local machine as an FTP client and has SSL FTP enabled (all FTP jobs on the ESP System Agent machine run using SSL FTP). The remote UNIX server does not support SSL FTP.
To transfer FTP data, you must set SSL connection to False in the FTP job definition. Otherwise, the job will fail.

The FTP job will also fail if the following configurations are set:

- The ESP System Agent FTP client has SSL FTP configured but not enabled.
- SSL connection is set to True in the job definition.
- The FTP server does not support SSL FTP.

To transfer data using SSL FTP, the FTP server must have SSL FTP enabled and the FTP client must have SSL FTP configured.

The following FTP job downloads the file `filename.txt` from the remote UNIX server to the `c:\downloaded_files` directory on the local machine. Since the FTP server does support SSL FTP, `Use SSL` is set to `NO`.

```plaintext
FTP_JOB FTP_DOWNLOAD
AGENT R7AGENT
USER user1
SERVERADDR hUNIX
TRANSFERDIRECTION DOWNLOAD
FTPFORMAT A SSL(NO)
REMOTENAME 'files_to_download/filename.txt'
LOCALNAME 'c:\downloaded_files\filename.txt'
ENDJOB
```

**Example: Compressing a file and downloading it using SSL**

In this example, the local machine has ESP System Agent Release 7 running as an FTP client. The remote machine has ESP System Agent Release 7 running as an FTP server. SSL FTP is enabled on both FTP client and FTP server. Both machines operate on a low bandwidth network.
The following FTP job downloads a large file named `largefile.txt` from the remote server to the FTP client. The machines are on a low bandwidth network, so the data is compressed at compression level 3. By default, the job runs using SSL FTP because SSL FTP is enabled on both FTP client and FTP server.

```
FTP_JOB FTPJob
  AGENT R7AGENT
  USER user1
  SERVERADDR aixunix
  TRANSFERDIRECTION DOWNLOAD
  FTPFORMAT A SSL(NO) COMPRESS(3)
  REMOTENAME 'files_to_download\largefile.txt'
  LOCALNAME 'c:\downloaded_files\largefile.txt'
ENDJOB
```

**Example: Uploading an ASCII-encoded file in the root file system from an i5/OS system to a UNIX system**

In this example, a file named textfile in the root file system is uploaded from an i5/OS system to a UNIX system. Note that the two locations include a complete path statement. After the upload is complete, the job FTPJOB2.DOWNLOAD is released for execution.

```
FTP_JOB FTPTEST1.UPLOAD
  AGENT I5AGENT
  USER test
  SERVERADDR hpunix
  SERVERPORT 5222
  TRANSFERDIRECTION UPLOAD
  FTPFORMAT A
  REMOTENAME '/u1/qtest/ftpdata/textfile'
  LOCALNAME '/home/cybesp/textfile'
  RUN DAILY
ENDJOB
```
Example: Downloading a QSYS.LIB EBCDIC-encoded file

In this example, an EBCDIC-encoded file named datafile in the QSYS.LIB file system is downloaded from an i5/OS system to another i5/OS system. Note that the file names are specified in the path format.

```
FTP_JOB FTPTEST2.DOWNLOAD
  AGENCY i5AGENT
  USER test
  SERVERADDR i5unix
  SERVERPORT 5222
  TRANSFERDIRECTION DOWNLOAD
  FTPFORMAT E
  REMOTENAME 'QSYS.LIB/DATALIB.LIB/DAT_FILE.FILE/DATA.MBR'
  LOCALNAME 'QSYS.LIB/ESPLIB.LIB/DOWNLOAD.FILE/DATA.MBR'
  RUN DAILY
ENDJOB
```

Example: Uploading and converting an EBCDIC-encoded file to ASCII

In this example, ESP Agent named i5Agent uploads a file member named RESULT from an i5/OS system to a UNIX system. The job automatically detects that the RESULT file member is EBCDIC-encoded and that the target UNIX system accepts only ASCII-encoded files. i5Agent is configured to automatically convert EBCDIC-encoded files to ASCII during an upload to an ASCII system, so the RESULT file member uploads successfully.

```
FTP_JOB FTPTEST3.CONVERT
  AGENCY i5AGENT
  USER test
  SERVERADDR hpunix
  SERVERPORT 5222
  TRANSFERDIRECTION UPLOAD
  FTPFORMAT U
  REMOTENAME '/u1/qetest/ftpdata/resultup'
  LOCALNAME 'QSYS.LIB/MYLIB.LIB/DATA.FILE/RESULT.MBR'
  RUN DAILY
ENDJOB
```

If ESP Agent is not configured to automatically convert uploaded EBCDIC-encoded files to ASCII, the job would fail. For more information on configuring ESP Agent, see the ESP System Agent for i5/OS Administrator’s Guide.

Verifying the FTP job status

To verify that the transfer completed successfully without file corruption, check the job’s spool file.

If the data was transferred using SSL FTP, the spool file contains a response similar to the following:
AUTH TLS
234 AUTH command OK. Initializing SSL connection.
If the file was compressed and transferred without file corruption, the spool file contains a response similar to the following:
Downloaded 81920/26119 bytes (original/compressed) in 0.161 seconds, 496.89 Kbytes/sec.
If the file was downloaded successfully, the spool file contains the following response:
Download successful

Database Job

Dependency: ESP System Agent Release 7; ESP Agent for Databases 1.0 or higher
ESP Agent for Databases supports the automation of common database tasks using the following database jobs:
• SQL — Executes an SQL statement
• DB Stored Procedure — Runs a stored procedure
• DB Trigger — Monitors for added, deleted, and updated rows in a database table
• DB Monitor — Monitors for added and deleted rows in a database table

Note: You cannot run DB2 stored functions (also called user-defined functions) directly using Stored Procedure jobs. However, you can include stored functions in SQL jobs. For example, the following SQL statement calls the TO_YEN stored function:

Note: SELECT TO_YEN(SALARY) FROM EMPLOYEE

Database Job Defaults

To set global defaults for a database job
On the Workload Editor menu bar, select Options > Global Defaults > Job > Database > select the database job type.

To set job defaults for a database job
On the Workload Editor menu bar, select Options > Job Defaults > Database > select the database job type.

The Agent Specifications, Notification, Resources, and Free Format Text dialogs appear. These are the defaults available for all Database jobs, at the global and job level. They are documented on the following pages:
• “Agent Specifications tab - SQL” on page 259
• “Agent Specifications tab - DB Stored Procedure” on page 266
Before you can specify details for a database object, you must have an icon representing the database job type on the workspace.

To specify job details for a database job
1. On the workspace, right-click the Database job type icon. A shortcut menu appears.
2. On the shortcut menu, click Job Details.
   The Job Details dialog appears. By default, the Name field shows the job type name and a number. The icons dropped on the workspace are numbered sequentially by job type until you optionally rename them.

All the available job detail tabs are documented on the following pages:

- “General tab” on page 96
- “Agent Specifications tab - SQL” on page 259
- “Agent Specifications tab - DB Stored Procedure” on page 266
- “Agent Specifications tab - DB Trigger” on page 270
- “Agent Specifications tab - DB Monitor” on page 275
- “Send Message tab” on page 106
- “Issue Command tab” on page 108
- “Options tab” on page 110
- “Run Frequency tab” on page 114
- “Time Dependencies tab” on page 120
- “Notification tab” on page 125
- “Resources tab” on page 128
- “Resource Specifications tab” on page 131
- “Free Format Text tab” on page 136
- “Comment tab” on page 140
You can define an SQL job to execute an SQL statement against an Oracle, Microsoft SQL Server, or DB2 database. When the job runs, the Agent invokes the SQL command and returns results in an output file or job spool file. You can add criteria to the job definition to test the query result. If the result matches the criteria, the job completes; otherwise, the job fails.

**Agent name**
The name of the Agent where the job is to run.

**DB User**
The database user ID the job runs under, for example jsmith. Every database user ID specified in a job definition must have a corresponding user ID and password pair defined using the PASSWORD command.

**Oracle DB user type**
The type of Oracle user. This field applies to Oracle databases only.

In Oracle, a user with sufficient authority can log in with different system privileges. For example, if a job requires sysdba privileges, use the following statement:

```
USERTYPE 'as sysdba'
```
The database resource location. ESP Agent uses JDBC to connect to the database.

- For an Oracle database, use the following format:
  `jdbc:oracle:thin:@<host>:<port>:<dbname>`
- For a Microsoft SQL Server database, use the following format:
  `'jdbc:sqlserver://<host>:<port>;DatabaseName=<dbname>'`
- For an IBM DB2 database, use the following format:
  `jdbc:db2://<host>:<port>/<dbname>`

**SQL command**
The SQL command to run against the database

**Output file**
The file for storing the query results. If you omit this statement, ESP Agent directs the output to the job’s spool file.

**Success criteria**
Regular expression ESP Agent uses to determine whether to complete the job. If the SQL statement returns a string that matches this expression, the job completes; otherwise, the job fails.

*Note:* Success criteria only applies to SQL queries that are SELECT statements.

**Examples: SQL jobs for Oracle database**

**Adding a row to an Oracle table**
In this example, an SQL job adds a row of data to the emp table.

```
SQL_JOB INSERT
  AGENT DB_AGENT
  USER scott
  DB_URL jdbc:oracle:thin:@myhost:1521:orcl
  SQL 'INSERT INTO EMP(EMPNO, ENAME, JOB, MGR, HIREDATE, SAL, +
                  COMM, DEPTNO) VALUES(2476, "dilbert", "sales", 435, +
                  "01-OCT-2005", 65000, 10, 75)'
ENDJOB
```
Updating a row in an Oracle table

In this example, an SQL job updates a record in the emp table and changes the sal to 75,000 for the employee with ename dilbert.

```
SQL_JOB UPDATE
AGENT DB_AGENT
USER scott
DB_URL jdbc:oracle:thin:@myhost:1521:orcl
SQL 'UPDATE EMP SET SAL=75000 where ENAME="dilbert"'
ENDJOB
```

Deleting a row from an Oracle table

In this example, an SQL job deletes a row from the emp table for the employee with ename dilbert.

```
SQL_JOB DELETE
AGENT DB_AGENT
USER scott
DB_URL jdbc:oracle:thin:@myhost:1521:orcl
SQL 'DELETE FROM EMP WHERE ENAME="dilbert"'
ENDJOB
```

Returning data from a table that match a condition

In this example, an SQL job queries the emp table for enames that have salaries greater than 40,000. If the query returns an ename that begins with the letter d, the job completes.

```
SQL_JOB SELECT
AGENT DB_AGENT
USER scott
DB_URL jdbc:oracle:thin:@myhost:1521:orcl
SQL 'SELECT ename FROM emp WHERE sal > 40000'
OUTPUT_FILE /emp/salary.txt
JOB_CRITERIA d.*
ENDJOB
```

For example, the salary.txt file contains the following output:

```
Output for: SELECT ENAME FROM WLM_TEST3 where SAL > 40000
ENAME
----------
dilbert
```
Examples: SQL jobs for MS SQL Server

The examples in this section are based on the stores and sales tables located in the pubs sample database provided with MS SQL Server.

Adding a row to a MS SQL Server table

In this example, an SQL job adds a row for a new store to the stores table.

```sql
SQL_JOB INSERT
AGENT DB_AGENT
USER sa
DB_URL 'jdbc:sqlserver://myhost:1433;DatabaseName=pubs'
SQL 'INSERT INTO stores(stor_id, stor_name, stor_address, +
city, state, zip) VALUES(6523, "Chapter", +
"6523 Main St.", "San Diego", "CA", "93223")'
ENDJOB
```

Deleting a row from a MS SQL Server table

In this example, the SQL job deletes the row for stor_id 6523 from the stores table.

```sql
SQL_JOB DELETE
AGENT DB_AGENT
USER sa
DB_URL 'jdbc:sqlserver://myhost:1433;DatabaseName=pubs'
SQL 'DELETE FROM stores WHERE stor_id=6523'
ENDJOB
```

Updating a row in a MS SQL Server table

In this example, an SQL job updates the row in the sales table that matches ord_num 6871 and changes the values for the ord_date and qty.

```sql
SQL_JOB UPDATE
AGENT DB_AGENT
USER sa
DB_URL 'jdbc:sqlserver://myhost:1433;DatabaseName=pubs'
SQL 'UPDATE sales SET ord_date="6/15/2006", qty=10 WHERE +
ord_num="6871"'
ENDJOB
```
Returning data from a table that match a condition

In this example, an SQL job queries the sales table for ord_num that have a qty greater than 20. The ord_num that match the query appear in the output file ordnum.txt located in the C:\sales directory.

```
SQL_JOB SELECT
AGENT DB_AGENT
USER sa
DB_URL 'jdbc:sqlserver://myhost:1433;DatabaseName=pubs'
SQL 'SQL SELECT ord_num FROM sales WHERE qty > 20'
OUTPUT_FILE C:sales\ordnum.txt
JOB_CRITERIA A2976
ENDJOB
```

The ordnum.txt file contains the following ord_num:

A2976
QA7442.3
P2121
N914014
P3087a
P3087a
X999
P723
QA879.1

Because the query returns an ord_num that matches the job criteria A2976, the job completes.

Suppose we change the job criteria statement in the above example to the following:

```
JOB_CRITERIA B[0-9]
```

In this case, the query would still return the same order numbers, but the job would fail because it would not find a matching ord_num containing the letter B and followed by a number.
Examples: SQL jobs for IBM DB2

Adding a row to an IBM DB2 table
In this example, an SQL job adds a row of data to the STAFF table under the user entadm.

```
SQL_JOB INSERT
  AGENT DB_AGENT
  USER entadm
  DB_URL jdbc:db2://10.1.4.131:50000/SAMPLE
  SQL 'INSERT into ENTADM.STAFF(ID, NAME, DEPT, JOB, YEARS, +
  SALARY, COMM) VALUES(556, "Jonson", 84, "Sales", 1, 40500.50, 100)'
ENDJOB
```

Updating a row in an IBM DB2 table
In this example, an SQL job updates a record in the STAFF table under the user entadm. The job changes the years to 3 for the employee with the name Jonson.

```
SQL_JOB UPDATE
  AGENT DB_AGENT
  USER entadm
  DB_URL jdbc:db2://10.1.4.131:50000/SAMPLE
  SQL 'UPDATE ENTADM.STAFF SET YEARS=3 where NAME="Jonson"'
ENDJOB
```

Deleting a row from an IBM DB2 table
In this example, an SQL job deletes a row from the STAFF table under the user entadm for the employee with the name Jonson.

```
SQL_JOB DELETE
  AGENT DB_AGENT
  USER entadm
  DB_URL jdbc:db2://10.1.4.131:50000/SAMPLE
  SQL 'DELETE FROM ENTADM.STAFF where NAME="Jonson"'
ENDJOB
```
Returning data from an IBM DB2 table that match a condition

In this example, an SQL job queries the STAFF table under the user entadm for names that have salaries greater than 40,000. If the query returns a name that begins with the letter J, the job completes.

```
SQL_JOB SELECT
   AGENT DB_AGENT
   USER entadm
   DB_URL jdbc:db2://10.1.4.131:50000/SAMPLE
   SQL 'SELECT NAME FROM ENTADM.STAFF where SALARY > 40000'
   OUTPUT_FILE /staff/salary.txt
   JOB_CRITERIA J.*
ENDJOB
```

For example, the salary.txt file contains the following output:

```
Output for: SELECT NAME FROM ENTADM.STAFF where SALARY > 40000
NAME
-------
Jonson
```
You can define a Stored Procedure job to run a procedure stored in a database. You can add criteria to the job definition to test the procedure’s output. If the result matches the criteria, the job completes successfully.

**Agent name**
The name of the Agent where the job is to run.

**DB User**
The database user ID the job runs under, for example jsmith. Every database user ID specified in a job definition must have a corresponding userID and password pair defined using the PASSWORD command.

**Oracle DB user type**
The type of Oracle user. This field applies to Oracle databases only.

In Oracle, a user with sufficient authority can log in with different system privileges. For example, if a job requires sydmba privileges, use the following statement:

```
USERTYPE 'as sysdba'
```

**DB URL**
The database resource location. ESP Agent uses JDBC to connect to the database.
For an Oracle database, use the following format:
jdbc:oracle:thin:@<host>:<port>:<dbname>

For a Microsoft SQL Server database, use the following format:
'jdbc:sqlserver://<host>:<port>;DatabaseName=<dbname>'

For an IBM DB2 database, use the following format:
jdbc:db2://<host>:<port>/<dbname>

**Procedure name**
Name of the stored procedure

**Return data type**
JDBC data type for the value returned by the stored function

For a list of supported data types, see the “RETURN_DATA_TYPE Statement: Specify Return Type for Stored Procedure” in the ESP Agent for Databases Guide to Scheduling Workload.

**Success criteria**
Regular expression ESP Agent uses to determine whether to complete the job. If the stored procedure returns a string that matches this expression, the job completes; otherwise, the job fails.

**Arguments**
Parameters passed to the stored procedure. Specify the parameter name, followed by whether the parameter is an input parameter, an output parameter or both, and followed by the data type. If you specify more than one parameter, use a new line for each parameter.

For a list of supported data types, see “ARGS Statement: Specify a parameter passed to a stored procedure” in the ESP Agent for Databases Guide to Scheduling Workload.

**Examples: DB Stored Procedure jobs for MS SQL Server**
The examples in this section are based on stored procedures in the pubs sample database provided with MS SQL Server.
Running a simple stored procedure in a MS SQL Server database

In this example, the job runs the byroyalty stored procedure located in the pubs sample database. When the job runs, the Agent passes the input parameter percentage a value of 40.

```
DBSP_JOB BYROYALTY
  AGENT DB_AGENCY
  USER sa
  DB_URL 'jdbc:sqlserver://myhost:1433;DatabaseName=pubs'
  STORED_PROCEDURE byroyalty
  ARGS percentage IN INTEGER, 40
ENDJOB
```

Example: DB Stored Procedure jobs for IBM DB2

The example in this section is based on a stored procedure in the SAMPLE database provided with IBM DB2.

Running a stored procedure with input and output parameters

In this example, the job runs the DEPT_MEDIAN stored procedure under the user entadm. DEPT_MEDIAN returns the median salary for the department with deptNumber 20 from the STAFF table. The median salary, 18171.25, appears in the job’s spool file.

```
DBSP_JOB DEPTMED
  AGENT DB_AGENCY
  USER entadm
  DB_URL 'jdbc:db2://10.1.4.131:50000/SAMPLE'
  STORED_PROCEDURE ENTADM.DEPT_MEDIAN
  ARGS deptNumber IN SMALLINT, 20
  ARGs medianSalary OUT DOUBLE
ENDJOB
```
The spool file for this job contains the following output:

---------------------------------------------------------
Output of messages for workload object DEPTMED/DBAPPL.7/MAN
Start date Thu Aug 31 15:23:44 EDT 2006
---------------------------------------------------------

{ call ENTADM.DEPT_MEDIAN(?, ?) }
medianSalary=18171.25

The job in this example runs the following stored procedure in the SAMPLE database:

CREATE PROCEDURE DEPT_MEDIAN
(IN deptNumber SMALLINT, OUT medianSalary DOUBLE)
LANGUAGE SQL
BEGIN

DECLARE v_numRecords INTEGER DEFAULT 1;
DECLARE v_counter INTEGER DEFAULT 0;
DECLARE c1 CURSOR FOR
    SELECT CAST(salary AS DOUBLE) FROM staff
    WHERE DEPT = deptNumber
    ORDER BY salary;
DECLARE EXIT HANDLER FOR NOT FOUND
    SET medianSalary = 6666;
-- initialize OUT parameter
    SET medianSalary = 0;
    SELECT COUNT(*) INTO v_numRecords FROM staff
    WHERE DEPT = deptNumber;
OPEN c1;
WHILE v_counter < (v_numRecords / 2 + 1) DO
    FETCH c1 INTO medianSalary;
    SET v_counter = v_counter + 1;
END WHILE;
CLOSE c1;
END
You can define a DB Trigger job to monitor a database table for added rows, deleted rows or updated rows. To monitor the database table for specific changes, you can add a condition to the job definition. When the condition is met, the job completes. You can set up continuous monitoring so that each time a database change occurs, ESP Workload Manager triggers an Event or an Alert. For continuous monitoring, the job state changes to MONITOR and remains in MONITOR until it is forced complete or the Delete Trigger command is issued.

You can also define DB Monitor jobs to monitor database changes. DB Monitor jobs only monitor for added and deleted rows. DB Trigger jobs also allow you to monitor a database for changes to rows and to specify conditions for those changes. DB Trigger jobs detect all changes made to the database, whereas DB Monitor jobs monitor for changes every 10 seconds by default.

### Agent name
The name of the Agent where the job is to run.

### DB User
The database user ID the job runs under, for example jsmith. Every database user ID specified in a job definition must have a corresponding user ID and password pair defined using the PASSWORD command.
Note:

- The user that a DB Trigger job runs under must be authorized to create triggers on the database.
- For Microsoft SQL Server, the user that a DB Trigger job runs under must own the database table identified in the Table name field.

**Oracle DB user type**
The type of Oracle user. This field applies to Oracle databases only.

In Oracle, a user with sufficient authority can log in with different system privileges. For example, if a job requires sysdba privileges, use the following statement:

```plaintext
USERTYPE 'as sysdba'
```

**DB URL**
The database resource location. ESP Agent uses JDBC to connect to the database.

- For an Oracle database, use the following format:
  ```plaintext
  jdbc:oracle:thin:@<host>:<port>:<dbname>
  ```
- For a Microsoft SQL Server database, use the following format:
  ```plaintext
  'jdbc:sqlserver://<host>:<port>;DatabaseName=<dbname>'
  ```
- For an IBM DB2 database, use the following format:
  ```plaintext
  jdbc:db2://<host>:<port>/<dbname>
  ```

**Table name**
Name of the table to monitor

**Trigger type**
Type of database change to monitor: INSERT, DELETE or UPDATE. For Oracle and MS SQL Server, you can specify one or more types. For DB2, you can specify only one type.

For Oracle, separate multiple types with OR, for example INSERT OR DELETE. For Microsoft SQL Server, separate multiple types with a comma, for example INSERT, DELETE.

**Trigger condition**
Condition to monitor within the database. For Oracle and DB2, this statement is the WHEN clause. For Microsoft SQL Server, this statement is the IF clause. For the specific database syntax, refer to your database vendor’s documentation.

**Alert or Event ID**
Enter an Alert or Event ID to trigger when the specified conditions are met.
Examples: DB Trigger jobs for Oracle

Monitoring an Oracle table for an added or deleted row
In this example, a Database Trigger job monitors the emp table for an added row or a deleted row. The job remains in an EXEC state waiting for an added or deleted row. When a row is either added or deleted, the job completes.

```
DB_TRIG DBTR
   AGEN DB_AGENT
   USER scott
   DB_URL jdbc:oracle:thin:@myhost:1521:orcl
   TABLE_NAME emp
   TRIG_TYPE 'INSERT OR DELETE'
ENDJOB
```

Monitoring a database table for deleted rows and sending a continuous Alert
In this example, a Database Trigger job monitors the emp table for deleted rows. When a row is deleted, the job changes from the EXEC state to the MONITOR state. Each time a row is deleted from the table, the Agent sends the Alert named alrt. The job will remain in a MONITOR state until it is forced complete or the Delete Trigger command is issued.

```
DB_TRIG DBTRIG1
   AGEN DB_AGENT
   USER scott
   DB_URL jdbc:oracle:thin:@myhost:1521:orcl
   TABLE_NAME emp CONTINUOUS(alrt)
   TRIG_TYPE DELETE
ENDJOB
```

Specifying trigger conditions for Oracle
In the following example, a Database Trigger job monitors the emp table for deleted rows. When a row containing deptno 75 is deleted, the job completes.

```
DB_TRIG DBTRIG1
   AGEN DB_AGENT
   USER scott
   DB_URL jdbc:oracle:thin:@myhost:1521:orcl
   TABLE_NAME emp
   TRIG_TYPE DELETE
   TRIG_COND old.deptno=75
ENDJOB
```
In the following example, a Database Trigger job monitors the emp table for added rows. When a row containing an ename beginning with the letter g is added, the job completes.

```
DB_TRIG DBTRIG1
  AGENCY DB_AGENT
  USER scott
  DB_URL jdbc:oracle:thin:@myhost:1521:orcl
  TABLE_NAME emp
  TRIG_TYPE INSERT
  TRIG_COND 'new.ename like "g\%\%"'
ENDJOB
```

In the following example, a Database Trigger job monitors the emp table for an added or updated row. The job completes when a new or updated row does not contain a job field equal to sales.

**Note:** The <> symbol indicates not equal to.

```
DB_TRIG DBTRIG1
  AGENCY DB_AGENT
  USER scott
  DB_URL jdbc:oracle:thin:@myhost:1521:orcl
  TABLE_NAME emp
  TRIG_TYPE 'INSERT OR UPDATE'
  TRIG_COND 'new.job<>'sales'
ENDJOB
```

**Examples: DB Trigger jobs for MS SQL Server**

**Monitoring a MS SQL Server database table for a new or deleted row**

In this example, a Database Trigger job monitors the stores table for an added row or a deleted row. The job remains in an EXEC state waiting for an added or deleted row. When a row is either added or deleted, the job completes.

```
DB_TRIG DBTRIG1
  AGENCY DB_AGENT
  USER sa
  DB_URL 'jdbc:sqlserver://myhost:1433;DatabaseName=pubs'
  TABLE_NAME stores
  TRIG_TYPE 'INSERT, DELETE'
ENDJOB
```
In this example, a Database Trigger job monitors the sales table for changes to the ord_date and qty columns. The job completes only when both columns have changed.

```sql
DB_TRIG DBTRIG1
AGENT DB_AGENT
USER sa
DB_URL jdbc:sqlserver://myhost:1433;DatabaseName=pubs'
TABLE_NAME sales
TRIG_TYPE UPDATE
TRIG_COND 'UPDATE(ord_date) and UPDATE(qty)'
ENDJOB
```

In this example, a Database Trigger job monitors the sales table for changes. When the qty for inserted title_id TC7777 is greater than or equal to 20, the job completes.

```sql
DB_TRIG DBTRIG1
AGENT DB_AGENT
USER sa
DB_URL jdbc:sqlserver://myhost:1433;DatabaseName=pubs'
TABLE_NAME sales
TRIG_TYPE INSERT
TRIG_COND '(select QTY from INSERTED where TITLE_ID="TC7777")>=20'
ENDJOB
```

In this example, a Database Trigger job monitors the sales table for deleted rows. When a row is deleted, the job changes from the EXEC state to the MONITOR state. Each time a row is deleted from the table, the Agent sends the Alert named altr. The job will remain in a MONITOR state until it is forced complete or the Delete Trigger command is issued.

```sql
DB_TRIG DBTRIG1
AGENT DB_AGENT
USER sa
DB_URL jdbc:sqlserver://myhost:1433;DatabaseName=pubs'
TABLE_NAME sales CONTINUOUS(altr)
TRIG_TYPE DELETE
ENDJOB
```
Examples: DB Trigger jobs for IBM DB2

Monitoring an IBM DB2 database table for an added row with a trigger condition

In this example, a Database Trigger job monitors the STAFF table for an added row. When a row is added, the job completes if the total number of rows is greater than or equal to 37.

```
DB_TRIG DBTRIG1
  AGENT DB_AGENT
  USER entadm
  DB_URL jdbc:db2://10.1.4.131:50000/SAMPLE
  TABLE_NAME staff
  TRIG_TYPE INSERT
  TRIG_COND '(select count(*) from STAFF) >= 37'
ENDJOB
```

Monitoring an IBM DB2 database table for changes

In this example, a Database Trigger job monitors the STAFF table for changes to the DEPT and JOB columns. The job completes once DEPT or JOB is updated.

```
DB_TRIG DBTRIG1
  AGENT DB_AGENT
  USER entadm
  DB_URL jdbc:db2://10.1.4.131:50000/SAMPLE
  TABLE_NAME staff
  TRIG_TYPE 'UPDATE of DEPT, JOB'
ENDJOB
```

Agent Specifications tab - DB Monitor

You can define a DB Monitor job to monitor a database table for added rows and deleted rows. To monitor the database table for specific changes, you can add a monitor condition to the job definition. When the condition is met, the job completes. You can set up continuous monitoring so that each time a database change occurs, ESP Workload Manager triggers an Alert or an Event. For continuous monitoring, the job state changes to MONITOR and remains in MONITOR until it is forced complete or the Delete Monitor command is issued.
DB Monitor jobs only monitor for added and deleted rows while DB Trigger jobs also allow you to monitor a database for changes to rows and to specify conditions for those changes.

Agent name
The name of the Agent where the job is to run.

DB User
The database user ID the job runs under, for example USER jsmith. Every database user ID specified in a job definition must have a corresponding userID and password pair defined using the PASSWORD command.

Oracle DB user type
The type of Oracle user. This field applies to Oracle databases only.

In Oracle, a user with sufficient authority can log in with different system privileges. For example, if a job requires sysdba privileges, use the following statement:

'as sysdba'

DB URL
The database resource location. ESP Agent uses JDBC to connect to the database.

- For an Oracle database, use the following format:
  
  jdbc:oracle:thin:@<host>:<port>:<dbname>
• For a Microsoft SQL Server database, use the following format:
  'jdbc:sqlserver://<host>:<port>;DatabaseName=<dbname>'

• For an IBM DB2 database, use the following format:
  jdbc:db2://<host>:<port>/<dbname>

**Table name**
Name of the table to monitor

**Monitor type**
Type of database change to monitor. Select INCREASE, DECREASE, or INCREASE OR DECREASE. In the procedure text, these types appear as I for INCREASE, D for DECREASE, or ID for INCREASE OR DECREASE.

**Monitor condition**
Monitor condition. This condition is equivalent to an SQL where clause.

**Alert or Event ID**
Enter an Alert or Event ID to trigger when the specified conditions are met.

**Example: Continuously monitoring a database table for added rows**
In this example, a Database Monitor job continuously monitors the emp table for an increase in the number of rows. When a new row has a sal greater than 100000, the Agent triggers an Event. The job remains in a MONITOR state until it is forced complete or the Delete Monitor command is issued.

```
DB_MON DBMON1
  AGENT DB_AGENT
  TABLE_NAME emp CONTINUOUS(high)
  MON_TYPE I
  MON_COND sal>100000
ENDJOB
```

This syntax in this example applies to Oracle, Microsoft SQL Server, and IBM DB2 databases.

**Example: Monitoring a database table for added or deleted rows**
In this example, a Database Monitor job monitors the STAFF table for a change in the number of rows. If the added or deleted row has the name Jonson, the job completes.

```
DB_MON DBMON1
  AGENT DB_AGENT
  TABLE_NAME staff
  MON_TYPE ID
  MON_COND NAME='Jonson'
ENDJOB
```
This syntax in this example applies to Oracle, Microsoft SQL Server, and IBM DB2 databases.

Monitor Workload Objects

You can specify workload defaults and details for all the monitor objects. You require Release 6 or higher of ESP Workload Manager Agents. The Monitor icon has a pop-up menu containing the different jobs you can schedule. The operating systems supported are Windows and UNIX. This functionality, by its nature, is operating system specific.

Monitor Defaults

To set global defaults for a monitor workload object
On the Workload Editor menu bar, select Options > Global Defaults > Job > Monitoring Objects > select the monitor you require.

To set job defaults for a monitor workload object
On the Workload Editor menu bar, select Options > Job Defaults > Monitoring Objects > select the monitor you require.

The Agent Specifications, Notification, Resources, and Free Format Text dialogs appear. These are the defaults available for all the monitors, at the global and job level. They are documented on the following pages:

- “Agent Specifications tab - Windows Event Log Monitoring” on page 280
- “Agent Specifications tab - Process Monitoring” on page 283
- “Agent Specifications tab - Service Monitoring” on page 286
- “Agent Specifications tab - Text File Reading and Monitoring” on page 288
- “Agent Specifications tab - IP Monitoring” on page 293
- “Agent Specifications tab - CPU Monitoring” on page 294
- “Agent Specifications tab - Disk Monitoring” on page 298
- “Notification tab” on page 125
- “Resources tab” on page 128
- “Free Format Text tab” on page 88
Monitor Details

Before you can specify details for a monitor object, you must have an icon representing the monitor job type on the workspace.

To specify job details for a monitor workload object

1. On the workspace, right-click the monitor job type icon. A shortcut menu appears.
2. On the shortcut menu, click Job Details.

The Job Details dialog appears. By default, the Name field shows the job type name and a number. The icons dropped on the workspace are numbered sequentially by job type until you optionally rename them.

All the available job detail tabs are documented on the following pages:

- “General tab” on page 96
- “Agent Specifications tab - Windows Event Log Monitoring” on page 280
- “Agent Specifications tab - Process Monitoring” on page 283
- “Agent Specifications tab - Service Monitoring” on page 286
- “Agent Specifications tab - Text File Reading and Monitoring” on page 288
- “Agent Specifications tab - IP Monitoring” on page 293
- “Agent Specifications tab - CPU Monitoring” on page 294
- “Agent Specifications tab - Disk Monitoring” on page 298
- “Send Message tab” on page 106
- “Issue Command tab” on page 108
- “Options tab” on page 110
- “Run Frequency tab” on page 114
- “Time Dependencies tab” on page 120
- “Notification tab” on page 125
- “Resources tab” on page 128
- “Resource Specifications tab” on page 131
- “Free Format Text tab” on page 136
- “Comment tab” on page 140
Windows Event Log monitoring is available with ESP System Agent Release 6 or higher.

The Windows Event Log monitor is designed to monitor the Windows event log on a local machine. This monitor returns the first event available or continuously monitors for events in a particular Windows event log.

Windows 2000 records events in three kinds of logs:

- **Application Log**—The application log contains events logged by applications or programs. For example, a database program might record a file error in the application log.

- **System log**—The system log contains events logged by the Windows 2000 system components. For example, the failure of a driver or other system component to load during startup is recorded in the system log.

- **Security log**—The security log can record security events such as valid and invalid logon attempts, as well as events related to resource use, such as creating, opening or deleting files.

For more information in Windows on what these statements refer to, select **Start > Control Panel > Administrative Tools > Event Viewer**. Select any of the three event categories and double click on any event to view a property page.

**Agent name**
Enter the name of the Agent that is to receive the monitoring.
Job Class
Enter an alpha character to represent the job class this job will run under. This field is optional.

Event Log Name
Enter the name of the event log. The format is case-sensitive, any character, and up to 256 characters in length.

Alert or Event ID
Enter an Alert or Event ID to trigger when the specified conditions are met.

Event Type
Click the down arrow to select the event type to monitor in the event log.

Windows Event ID
Click the down arrow to select a comparison operator, and enter an optional event ID in the adjacent field. The event ID can be up to 10, numeric digits.

Event Source
Enter the source of the event as displayed in the event viewer for the event log. The format is case-sensitive, any character, and up to 256 characters in length.

Computer Name
Enter the name of the local machine where the event log is located. The format is case-sensitive, any character, and up to 256 characters in length.

Event Category
Enter the category of the event as shown in the Windows event viewer. The format is case-sensitive, any character, and up to 4078 characters in length.

Event Description
Enter the description of the event as shown in the event viewer. The format is case-sensitive, any character, and up to 4078 characters in length.

Monitor from date/time
Enter the date and time of the event log. ESP Agent monitors an event log that occurs on or after the specified date and time. The date and time must be in the following format:

YYYYMMDD HH:MM:SS

where
- YYYY — Year
- MM — Month
- DD — Day
- HH — Hour
- MM — Minute
- SS — Second
**Note:** The Monitor from date/time feature works with ESP System Agent Release 7 only.

**Example: Monitoring a system event log**

In this example, a system event log is monitored for an event type of WARN, event source of LLDSAPNT223, and event category of None.

Example: Monitoring a security log for audit failure events

The following Windows Event Log Monitoring job monitors a security log for audit failure events that have IDs greater than or equal to 500. When it finds such an event, the job completes successfully.

Example: Monitoring an application log that occurs on or after a specified date

The following Windows Event Log Monitoring job monitors an application log that occurs any time on or after September 1, 2006. To specify a date only, you must enter zeros in place of the time. When it finds such an event, the job completes successfully.
You can define a Process Monitoring job to monitor for a process status on the machine where ESP Agent is installed. The monitor can either check for a process status and return it immediately, or it can wait until the process has reached the specified status. Process monitoring is designed to monitor for process execution on a local machine.

**Dependency:**
- ESP System Agent Release 6 or higher
- ESP System Agent for i5/OS, Release 7

**Agent name**
Enter the name of the Agent that is to receive the monitoring.

**Job Class**
Enter an alpha character to represent the job class this job will run under. This field is optional.

For more information, refer to the JOBCLASS statement in the *ESP System Agent Guide to Scheduling Workload*.

**Process**
Enter the name of the process to be monitored.

For more information, refer to the PROCESS statement in the *ESP System Agent Guide to Scheduling Workload*.

**On UNIX**
Specify *processname* using a PID or a process name. *processname* can contain any character and can be up to 256 characters long. The format is case sensitive.
On Windows
Specify *processname* using a full path or a process name. *processname* can contain any character and can be up to 256 characters long. The format is case sensitive.

On i5/OS
Use the following format to specify *processname*:

\[
\text{jobid}/\text{username}/\text{jobname}
\]

where

- *jobid* is the six-digit job ID or *ALL.*
- *username* is the user ID the job runs under and can be up to 10 characters long. *username* can also be a generic name or *ALL.*
- *jobname* is the job name on the i5/OS system and can be up to 10 characters long. *jobname* can also be a generic name or *ALL.*

**Status**
Specifies the status of the process. When the specified condition is met, the statement can execute:

- **Running**—Select this option to indicate the monitored item is running.
- **Stopped**—Select this option to indicate the monitored item is stopped.
- **Wait**—Select this option to indicate
  - Checked = WAIT—The job will monitor the Agent and WAIT until it detects the process being monitored. Once it detects the process, the defined action occurs.
  - Cleared = NOW—The NOW state is used in conjunction with the running and stopped conditions. For example, the job will monitor the Agent and when the process has a status of stopped_now, the defined action occurs.

For more information, refer to the STATUS statement in the *ESP System Agent Guide to Scheduling Workload.*

**Example: Monitoring the ESP Agent process**
In this example, the process cybAgent.exe is monitored for a status of RUNNING_NOW. If the process is running, the job continues monitoring the process until it stops. When the process stops, the job completes successfully.
Example: Monitoring process cybAgent
In this example, ESP Agent monitors the CYBAGENT process. If the CYBAGENT process is running, the jobs listed in the RELEASE statement are released for execution.

```
PROCESS_MON PROCESS2.STMNT
   AGENT I5AGENT
   PROCESS '123456/CYBESPU/CYBAGENT'
   STATUS RUNNING NOW
   RELEASE (PRPATH.JOB1,PRPATH.JOB2)
   RUN DAILY
ENDJOB
```

Example: Monitoring a process that has any job number and is running under any user name
In this example, ESP Agent monitors for any process named CYBAGENT, regardless of the first part (job number) and the second part (user name) of the process ID. The job completes successfully if at least one process named CYBAGENT is running. Note that the entire process ID is enclosed in single quotation marks so that the text following /* is not interpreted as a comment.

```
PROCESS_MON CHKPROC2
   AGENT I5AGENT
   PROCESS '*ALL*AND/CYBAGENT'
   STATUS RUNNING NOW
   RUN DAILY
ENDJOB
```

Example: Monitoring multiple processes that have similar names
In this example, ESP Agent monitors all processes running under the JDOE user profile and whose names start with CALC. When all of these processes stop running, the job completes successfully.

```
PROCESS_MON CALMON
   AGENT I5AGENT
   PROCESS '*ALL/JDOE/CALC*'
   STATUS STOPPED WAIT
   RUN DAILY
ENDJOB
```
Service monitoring is available with ESP System Agent Release 6 or higher. The Service monitor is designed to monitor Windows Services on a local Windows machine against specified criteria.

**Agent name**
Enter the name of the Agent that is to receive the monitoring.

**Job Class**
Enter an alpha character to represent the job class this job will run under. This field is optional.

For more information, refer to the JOBCLASS statement in the *ESP System Agent Guide to Scheduling Workload.*

**Service Name**
Enter the name of the service to be monitored. The name can be specified as a full path statement or as a program name. The format is case-sensitive, any character, and up to 256 characters in length.

**Status**
Specifies the status of the service. When the specified condition is met, the statement can execute:

- **Running**—Select this button to indicate the monitored item is running.
- **Stopped**—Select this button to indicate the monitored item is stopped.
- **Continue Pending**—Select this button to indicate the monitored item is in continue pending state.
• **Pause Pending**—Select this button to indicate the monitored item is in pause pending state.

• **Paused**—Select this button to indicate the monitored item is paused.

• **Start Pending**—Select this button to indicate the monitored item is starting.

• **Stop Pending**—Select this button to indicate the monitored item is stopping.

• **Exists**—Select this button to indicate the monitored item exists.

• **Not Exists**—Select this button to indicate the monitored item does not exist.

• **Wait**—This is an additional state you can assign to the monitored service. Use the Wait check box to indicate whether the job should complete immediately, based on the current status of the Service or whether the job should continuously monitor the Service until the specified status is achieved.

  • Checked = WAIT—The job will monitor the Agent and wait until it detects the service being monitored. Once it detects the service, the defined action occurs.

  • Cleared = NOW—Indicates the conditions are verified immediately and the job is triggered if the conditions are met.

**Example: Monitoring a service for a particular status**

In this example, the service ESP Espresso is monitored for a status of CONTINUE_PENDING.
Agent Specifications tab - Text File Reading and Monitoring

Dependency:

• For UNIX and Windows systems, text file monitoring is available with ESP System Agent Release 6 or higher.

• For i5 systems, text file monitoring is available with ESP System Agent for i5/OS, Release 7.

The Text File monitor is designed to monitor the contents of a text file on a Windows machine to search for a text string. Based upon the specified operands, the Text File monitor controls the execution of a job. A typical application of this monitor would be to monitor for an error message in a log file after execution of a script.

**Agent name**
Enter the name of the Agent that is to receive the monitoring.

**Job Class**
Enter an alpha character to represent the job class this job will run under. This field is optional.

For more information, refer to the JOBCLASS statement in the ESP System Agent Guide to Scheduling Workload.

**Log Name**

**Filename**
Enter the name and location (path) of the text file that is searched for a text string. The format is case-sensitive, any character, and up to 256 characters in length. If a blank character is used in a path statement, the entire statement must be enclosed in single quotes, for example ‘C:\Program Files\Cybermation\R6 Agent’
For more information, refer to the TEXTFILE statement in the ESP System Agent Guide to Scheduling Workload.

**Alert or Event ID**
Enter an Alert or Event ID to trigger when the specified conditions are met.

**Exists**
This field contains a three state check box:

- A check box with a check mark indicates the EXIST option is enabled. The EXIST option appears in the right-hand pane. EXIST means, monitor a specified text file to see if a text string exists. If the text string exists, the job completes.

- A check box without a check mark indicates the NOTEXIST option is enabled. The NOTEXIST option appears in the right-hand pane. NOTEXIST means, monitor a specified text file to see if a text string does not exist. If the text string does not exist, the job completes.

- A grayed out check box with a check mark indicates the option is ignored. No form of the EXIST option appears in the right-hand pane.

**Text string to look for**
Specifies what text to look for. The format is case-sensitive, any character, and up to 1022 characters in length.

For more information, refer to the TEXTSTRING statement in the ESP System Agent Guide to Scheduling Workload.

**Search Mode**
Specifies the range in which a Text monitor job will search for a text string, using a search boundary type of line, regular expression or date and time. Select one of the following search modes:

- Line — Select this button to search for the text string in the line boundaries defined by the First Line and Last Line fields. If Line is selected, the search boundaries are numeric.

- Regex — Select this button to search for a text string within boundaries defined by a regular expression. If Regex is selected, the search boundaries must be regular expressions.

- Date/Time — Select this button to search for a text string within boundaries defined by a specified date and time. If Date/Time is selected, then the use of the Time Format field is mandatory. The search boundaries are a time pattern.

For more information, refer to the SEARCHRANGE statement in the ESP System Agent Guide to Scheduling Workload.

**First Line**
Specifies the start (from) of the range to be searched. The format is case-sensitive, any character, and up to 256 characters in length.
**Last Line**
Specifies the end (to) of the range to be searched. The format is case-sensitive, any character, and up to 256 characters in length.

**Time Format**
Specifies the mask that is used to search a log file with a time stamp. This defines the upper and lower boundaries of the time format as a time pattern. The format is case-sensitive, any character, and up to 256 characters in length.

For more information, refer to the TIMEFORMAT statement in the ESP System Agent Guide to Scheduling Workload.

**Usage notes**
To specify the time format, you have to construct a time pattern string that is used as a mask for searching out the particular time stamp that you want to find. In this pattern, all ASCII letters are reserved as pattern letters. The following table shows the symbols that can be specified. Examples are shown in “Sample time format patterns” on page 291.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Definition</th>
<th>Type</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>G</td>
<td>era designator</td>
<td>Text</td>
<td>AD</td>
</tr>
<tr>
<td>y</td>
<td>year</td>
<td>Number</td>
<td>2000</td>
</tr>
<tr>
<td>M</td>
<td>Month in year</td>
<td>Text &amp; Number</td>
<td>July 07</td>
</tr>
<tr>
<td>d</td>
<td>Day in month</td>
<td>Number</td>
<td>10</td>
</tr>
<tr>
<td>h</td>
<td>Hour in am/pm (1 ~ 12)</td>
<td>Number</td>
<td>12</td>
</tr>
<tr>
<td>H</td>
<td>Hour in day (0 ~ 23)</td>
<td>Number</td>
<td>0</td>
</tr>
<tr>
<td>m</td>
<td>Minute in hour</td>
<td>Number</td>
<td>30</td>
</tr>
<tr>
<td>s</td>
<td>Second in minute</td>
<td>Number</td>
<td>55</td>
</tr>
<tr>
<td>S</td>
<td>Millisecond</td>
<td>Number</td>
<td>978</td>
</tr>
<tr>
<td>E</td>
<td>Day in week</td>
<td>Text</td>
<td>Tuesday</td>
</tr>
<tr>
<td>D</td>
<td>Day in year</td>
<td>Number</td>
<td>189</td>
</tr>
<tr>
<td>F</td>
<td>Day of week in month</td>
<td>Number</td>
<td>2 (2nd Wednesday July)</td>
</tr>
<tr>
<td>w</td>
<td>Week in year</td>
<td>Number</td>
<td>27</td>
</tr>
<tr>
<td>W</td>
<td>Week in month</td>
<td>Number</td>
<td>2</td>
</tr>
<tr>
<td>a</td>
<td>am/pm marker</td>
<td>Text</td>
<td>PM</td>
</tr>
<tr>
<td>k</td>
<td>Hour in day (1 ~ 24)</td>
<td>Number</td>
<td>24</td>
</tr>
<tr>
<td>K</td>
<td>Hour in am/pm (0 ~ 11)</td>
<td>Number</td>
<td>0</td>
</tr>
<tr>
<td>z</td>
<td>Time zone</td>
<td>Text</td>
<td>EST—Eastern Standard Time</td>
</tr>
<tr>
<td>‘</td>
<td>Escape for text</td>
<td>Delimiter</td>
<td></td>
</tr>
<tr>
<td>“’</td>
<td>Single quote</td>
<td>Literal</td>
<td>‘</td>
</tr>
</tbody>
</table>
Sample time format patterns

In these samples, the baseline is July 10, 2000 at 12:08 PM, Eastern Standard Time.

<table>
<thead>
<tr>
<th>Format Pattern</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;yyyy.MM.dd G 'at' hh:mm:ss z&quot;</td>
<td>2000.07.10 AD at 12:08:56 EST</td>
</tr>
<tr>
<td>&quot;EEE, MMM d, &quot;yy&quot;</td>
<td>Wed, July 10, '97</td>
</tr>
<tr>
<td>&quot;h:mm a&quot;</td>
<td>12:08 PM</td>
</tr>
<tr>
<td>&quot;hh 'o'clock' a, zzzz&quot;</td>
<td>12 o'clock PM, EST</td>
</tr>
<tr>
<td>&quot;K:mm a, z&quot;</td>
<td>12:08 PM, EST</td>
</tr>
<tr>
<td>&quot;yyyyy.MMMMMM.dd GGG hh:mm aaa&quot;</td>
<td>2000.July.10 AD 12:08 PM</td>
</tr>
</tbody>
</table>

**Time pos**

Specifies the first column of the time stamp in the log file. The format is numeric, up to five digits.

For more information, refer to the TIMEFORMAT statement in the ESP System Agent Guide to Scheduling Workload.

**Example**

```
TEXT_MON
TEXT_MON
AGENT.restaurant
JOBCLASS A
EXISTING log file=EXIST
TEXTFILE c:\program files\cybermediationsp-system -
agent\agentparms.Z
SEARCH RANGE FROM 1 TO (100) LINE
RUN DAILY
ENDJOB
```

**Example: Monitoring a file for a string in the first 200 lines of the file**

In this example, an Application contains a Text File Reading and Monitoring job and a UNIX job. If the Text File Reading and Monitoring job completes successfully, the UNIX job is released.
The Text File Reading and Monitoring job monitors a file called log.txt and searches for the string “ERROR” in the first 200 lines of the file. If there is no “ERROR” in the log file (the job does not find the string “ERROR”), the job completes successfully and the UNIX job is released. If there is an “ERROR” in the log file (the job finds the string “ERROR”), the job fails and the UNIX job is not released.

Example: Searching for a text string

In this example, the job searches the DATA member, between lines 1 and 20, for the text string "Create file failed". When the text string is found, ESP Agent issues an Alert named A123. The job monitors for the text string continuously, so the job continues to search in the lines added to the file after the first match was found.
The IP Monitoring job is designed to monitor an IP address or a port on a specified IP address.

**Dependency:**
- For UNIX and Windows systems, IP monitoring is available with ESP System Agent Release 6 or higher.
- For i5 systems, IP monitoring is available with ESP System Agent for i5/OS, Release 7.

**Agent name**
Enter the name of the Agent that is to receive the monitoring.

**Job Class**
Enter an alpha character to represent the job class this job will run under. This field is optional.

For more information, refer to the JOBCLASS statement in the *ESP System Agent Guide to Scheduling Workload*.

**IP Address**
Enter the IP address that will be monitored. This can be the DNS name or dotted decimal IP address. The format is case-sensitive, any character, up to 100 characters long.

**IP Port**
Enter the port number for the IP address specified in the IP Address field. This is the port the Agent will attempt to connect to. The format is numeric, up to five digits. This is an optional field.
Status
Specifies the status of the IP address/port. When the specified condition is met, the statement can execute:

- Running—Select this button to indicate the monitored item is running.
- Stopped—Select this button to indicate the monitored item is stopped.
- Wait—This is a 3 state check box:
  1. Cleared—NOW (This is an additional state you can assign to the monitored IP address. This is used in conjunction with running and stopped.)
  2. Checked—WAIT (This is an additional state you can assign to the monitored IP address. The job will monitor the Agent and wait until it detects the IP address being monitored. Once it detects the IP address, the defined action occurs.)
  3. Grayed—IGNORED

Example: Monitoring a device at a specific IP address and port number
The following IP Monitoring job monitors a device at IP address 11.11.11.11 and port number 22. If the device is currently running, the job completed successfully.

Agent Specifications tab - CPU Monitoring
You can monitor the CPU usage of the machine where ESP Agent is installed using the CPU Monitoring job. The job can return the result either immediately or wait for the specified device to reach an active or inactive state.

**Dependency:**

- For UNIX and Windows systems, CPU monitoring is available with ESP System Agent Release 6 or higher.
- For i5 systems, CPU monitoring is available with ESP System Agent for i5/OS, Release 7.

**Agent name**
Enter the name of the Agent on which the action is to take place.

**Job Class**
Enter an alpha character to represent the job class this job will run under. This field is optional.

For more information, refer to the JOBCLASS statement in the *ESP System Agent Guide to Scheduling Workload*.

**Alert or Event ID**
Enter an Alert or Event ID to trigger when the specified conditions are met.

**CPU**
For more information about the fields in the CPU section, refer to the CPU statement in the *ESP System Agent Guide to Scheduling Workload*.

**From**
Specifies the lower boundary of CPU utilization in percent.

**To**
Specifies the upper boundary of CPU utilization in percent.

**No change**
Indicates the monitor will not trigger if the value change is within the value in percent. This field is optional.

**Within**
Select to indicate the monitor is triggered when the value is inside the boundaries specified in the From and To fields.

**Outside**
Select to indicate the monitor is triggered when the value is outside the boundaries specified in the From and To fields.

**Available**
Select to indicate the monitor takes the available CPU capacity as the reading.

**Used**
Select to indicate the monitor takes the used CPU capacity as the reading.
Example

The CPU monitoring job in this example triggers an Alert when the available CPU is less than 25 percent or greater than 75 percent. Subsequent Alerts trigger when the CPU usage changes by more than 10 percent.
<table>
<thead>
<tr>
<th>Time</th>
<th>CPU</th>
<th>Is the Alert triggered? (Yes or No)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>When No Change is not specified</td>
</tr>
<tr>
<td>14:00:01</td>
<td>25%</td>
<td>No</td>
</tr>
<tr>
<td>14:00:02</td>
<td>20%</td>
<td>Yes</td>
</tr>
<tr>
<td>14:00:03</td>
<td>19%</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>No</td>
</tr>
</tbody>
</table>
|         |      | Available CPU is below 25%          | Available CPU remains below 25%, but the change from the last reading is only 1%.
| 14:00:04 | 8%   | Yes                                 | Available CPU is below 25% |
| 14:00:05 | 19%  | Yes                                 | Available CPU is below 25% |
|         |      | Yes                                 | Yes |
|         |      | CPU usage has changed 12% from the last time the Alert was triggered. |
| 14:00:06 | 32%  | No                                  | Available CPU must be below 25% or above 75% |
|         |      | No                                  | No |
|         |      | Available CPU changed by more than 10%, it no longer falls within the range defined by the From and To fields. It is not below 25% or above 75%. |
Disk monitoring is designed to monitor attributes of the amount of space used on a specified disk (or logical partition).

**Note:** On i5 systems, you can use the disk monitoring job to monitor storage space in the file systems mounted on the i5 system. You can specify a variety of conditions to monitor, including available or used space expressed in kilobytes, megabytes, gigabytes or as a percentage. The storage space can be monitored for a change amount (a delta). You can limit the delta by a "no change" amount so that if the change is within the no change amount, no status is reported.

**Dependency:**
- For UNIX and Windows systems, disk monitoring is available with ESP System Agent Release 6 or higher.
- For i5 systems, disk monitoring is available with ESP System Agent for i5/OS, Release 7.

**Agent name**
Enter the name of the Agent that is to receive the monitoring.

**Job Class**
Enter an alpha character to represent the job class this job will run under. This field is optional.

**Drive**
Enter the path to the disk or logical partition to be monitored.
Alert or Event ID
Enter an Alert or Event ID to trigger when the specified conditions are met.

**Hint:** Use the **No change** field to further refine your criteria, reducing the number of times the Event is triggered. The first time the available or used disk space matches the criteria, the Event is triggered. Afterwards, the Event is triggered only if the change in disk space available/used is greater than the amount defined in the **No change** field.

**From**
Specifies the lower boundary of space used. The units for this field are determined by the value in the **Format** field.

**To**
Specifies the upper boundary of space used. The units for this field are determined by the value in the **Format** field.

**No change**
Indicates the monitor will not trigger if the value change is within the number specified. The units for this field are determined by the value in the **Format** field.

**Format**
Click the **down arrow** to select the format of disk space used:
- Percent—percentage of disk space used. The associated fields From, To, and No change cannot add up to more than 100 percent.
- GB—Gigabytes of disk space used
- MB—Megabytes of disk space used
- KB—Kilobytes of disk space used
- B—Bytes of disk space used

**Within**
Select to indicate the monitor is triggered when the value is inside the boundaries specified in the From and To fields.

**Outside**
Select to indicate the monitor is triggered when the value is outside the boundaries specified in the From and To fields.

**Available**
Select to indicate the monitor uses the available space as the reading.

**Used**
Select to indicate the monitor uses the used space as the reading.
Example
In this example, the local C drive is continuously monitored. The space used is monitored and the value is expressed as a percentage. When the value for disk space used falls between 90 and 100 percent, an alert (DISK) is processed and its associated Event is triggered.

Example: Monitoring the system auxiliary storage pool (ASP)
In this example, ESP Agent monitors the system ASP. In the DISK statement, the space available is monitored and the value is expressed in megabytes. The system ASP is denoted by the forward slash (/). You can also specify the system ASP as /dev/QASP01.

DISK_MON DM1_STMTNT
AGENT i5AGENT
DISK '/ ' FORMAT(MB) USED
ENDJOB

Example: Continuously monitoring the system ASP for a storage space value within a range
In this example, ESP Agent continuously monitors the auxiliary storage pool (ASP) named QASP02. The space used is monitored and the value is expressed as a percentage. When 90 to 100 percent of the storage space is used, an Alert named DISK is issued.

Alternatively, if an Event name is specified, the Event is triggered when 90 to 100 percent of the storage space is used.

DISK_MON DM2_STMTNT
AGENT i5AGENT
DISK '/dev/QASP02' FROM(90) TO(100) CONTINUOUS(DISK) FORMAT(+ PERCENT) WITHIN USED
RUN DAILY
ENDJOB

Example: Continuously monitoring a mounted file system for a storage space value outside of a range
In this example, ESP Agent continuously monitors an NFS server mounted at /u1. The space used is monitored and the value is expressed as a percentage. When the value of storage space used is less than 16 percent or greater than 95 percent, an Alert named DISK is issued.
You can specify workload defaults and details for J2EE job types. You require Release 6 Service Pack 2 of ESP Workload Manager Agents. The J2EE icon has a pop-up menu containing the following job types you can schedule:

- EJB
- JMS Publish
- JMS Subscribe

### J2EE Defaults

**To set global defaults for a J2EE workload object**

On the Workload Editor menu bar, select **Options > Global Defaults > Job > J2EE** and choose the J2EE job type you require.

**To set job defaults for a J2EE workload object**

On the Workload Editor menu bar, select **Options > Job Defaults > J2EE** and choose the J2EE job type you require.

The Agent Specifications, Notification, Resources, and Free Format Text dialogs appear. These are the defaults available for all the J2EE job types at the global and job level. They are documented on the following pages:

- “Agent Specifications tab - J2EE EJB” on page 303
- “Agent Specifications tab - J2EE JMS Publish” on page 305
- “Agent Specifications tab - J2EE JMS Subscribe” on page 308
- “Notification tab” on page 125
- “Resources tab” on page 128
- “Free Format Text tab” on page 88

### J2EE Details

Before you can specify details for a J2EE job type, you must have an icon representing the job type on the workspace.
To specify job details for a J2EE workload object

1. On the workspace, right-click the J2EE job type icon. A shortcut menu appears.

2. On the shortcut menu, click **Job Details**.
   The Job Details dialog appears. By default, the Name field shows the job type name and a number. The icons dropped on the workspace are numbered sequentially by job type until you optionally rename them.

All the available job detail tabs are documented on the following pages:

- “General tab” on page 96
- “Agent Specifications tab - J2EE EJB” on page 303
- “Agent Specifications tab - J2EE JMS Publish” on page 305
- “Agent Specifications tab - J2EE JMS Subscribe” on page 308
- “Send Message tab” on page 106
- “Issue Command tab” on page 108
- “Options tab” on page 110
- “Run Frequency tab” on page 114
- “Time Dependencies tab” on page 120
- “Notification tab” on page 125
- “Resources tab” on page 128
- “Resource Specifications tab” on page 131
- “Free Format Text tab” on page 136
- “Comment tab” on page 140
About the J2EE EJB job type

The EJB job type allows you to access a stateless Enterprise Java Bean (EJB). An EJB contains business logic that has a related externalized interface (Method). You can use this job type to make a Remote Procedure Call (RPC) to the EJB, invoke the Method, and have the results returned.

Related documentation

For more information on scheduling EJB workload, see the Guide to Scheduling Workload, ESP System Agent, Version 6 Service Pack 2.

For more information on any job definition statement used within an EJB workload object, see the ESP Workload Manager Reference Guide.

Hint: Click F1 in any field for Help information specific to that field.

The following fields are mandatory except where optional is indicated.

Agent name
Enter the name of the Agent where the job is to run.
**User ID**
Enter the Java Naming and Directory Interface (JNDI) user ID. This user ID refers to the Application Server within the JNDI framework. If specified, this authentication information is supplied when creating the initial context. This field is optional.

**Job Class**
Enter an alpha character to represent the job class this job will run under. This field is optional.

**Initial context factory**
Enter or use the down arrow to specify the Initial Context Factory to use when creating the initial context. The initial context is required within the JNDI framework. The Initial Context Factory is supplied by a specific provider of the naming and directory service. The factory is responsible for acquiring an arbitrary initial context the application can use.

**Provider URL**
Enter or use the down arrow to indicate the Service Provider URL using dotted-decimal notation or the DNS name. The Service Provider implements a context or initial context. This context can be plugged in dynamically to the JNDI architecture the JNDI client USES.

**Bean name**
Enter or use the down arrow to specify the Stateless Session Bean JNDI name.

**Method name**
Enter or use the down arrow to specify the EJB Method to be invoked remotely.

**Type**
Enter the EJB Method type to be invoked.

**Value**
Enter the EJB Method value to be invoked.

**Output destination**
Enter or use the down arrow to specify the output destination file of the EJB response. This field is optional.
Example

In this example, the EJB1 job remotely invokes the CybEJBTestBean Stateless Session Bean reverse method. The reverse method has one parameter: a java.lang.String object with the value a23. The output from the reverse method is saved to the file Makapt15.txt. The Service Provider is located at iiop://100.10.31.66:2809, where 100.10.31.66 is the IP address of the WebSphere Application server and 2809 is the ORB port.

Agent Specifications tab - J2EE JMS Publish
About the J2EE JMS Publish job type

The Java Messaging Service (JMS) Publish job type allows you to send a message to a Queue or publish a message to a Topic. Using this job type to publish to a Topic, you can broadcast to any Topic subscriber. A third-party client could consume this message or another ESP Workload Manager Application could have a JMS Subscribe job listening for a particular message (using a filter).

Related documentation

For more information on scheduling JMS workload, see the Guide to Scheduling Workload, ESP System Agent, Version 6 Service Pack 2.

For more information on any job definition statement used within a JMS Publish workload object, see the ESP Workload Manager Reference Guide.

Hint: Click F1 in any field for Help information specific to that field.

The following fields are mandatory except where optional is indicated.

**Agent name**
Enter the name of the Agent where the job is to run.

**User ID**
Enter the Java Naming and Directory Interface (JNDI) user ID. This user ID refers to the Application Server within the JNDI framework. If specified, this authentication information is supplied when creating the initial context. This field is optional.

**Job Class**
Enter an alpha character to represent the job class this job will run under. This field is optional.

**Initial context factory**
Enter or use the down arrow to specify the Initial Context Factory to use when creating the initial context. The initial context is required within the JNDI framework. The Initial Context Factory is supplied by a specific provider of the naming and directory service. The factory acquires an arbitrary initial context the application can use.

**Provider URL**
Enter or use the down arrow to indicate the Service Provider URL using dotted-decimal notation or the DNS name. The Service Provider implements a context or initial context. This context can be plugged in dynamically to the JNDI architecture the JNDI client uses.

**Connection factory**
Enter or use the down arrow to specify the Connection Factory JNDI name. The Connection Factory contains all the bindings needed to look up the referenced Topic or Queue. JMS jobs use the Connection Factory to create a connection with the JMS Provider.
**JNDI destination**
Enter or use the down arrow to indicate the JNDI name of the Topic or Queue. The job uses the JNDI name to indicate where messages are sent.

**Message class**
Enter or use the down arrow to specify the JMS Message Java class.

**Destination type**
Enter or use the down arrow to specify whether the Agent publishes to a Topic or a Queue. An “N” represents the field value Queue and a “Y” represents the field value Topic. The word Topic identifies this statement.

**Type**
Enter the Message Java class type.

**Value**
Enter the Message Java class value.

**Example**
In this example, the JMSP1 job publishes the message “this is my message” to the Queue named Queue. The Service Provider is located at iiop://100.10.31.66:2809, where 100.10.31.66 is the IP address of the WebSphere Application server and 2809 is the ORB port.
About the J2EE JMS Subscribe job type

The Java Messaging Service (JMS) Subscribe job type allows the consumption of messages from a Queue or Topic. You can selectively filter all messages against a text string constructed using Regular Expression logic. You can also choose to continuously monitor by defining an alert. Whether the alert is defined or not, the message that meets the filter criteria is sent to a destination file that you designate.

Related documentation

For more information on scheduling JMS workload, see the Guide to Scheduling Workload, ESP System Agent, Version 6 Service Pack 2.

For more information on any job definition statement used within a JMS Subscribe workload object, see the ESP Workload Manager Reference Guide.

Hint: Click F1 in any field for Help information specific to that field.

The following fields are mandatory except where optional is indicated.

Agent name
Enter the name of the Agent where the job is to run.

User ID
Enter the Java Naming and Directory Interface (JNDI) user ID. This user ID refers to the Application Server within the JNDI framework. If specified, this authentication information is supplied when creating the initial context. This field is optional.
Job Class
Enter an alpha character to represent the job class this job will run under. This field is optional.

Initial context factory
Enter or use the down arrow to indicate the Initial Context Factory to use when creating the initial context. The initial context is required within the JNDI framework. The Initial Context Factory is supplied by a specific provider of the naming and directory service. The factory acquires an arbitrary initial context the application can use.

Provider URL
Enter or use the down arrow to indicate the Service Provider URL using dotted-decimal notation or DNS name. The Service Provider implements a context or initial context. This context can be plugged in dynamically to the JNDI architecture the JNDI client uses.

Connection factory
Enter or use the down arrow to specify the Connection Factory JNDI name. The Connection Factory contains all the bindings needed to look up the referenced Topic or Queue. JMS jobs use the Connection Factory to create a connection with the JMS Provider.

JNDI destination
Enter or use the down arrow to indicate the Topic or Queue JNDI name. The job uses the JNDI name to indicate the destination where messages are received.

Filter
Enter or use the down arrow to specify the filter used to monitor the Topic or Queue with Regular Expression logic. This field is optional.

Destination type
Enter or use the down arrow to specify whether the Agent publishes to a Topic or a Queue. An “N” represents the field value Queue and a “Y” represents the field value Topic. The word Topic identifies this statement.

Monitor continuously using
Enter the ESP Workload Manager alert name. When the filter value is detected, ESP Workload Manager invokes the alert. If you specify an alert, the job runs continuously. You must force the job to complete to end the monitoring. If no alert is specified, the job completes when ESP Workload Manager detects the filter value.

Output destination
Enter or use the down arrow to indicate the output destination file of messages from the Topic or Queue. This field is optional.
Example

In this example, the JMSS1 job continuously monitors the Queue named Queue (residing on WebLogic) for messages matching the filter criteria. The consumed messages from the Queue are stored in the file outputfile1. The Service Provider is located at t3://100.10.31.66:7001, where 100.10.31.66 is the IP address of the WebLogic Application server and 7001 is the ORB port.

Oracle Workload Objects

The ESP Business Agent for Oracle E-Business Suite, Release 3 provides an interface between the ESP Workload Manager and the Oracle E-Business Suite. You can schedule workload that runs on Oracle Applications (OA). The Oracle icon has a pop-up menu containing the following job types:

- Single Request
- Request Set

These are the two types of OA workload available. Single Requests have one program while Request Sets have multiple programs.

You can specify workload defaults and details for both OA job types.

Oracle Defaults

To set global defaults for an Oracle workload object

On the Workload Editor menu bar, select Options > Global Defaults > Job > Oracle > and choose the OA job type you require.

To set job defaults for an Oracle workload object

On the Workload Editor menu bar, select Options > Job Defaults > Oracle > and choose the OA job type you require.

The Agent Specifications, Environment Variables, Notification, Resources, and Free Format Text dialogs appear. These are the defaults available for the OA job types at the global and job level. They are documented on the following pages:

- “Agent Specifications tab - Oracle Single Request” on page 312
- “Agent Specifications tab - Oracle Request Set” on page 315
Oracle Details

Before you can specify details for an OA job type, you must have an icon representing the job type on the workspace.

To specify job details for an Oracle workload object

1. On the workspace, right-click the OA job type icon. A shortcut menu appears.
2. On the shortcut menu, click **Job Details**.

   The Job Details dialog appears. By default, the Name field shows the job type name and a number. The icons dropped on the workspace are numbered sequentially by job type until you optionally rename them.

All the available job detail tabs are documented on the following pages:

- “General tab” on page 96
- “Agent Specifications tab - Oracle Single Request” on page 312
- “Agent Specifications tab - Oracle Request Set” on page 315
- “Send Message tab” on page 106
- “Issue Command tab” on page 108
- “Options tab” on page 110
- “Run Frequency tab” on page 114
- “Time Dependencies tab” on page 120
- “Notification tab” on page 125
- “Resources tab” on page 128
- “Resource Specifications tab” on page 131
- “Free Format Text tab” on page 136
- “Comment tab” on page 140
Related documentation
For information on scheduling Oracle workload, see the *Guide to Scheduling Workload, ESP Business Agent for Oracle E-business Suite, Release 3*.

For information on any job definition statement used within an Oracle workload object, see the *ESP Workload Manager Reference Guide*.

**Hint:** Click **F1** in any field for Help information specific to that field.

**Note:** The following fields are mandatory.

**Agent name**
Enter the name of the Oracle Applications Agent where the job is to run.
OA Application Display name or Short name
Enter the name of an Oracle Applications application. Select the radio button to indicate you entered an OA Application Display name or an OA Application Short name. In Oracle Applications, the Application Display name is part of the request definition, and is found in the Application field. In Oracle Applications, the program short name is part of the Single Request definition, and is found in the Short Name field of the Concurrent Programs dialog.

Program name
Enter the short name of an Oracle Applications Single Request program.

Note: The following two fields are not mandatory if they are defined in the Agent parameter file.

User name
Enter the Oracle Applications user name.

Responsibility
Enter an Oracle Applications responsibility name.

Note: The remaining fields on this dialog are optional.

Description
Enter a description of an Oracle Applications Single Request.

Program arguments
Enter argument strings to be passed to an Oracle Applications Single Request. You can list up to 100 arguments, separated by commas. Do not define the arguments in separate statements if the list of arguments contains empty arguments. An empty argument cannot be defined on its own, it can only be defined as part of a list of arguments.

Printer name
Enter the name of a printer for Oracle Applications to use. In Oracle Applications, the printer name is specified as a request definition option, and is found in the Printer column of the Upon Completion dialog.

Print style
Enter an Oracle Applications print style. In Oracle Applications, the print style is specified as a request definition option, and is found in the Style field of the Upon Completion dialog.

Print copies
Enter or use the arrows to indicate the number of copies to print. In Oracle Applications, the number of copies to be printed is specified as a request definition option, and is found in the Copies column of the Upon Completion dialog.

Save output
Click the down arrow to indicate whether to save the output.
**Monitor children**  
Click the down arrow to indicate whether the Agent monitors the children of Oracle Applications programs. Program children are programs that the parent program releases.

**Use arguments defaults**  
Click the down arrow to indicate whether to pass default arguments to Oracle Applications programs.

**Monitor children delay**  
Enter or use the arrows to notify the Agent to wait a set number of seconds after a parent completes before monitoring for children. Program children are programs that the parent program releases.

**Example**

```
DA_JOB GST1
AGENT 'ODS
APPLICATION 'Application Object Library'
USER 'SYSADMIN'
PROGRAM 'FOOPUR
RESPNAME 'System Administrator'
ARGS 'ALL Age1, APPS SYSADMIN, System Administrator FND/FND SOURS++
PRINTER 'tomasonic1/400
PRINTSTYLE PORTRAIT
PRINTCOPES 2
AR(D)EFAULTS No
SAVEOUTPUT Yes
RUN_DAILY
ENDJOB
```
Agent Specifications tab - Oracle Request Set

Related documentation
For information on scheduling Oracle workload, see the *Guide to Scheduling Workload, ESP Business Agent for Oracle E-business Suite, Release 3*.

For information on any job definition statement used within an Oracle workload object, see the *ESP Workload Manager Reference Guide*.

**Hint:** Click F1 in any field for Help information specific to that field.

**Note:** The following fields are mandatory.

**Agent name**
Enter the name of the Oracle Applications Agent where the job is to run.
OA Application Display name or Short name
Enter the name of an Oracle Applications application. Select the radio button to indicate you entered an OA Application Display name or an OA Application Short name. In Oracle Applications, the Application Display name is part of the request definition, and is found in the **Application** field. In Oracle Applications, the Request Set short name is part of the Request Set definition, and is found in the **Set Code** field of the **Request Set** dialog.

Request Set name
Enter the short name of an Oracle Applications Request set.

User name
Enter the Oracle Applications user name.

Responsibility
Enter an Oracle Applications responsibility name.

*Note:* The remaining fields on this dialog are optional.

Printer name
Enter the name of a printer to be used by Oracle Applications. In Oracle Applications, the printer name is specified as a request definition option, and is found in the **Printer** column of the **Upon Completion** dialog.

Print style
Enter an Oracle Applications print style. In Oracle Applications, the print style is specified as a request definition option, and is found in the **Style** field of the **Upon Completion** dialog.

Print copies
Enter or use the arrows to indicate the number of copies to print. In Oracle Applications, the number of copies to be printed is specified as a request definition option, and is found in the **Copies** column of the **Upon Completion** dialog.

Save output
Click the down arrow to indicate whether to save the output.

Monitor children
Click the down arrow to indicate whether the Agent monitors the children of Oracle Applications programs. Program children are programs the parent program releases.

When Monitor children is used in a Request Set, it applies to all of the programs in the Request Set and cannot be set up differently for each program.

Use arguments defaults
Click the down arrow to indicate whether to pass default arguments to Oracle Applications programs.
Monitor children delay
Enter or use the arrows to notify the Agent to wait a set number of seconds after a parent completes before monitoring for children. Program children are programs the parent program releases.

When Monitor children delay is used in a Request Set, it applies to all of the programs in the Request Set and cannot be set up differently for each program.

To add a program argument to a Request Set job
1. Click Add.
   The Program Data dialog appears.
2. In the Program Sequence Number field, enter a number.
3. In the Program Arguments field, enter the arguments. You can list up to 100 arguments, separated by commas. Do not define the arguments in separate statements if the list of arguments contains empty arguments. An empty argument cannot be defined on its own, it can only be defined as part of a list of arguments.
4. Click Add.
5. If required, complete the additional printer fields for the program arguments.
6. Click OK.
   The program argument is added to the Program data list box.

Example

```
OA_JOB OAM1
AGENT CYBOA
APPLDISPLAYNAME 'Oracle Bills of Material'
OAUSER SYSADMIN
REQUESTSET FNDRSSUB29
RESPNAME 'System Administrator'
ARGDEFAULTS No
CHILDMONITOR Yes
PROGRAMDATA 1
PROGARGS 12345,2,,3223,2,,1
PROGRAMDATA 2
PROGARGS 12345,,,1,1755,,-1,,
RUN DAILY
ENDJOB
```
External Workload Objects

There are no workload defaults for the External workload object.

About Externals

An external job is a job defined in an Application that ESP Workload Manager submits from another Application. You can establish relationships between jobs in different Applications.

The EXTERNAL keyword is used as part of a JOB statement to identify to ESP Workload Manager that a job is part of another Application. As long as the Application containing the successor is active at the time the predecessor completes successfully, the required dependency is satisfied.

The Application that submits the job is known as the home Application. The Application where the job is defined as external is known as the distant Application.

When you define an external job:

- You can use different frequencies in the home and distant Application.
- You must use the same qualifier in each Application.
- Use the LAX command in the Workload Director’s Line Mode Interface (LMI) to display external jobs in active Applications.
- View the job details of an External job in Workload Director’s graphical or custom views. The Application ID and schedule criteria is available.

Example: Inter-Application dependency

In this example, ESP Workload Manager submits job X on Fridays, as part of Application APPL1. Job Z in the Application APPL2 waits for job X. The home Application for job X is APPL1; the distant Application for job X is APPL2. Visually, the dependencies look like this:
The Application definition for APPL1 looks like this:

![Diagram of APPL1]

The Application definition for APPL2 looks like this:

![Diagram of APPL2]

When ESP Workload Manager generates APPL2 on Fridays, job Z waits until job X completes in its home Application, APPL1.

**Controlling external jobs**

Under different situations, ESP Workload Manager must decide whether or not it should mark an EXTERNAL job complete. The following are some general rules ESP Workload Manager uses:

- A job defined as EXTERNAL in an Application is normally marked complete by ESP Workload Manager if the job is run manually.
- If more than one generation of an Application is active when an external job ends, ESP Workload Manager posts the job as complete in all active Applications.

Some of the ways you can control how to post external jobs complete are described below.

**Specifying an Application**

When you define an external job, you can use the APPLID operand to specify the name of the Application that submits the job. ESP Workload Manager does not mark the external job complete unless it was submitted by the Application specified. For example, ESP Workload Manager only marks the following job as complete when the job is submitted from the Application called ANOTHER.

```
JOB ABC EXTERNAL APPLID(ANOTHER)
```
**SCHEDULED operand**

You can specify a SCHEDULED operand on a JOB statement to reflect when an external job is scheduled. The Application containing the external does not have to be active when the job in the home Application ends. ESP Workload Manager automatically looks back to see if the dependency has been satisfied.

The job in the example below only gets marked complete when run from another Application with the same scheduled date. This provides synchronization of Applications.

```
JOB ABC EXTERNAL SCHEDULED ('TODAY')
```

The following example shows specifying a range:

```
JOB ABX EXTERNAL SCHEDULED ('NOW LESS 2 HOURS ENDING NOW PLUS 2 HOURS')
```

**Example**

In the following example, ESP Workload Manager is to run two jobs, JOBA and JOBB. ESP Workload Manager cannot release JOBA until it makes sure JOBX is complete. JOBX is an external job that may have run in the past 24 hours or may be scheduled in the next 24 hours.

For information on how ESP Workload Manager resolves external dependencies, see the *ESP Workload Manager Advanced User’s Guide.*
Selecting an External job
1. On the job palette, click the External icon.
2. Select the applicable External job.

The External job works the same for all the different job types except the External Scheduler.

External Details

To specify job details for the External workload object
1. On the workspace, right-click the External icon. A shortcut menu appears.
2. On the shortcut menu, click Job Details.

The Job Details dialog appears. By default, the Name field shows the job type name and a number. The icons dropped on the workspace are numbered sequentially by job type until you optionally rename them.

All the available job detail tabs are documented on the following pages:

- “General tab” on page 96
- “Send Message tab” on page 106
- “Issue Command tab” on page 108
- “Options tab” on page 110
- “Run Frequency tab” on page 114
- “Time Dependencies tab” on page 120
- “Notification tab” on page 125
- “Resources tab” on page 128
- “Resource Specifications tab” on page 131
- “Free Format Text tab” on page 136
- “Comment tab” on page 140
External Scheduler Workload Object

You can specify defaults and details for the External Scheduler workload object. The External Scheduler is represented by the EXTMON icon.

About External Scheduler

The External Scheduler is used to represent an instance of ESP Espresso. The conceptual information explained for external jobs (see “About Externals” on page 318) applies here. The only difference is the external job is being submitted from ESP Espresso.

ESP Workload Manager requires the R5 Agent to schedule workload from ESP Espresso to the job types listed in the External pop-up menu.

For information about submitting jobs from ESP Espresso to ESP Workload Manager and from ESP Espresso to ESP Espresso, see the Integrating Cybermation Scheduling Solutions guide.

Example

In the following example, the EXTERNAL job is used to build a dependency between jobs running in different schedulers. JOBX is submitted from ESP Espresso.

External Scheduler Defaults

To set global defaults for the External Scheduler workload object
On the Workload Editor menu bar, select Options > Global Defaults > Job > External Scheduler.

To set job defaults for the External Scheduler workload object
On the Workload Editor menu bar, select Options > Job Defaults > External Scheduler.
The Agent Specifications, Notification, Resources, and Free Format Text dialogs appear. These are the defaults available for the External Scheduler workload object, at the global and job level. They are documented on the following pages:

- “Agent Specifications tab - External Scheduler” on page 324
- “Notification tab” on page 125
- “Resources tab” on page 128
- “Free Format Text tab” on page 88

**External Scheduler Details**

Before you can specify External Scheduler details, you must have the icon on the workspace.

**To specify job details for the External Scheduler workload object**

1. On the workspace, right-click the **External Scheduler** icon. A shortcut menu appears.
2. On the **shortcut menu**, click **Job Details**. The Job Details dialog appears. By default, the Name field shows the job type name and a number. The icons dropped on the workspace are numbered sequentially by job type until you optionally rename them.

All the available job detail tabs are documented on the following pages:

- “General tab” on page 96
- “Agent Specifications tab - External Scheduler” on page 324
- “Send Message tab” on page 106
- “Issue Command tab” on page 108
- “Options tab” on page 110
- “Run Frequency tab” on page 114
- “Time Dependencies tab” on page 120
- “Notification tab” on page 125
- “Resources tab” on page 128
- “Resource Specifications tab” on page 131
- “Free Format Text tab” on page 136
- “Comment tab” on page 140
Specify Agent

Name
Enter the name of the Agent on which the action is to take place. This must be an R5 Agent.

External Scheduler
Enter the name of the external scheduler. This can be up to 16 characters in length.
Adding Release Conditions to Job Dependencies

ESP Workload Manager releases a job after its predecessor job completes normally; this is the default. You may change this setting so a job can release after the predecessor job completes abnormally, when any predecessor terminates, or when certain release conditions are met.

Workload Editor displays different dependency lines depending on the release condition you specify between jobs. You have four release condition options; each option has a different dependency line type. In the example below, JobE is dependent on a conditional release of JobE. The conditional release is indicated by the thick solid line between JobD and JobE.

To add a release condition

1. In Workload Editor, open the Application.
2. Right-click the dependency line between the two jobs.
3. From the context menu, select Release Condition.
   The Release Condition dialog appears.
4. Choose one of the release condition options.
   • Abnormal completion of the predecessor — Releases the successor job on abnormal termination, including a condition code failure
   • Any completion of the predecessor — Releases the successor job when the predecessor terminates successfully or not
   • Normal completion of the predecessor — Releases the successor job when the predecessor completes normally
• **Conditional Release (Free form)** — Releases the successor job based on a condition such as a predecessor ending with a particular return code or ABEND code.

In the **Conditional Release** text box, enter a COND statement using the RC(x) and SUBNUM(x) parameters. For z/OS jobs, you can also use the RC("xxxx") parameter.

You can use the parameters individually or with any combination using AND/OR. You can also use symbolic variables within your COND statement. You must enclose the symbolic name with quotes, for example '%ESPADAY'.

For more information, see the “RELEASE statement” in the *ESP Workload Manager Reference Guide*.

**Note:** In Workload Director, the Conditional Release option is not supported when you insert a job.

**Example: Adding a conditional release using RC(x)**

In this example, JobA releases JobB when JobA ends with a return code of 2. The following release condition is set between JobA and JobB.
Uploading and Downloading Applications

This section explains how to upload and download your completed Applications.

Uploading an Application

After you save your Application locally, upload it to the mainframe. You must be connected to ESP Workload Manager to upload your Application.

To upload an Application to ESP Workload Manager

1. On the Workload Editor menu bar, select File > Upload Workload Definition. The Upload Procedure Library dialog appears.
   
   Note: An Application is a type of Procedure.

2. In the Name field, enter the name of the data set where you want to store your Procedures and Applications. This data set must have been previously allocated.

3. In the Member field, enter the name of your Application. Your Application will be stored in the data set name and member specified.

4. In the Do not override if member exists field, select this box if a member with the same name already exists, and you don’t want to replace it.

5. In the ESP Workload Manager field, click the arrow to choose the server.

6. Click OK. A confirmation message appears.

7. Click OK. The Application is uploaded.

Downloading an Application

You can download Applications that have been uploaded to the mainframe. You must be connected to ESP Workload Manager to download your Application.

To download an Application to ESP Workload Manager

1. On the Workload Editor menu bar, select File > Download Workload Definition. The Download Procedure Library dialog appears.
   
   Note: An Application is a type of Procedure.

2. In the Name field, select the name of the data set where your Procedures and Applications are stored.

3. In the Member field, enter the name of your Application.

4. In the ESP Workload Manager field, click the arrow to choose the server.
5. Click **OK**. A confirmation message appears.
6. Click **OK**. The Application is downloaded.
This chapter describes the Calendar Manager interface and presents an overview of Calendar Manager concepts and terms. It explains how to create new calendars, modify existing ones, and how to customize holidays and special days.

This section contains the following topics:

• About the Calendar Manager
• Opening the Calendar Manager
• Setting up a New Calendar
• Customizing Holidays and Special Days
About the Calendar Manager

The Calendar Manager component of Workstation is where you can create calendars or view existing calendars. A calendar is a collection of holiday definitions, special days, and special periods that are unique to your installation. Once you have set up a calendar that fits your needs, you can use it when scheduling Events. For more information on invoking Calendars in Events, see “Defining the Additional Options dialog” on page 353.

If you do not have authority to define a calendar and its attributes, check with your system administrator.

When ESP Workload Manager is installed, a calendar called SYSTEM is defined. All Events have READ access to the SYSTEM calendar. ESP Workload Manager is familiar with the standard calendar and its terms.

A calendar identifies workdays, the first day of the week, and the start time for a day. Different groups of users can have their own set of unique holidays, special days, and periods. Even if they choose the same names for a set of special days or periods, the reference only applies to the special day or period in the calendar named in an Event.

In order to work with the Calendar Manager there are some key commands and terms that you should be familiar with.

**CALENDAR command**

You can use the CALENDAR command to specify two additional calendars for an Event. This enables you to schedule Events and jobs in terms that are unique to a calendar. If you do not specify a calendar, ESP Workload Manager uses the calendars assigned by default to the group or user that owns the Event.

ESP Workload Manager merges holiday definitions in all calendars associated with an Event. When special days or periods use the same name in different calendars, ESP Workload Manager uses the first definition it finds. ESP Workload Manager searches in this order:

1. The first calendar you define for the Event or first default calendar.
2. The second calendar you define for the Event or second default calendar.
3. The SYSTEM calendar.

**Default calendar**

When defining holidays, special days, and special periods, indicate the calendar storing the definition. If you do not specify a calendar name, your first default calendar as defined in your user ID entry is used. If you do not have a first default calendar, your second default calendar is used. If you do not have any default calendars defined, the entry automatically goes into the SYSTEM calendar.
SYSTEM calendar

Only global holidays and special days should be stored in the SYSTEM calendar. Department-specific holidays and special days can be stored in as many calendars as required.

Retaining entries

ESP Workload Manager checks for and deletes old entries only when a calendar is updated for other define and delete requests. When more than two days have gone by since holiday and special day entries have occurred, they are automatically deleted unless you specify otherwise using the RETAIN operand at definition time.

Holidays

A holiday is a non-work day with special significance for scheduling at your installation. Holidays are useful for schedule criteria that are difficult to describe with algorithms.

Special days and periods

A special day is a work day with special significance for scheduling at your installation. Special days are useful for schedule criteria that are difficult to describe with algorithms.

A special period is a period of processing with special significance for scheduling at your installation. An example is a fiscal month. A special period can also represent the time between two similarly named special days. Special periods are defined the same way as special days. A set of periods with the same name can occur at regular intervals, such as fiscal year or a trading period. You can also define periods that have irregular intervals and that refer to these special periods when specifying a schedule. A single calendar can contain many different special days and periods.
Opening the Calendar Manager

The Calendar Manager button is located on the Workstation Toolkit.

Open the Calendar Manager using one of these methods
- On the Workstation Toolkit, click the Calendar Manager button.
- On the Workstation Toolkit menu bar, select ESP Tools > Calendar Manager.

The Calendar Manager appears.

Viewing an existing calendar

If there are any calendars already defined for the ESP Workload Manager system you are connected to, they are loaded when you open the Calendar Manager. Calendars are displayed in the left-hand pane, in a tree view. To view a calendar’s definitions, click on a calendar in the left-hand pane.

Refreshing the Calendar Manager

If another user makes calendar modifications while you are working in the Calendar Manager, you may need to refresh your calendar list to see the modifications. To refresh your calendar list, click the Refresh button.
Making changes to an existing calendar

To make changes to an existing calendar
1. In Calendar Manager, select the calendar you want to change.
2. Make the required changes.
3. To store your changes on ESP Workload Manager, click **Upload**.

Refreshing Event schedules

You will need to refresh your Event schedules when you have added a special calendar term to a calendar and the following conditions apply:

- You have used the special calendar term in a scheduled Event.
- You have added an earlier instance of that term.
- You want the next scheduled date of the Event to be rescheduled based on the earlier instance of the term.

To refresh your Event scheduling, use one of the following methods:

- Right-click the calendar and select **Refresh Event Scheduling**.
- Select **Calendar > Refresh Event Scheduling**.

**Note:** To issue the Refresh Event Scheduling command, you must have the authority to create or delete calendars (ALTER access).

**Example: Using the Refresh Event Scheduling command**

Your calendar has a special day called INVENTORY.DAY that occurs on January 31, 2008. You have an Event scheduled for 4pm INVENTORY.DAY. You add another INVENTORY.DAY to the calendar that occurs on November 30, 2007. Because you have added an earlier instance of the INVENTORY.DAY to your calendar, you want to reschedule the Event based on the November 30 INVENTORY.DAY. To reschedule the Event, you issue the **Refresh Event Scheduling** command.
Setting up a New Calendar

To set up a new calendar you create and define required information. You then upload the calendar and customize Holidays and Special Days. For information on Calendar customizations, see “Customizing Holidays and Special Days” on page 336.

Creating a new calendar

There are two ways to create a new calendar. You can create a new calendar with blank fields that you fill in or you can copy and paste an existing calendar and modify the field information as needed.

You require SPECIAL or CALENDARDEF authority in a non-SAF environment to define a calendar. With SAF, you control access to calendars using the CALENDAR.calname resource.

To create a new blank calendar

1. On the Calendar Manager toolbar, click the Create button.

The Calendar dialog appears. Proceed to “Defining basic information” on page 335.

To create a new calendar by copying and pasting

1. In the tree view, click the calendar you want to copy.

The calendar name appears in the Name field.

2. Click the Copy button.

3. Click the Paste button.

An unnamed calendar appears, containing the same field information as the calendar you copied.

4. Modify the field information as needed.
Defining basic information

You must define basic information before you can upload your calendar and customize Holidays and Special Days.

**Name**
The first step in defining a calendar is naming the calendar. In the **Name** field, enter a name for your calendar. This can be up to eight alphanumeric or national characters ($.#.@). The first character must be alphabetic.

**Owner**
Specifies the name of a user ID or group ID containing up to 8 alphanumeric characters. This controls who can alter or delete the calendar. It does not control who can define holidays and special days for the calendar. This applies only if you are using ESP Workload Manager’s internal security. If you leave this field empty, the Owner defaults to your user ID when you upload the calendar.

**Select Calendar Type - Absolute or Logical**
Indicates an Absolute or Logical calendar is to be used. An Absolute calendar is the default and is recommended. With an Absolute calendar, the days begin at midnight. With a Logical calendar, you specify the start time of the day in the Shift by field.

**Shift by**
Indicates the start time of a logical day. If specified, your logical day is shifted forward by the specified time. Enter a time in the **hh:mm** format.

**Select workdays for Calendar**
Specify which days are to be considered workdays.

**First day of week**
Specify the first day of the week.

**Upload**
To upload your calendar, click **Upload**. Your calendar definition is uploaded to ESP Workload Manager, and it appears in the left-hand pane tree view. Also, the Holidays and Special Days tabs appear. You can now define these days for your calendar.

The following is an example of a defined calendar:
Customizing Holidays and Special Days

You can customize new and existing calendars after they have been uploaded.

Defining a holiday

To define a holiday for your calendar, select the Holidays tab after you have uploaded your calendar.

You can define holidays only in the calendar defined as your first default calendar or in calendars you have access to. If you do not have any default calendars defined, the holiday is automatically stored in the SYSTEM calendar.

Enter Name and Date

Name
The first step in defining a holiday is naming the holiday. In the Name field, enter a name for your holiday. This can be up to 16 alphanumeric or national characters ($,#,@), including the underscore.

Start and End
To indicate the starting and ending date of the holiday, click the field with the three dots (ellipsis), to the right of the start and end date fields. A monthly calendar appears. Select the appropriate start dates, then move to the next box and select the appropriate end date. The dates appear in the date fields.

For xx hours
This field indicates the length of the holiday in hours.

Retain Holiday for
Indicates the number of days, weeks or years after each occurrence of the holiday, that you want it to remain on the system for reference. ESP Workload Manager deletes a holiday after its retain count expires. It does this when an update is made to the calendar containing the holiday.

Upload
To upload the defined holidays, click Upload. The holiday appears in the List of Holidays field.
Delete

To delete a single defined holiday, select the holiday in the List of Holidays field. The holiday should be highlighted. Click Delete. The holiday is removed from the list.

To select and delete multiple consecutive days, click the first day, press and hold down the Shift key, click the last day, and then click Delete. The holidays are removed from the list.

To select and delete multiple non-consecutive days, hold down the Ctrl key and click the days, then click Delete. The holidays are removed from the list.

Defining a special day

To define a special day for your calendar, select the Special Days tab after you have uploaded your holidays.

You can only define special days in the calendar defined as your first default calendar or in calendars you have access to. If you do not have any default calendars defined, the special day is automatically stored in the SYSTEM calendar.

Enter Name and Schedule criteria

Name
The first step in defining a special day is naming the special day. In the Name field, enter a name for your special day. This can be up to 16 alphanumeric or national characters ($,#,@), including the underscore.

Once
Indicates the date and time when the special day occurs.
Enabling the **Once** field can also specify the beginning date and time of a single special period. You must specify at least two special periods of the same name so that ESP Workload Manager knows when the first period ends.

The Once field is mutually exclusive with the Repeat field.

**Repeat**

Use this field when specifying multiple special days or regular periods with the same name. It allows you to specify more occurrences of an existing special day or period definition without having to completely redefine them. Specify valid schedule criteria that define when the special day or period should repeat itself (such as “every 15th workday” or “last workday of month”).

The Repeat field is mutually exclusive with the Once field.

**Schedule Criteria**

Enter a date or click the button with the three dots (ellipsis) located to the right of the date field. The Schedule Criteria Editor appears. Enter your schedule criteria in the Schedule Criteria text field at the bottom of the Schedule Criteria Editor. Once you have entered it, you can test your schedule criteria by clicking the Test button. The Test Schedule Criteria dialog appears. (For details on this dialog, see “Testing schedule criteria” on page 377.) Click **Test**. If the results are OK, click **Done**. The Schedule Criteria Editor reappears. Click **OK**.

For information and examples on how to use the Schedule Criteria Editor, see “Schedule Criteria Editor” on page 115.

**Using Calendars**

These fields are only applicable if you enable the Repeat field. Click the **down arrow** to select a calendar name. This name informs ESP Workload Manager where to find the special day or period definitions you are referring to.
Retain Special Day for
Indicates the number of days, weeks or years after each occurrence of the special day or period, that you want it to remain on the system for reference. The default is two days. ESP Workload Manager deletes a special day after its retain count expires. It does this when an update is made to the calendar containing the special day.

Upload
To upload the defined special days, click **Upload**. The Special Day appears in the List of Special Days field.

Delete
To delete a defined special day, select the special day in the List of Special Days field. The special day should be highlighted. Click **Delete**. The special day is removed from the list.

To select and delete multiple consecutive days, click the first day, press and hold down the Shift key, click the last day, and then click **Delete**. The special days are removed from the list.

To select and delete multiple non-consecutive days, hold down the **Ctrl** key and click the days, then click **Delete**. The special days are removed from the list.
This chapter describes the Event Manager interface and presents an overview of Event Manager concepts and terms. It explains how to create, simulate, test, and trigger Events.

This section contains the following topics:

• About the Event Manager
• Displaying Events
• Setting User Profile Options
• Creating an Event
• Simulating an Event
• Testing an Event
• Triggering an Event
About the Event Manager

The Event Manager enables you to create and maintain Events. You control what actions Events perform and when Events are to perform them.

An Event must do one of the following:

- Send a message to other users, an operator console or yourself
- Submit JCL
- Invoke a Procedure or Application (created in the Workload Editor)
- Issue an operating system command

The following tasks can be performed in the Event Manager:

- Create, edit, and delete Event definitions
- List and view Event definitions
- Suspend, resume, hold, and release Event definitions
- Simulate the function of any defined Event
- Display the next scheduled execution of an Event
- Test schedule criteria
- Trigger an Event
- Use a calendar (created in the Calendar Manager)
Displaying Events

To display Events, open and activate the Event Manager. The Event Manager button is located on the Workstation Toolkit.

Open the Event Manager using one of these methods

- On the Workstation Toolkit, click the Event button.
- On the Workstation Toolkit menu bar, select ESP Tools > Event Manager.

The Event Manager appears.

Activating the Event Manager

In the left-hand pane, click the server address. A message appears informing you the calendars and symbolic variable libraries are loading.
Listing Events

1. Connect to ESP Workload Manager.
2. Open Event Manager.
3. To enable the Prefix and Name fields, select the ESP Workload Manager connection.
4. Optional. In the Prefix field, enter your user ID or group ID.
   **Note:** If you leave the Prefix field empty, Event Manager uses the Event default prefix defined in the Event User Profile.
   You can mask the prefix using the asterisk and hyphen as wildcard characters.
   - An asterisk (*) indicates that any character in the asterisk location acts as a match.
   - A hyphen (-) indicates that any character in that or subsequent character positions is considered a match. You can only use the hyphen at the end of a character string.
5. Optional. To narrow your search, in the Name field, enter an Event name.
   You can also mask the Event name using the asterisk and hyphen as wildcard characters.
   **Note:** If you leave the Name field empty, Event Manager lists all Events that match the prefix only.
6. To list the Events, click **List of Events**.

Viewing Event comments

Once you have uploaded an Event to ESP Workload Manager, you can view two types of Event comments: user-defined and system-generated comments. You can add, edit, and delete user-defined comments. The system-generated comments provide information such as overdue Event executions.

**To view Event comments**
1. Open Event Manager.
2. List the Event you want to view.
3. Click the Comments tab.

Viewing Event definitions

1. From the tree view list of Events, select an Event.
2. From the Actions menu, select **View event definition**.
The Event definition appears.

Copy an Event

Copying an Event saves time because it eliminates the process of defining a new Event. Copying is especially useful when you already have an Event doing a similar function.

There are two ways to copy an Event. The first procedure shows you how to change the name of an Event on a system and save it to the same system. The second procedure shows you how to copy an Event from one system to another system.

Copy an Event to the same system

1. From the tree view list of Events, select the Event you want to copy.
   The Event Properties tab for the selected Event appears in the right-hand pane.
2. In the Name field, change the Event’s name.
3. Make any other changes to the Event.
4. Click the Save button.
5. Click the Upload button.
   A confirmation message appears informing you of the new Event’s next scheduled execution time.
   The list of Events refreshes to include the new Event.

Copy an Event from one system to another system

1. Ensure you have two server connections available in the tree view and a list of Events displayed for each server.
2. From the tree view, select the Event you want to copy.
   The Event Properties tab for the selected Event appears in the right-hand pane.
3. From the tree view, right-click the selected Event.
   A short-cut menu appears.
4. From the short-cut menu, click **Copy event definition**.
5. Right-click the destination server, in the above example it is lpara:4515.
6. From the short-cut menu, click **Paste event definition**. ESP Workload Manager adds the copied Event to the Event list.
Setting User Profile Options

The User Profile Options dialog is an area where you can enter information about your work environment. This information will appear in the appropriate fields in the Event Manager.

On the Event Manager menu bar, select **Options > User Profile Options**.

The User Profile Options dialog appears.

**Event default prefix**
This is the prefix used as the first qualifier in an Event name. It specifies the name of a user ID or group ID containing up to 8 alphanumeric characters, including the national characters.

**Specify Calendar(s) to Use**
Enter your calendar name in this field. This is a calendar you defined in the Calendar Manager.

**Select Symbolic Variable Library**
Enter your symbolic-variable-library name or select it from the drop-down list. Symbolic-variable libraries define and store symbolic variables. The symbolic variables will be available to all Events that refer to that symbolic-variable library.
Add
To add the symbolic-variable-library name to the List of Symbolic Variable Libraries box, click Add.

List of Symbolic Variable Libraries
View the selected symbolic-variable libraries in this list box.

Delete
To delete a single list item from the list box, select the list item. Click Delete. The list item is removed from the list.

To select and delete multiple consecutive list items, click the first list item, press and hold down the Shift key, click the last list item, and then click Delete. The list items are removed from the list.

To select and delete multiple non-consecutive list items, hold down the Ctrl key and click the list items, then click Delete. The list items are removed from the list.

Specify JCL Submission Library_Data set name
Enter the data set name where the jobs will be submitted from or select it from the drop-down list. These are jobs that are specified individually in Events or in your Procedures and Applications.

Data set type
Enter the type of data set being submitted or the type the job member is being submitted from. Optionally, select a type from the drop-down list.

Specify Procedure Library_Data set name
Enter the data set name that holds your Procedures and Applications or select it from the drop-down list.

Specify Copy JCL Library_Data set name
Enter the data set name that is to receive the working copy of the JCL or select it from the drop-down list.

Is a GDG
If you are writing the JCL to a Generation Data Group (GDG), select the Is a GDG check box and set a generation number. The Generation field becomes active.

Generation
In order to set information for this field, the Is a GDG check box must be selected. Once the Generation field is active, enter or select the generation number of the data set.

Display in the Graphical View
You can select the variation of a job name you want an Event simulation to display in the graphical view. You can display the job name (name and qualifier), the long name (the job’s alias), or both. If you choose both, the long name appears in brackets beside the job name.
Event Simulation Log

View JCL
To view JCL in the simulation each time you simulate an Event, select the View JCL option. You can override this default setting when you simulate an Event.

View ESP Procedure
To view ESP Procedure code in the simulation each time you simulate, select the View ESP Procedure check box. You can override this default setting when you simulate an Event.
Creating an Event

This section walks you through all the dialogs that comprise the Event Manager’s features. It is not necessary to enter data in all the dialogs to create a new Event.

**Note:** For a quick and streamlined approach to creating a new Event, see “Running your Application” on page 38.

On the Event Manager menu bar, select **New**.

The Event Properties dialog appears.

**Defining the Event Properties dialog**

The first step in defining an Event is naming the Event. Naming an Event establishes its ownership. Not all users have the same authority or access to functions and resources. For information on controlling users’ authority and access, see the *ESP Workload Manager Security Guide*.

An Event name has two parts, a prefix and a name.

**Prefix**

Specifies the name of a user ID or group ID containing up to 8 alphanumeric characters, including the national characters ($, #, @). This prefix must be a prefix you are allowed to use. Your security administrator controls which prefixes you are allowed to use.
Name
Specifies a name that contains up to 16 characters, including the national characters and the underscore. The first character must be alphabetic. Event names must be unique. It is a good idea to give your Event a name related to the function the Event is performing.

Monitor Point
ESP Workload Manager job monitoring is an extension of its job tracking. Through job monitoring, ESP Workload Manager triggers Events automatically when a job reaches a particular stage in processing.

Alert processing is a similar mechanism you can use to instruct ESP Workload Manager to trigger Events automatically. You can use alerts for the different stages of job processing in an Application, such as at submission time, at the end of a job or when a job is resubmitted.

Job monitoring checks at these monitor points:
- Job start
- Step end
- Job end
- Overdue
- Purge
- Post

The following are some of the functions you can do using a job monitor Event or an alert Event:
- Send a message to a user or console
- Automatically start a sub-system
- Restart a standard job by automatically re-submitting it
- Automatically restart a started task following an ABEND
- Activate or deactivate resources by issuing the appropriate commands
- Hold or release jobs or Applications when a sub-system or started task starts or stops

For information on job monitoring and alert processing, see the ESP Workload Manager Advanced User’s Guide.

ESP Class
The CLASS field is used to display and manipulate class queues. When an Event is defined, it can be associated with a particular class. A class is a user-defined string of up to eight characters that can be used to group Events logically together. If a class name is omitted from an Event definition, the Event name prefix is used as the class name.
For information on the CLASS command, see the *ESP Workload Manager Reference Guide*.

**ESP System ID**

In an environment with multiple ESP Workload Manager subsystems, you should use the ESP system ID field to identify the system the Event is to run on. This name is defined in the initialization parameters for ESP Workload Manager. Check with your administrator or use the LSYS command for the correct name to use. The LSYS command can be entered from the Workload Director component of Workstation. Scroll to the right at the bottom of the left-hand pane in Workload Director to reveal the LMI View. Double-click the IP address to receive the command input panel. Enter `LSYS`.

The following example specifies a system identifier of ESPM for the Event PROD.BILLING.

![Event Properties](image)

**Initiator class**

Specifies the Event initiator class. This allows prioritization of Events and workload submission. With SAF, you need READ access to `EVENTINITCLASS.nnn`.

**Owner**

Indicates the owner of the Event. If this parameter is not specified, the last user to modify the Event becomes the owner.

**Hold count**

Displays the current number of hold counts for the Event.

**Suspend count**

Displays the current number of suspend counts for the Event.
Mailbox
Enter a mailbox name. The mailbox becomes the destination for messages coming from Events or from the Notification dialog. When a new message arrives in a mailbox, it is distributed to all defined subscribers. Subscriptions are supported for TSO users and email addresses. For information on how to define subscribers, see the LOADNL command in the ESP Workload Manager Reference Guide v.5.4.

Replace if exists
Check mark this field to indicate this Event is to replace an existing Event with the same name.

When you have entered the required information, click Next.

Defining the Additional Options dialog

Select Additional Calendar(s) to Use
Calendar 1 Calendar 2
A calendar is a collection of definitions of holidays, special days, and special periods that are unique to your installation. Although ESP Workload Manager is familiar with the standard calendar, you may need to use scheduling terms that are specific to your installation. To define your own set of scheduling terms, you can define one or more calendars. This is done in the Calendar Manager component of Workstation. For more information, see Chapter 4, “The Calendar Manager.”

Enter up to two calendar names using these fields.
Select Symbolic Variable Library - Identifier
Symbolic-variable libraries define and store symbolic variables. It is useful to keep common symbolic variables together in a symbolic-variable library. The symbolic variables will be available to all Events that refer to that symbolic-variable library. A symbolic-variable library consists of one or more sequential data sets or partitioned data set members. The DEFSYML command gives a logical identifier to these data set structures. When ESP Workload Manager encounters the name of a symbolic-variable library in an Event during processing, it obtains the value from the appropriate data set or member. Different Events can reference the same symbolic-variable library.

Enter the logical identifier for your symbolic-variable library.

Add
To add the symbolic-variable-library name to the List of Symbolic Variable Libraries box, click Add.

List of Symbolic Variable Libraries
To view the information defined for a specific list item, select the list item from the list box. The fields display the defined information for that item.

Delete
To delete a single list item, select the list item from the list box. Click Delete. The list item is removed from the list.

To select and delete multiple consecutive list items, click the first list item, press and hold down the Shift key, click the last list item, and then click Delete. The list items are removed from the list.

To select and delete multiple non-consecutive list items, hold down the Ctrl key and click the list items, then click Delete. The list items are removed from the list.

Next
Once you have entered the required information, click Next.
Defining the Run ESP Procedure(s) dialog

Specify ESP Procedure to Run

Data set name
A Procedure is a set of stored instructions that ESP Workload Manager invokes. Part or all of these instructions can define a group of jobs and tasks as an Application. Although you use a Procedure to define all Applications, not all Procedures contain an Application definition. CLANG is an integral component of Procedures and provides power and flexibility. Its several language elements enable you to specify conditional processing requirements. For information about Procedures, Applications, and CLANG, see Chapter 3, “The Workload Editor.”

When you create a Procedure definition, you store it in a member of a partitioned data set or in a sequential data set. To invoke the Procedure, you must create the Procedure prior to creating the Event that invokes it.

Enter your sequential or partitioned data set name in this field.

Member name
If your Procedure definitions are stored in a partitioned data set, then each definition will be a member of that partitioned data set.

Enter the member name in this field.

Cache ESP Procedure
Click the down arrow to select whether you cache the Procedure.

By caching (storing) a Procedure in memory, you can improve CPU usage and processing speed for Procedures that include more than 400 jobs.

Note: Caching must be enabled on the host to cache a Procedure.

Add
To add the procedure to the List of Procedures to Run box, click Add.
List of Procedures to Run
To view the information defined for a specific list item, select the list item from the list box. The fields display the defined information for that item.

Temporary ESP procedure library
Use the Temporary ESP procedure library section to identify a data set you want to use instead of the data set identified in the Specify ESP Procedure to Run section.

In the following example, ESP Workload Manager invokes the ESP procedure PAYJOBS from data set CYBER.PROC.CNTL.TEMP instead of data set CYBER.PROC.CNTL.

Note: You can restrict when ESP Workload Manager uses the temporary ESP procedure library by setting From and To times. You set these times in Workload Editor using the Workload Definition Defaults Options tab. For details, see “Options tab” on page 71.

Data set name
To run the ESP Procedure from a temporary ESP procedure library, enter the data set name that contains that ESP procedure. Use this field to override the data set name in the Specify ESP Procedure to Run section. When ESP Workload Manager schedules or triggers the Event, it substitutes the data set name in the ESP Procedure to Run section with this data set name.

To work, this data set must exist at the time of scheduling or triggering of the Event and the ESP procedure specified in the ESP Procedure to Run section must reside in the temporary ESP procedure library.

For more information, see the TEMPPROC command in the ESP Workload Manager Reference Guide.
To restrict when ESP Workload Manager uses the temporary ESP procedure library, use the From and To fields located on the Workload Definition Defaults Options tab in Workload Editor.

**Use within ESP procedure**
When selected, this option corresponds to the NEST operand in the TEMPPROC command. For more information, refer to the TEMPPROC command in the *ESP Workload Manager Reference Guide*.

---

### Defining the Submit z/OS Job(s) dialog

![Specify Job(s) to Submit](image)

**Specify Job(s) to Submit**

**Data set name**
Indicates the name of the data set where the jobs specified in Procedures and Applications are being submitted from. Typically, this is a JCL library.

**Data set type**
Indicates the type of data set being submitted or the type the job member is being submitted from. Choose a type from the drop-down list.

**Is a GDG Generation**
If the job you wish to submit is a member of a generation data group, then select this check box. When selected, the **Generation** field becomes available. Use the up and down arrows to indicate the generation number of the data set that contains the job you want to submit.

**Member name**
Indicates the member name of the data set.

**Add**
To add the job to the List of Jobs to Submit box, click **Add**.
List of Jobs to Submit
To view the information defined for a specific list item, select the list item from the list box. The fields display the defined information for that item.

Delete
To delete a single list item, select the list item from the list box. Click Delete. The list item is removed from the list.

To select and delete multiple consecutive list items, click the first list item, press and hold down the Shift key, click the last list item, and then click Delete. The list items are removed from the list.

To select and delete multiple non-consecutive list items, hold down the Ctrl key and click the list items, then click Delete. The list items are removed from the list.

Next
Once you have entered the required information, click Next.
Defining the Send Message(s) dialog

Use this dialog to send a message to yourself, another user, a group of users or an operator console.

**Specify Message to Send**

**Recipient(s)**
Enter the user ID of the person receiving the message.

**Console ID**
Enter the UCM ID or the system console name that is to receive the message.

**Routing code**
Enter the MCS routing code for a message to be sent to one or more operator consoles. Value between 1 and 128.

**Keep on console**
Indicates the message is marked as non-roll-deletable, if it is sent to a console.

**Message text**
Enter the message to be sent.

**Add**
To add the message to the List of Messages to Send box, click Add.
List of Messages to Send
To view the information defined for a specific list item, select the list item from the list box. The fields display the defined information for that item.

Delete
To delete a single list item, select the list item from the list box. Click Delete. The list item is removed from the list.

To select and delete multiple consecutive list items, click the first list item, press and hold down the Shift key, click the last list item, and then click Delete. The list items are removed from the list.

To select and delete multiple non-consecutive list items, hold down the Ctrl key and click the list items, then click Delete. The list items are removed from the list.

Next
Once you have entered the required information, click Next.

Defining the Issue Command(s) dialog

Use this dialog to have an Event submit an operating system command. There are restrictions on which users can issue commands. Contact your administrator to find out if you are authorized to issue any commands.

Specify Command to Issue

Command text
Enter the operating system command the Event is to submit.

Add
To add the command to the List of Commands to Issue box, click Add.
In the following example, ESP Workload Manager starts a CICS region numbered 01:

**List of Commands to Issue**
To view the information defined for a specific list item, select the list item from the list box. The fields display the defined information for that item.

**Delete**
To delete a single list item, select the list item from the list box. Click **Delete**. The list item is removed from the list.

To select and delete multiple consecutive list items, click the first list item, press and hold down the **Shift** key, click the last list item, and then click **Delete**. The list items are removed from the list.

To select and delete multiple non-consecutive list items, hold down the **Ctrl** key and click the list items, then click **Delete**. The list items are removed from the list.

**Next**
Once you have entered the required information, click **Next**.
Defining the Schedule Definition dialog

Specify Schedule Criteria
Schedule criteria is the specification of scheduling conditions that need to be met for an Event to be executed. ESP Workload Manager allows you to use free format, everyday English to specify schedule criteria when scheduling Events and jobs. ESP Workload Manager has a built-in understanding of general scheduling terms. You may also add your own unique scheduling terms to ESP Workload Manager. These may include special processing periods, holidays, and other special days. You can specify scheduling criteria up to the year 2040.

Schedule
The schedule criteria you enter specifies when to execute your Event. Click the Schedule button to indicate you are defining schedule criteria for the Event. The Event should automatically run according to the schedule criteria entered in the text field. For example, 5 pm daily. Type schedule criteria in the text field or click the button with the three dots (... ellipsis), located to the right of the text field. Clicking this button opens the Schedule Criteria Editor. Instead of typing in text, you can select keywords and days to specify when the Event is to run or not run. For information and examples on schedule criteria, see “Schedule Criteria Editor” on page 115.

Once you have specified your run frequency, you can test it. Enter your schedule criteria in the Schedule Criteria text field at the bottom of the Schedule Criteria Editor. Once you have entered it, you may test your schedule criteria by clicking the Test button. If you click this button, the Test Schedule Criteria dialog appears. Click Test. If the results are OK, click Done. The Schedule Criteria Editor reappears. Click OK.

Do not schedule
Click the Do not schedule button to indicate you are defining schedule criteria for when the same Event is not to run. This is used to handle exceptions. You can have schedule and no schedule commands in the same Event. If your Schedule command has a time, then you must use the same time on the no schedule command.
Example

- Enable the Schedule field and code **5 pm daily** in the text field, then click **Add**.
- Enable the Do not schedule field and code **5 pm last workday of month** in the text field, then click **Add**.

The results of the above coding are the Event is scheduled to run every day at 5 pm, except on the last workday of the month. For more information on schedule criteria, see “Schedule Criteria Editor” on page 115.

Expect

Click the **Expect** button to indicate when an Event is expected to run. Use this field in Events without a Schedule command if you want the Event’s activities reflected when creating scheduled activity reports.

Add

To add the schedule criteria to the Resulting Schedule Criteria box, click **Add**.

Specify Special Processing Options

Type of Day

Click the **down arrow** to reveal days of the week and other scheduling terms. These are used in conjunction with selecting one of the special processing options listed below.

Your scheduling criteria for Event execution may create conflicts. For example, if you want the Event to execute on the second day of every month except on a weekend, inform ESP Workload Manager to either:

- Advance the Event (run it sooner than usual) by any number of days or weekdays
- Delay the Event (run it later than usual) by any number of days or weekdays
- Ignore the Event (do not run it at all)

1. Specify the scheduling term to advance, delay or Ignore, using the Type of Day drop-down list (for example, weekend).
2. Specify the number of weekends to advance (for example, 1), using the up or down arrows to reveal a scroll list of numbers.

Run earlier by

Enable this button to indicate Advance the Event.

Run later by

Enable this button to indicate Delay the Event.

Ignore

Enable this button to indicate Ignore the Event.
Days and Weekdays
These buttons are an optional method of specifying schedule criteria. They are used with the Run earlier by, Run later by or Ignore fields, and a number value to indicate the Event should be delayed by 4 days.

Add
To add the special processing options to the Resulting Schedule Criteria box, click Add.

Resulting Schedule Criteria
To view the information defined for a specific list item, select the list item from the list box. The fields display the defined information for that item.

Delete
To delete a single list item, select the list item from the list box. Click Delete. The list item is removed from the list.

To select and delete multiple consecutive list items, click the first list item, press and hold down the Shift key, click the last list item, and then click Delete. The list items are removed from the list.

To select and delete multiple non-consecutive list items, hold down the Ctrl key and click the list items, then click Delete. The list items are removed from the list.

Next
Once you have entered the required information, click Next.

Defining the Data Set Trigger dialog

You can use a data set trigger to trigger an Event automatically on data set activity. Data set triggering can be restricted to data sets created by a specific job, a group of jobs or a user ID.

A data set trigger can be used on:
• The creation of a data set
• The closure of a data set after an update
• The renaming of a data set
• The successful completion of an FTP file transfer
• The explicit notification of a data set activity (used when the data set activity does not generate an SMF record)

**Data set name**
Indicates the full name of a data set the Event is to trigger on.

**FTP data-set trigger**
Indicates the data set trigger is activated following the successful completion of a File Transfer Protocol (FTP) transmission.

**Receive**
The Receive button indicates the FTP transfer is from the remote FTP partner to the local mainframe FTP partner.

**Send**
The Send button indicates the FTP transfer is from a local mainframe FTP partner to the remote FTP partner.

**Host**
Entering a host name in this field restricts the activation of the data set trigger to transfers to or from the specified remote host. This is valid only within the context of an FTP trigger. The specified remote host is either a DNS host name or an IP address. The maximum length for a DNS host name is 100 characters.

**Logon**
Entering a logon ID in this field restricts the activation of the data set trigger to transfers to or from a specific user. This is valid only within the context of an FTP trigger. The logon ID represents the user ID the FTP client uses to logon to the FTP server. You can use wildcard characters. The following example accepts any user whose user ID starts with abc:

`LOGON (abc-)`

If the FTP client is the remote partner, then logon ID is the user ID of the local FTP partner. If the FTP client is the local partner, then logon ID is the user ID of the remote FTP partner.

**Note:** For more information about FTP data set triggers, see the *ESP Workload Manager User’s Guide*.

**Explicit data set trigger**
Enable this field when an Event is to trigger on the explicit notification of the specified data set being updated.

**Note:** The explicit notification is accomplished by the ESP Workload Manager program CYBESDT1. For more information about explicit data set triggering, see the *ESP Workload Manager Operator’s Guide*. 
Updated
Enable this field when the Event is to trigger on the update or creation of the data set specified.

Renamed
Indicates the trigger should also occur if a data set is renamed to the data set name specified.

Multiple
Indicates closure of at least one other data set is needed to trigger this Event. The Event does not run until all specified data set triggers are detected.

Primed
Indicates a data set trigger was already detected for this data set. This field is used only when redefining an Event, when one of the specified multiple data set triggers is already detected.

Trigger when action is performed by Jobname or User ID
Enable the job name button or the User ID button. They are mutually exclusive. Enter the job name or user ID name in the text field.

Trigger on x occurrence(s) of action(s) specified
Click the up or down arrows to select the number of occurrences that are to occur before the Event triggers.

Initial trigger count
Click the up or down arrows to select the initial trigger count.

Add
To add the data set triggers to the List of Data Set Trigger Conditions box, click Add.

List of Data Set Trigger Conditions
To view the information defined for a specific list item, select the list item from the list box. The fields display the defined information for that item.

Delete
To delete a single list item, select the list item from the list box. Click Delete. The list item is removed from the list.

To select and delete multiple consecutive list items, click the first list item, press and hold down the Shift key, click the last list item, and then click Delete. The list items are removed from the list.

To select and delete multiple non-consecutive list items, hold down the Ctrl key and click the list items, then click Delete. The list items are removed from the list.

Next
Once you have entered the required information, click Next.
Defining the Event Control Options dialog

There are five commands you can use when you define an Event, to control the processing of that Event. They are:

- Hold
- Release
- Suspend
- Resume
- Delete

For example, you can schedule the deletion of an Event or schedule an Event to be suspended at some time in the future.

Each of these commands can be enabled by selecting its field, specifying schedule criteria in the text field, and clicking Add.

On the Event Manager toolbar, there are Quick Use buttons that provide shortcut access to these commands. To quickly hold an Event, simply click on the Event in the left-hand pane, then click the Hold button on the toolbar. You will receive a confirmation message the Event is held.

Specify Schedule Criteria to

Hold
Indicates an Event will be held from being processed at a particular time.

When ESP Workload Manager encounters a HOLD command in an Event, it increases the Event’s hold count by one at the time and date specified in the command. As long as the hold count has a value of at least one, ESP Workload Manager delays the Event’s execution. This way you can use the HOLD command to postpone an Event.
Release
Conversely, the RELEASE command decreases the Event’s hold count at the time and date specified in the command. When the hold count equals zero, the Event is eligible for execution.

If the Event’s scheduled time comes up while it is being held, ESP Workload Manager marks the Event as overdue. ESP Workload Manager adds a comment to a held Event if it misses its scheduled time, indicating that execution is pending and the time it should have executed. After you release the Event, ESP Workload Manager checks the overdue count. If you specified a number other than zero or let the count default to one, the Event executes immediately for every occurrence it missed while on hold, up to the value of the overdue count.

Suspend
The SUSPEND command works similarly to HOLD, but has a slightly different purpose. If an Event misses its scheduled execution time while suspended, ESP Workload Manager ignores the Event and does not execute it at all, nor marks it overdue. Each time ESP Workload Manager encounters SUSPEND, it increases the Event suspend count by one at the specified time and date. When the suspend count is greater than zero, ESP Workload Manager bypasses the Event without executing it.

Note: If an Event is both suspended and held at its scheduled execution time, ESP Workload Manager ignores the hold state and considers the Event suspended.

Resume
The RESUME command reduces the suspend count by one at each occurrence. When the suspend count is zero, ESP Workload Manager can execute the Event at the next scheduled time.

Delete
The DELETE command is used to schedule the deletion of an Event. You might use the DELETE command if, for example, you want to delete an Event that is only temporary. It can also be used to delete a daily Event after a particular date. For example, the following schedule criteria would be entered in the Schedule Criteria text field, with the delete field selected.

DELETE 10AM MAY 10, 2003

Schedule Criteria
Enter a date or click the button with the three dots, located to the right of the date field. If you click this button, the Schedule Criteria Editor appears. Enter your schedule criteria in the Schedule Criteria text field at the bottom of the Schedule Criteria Editor. Once you have entered it, you may test your schedule criteria by clicking the Test button. If you click this button, the Test Schedule Criteria dialog appears. (For details on this box, see “Testing schedule criteria” on page 377.) Click Test. If the results are O.K., click Done. The Schedule Criteria Editor reappears. Click OK.

For information and examples on schedule criteria, see “Schedule Criteria Editor” on page 115.
Add
To add the schedule criteria to the List of Control Criteria box, click **Add**.

**Note:** If you want your Event to run according to the schedule criteria defined in the Schedule Definition dialog, do not enable any of the above five fields. Your Event will upload to the host and be in an active state without any of these fields being selected.

**List of Control Criteria**
To view the information defined for a specific list item, select the list item from the list box. The fields display the defined information for that item.

**Delete**
To delete a single list item, select the list item from the list box. Click **Delete**. The list item is removed from the list.

To select and delete multiple consecutive list items, click the first list item, press and hold down the **Shift** key, click the last list item, and then click **Delete**. The list items are removed from the list.

To select and delete multiple non-consecutive list items, hold down the **Ctrl** key and click the list items, then click **Delete**. The list items are removed from the list.

**Next**
Once you have entered the required information, click **Next**.

**Defining the Copy JCL dialog**

![Specify Destination Data Set](image)

**Specify Destination Data Set**
The COPYJCL command lets you generate a copy of the JCL for every job, as ESP Workload Manager submits it. You can specify COPYJCL in the Event definition of any Event that submits jobs. This copy is written to a member of a partitioned data set providing a working copy of the JCL with, where applicable, all symbolic variables resolved. This JCL can be used for job re-submission. ESP Workload Manager keeps track of where the job was submitted from and the JCL that was used.

When you use the COPYJCL command, you must also specify the library that is to receive the copy, followed by either the JOB NAME or JOBID keyword. The keywords you use influence the member name ESP Workload Manager assigns to the JCL copy.

**Data set name**
Specifies the data set name that is to receive the working copy of the JCL.
Is a GDG Generation
Select this field if the destination data set is a GDG type data set. When selected, the Generation field becomes active. Use the up and down arrows to indicate the generation number of the destination data set. This number can be any number from 0 to -254.

Jobname
The job name field requests ESP Workload Manager to store the copy of the JCL under the same name used for the job. Each submission of a particular job overwrites the previous copy of that job’s JCL.

Job ID
The job ID field requests ESP Workload Manager to store the copy of the JCL by job ID. A member is not overwritten until the job number reoccurs.

Finish
Once you have entered the required information, click Finish. The Event Properties dialog appears with the other nine tabs available. At this point, you can select any tab to review or change your Event definition.

Save
To make modifications to an Event, select the required tab and change the field information in that panel. To save the new information, click the Save button. The Save button only applies to the current panel.

Reset
If you make changes that you do not want to save, click the Reset button to put the information back to what it was before you changed it. The Reset button only applies to the current panel.

Upload
To upload the Event definition to the host, click Upload. You receive a confirmation message and your new Event name appears in the tree view, in the left-hand pane. If your Event does not appear, check to ensure the prefix used when creating your Event is the prefix specified in the Prefix field. For more information, see “Viewing Event definitions” on page 344.
Adding comments to an Event

You can add, edit, and delete free format text in an Event definition using the Comments dialog. When you view the Event in Event Manager after uploading it to ESP Workload Manager, the comments will appear as user comments.

For more details, refer to the COM command in the ESP Workload Manager Reference Guide.
Simulating an Event

Simulating Events enables you to simulate the functions of any defined Event.

About simulating an Event

On a selected Event, the SIMULATE command informs you of the jobs ESP Workload Manager submits, any messages it sends and how it substitutes symbolic variables. This command is particularly useful with Procedures because you can use it to see how the complex and conditional components of your Procedure will run at a particular date and time. ESP Workload Manager also displays error messages if it encounters problems, such as syntax errors or successor loops in a Procedure. You can simulate an Event for a day on which it is not normally scheduled. In this case, ESP Workload Manager simulates what would happen if the Event was triggered on that particular day.

Event Manager displays the results of your simulation graphically, as ESP Workload Manager Procedure code, and as JCL. The text is displayed in the Event simulation log.

**Hint:** You can search for a particular job in the simulation graph using the **LocateJob** button.

Defining the Simulate Event dialog

Specify schedule criteria in the Simulate Event dialog. If you do not enter any criteria, ESP Workload Manager either simulates the next occurrence of the Event or if the Event has no scheduled execution, it assumes an execution time of NOW.

To simulate an Event

Open the Simulate Event dialog using one of these methods:

- In the left-hand pane, right-click the Event you want to simulate. The Event name is highlighted, and a shortcut menu appears. Select **Simulate**.
- On the Event Manager menu bar, select **Actions > Simulate**.
- On the toolbar, click the **Simulate** button.

The Simulate Event dialog appears.
Schedule criteria
Enter schedule criteria or select the box with the three dots to the right of the schedule criteria field to open the Schedule Criteria Editor. This editor allows you to build numerous scheduling scenarios.

For more information on schedule criteria, see “Schedule Criteria Editor” on page 115.

Start with job
If you want to start the simulation with a job that is not the first job in your application, enter the job name here.

View JCL
To view JCL in the Event simulation log, select the View JCL check box. You can set this option as a default through your user profile options. For details, see “Setting User Profile Options” on page 347.

View ESP Procedure
To view ESP Procedure code in the Event simulation log, select the View ESP Procedure check box. You can set this option as a default through your user profile options. For details, see “Setting User Profile Options” on page 347.

Specify User Parameters to Pass to Event - Parameter 1 to 4
These four fields can be used to pass user information to the Event being triggered.

Parameters are case-sensitive
Enable this field to indicate the user-parameter data is case sensitive.

Example: Next execution of the Event
To simulate the next execution of the Event, you do not have to fill in any of the fields on the Simulate Event dialog, just click OK. The default is the next scheduled execution or now if the Event is not scheduled. A message appears asking you to wait while Workstation simulates the Event. A graphical representation of the Procedure or Application is displayed. If there are errors, the Event Manager Log appears.
If it is prior to the execution time specified, you see what jobs are selected for today. Otherwise, you see what jobs are selected for the next day.

Jobs in an Application may not require the same run frequency. By default, when ESP Workload Manager selects jobs for submission, it automatically checks to see if any relationships among jobs should be inherited.

Displaying the Event log
The Event Manager displays the results of your simulation in the Event log. Once the graphical simulation results appear, click the Viewlog icon to display the Event log.

Note: To view JCL in the Event log, you must first select the View JCL check box in the Simulation Event dialog. To view ESP Procedure code, you must first select the View ESP Procedure check box in the Simulation Event dialog.

Triggering an Event from the Graphical Simulation of event dialog
To save you time following an Event simulation, you can trigger the Event directly from the graphical simulation using a Trigger button. Event Manager opens the Trigger the Event dialog and retains all the simulation details you had entered except the schedule criteria. Triggering an Event this way saves you time because you don’t have to reenter information you had already entered during the simulation.

To trigger an Event from the Graphical Simulation of event dialog, click the Trigger button.

The Trigger the Event dialog appears. The trigger options, except the schedule criteria, and the user parameters are retained from the simulation.

Locating a job in the simulation graph
When you simulate an Event, use the LocateJob button to highlight a job within the graphical simulation that matches your search criteria.

1. Simulate an Event.
2. In the Graphical Simulation of event dialog, click the LocateJob button.
   
   The Locate Job dialog appears.
3. In the Job Name field, enter the first n characters of the job you want to locate in the format jobname.qualifier.
   
   • To locate a specific job, enter the complete job name and qualifier, for example myjob.run1.
• To return a list of jobs that match a specific character string, enter the first few jobname characters, for example myj.

4. Click **Search**.
   
   A list of matching jobs appears sorted alphabetically.

5. In the **Search Results** box, select the job you want to locate and click **Locate**.
Testing an Event

Testing Events enables you to see your schedule criteria in action.

Testing the next execution of an Event

Using the Next command, you can display the next scheduled executions of an Event. The Next feature lets you specify the number of execution times you want to test, up to a maximum of 99. As long as your Event contains at least one SCHEDULE command, ESP Workload Manager tests the execution times and dates for the number of executions you specify.

To test the next executions of an Event

1. Open the Next dialog using one of these methods:
   • In the left-hand pane, right-click the Event you want to test. The Event name is highlighted, and a shortcut menu appears. Select Next.
   • On the Event Manager menu bar, select Actions > Next.
   • On the toolbar, click the Next button.
2. Click the up arrow or down arrow to select the number of cycles to test.
3. Click Test.

Example
To display the next five execution dates and times for your Event:

1. Click the up arrow until the number five appears.
2. Click Test.
The next five scheduled times and dates appear.
Testing schedule criteria

There are two ways to test schedule criteria prior to actually using them, with the Test feature or with the Schedule Criteria Editor. You can test any date or schedule specification. ESP Workload Manager then responds with the actual date and time. If you specify a number, ESP Workload Manager displays as many subsequent dates and times as you indicate. Test results are displayed in the results window.

To test schedule criteria with the Test dialog

1. Open the Test dialog using one of these methods:
   - In the left-hand pane, right-click the Event you want to test. The Event name is highlighted, and a shortcut menu appears. Select Test Schedule Criteria.
   - On the Event Manager menu bar, select Actions > Test Schedule Criteria.
   - On the toolbar, click the Test button.

   The Test Schedule Criteria dialog appears.

   ![Test Schedule Criteria dialog](image)

2. Click the arrows in the Number of cycles field to indicate how many cycles of the schedule criteria you would like to see resolved.

3. If required, select calendars from Calendar 1 and Calendar 2.

4. Click Test.

   The results are displayed in the Results window.

Example

To test the schedule criteria last workday of month, for the next five months:

1. In the Schedule criteria field, enter last workday of month.
2. In the Number of cycles field, click the up arrow until the number five appears.
3. Click Test.
The display in the Results box appears similar to the following graphic.

To test schedule criteria with the Schedule Criteria Editor
Select the box with the three dots to the right of the schedule criteria field. This opens up the Schedule Criteria Editor. This editor allows you to build numerous scheduling scenarios.

For information on using the Schedule Criteria Editor, see “Schedule Criteria Editor” on page 115.
Triggering an Event

The Trigger feature is used to trigger the execution of an Event. If you do not specify the time at which you want the Event to execute, the default time is NOW. The Event execution either replaces the next scheduled execution (that is, brings forward the next execution) or it can be a temporary addition to the schedule.

To trigger an Event

Open the Trigger dialog using one of these methods:

- In the left-hand pane, right-click the Event you want to trigger. The Event name is highlighted, and a shortcut menu appears. Select Trigger.
- On the Event Manager menu bar, select Actions > Trigger.
- On the toolbar, click the Trigger button.

The Trigger the Event dialog appears.

Defining the Options tab

Schedule criteria

Use this field to indicate a time, and optionally a date, when the trigger is to occur. Choose to have the new time and date replace the next scheduled Event or execute in addition to the next scheduled Event. For information on using the Schedule Criteria Editor, see “Schedule Criteria Editor” on page 115.

Instead of scheduling a trigger, you can select the Bypass next scheduled execution check box to skip the next scheduled Event.
**ESP subsystem**

Specifies the subsystem you want to trigger the Event on. This is the name defined to ESP Workload Manager and may not necessarily be the same as the SMF identifier. Check with your administrator or use the LSYS command to find the correct name to use.

**Replace next scheduled Event**

Enable this button to indicate this execution is to replace the next scheduled execution of the Event. This is used when you want to process an Event at a time different from its next scheduled time. Using REPLACE advances the execution time for an Event. For example, if you need to run an Event now instead of at 7 pm, trigger the Event with the REPLACE option.

When you use the REPLACE option, ESP Workload Manager selects jobs and resolves symbolic variables based on the replaced time and date. For example, if you have an Event that runs every Saturday and this week you want to run the Event on Friday instead, you can trigger the Event with the REPLACE option. ESP Workload Manager selects the jobs and resolves symbolic variables based on Saturday’s date.

**Add new scheduled Event**

Enable this button to indicate this execution is to be made in addition to the normal schedule. The normal schedule is not changed.

**Bypass next scheduled execution**

Enable this field if you want to bypass the execution of the next scheduled Event. This might be used when you trigger an Event in error, and you need to undo this operation or when you want to cancel one execution of an Event.

Select the **Parameters** tab.

---

**Defining the Parameters tab**

**Specify User Parameters to Pass to Event - Parameter 1 to 4**

These four fields can be used to pass user information to the Event being triggered.
Parameters are case-sensitive
Enable this field to indicate the user parameter data is case-sensitive.

Start with job
Indicates one or more job names belonging to the Application generated by this Event. This requests that only those jobs specified are to be submitted. Use this field if you want to build an Application of certain jobs. This is useful if you want to run or rerun, part of an Application. Each job name specification can be an individual job name or can include a plus sign (+) to indicate this job and all its successors are to be selected.

Submit Application on hold
This can be used to place an Application on hold when the Event being triggered generates an Application. No activity will take place in the Application until it is released. The Application can be released using the Workload Director component of Workstation.
This chapter describes the Workload Director interface and presents an overview of Workload Director concepts and terms. You are shown how to access and view your workload using Graphical and Custom Views. Job commands are documented for the different job types available. This chapter also describes job attributes, how to set options, and how to print.

This chapter is divided into the following topics:

• About the Workload Director
• Opening the Workload Director
• Controlling Applications
• Controlling Jobs
• Controlling subApplications
• Working with Custom Views
• Monitoring and Controlling SAP Systems
The Workload Director component of Workstation is used to monitor and control active Applications, subApplications, and jobs. You can view your workload with a graphical display or a text-based display. Colors can be used to indicate the different processing states an Application or job is in. There is also a Line Mode Interface to enter any ESP Workload Manager commands.

The following lists describe some of the tasks you can do with your Applications, subApplications and jobs. See the respective topic for the full range of functionality available.

### Applications
At the Application level, you can:

- View the details of an Application
- Hold and release an Application
- Mark an Application as COMPLETE
- Remove an Application from APPLWAIT
- Hide Applications that are COMPLETE
- Insert a job, and locate a job or find a troubled job
- Rerun an Application
- Display the critical path

### subApplications
SubApplications are groups of workload objects that belong to an Application. At the subApplication level, you can:

- Graphically display a subApplication within a large Application
- Hold and release subApplications
- Mark subApplications as COMPLETE
- Bypass or Unbypass subApplications
- Make subApplications ready for submission
- Run subApplications on demand (request and unrequest)

### Jobs
Jobs are the smallest units of work that can be individually managed. At the job level, you can:

- View the details of a job
- Hold and release jobs
• Run jobs on demand
• Bypass or Unbypass jobs
• Search for a job or a list of Applications containing a job
• Drop one, some or all of a job’s predecessors
• Reset a job’s time dependencies
• Make jobs ready for submission
• Mark jobs as COMPLETE
• Modify resources
• Retrieve a spool file
• Retrieve a trace file for a PeopleSoft job
• Notify other users regarding changes to a job (update user status)
• Edit or browse:
  • JCL and CopyJCL
  • ESP Procedures
  • Job Documentation
  • z/OS data sets
• Cancel a workload object
• Resubmit jobs that have failed
Opening the Workload Director

The Workload Director button is located on the Workstation Toolkit.

Open the Workload Director using one of these methods
• From the Workstation Toolkit, click the Workload Director button.
• From the Workstation Toolkit menu bar, select ESP Tools > Workload Director.

The Workload Director appears.
About the Workload Director Interface

The Workload Director interface contains the following components:

- Title bar
- Menu bar
- Toolbar
- Graphical View
- Custom View
- Line Mode Interface (LMI View)
- Status bar

The interface is split into two panes. The left-hand pane or tree view is a navigation tool used to select the Application to view, and select the view you want to work with. Tabs that control which view are active are located at the bottom of the tree view.

The right-hand pane displays the workload in the view selected or displays the Line Mode Interface.
Title bar

The Title bar is the bar located at the top of the Workload Director interface.

Menu bar

The menu bar contains the following options:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>• Change print and page setup options</td>
</tr>
<tr>
<td></td>
<td>• Setup postscript</td>
</tr>
<tr>
<td></td>
<td>• View a print preview</td>
</tr>
<tr>
<td></td>
<td>• View a print summary</td>
</tr>
<tr>
<td></td>
<td>• Print all Custom Views</td>
</tr>
<tr>
<td></td>
<td>• Exit Workload Director</td>
</tr>
<tr>
<td>Graphical View</td>
<td>• Zoom in or out</td>
</tr>
<tr>
<td></td>
<td>• Change the display of the Graphical View</td>
</tr>
<tr>
<td></td>
<td>• Change the style of graph you view</td>
</tr>
<tr>
<td></td>
<td>• Use the Overview window</td>
</tr>
<tr>
<td>Custom View</td>
<td>• Create, open, change, copy, and delete Custom Views</td>
</tr>
<tr>
<td>Options</td>
<td>• Set the state priority and state colors</td>
</tr>
<tr>
<td></td>
<td>• Automatically remove Applications that are complete</td>
</tr>
<tr>
<td></td>
<td>• Enable automatic subscription</td>
</tr>
<tr>
<td></td>
<td>• Show or hide the line count column in the Custom View</td>
</tr>
<tr>
<td></td>
<td>• Enable the auto trouble locate and show server response features</td>
</tr>
<tr>
<td></td>
<td>• Set user profile options</td>
</tr>
<tr>
<td>Action</td>
<td>• Perform actions on jobs and Applications</td>
</tr>
<tr>
<td></td>
<td>• Hide all Applications from view that are currently complete</td>
</tr>
<tr>
<td></td>
<td>• Expand and collapse the Graphical View</td>
</tr>
<tr>
<td></td>
<td>• Locate a job in both the Graphical and Custom Views</td>
</tr>
</tbody>
</table>
Menu items
Workload Director does not disable menu items for commands that are unavailable. The menu items are available at all times. The job and Application level commands that are applicable are determined dynamically by ESP Workload Manager.

User Profile Options

To display the User Profile Options for Workload Director
From the menu bar select Options > User Profile Options.

Display in the Graphical View
Select the variation of a job name you want Workload Director to display. You can display the job name (name and qualifier), the long name (the job’s alias), or both. The long name appears in brackets beside the job name.

Online Documentation
Specify the location and format of your job documentation files. These are files you create and store. For example, they may contain restart information for jobs.

1. In the Online Documentation text field, enter a path or URL where the documentation files are stored. Do not include the file name.

2. Select the radio button to indicate the file’s naming convention.
3. In the **Extension** field, enter a file extension (no period) to indicate the job documentation’s application format, for example:
   - HTML
   - DOC
   - TXT
   - XLS

   Workload Director accepts all file formats. An application for the format specified must be installed on your system.

4. Click **OK**.

5. In the Graphical or Custom View, right-click a job that has a documentation file and select **Browse Online Documentation**.

   The appropriate application opens displaying the documentation file for the job.

   For information on the Browse Online Documentation command, see “Browse Online Documentation” on page 451.

   **Note:** When creating documentation files, name the file the same as the job it applies to. Workload Director requires the file name and job name to be the same to retrieve the file.

---

**Toolbar**

The toolbar contains buttons that provide shortcut access to the most commonly used commands on the Workload Director menus.

<table>
<thead>
<tr>
<th>Button</th>
<th>Name</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Zoom Out" /></td>
<td>Zoom Out</td>
<td>To reduce the size of a workflow diagram that appears in the Graphical View.</td>
</tr>
<tr>
<td><img src="image" alt="Zoom In" /></td>
<td>Zoom In</td>
<td>To enlarge the size of a workflow diagram that appears in the Graphical View.</td>
</tr>
<tr>
<td><img src="image" alt="Display All" /></td>
<td>Display All</td>
<td>To display all job attributes (job names, job icons, state colors, and state labels) that appear in the Graphical View.</td>
</tr>
<tr>
<td><img src="image" alt="Display Color" /></td>
<td>Display Color</td>
<td>To show or hide the state color of jobs in the Graphical View.</td>
</tr>
<tr>
<td><img src="image" alt="Display Icons" /></td>
<td>Display Icons</td>
<td>To show or hide the job icons in the Graphical View.</td>
</tr>
<tr>
<td><img src="image" alt="Display Names" /></td>
<td>Display Names</td>
<td>To show or hide the job names in the Graphical View.</td>
</tr>
<tr>
<td>Button</td>
<td>Name</td>
<td>Use</td>
</tr>
<tr>
<td>--------</td>
<td>--------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td><img src="image" alt="Display Labels" /></td>
<td>Display Labels</td>
<td>To show or hide the state labels in the Graphical View.</td>
</tr>
<tr>
<td><img src="image" alt="Direct Line Style" /></td>
<td>Direct Line Style</td>
<td>To set the line style between jobs to direct.</td>
</tr>
<tr>
<td><img src="image" alt="Orthogonal Style" /></td>
<td>Orthogonal Style</td>
<td>To set the line style between jobs to orthogonal. (Orthogonal means at right angles.)</td>
</tr>
<tr>
<td><img src="image" alt="Horizontal Orientation" /></td>
<td>Horizontal Orientation</td>
<td>To rotate the workflow diagram in the Graphical View 90 degrees.</td>
</tr>
<tr>
<td><img src="image" alt="Fit in Window" /></td>
<td>Fit in Window</td>
<td>To view the entire workflow diagram in the window.</td>
</tr>
<tr>
<td><img src="image" alt="Overview Window" /></td>
<td>Overview Window</td>
<td>To view the Graphical View in a secondary window that you can use to zoom in and navigate around an Application.</td>
</tr>
<tr>
<td><img src="image" alt="Toggle Browser" /></td>
<td>Toggle Browser</td>
<td>To show or hide the left-hand pane (tree view) of the interface.</td>
</tr>
<tr>
<td><img src="image" alt="Show Custom View Line Count" /></td>
<td>Show Custom View Line Count</td>
<td>To show or hide the line-count column in the Custom View.</td>
</tr>
<tr>
<td><img src="image" alt="Locate a job in graph" /></td>
<td>Locate a job in graph</td>
<td>To locate a job in an Application or to view a list of Applications that contain a specific job.</td>
</tr>
<tr>
<td><img src="image" alt="Expand selected item" /></td>
<td>Expand selected item</td>
<td>To open the Application folders beneath the selected item.</td>
</tr>
<tr>
<td><img src="image" alt="Collapse selected item" /></td>
<td>Collapse selected item</td>
<td>To close the Application folders beneath the selected item</td>
</tr>
<tr>
<td><img src="image" alt="Auto Trouble Locate" /></td>
<td>Auto Trouble Locate</td>
<td>To automatically display failed workload in the Graphical View.</td>
</tr>
</tbody>
</table>
Graphical View

The Graphical View displays the workflow diagram for an Application. It organizes jobs using icons, labels, colored borders, and lines. You can change the Graphical View to suit your needs. For details, see “Changing the Graphical View” on page 398.

Custom View

Another way to display workload is to use a text-based Custom View. There are predefined Custom Views or you can create your own. Custom Views display information according to settings defined in three categories:

- Presentation
- Filter
- Font/Colors

You can create and save Custom Views to display only the information you want, in the format you want. The Custom View displays a text-based view of the workload, see the example below.
For more details, see “Working with Custom Views” on page 518.

Line Mode Interface

The Line Mode Interface (LMI) allows you to issue commands to ESP Workload Manager. Any command listed in the ESP Workload Manager Reference Guide can be entered.

To enter commands using the LMI view

1. At the bottom of the left-hand pane, click the LMI View tab. You may need to use the arrows and scroll to reveal the tab.

   The tree view displays the server connections.
2. Double-click the server connection.  
The LMI view appears in the right-hand pane.

3. In the text field, enter the command.

4. Press **Enter**.  
The results of the command appear in the display area.

5. If required, click **Scroll Lock** to stop the screen from scrolling.  
You can use the standard Windows keystrokes to copy and paste information in LMI:

<table>
<thead>
<tr>
<th>To</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>Control + Insert</td>
</tr>
<tr>
<td>Paste</td>
<td>Shift + Insert</td>
</tr>
<tr>
<td>Copy</td>
<td>Control + C</td>
</tr>
<tr>
<td>Paste</td>
<td>Control + V</td>
</tr>
</tbody>
</table>
Status bar

The status bar appears at the bottom of the Workload Director interface, it displays the following:

- **Toolbar button name** - When you move the cursor over a button on the toolbar, the name of the button appears in the left-hand corner of the status bar.

- **State message update time** - The amount of time since the state, condition, status or hold count of any job within any Application has changed.

- **Transmission data** - When you subscribe, the server connection and transmission data appear on the status bar.

Switching Views

You can switch between the Graphical View, Custom View, and LMI view using the tabs located in the left-hand pane at the bottom of the Workload Director interface.

**To switch to the Graphical View**

1. Click the **Graphical View** tab. The tree view changes to display Applications.
2. Double-click the generation of the Application you want to view. For more details, see “Viewing generations of an Application” on page 428.

**To switch to the Custom View**

1. Click the **Custom View** tab. The tree view changes to display the Custom Views that are defined.
2. Double-click the Custom View name. For more details, see “Working with Custom Views” on page 518.

**To switch to the LMI view**

1. Click the **right arrow** if the **LMI View** tab is not visible.
2. Click the **LMI View** tab. The tree view displays the server connections.
3. Double-click the server connection in the tree view. The LMI view appears in the right-hand pane.
To change the font
1. In the tree view, right-click **ESP Workstation**. The Font option appears.
2. Click the **Font** option. The Font dialog appears.

3. Select the Font, Font Style, and Size you want.
4. Click **OK**.

Receiving workload data

To view workload, you must select a subscribe option to receive the data from ESP Workload Manager. You can:

- Manually subscribe with a filter to limit the Applications in the display.
- Automatically subscribe with a filter so each time you start Workload Director the filtered workload appears. See “Set automatic filters” on page 418.
- Subscribe with no filter to receive all of the workload data.

**Note:** Subscribing with no filter may cause a performance slowdown.

**To receive workload data**

1. Connect to an ESP Workload Manager server, see “Connecting Workstation and ESP Workload Manager” on page 10.
2. Open the Workload Director, see “Opening the Workload Director” on page 386.
3. In the **Graphical View**, right-click one of the servers you are connected to, and select one of the following options from the shortcut menu:
- **Subscribe with Filter** - Select this option to limit the Applications you view. To create a filter, see “Create a filter” on page 406. To apply an existing filter, see “Apply a filter” on page 408.

- **Subscribe No Filter** - Select this option to view the entire set of Applications. A plus sign (+) appears beside the server. To view the Application folders, click the plus sign or double-click the server name. To view a generation of an Application, double-click the generation folder. The Application appears in the Graphical View.

- **Unsubscribe** - Select this option to remove the data from view and end further transmission of data between Workload Director and ESP Workload Manager.

When you subscribe Workload Director displays the transmission in the Status bar.

4. Repeat step 3 for each server you want to receive data from. Before you subscribe to another server, make sure the transmission for the previous server has finished.

**Note:** You might be disconnected from the Workstation server if the subscribe takes more than 10 minutes. If this is the case in your environment, see “Changing the InitConnection file” on page 397.

### Changing the InitConnection file

The InitConnection file resides in the Workstation program files bin directory. Workstation uses the value in this file to determine the interval when Workstation performs a handshaking protocol with the Workstation Server. At the interval specified in the file, Workstation sends a message (RUTHERE) to the Workstation Server. The Workstation Server responds with an acknowledgement (IAMHERE). If the Workstation Server is busy processing a command for more than the time specified in the InitConnection file, the Workstation Server cannot acknowledge the handshake. Workstation concludes the Workstation Server is not up, and it closes the connection. The default value in the InitConnection file is 10 minutes.

The following is the InitConnection configuration file:

```ini
# InitConnection file
#
# <RUTHERE Interval>
# 60000 = 10 minutes

60000
</RUTHERE Interval>

# InitConnection file
```

The line containing the value 60000 is the time interval. The time interval is measured in milliseconds. The formula for the time interval is:

\[ x \times 60 \times 1000 \]

\[ x = \text{minutes} \]

\[ 60 = \text{seconds in 1 minute} \]

\[ 1000 = \text{milliseconds in 1 second} \]
The current setting is 10 minutes multiplied by 60 seconds multiplied by 1000 milliseconds for a time interval of 60000.

**Changing the Graphical View**

You can change the Graphical View in the following ways:

- Change the size of a graph (workflow diagram), enlarge, reduce or fit to window
- Display job attributes
- Change the line style of a graph (direct line or orthogonal)
- Change the graph orientation (vertical or horizontal)
- Change the job name display

**Change the size of a graph**

Use the Graphical View menu or toolbar buttons to change the size of the graph Workstation displays in the Graphical View. You can enlarge (zoom in), reduce (zoom out) or fit the graph in the window.

<table>
<thead>
<tr>
<th>To</th>
<th>Do one of the following</th>
</tr>
</thead>
</table>
| Enlarge a graph     | • From the menu bar, select **Graphical View > Zoom In.**  
|                     | • Use the keyboard shortcut **Ctrl + I.**  
|                     | • From the toolbar, select **Zoom In.**  |
| Reduce a graph      | • From the menu bar, select **Graphical View > Zoom Out.**  
|                     | • Use the keyboard shortcut **Ctrl + U.**  
|                     | • From the toolbar, select **Zoom Out.**  |
### Display job attributes

Display any or all of the job attributes that appear in the Graphical View.

<table>
<thead>
<tr>
<th>To</th>
<th>Do one of the following</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fit a graph in the window</td>
<td>• From the menu bar, select <strong>Graphical View &gt; Graphical Representation &gt; Fit in Window.</strong></td>
</tr>
<tr>
<td></td>
<td>• Use the keyboard shortcut <strong>Ctrl + W.</strong></td>
</tr>
<tr>
<td></td>
<td>• From the toolbar, select <strong>Fit in Window.</strong></td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Graphical View" /></td>
</tr>
<tr>
<td>Display the job name</td>
<td>• From the menu bar, select <strong>Graphical View &gt; Display &gt; Names.</strong></td>
</tr>
<tr>
<td></td>
<td>• From the toolbar, select <strong>Display Names.</strong></td>
</tr>
<tr>
<td>Display the icon that represents the job</td>
<td>• From the menu bar, select <strong>Graphical View &gt; Display &gt; Icons.</strong></td>
</tr>
<tr>
<td></td>
<td>• From the toolbar, select <strong>Display Icons.</strong></td>
</tr>
<tr>
<td>Display the color that represents the state of the job</td>
<td>• From the menu bar, select <strong>Graphical View &gt; Display &gt; State Colors.</strong></td>
</tr>
<tr>
<td></td>
<td>• From the toolbar, select <strong>Display Color.</strong></td>
</tr>
<tr>
<td>Display the state of the job</td>
<td>• From the menu bar, select <strong>Graphical View &gt; Display &gt; State Labels.</strong></td>
</tr>
<tr>
<td></td>
<td>• From the toolbar, select <strong>Display Labels.</strong></td>
</tr>
<tr>
<td>To</td>
<td>Do one of the following</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------------------------------------------------------</td>
</tr>
<tr>
<td>Display all the job</td>
<td>• From the menu bar, select <strong>Graphical View</strong> &gt; <strong>Display</strong> &gt; <strong>All Attributes</strong>.</td>
</tr>
<tr>
<td>attributes</td>
<td>• From the toolbar, select <strong>Display All</strong>.</td>
</tr>
</tbody>
</table>
Change the line style of a graph

Change the line that connects the jobs in a graph. Two styles are available:

- Direct Line style
- Orthogonal Line style

### Direct Line Style

![Diagram of Direct Line Style]

### Orthogonal Line Style

![Diagram of Orthogonal Line Style]

<table>
<thead>
<tr>
<th>To</th>
<th>Do one of the following</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change to Direct Line style</td>
<td>• From the menu bar, select <strong>Graphical View &gt; Graphical Representation &gt; Direct Line Style</strong>.</td>
</tr>
<tr>
<td></td>
<td>• From the toolbar, select <strong>Direct Line Style</strong>.</td>
</tr>
<tr>
<td>Change to Orthogonal Line style</td>
<td>• From the menu bar, select <strong>Graphical View &gt; Graphical Representation &gt; Orthogonal Line Style</strong>.</td>
</tr>
<tr>
<td></td>
<td>• From the toolbar, select <strong>Orthogonal Style</strong>.</td>
</tr>
</tbody>
</table>
Change the graph orientation

Change the orientation of the graph to make it vertical or horizontal.

Vertical orientation

Horizontal orientation

<table>
<thead>
<tr>
<th>To</th>
<th>Do one of the following</th>
</tr>
</thead>
</table>
| Change the orientation  | • From the menu bar, select **Graphical View > Graphical Representation > Horizontal Orientation.**  
                           | • From the toolbar, select **Horizontal Orientation.** |
Change the job name display

You can select how the job name appears in Workload Director graphical views using the User Profile Options.

1. From the Workload Director menu bar, select Options > User Profile Options.
2. Select one of the following options:

<table>
<thead>
<tr>
<th>To display</th>
<th>Example</th>
<th>Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job name and qualifier</td>
<td><img src="image" alt="Job Name Example" /></td>
<td>Job Name</td>
</tr>
<tr>
<td>Job’s alias</td>
<td><img src="image" alt="Long Name Example" /></td>
<td>Long Name</td>
</tr>
<tr>
<td>Job name, qualifier, and job alias</td>
<td><img src="image" alt="Both Job Name and Long Name Example" /></td>
<td>Both Job Name and Long Name</td>
</tr>
</tbody>
</table>

Note: For the changes to take place in Workload Director, you must resubscribe.

Using a Graphical Overview

Generate an overview window of the Graphical View, and use it to zoom in and navigate around an Application. The graphical overview appears as a secondary window in the top right-hand corner of the Workload Director interface. In the graphical overview window, you can box a portion of the graph and move it around to zoom in on a portion of the Application.

This feature is a useful navigation tool for viewing large Applications.

To use the graphical overview

1. Use one of these methods to open the Graphical overview:
   - From the menu bar, select **Graphical View > Overview Window**
   - From the toolbar, click the **Overview Window** icon
   - Use the keyboard shortcut **Ctrl + R**
A secondary window appears that displays the Graphical View of the Application.

2. To view a different area in the Graphical View, click the mouse pointer in the secondary window. When it changes to a cross arrow, drag it to define an area you want to view. Notice the area in the Graphical View that is defined by the secondary window box is brought into focus.
3. Redefine the navigation box in the secondary window by dragging any of its sides to further narrow the view in the Graphical View.

4. To navigate the Graphical View, click and drag the box around in the secondary window.

5. From the toolbar, click **Fit in Window** to return the graph to the normal size.

**Using Filters when displaying Applications**

You can create filters to limit the number of Applications Workload Director displays. Different filters can be used for different servers or you might require multiple filters for the same server, and change the filter you apply at any time. You can also set an option that applies a selected filter automatically each time Workload Director starts.
Create a filter

The following are suggestions for criteria you can filter on:

- Application names
- Event names
- A combination of Application names and Event names

To create a filter

1. In the Graphical View, right-click a server.
   You must have an active connection to the server.

2. From the shortcut menu, click **Subscribe with Filter**.
   The Subscribe with Filter dialog appears.

3. In the **Filter Name** field, enter a name for the filter. Use any unique name that is meaningful.

4. In the **Filter Criteria** box, enter the filter criteria.
   For details, see “Filter Criteria” on page 407. To create more complex filters, see “Operators” on page 407.

5. To view completed Applications when you subscribe, select the **View completed Applications** option. Workload Director displays the completed Applications which are still available on the ESP scoreboard.
6. To view Applications that have been scheduled within a specific time period, select the View Applications from the last option and specify a time period in minutes, hours, days, or workdays.

7. To add the filter to the Select Filter list box, click Add.

8. To apply the filter to the active workload, click OK. Workload Director changes the view to display the filtered Applications.

   Note: Workload Director saves the list of defined filters in the User Profile.

**Filter Criteria**

Use the filter criteria below to create a simple filter.

<table>
<thead>
<tr>
<th>To display</th>
<th>Filter criteria</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applications that have a specific Application name</td>
<td>APPL = ‘applname’ OR APPL EQ ‘applname’</td>
<td>APPL = ‘PAYROLL’ displays all Applications that are named PAYROLL.</td>
</tr>
<tr>
<td>Applications that are driven by a specific Event</td>
<td>EVENT = ‘prefix description’ OR EVENT EQ ‘prefix description’</td>
<td>EVENT = ‘CYBER PAYROLL’ displays all Applications that are triggered by the Event named CYBER.PAYROLL.</td>
</tr>
</tbody>
</table>

   Note: If a prefix has fewer than eight characters, you must add spaces in their place before the description.

   Note: There are three spaces after CYBER before PAYROLL.

   Note: When you enter the filter criteria, make sure you include a space before and after the equal sign.

**Operators**

Enter more complex filter criteria using the following operators:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>AND</td>
<td>Selects only Applications that satisfy both sides of the expression.</td>
<td>APPL = ‘ALPHA’ AND APPL = ‘BETA’ displays all Applications that are named ALPHA and BETA.</td>
</tr>
<tr>
<td>OR</td>
<td>Selects Applications that satisfy at least one side of the expression. The operator AND takes precedence over OR.</td>
<td>APPL = ‘ALPHA’ OR EVENT = ‘CYBER PAYROLL’ displays all Applications that have the name ALPHA or are triggered by the Event CYBER.PAYROLL.</td>
</tr>
</tbody>
</table>
Apply a filter

1. In the Graphical View, right-click the server you want to subscribe to.
2. From the shortcut menu, click **Subscribe with Filter**.
3. In the **Select Filter** list box, select the filter you want to apply.
4. Click **OK**.

Workload Director changes the view to display the filtered Applications and lists

---

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
</table>
| *        | Matches any one character. | APPL = ‘ALPHA*’
displays all Applications that begin with ALPHA and have only one additional character, for example, ALPHA1, ALPHA2. |
| -        | Matches zero or more characters. | APPL = ‘ALPHA-’
displays all Applications that begin with ALPHA, for example, ALPHA, ALPHA1, ALPHABET. |
| ()       | Forces precedence | (JOBNAME(1,3) EQ ‘PAY’ OR JOBNAME(1,3) EQ ‘ACC’) AND APPL EQ 'FINANCE' displays Applications that start with 'PAY' or 'ACC' and belong to an Application called FINANCE. |
| NE or ¬= (for not equal) | Excludes the name | APPL NE ‘ALPHA’
displays all Applications except those named ALPHA. |
the current filter on the toolbar.

![Image of Workload Director interface](image)

### Change a filter

Change the filter criteria for a specific filter at any time.

1. In the Graphical View, right-click the server you want to subscribe to.
2. From the shortcut menu, click **Subscribe with Filter**.
3. In the **Select Filter** list box, select the filter you want to change.
4. In the **Filter Criteria** box, make the desired changes to the filter criteria.
5. To save the changes, click **Update**.
6. To apply the changed filter, click **OK**. Workload Director changes the view to display the filtered Applications.
   
   If you don’t want to apply the filter immediately, click **Cancel**.

### Delete a filter

Remove a filter from the list of available filters.

1. In the Graphical View, right-click any server.
2. From the shortcut menu, select **Subscribe with Filter**. The Subscribe with Filter dialog appears.
3. In the **Select Filter** list box, select the filter you want to delete.
4. To delete the filter, click **Delete**. Workload Director removes the filter name from the Select Filter list box.
5. To close the dialog, click **OK** or **Cancel**.
View the current filter

Check the current filter display to see which subscription filter you are viewing workload through. This display is especially useful when you are working with multiple subscription filters at the same time.

Workload Director displays the current subscription filter on the bar between the toolbar and the tree view. As you work, the display updates automatically whenever you click on an item with a different subscription filter.

- In the tree view, you update the display by clicking on a server connection, Application, sub-Application or job.
- In the graphical view, you update the display by clicking anywhere inside a graphical window.
About Jobs

The Graphical View of Workload Director displays the jobs within an Application. It displays the following attributes for jobs:

- Job icon
- Job name
- Job state label
- Job state color

For information about all the job details available, see “Viewing Details of a Job” on page 443.

Job icons

A job icon represents a single job that ESP Workload Manager is controlling. The colored frame shows the current state of the job. See “Job state colors” on page 412. The icon identifies the job type. Relationships between jobs are shown by the relative positions of the job icons and by dependency lines.

Job name

The job name is shown as the caption below the icon.

For z/OS jobs, only the job name appears in the graphical view. For all other job types, you can set the display to show the job name, the long name or both. Use the User Profile Options to set the graphical view to change the job name display. See “Change the job name display” on page 403.
Job state labels

When ESP Workload Manager manages a job, it passes through different stages in its processing, called states. For example, a job that is held at the Application level will be assigned the state of APPLHOLD. In the Graphical View, the job state appears below the job name. For a list of the available job states, see “State priority defaults” on page 414.

Job state colors

Workload Director uses specific colors to indicate the state of a job. For example, a job that is in a MANHOLD state is the color magenta. You can set the color associated with a state. See “State colors” on page 416.

Hint: Right-clicking a job in Graphical View produces a list of commands. To view more detailed information about the job, select Details.

Application States

Workload Director assigns one of seven possible state categories as the Application state. They are, Trouble, Manual Intervention, Waiting, Processing, Complete, Applhold, and Applwait. The Application state is an indicator of a change that has occurred within an Application that might require action, for example, a failed job. The table below lists the categories and the job states they contain in order of severity.

The Application state is determined by the job within the Application that has the most severe state category. For example, consider an Application that contains the following five jobs:

Job 1 — Job state is FAIL; state category is Trouble.
Job 2 — Job state is SUBERROR; state category is Trouble.
Job 3 — Job state is PREDWAIT; state category is Waiting.
Job 4 — Job state is COMPLETE; state category is Complete.
Job 5 — Job state is PREDWAIT; state category is Waiting.
This Application contains jobs that are in three state categories. They are, Trouble, Waiting, and Complete. Because the category Trouble is the most severe, Workload Director assigns Trouble as the Application state.

<table>
<thead>
<tr>
<th>State Category</th>
<th>Job states</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trouble (most severe)</td>
<td>FAIL, FAILED, INACTIVE, MONERROR, SUBERROR, SYSERROR</td>
</tr>
<tr>
<td>Manual Intervention</td>
<td>MANHOLD, MANTASK, TASK</td>
</tr>
<tr>
<td>Applhold</td>
<td>APPLHOLD</td>
</tr>
<tr>
<td>Applwait</td>
<td>APPLWAIT</td>
</tr>
<tr>
<td>Waiting</td>
<td>EXTERNAL, INPUT, OVERDUE, PREDWAIT, RESWAIT, SUBDELAY, WAITING</td>
</tr>
<tr>
<td>Processing</td>
<td>ACTIVE, BYPASS, BYPASSED, BYPREQ, EXEC, READIED, READY</td>
</tr>
<tr>
<td>Complete (least severe)</td>
<td>COMPLETE</td>
</tr>
</tbody>
</table>

**Setting Options**

Workload Director gives you these options:

- State priority—see “Set the state priority” on page 413.
- Automatic Hide—see “Set automatic hide” on page 417.
- Automatic Subscription—see “Set automatic filters” on page 418.
- Show Custom View Line Count—see “Show or hide the line count” on page 530.
- Auto Trouble Locate—see “Locating Trouble within an Application” on page 435.
- Show Server Response—see “Show server response” on page 420.
- Release Conditions—see “Release Conditions” on page 420.

**Set the state priority**

The state priority determines the state and color of each job that appears in the Custom View. Each state and condition of a job has a priority number assigned to it. The priority number ranges from 1 to 255, where 1 is the highest priority and 255 is the lowest. A state priority of 0 is UNKNOWN. You can change the state priority defaults.

**Note:** For the default settings, see “State priority defaults” on page 414.
To set the state priority

1. From the Options menu, select State Priority.
   The State Priority dialog appears.

2. Change the number in the State Priority field for the state you want to set. Use one of the following methods:
   - Click the State Priority field for the state you want to set. A spin box (double arrow) appears at the end of the field. Click the arrows to move the number up or down.
   - Select the existing number and enter the desired number.

3. Repeat step 2 for each state you want to change.

4. To save the settings, click OK.

State priority defaults

The following table lists the available job states, the default settings for the State Priority dialog, and a description for each state name.

<table>
<thead>
<tr>
<th>State Name</th>
<th>State Priority</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACTIVE</td>
<td>12</td>
<td>The job is active in the system.</td>
</tr>
<tr>
<td>ANC_WAIT</td>
<td>6</td>
<td>A job is waiting for a job with the same name to complete in a previous generation of the same Application.</td>
</tr>
<tr>
<td>APPLHOLD</td>
<td>2</td>
<td>The Application has been held with the HOLD command.</td>
</tr>
<tr>
<td>APPLWAIT</td>
<td>2</td>
<td>The Application has dependencies that are incomplete.</td>
</tr>
<tr>
<td>BYPASSED</td>
<td>5</td>
<td>ESP Workload Manager bypassed the job.</td>
</tr>
<tr>
<td>State Name</td>
<td>State Priority</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>COMPLETE</td>
<td>255</td>
<td>The job completed successfully.</td>
</tr>
<tr>
<td>DBERROR</td>
<td>1</td>
<td>ESP Workload Manager detected an error when accessing a database.</td>
</tr>
<tr>
<td>DEFINED</td>
<td>6</td>
<td>This state is applicable to the distributed environment only. A file is defined.</td>
</tr>
<tr>
<td>EXEC</td>
<td>12</td>
<td>The job is executing in the system.</td>
</tr>
<tr>
<td>EXTERNAL</td>
<td>20</td>
<td>The job is waiting for an External job that is submitted by another Application.</td>
</tr>
<tr>
<td>EXTSCHDOWN</td>
<td>1</td>
<td>The External Scheduler is unavailable.</td>
</tr>
<tr>
<td>FAILED</td>
<td>1</td>
<td>The job failed to complete.</td>
</tr>
<tr>
<td>FLUSHED</td>
<td>1</td>
<td>The job has been flushed from the system.</td>
</tr>
<tr>
<td>INACTIVE</td>
<td>4</td>
<td>The job is inactive. It is not executing.</td>
</tr>
<tr>
<td>INPUT</td>
<td>12</td>
<td>The job is in the input queue. JES has assigned the job a JES number.</td>
</tr>
<tr>
<td>INTVRQ</td>
<td>1</td>
<td>The job requires user intervention.</td>
</tr>
<tr>
<td>JANCWAIT</td>
<td>6</td>
<td>A job is waiting for a job with the same name to complete in a previous generation of an Application with the same name.</td>
</tr>
<tr>
<td>MANHOLD</td>
<td>2</td>
<td>The job is held manually.</td>
</tr>
<tr>
<td>MANSUB</td>
<td>2</td>
<td>The job is waiting for a job submitted outside ESP Workload Manager.</td>
</tr>
<tr>
<td>MANTASK</td>
<td>6</td>
<td>The Task is waiting for manual completion.</td>
</tr>
<tr>
<td>MONERROR</td>
<td>1</td>
<td>ESP Workload Manager has detected an error with the Monitor job.</td>
</tr>
<tr>
<td>MONITOR</td>
<td>6</td>
<td>The job is a monitor job.</td>
</tr>
<tr>
<td>ONREQUEST</td>
<td>8</td>
<td>The job is an on-request job.</td>
</tr>
<tr>
<td>OVERDUE</td>
<td>1</td>
<td>The job is overdue.</td>
</tr>
<tr>
<td>PREDWAIT</td>
<td>5</td>
<td>The job is waiting for its predecessor to complete.</td>
</tr>
<tr>
<td>READY</td>
<td>12</td>
<td>The job is eligible to run.</td>
</tr>
<tr>
<td>State Name</td>
<td>State Priority</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>RESWAIT</td>
<td>2</td>
<td>The job is waiting for a resource to become available.</td>
</tr>
<tr>
<td>RUNNING</td>
<td>10</td>
<td>The job is running.</td>
</tr>
<tr>
<td>SANDELAY</td>
<td>2</td>
<td>The SubApplication is waiting for a previous version of a SubApplication with the same name to complete.</td>
</tr>
<tr>
<td>SAWAIT</td>
<td>2</td>
<td>The SubApplication is waiting for a previous version of a SubApplication with the same name to complete.</td>
</tr>
<tr>
<td>SCHED</td>
<td>6</td>
<td>The job is scheduled to run.</td>
</tr>
<tr>
<td>SUBDELAY</td>
<td>2</td>
<td>The job’s submission is delayed.</td>
</tr>
<tr>
<td>SUBERROR</td>
<td>1</td>
<td>The job encountered an error while being submitted.</td>
</tr>
<tr>
<td>SUBMIT</td>
<td>6</td>
<td>The job is ready to be submitted.</td>
</tr>
<tr>
<td>SYSTEM</td>
<td>1</td>
<td>The job’s completion code is unknown, which can be caused by a TCELL overflow or by a system failure.</td>
</tr>
<tr>
<td>TASK</td>
<td>2</td>
<td>A Task requires completion.</td>
</tr>
<tr>
<td>TIMEWAIT</td>
<td>6</td>
<td>A job is waiting for a time dependency.</td>
</tr>
<tr>
<td>WAITING</td>
<td>2</td>
<td>A job’s submission time is delayed.</td>
</tr>
</tbody>
</table>

**State colors**

Set the color associated with a state for both Applications and jobs.
To set the state color

1. From the **Options** menu, select **State Colors**.
   The Edit State Colors dialog appears.

2. Select the color field for the Application or job you want to set. A color chart appears. Click the color you want to associate with the state.

3. Click **OK**. The change takes effect the next time you open the Workload Director.

Set automatic hide

The automatic hide feature lets you manage the number of completed Applications that appear in Graphical or Custom View. An Application is considered complete when every job within the Application is in a COMPLETE state and the Application is not held nor waiting. By default, Workload Director never removes Applications that are complete from view unless automatic hide parameters are set.

Change the automatic hide default to a specific number of minutes or a specific hour each day. Applications that get removed from view are associated with your filter subscription. To view the hidden Applications again, simply resubscribe with the same filter.

When you hide Applications, you are only removing these Applications from view. Hiding Applications does not delete them from ESP Workload Manager.
To set the Automatic Hide of Applications

1. From the **Options** menu, select **Automatic Hide**. The Automatic Hide dialog appears.

2. Select one or both of the following options:
   - Every [ ] minutes
   - At [hour:minutes:seconds] each day

3. Click **OK**.

You can immediately hide a single Application or multiple Applications:

<table>
<thead>
<tr>
<th>To immediately hide</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>A single Application that is complete.</td>
<td>• On the <strong>Action</strong> menu, select <strong>Application &gt; Hide This Now</strong>.</td>
</tr>
<tr>
<td>All completed Applications.</td>
<td>• On the <strong>Action</strong> menu, select <strong>Hide All Completed Now</strong>.</td>
</tr>
</tbody>
</table>

**Set automatic filters**

Set an option so that each time you start Workload Director it automatically applies a filter to limit the data it receives from ESP Workload Manager. Select a filter for each server connection you have defined in Connection Manager. The default filter is none, which results in all the data that you have access to being received from ESP Workload Manager.
To set automatic filters

1. From the Options menu, select Automatic Subscription. The Default Subscription Filters dialog appears.

   ![Default Subscription Filters dialog]

   **Note:** The server names that appear in the list box are the same as those that appear in Connection Manager.

2. Make sure the Subscribe Automatically option is selected.

3. Click in the Filter Name field. A drop-down menu appears displaying the filters available for the server.

   ![Drop-down menu]

4. From the drop-down menu, select a filter.

   **Note:** To receive all the data from ESP Workload Manager, select the default filter none. To create a filter, see “Create a filter” on page 406. To change the criteria for a filter, see “Change a filter” on page 409.

5. To save the change to the default, click OK. The next time you start Workload Director, it applies the filter you selected in step 4.

To remove automatic filters

1. From the Options menu, select Automatic Subscription. The Default Subscription Filters dialog appears.

2. Select the Subscribe manually radio button.
3. Click **OK**.

The next time you start Workload Director, you can select how to subscribe.

### Show server response

Select whether to show or hide the server responses.

To show server responses, from the **Options** menu, select **Show Server Response**. A check mark indicates messages from the server will be visible.

To hide server responses, from the **Options** menu, select **Show Server Response** if there is a check mark. This action will remove the check mark.

### Release Conditions

You can view the release conditions of a job in Workload Director. The dependency line between two jobs indicates the type of release condition. Use the following table to understand the dependency line types.

<table>
<thead>
<tr>
<th>Example</th>
<th>Dependency Line Description</th>
<th>Release Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Dashed line" /> JobC ➔ JobD</td>
<td>Dashed line</td>
<td>Abnormal completion of the predecessor — Releases the successor job on abnormal termination, including a condition code failure</td>
</tr>
<tr>
<td><img src="image" alt="Dotted line" /> JobA ➔ JobB</td>
<td>Dotted line</td>
<td>Any completion of the predecessor — Releases the successor job when the predecessor terminates successfully or not</td>
</tr>
</tbody>
</table>
You set the release conditions in Workload Editor. For more information on setting release conditions, see “Adding Release Conditions to Job Dependencies” on page 325.

**To view the release condition setting**

In the right-hand pane, right-click the job dependency line on the graph.

The Release Condition dialog appears.
Printing Graphical Views

Print the Applications Workload Director displays in graphical format or text-based format. There is more printing flexibility with the graphical format. For information on printing in text-based, see “Printing Custom Views” on page 532.

The following print tasks can be performed in Graphical View:

- Change the print options
- Print preview and Print
- Print a summary
- PostScript setup

Change the print options

The following print options can be changed for the Graphical View:

- The margin settings
- The portion of the page to print (scale by)
- Printable features — page numbers, a caption, a print border, and crop marks
- Printer options — paper size and orientation, the printer, and other standard printer properties

To change the print options

1. In the tree view, double-click the generation of the Application you want to set options for.
2. From the File menu, select Print Setup. The Print Setup dialog appears.

3. Select a Scale By option:
   - Actual Size (default) - To print the Graphical View at its actual size.
   - Pages - To set the number of page rows and page columns.
4. Optional. In the **Margins** field, enter the desired margin in inches.
5. Optional. Select the check box for any of the following print options:
   - Print Page Numbers
   - Print Caption
   - Print Border
   - Print Crop Marks
   If you have selected Print Caption, enter a caption in the **Caption** field.
6. Optional. To specify the printer options, click the **Printer** button.
   A second Print Setup dialog appears to select the destination printer.

7. Make your selections, and click **OK**.
   The first Print Setup dialog re-appears.
8. Click **OK**.

**Print preview**

Use the print preview feature to view and print an overview of an Application.

**To print a preview**

1. In the tree view, double-click the generation of the Application you want a print preview of.
2. From the **File** menu, select **Print Preview**.
A preview of the Graphical View appears.

3. Click **Print**. The Print dialog appears.
4. Select the print options you want, and click **OK**.

**Print**

When you have set your options, you are ready to print.

1. Click **Print**. The Print dialog appears.
2. Click **OK**.

**Print a summary**

Print a text-based summary of the Application in Graphical View. The following details are available:

- Job Name
- Job Type
- State
- Status
- Predecessors and Successors
To print a summary

1. In the tree view, double-click the generation of the Application you want to print.

2. From the **File** menu, select **Print Summary**.
   A new window appears to display a text-based view of the Application. The Print dialog appears overlapping the new window.

3. Click **OK**.
PostScript setup

Use the PostScript setup feature to establish settings for a PostScript file.

To setup a PostScript file

1. In the tree view, double-click the generation of the Application you want a PostScript file of.
2. From the File menu, select PostScript Setup.
   The PostScript Setup dialog appears.
   
3. Make your selections, and click OK.
4. From the File menu, select Print.
5. In the Print dialog, click the Print to file box, and then click OK. A Print to File dialog appears.
6. Enter a file name for the .prn file in the File name field, and click Save to save the PostScript file to the directory location being shown.

   Hint: Write down the directory location where the PostScript file is being saved.

   Note: Custom View printing is described later in this chapter. See “Printing Custom Views” on page 532.
Controlling Applications

An Application consists of one or more jobs that run under the control of ESP Workload Manager. Use Workload Director to view and control the state of Applications and the jobs they contain. This section describes the operations you can perform on Applications and how to perform them.

To view the list of commands available at the Application level, in the left-hand pane, right-click an Application generation folder.

The command list appears.

- To Insert a Job, see “Inserting Jobs” on page 505
- To Locate a Job, see “Locating a Job within a Graphical View” on page 504
- To Find a Troubled Job, see “Find Troubled Job feature” on page 435
- To View the Details of an Application, see “View Details of an Application” on page 429
- To Complete an Application, see “Completing an Application” on page 432
- To Hold and Release an Application, see “Holding and Releasing Applications” on page 432
- To Unwait an Application, see “Removing Applications from APPLWAIT” on page 434
- To Hide an Application, see “Set automatic hide” on page 417
- To Rerun an Application, see “Application level rerun” on page 436
Viewing generations of an Application

A generation of an Application represents an instance of the Application that is ready to be processed by ESP Workload Manager. Because an Application may be scheduled to run at different times, multiple generations of the Application can occur. Workload Director assigns a number to each occurrence of an Application, referred to as the generation number.

In Workload Director, the Graphical View organizes and displays the Applications and their generations. Each Application is represented by a folder labelled with the Application name and the number of generations of the Application.

To view generations of an Application

In the Graphical View, double-click the folder representing the Application you want to view or click the plus sign (+) beside the Application folder.

Workload Director opens the Application folder and displays all the generations of the Application.

Each generation of the Application is represented by a folder labelled with the Application name, the generation number of the Application, the Application state, and the number of jobs the Application contains.

Application state

An Application will have one of seven possible Application states:

- Trouble
- Manual Intervention
- Applhold
- Applwait
- Waiting
- Processing
- Complete

The Application’s state appears in the Graphical View beside the name of the Application. For more details, see “Application States” on page 412.
View Details of an Application

View the following details of an Application:

- Application name
- State
- Number of jobs within the Application
- Name of the Event that triggered the Application
- User identification of the person who triggered the Application (only if the Event is manually triggered)

To view details of an Application

1. In the Graphical View, select the generation of the Application you require details for.
2. Open the Details dialog using one of these methods:
   - In the left-hand pane, right-click the Application generation folder, and select Details from the shortcut menu.
   - From the Action menu, select Application > Details.

The Details dialog appears.

3. To view more details, click More.
View Jobs in an Application

To view the jobs within an Application in the Graphical View, double-click the
generation of the Application you want to view. The jobs for the Application appear in
the right-hand pane.

Show Statistics

Display statistics relating to the number of Applications you have created and run, the
number of Events you have executed, and the jobs submitted. These statistics
represent information for this ESP Workload Manager system only. No counts are
shown for any ESP Workload Manager proxy systems or any other remote system.

To show statistics

1. In the Graphical View, right-click on the server address.
   A shortcut menu appears.
2. From the shortcut menu, select **Show Statistics**. The Show Statistics dialog appears.

![Show Statistics Dialog](image)

The statistics are measured on the following intervals:

- This year
- This month
- This day
- Since last ESP Workload Manager start

These counters are reset with a ESP Workload Manager cold start.
Completing an Application

You can issue a command to change the state of an Application and all of its jobs to Complete. Completing an Application prevents it from running. Workstation provides three commands to complete an Application.

**Note:** CA recommends you use the **Complete and Release** command to complete Applications.

**To complete an Application**

In the Graphical View, right-click the generation of the Application you want to complete and select one of the following commands.

- **Complete** — Completes an Application generation and all of its jobs. The Complete command does not automatically release an Application. If the Application is in APPLHOLD status, the Application does not complete until you manually release the Application. This command is equivalent to the CA command for CSF.

- **Complete and Release** — Completes an Application generation and releases it. If the Application is in APPLHOLD status, this command removes APPLHOLD. The Complete and Release command is equivalent to the TA command for CSF.

- **Complete This and Prior Generations** — Completes the selected Application generation and all of its jobs, as well as completing previous incomplete Application generations and the jobs within them.

**Holding and Releasing Applications**

Place an entire Application on hold, ensuring that none of the jobs within the Application can run. Hold an Application before the jobs within it start to run or while some of the jobs are currently running. The HOLD command does not affect those jobs currently running but does prevent new jobs from being submitted.

Once you place an Application on hold, its state changes to APPLHOLD. You can remove the APPLHOLD state only by releasing the Application.
To place an Application on hold

1. In the Graphical View, select the generation of the Application you want to hold.
2. Open the Hold dialog using one of these methods:
   - In the left-hand pane, right-click the Application generation folder, and select Hold from the shortcut menu.
   - From the Action menu, select Application > Hold.

The Hold confirmation message appears.

3. Click OK. If the Show Server Response option is enabled, the Server Response dialog appears informing you the Application is held.
4. Click OK. The state of the Application and all of its jobs change to APPLHOLD.

To release an Application from APPLHOLD

1. In the Graphical View, select the generation of the Application you want to release.
2. Open the Release dialog using one of these methods:
   - In the left-hand pane, right-click the Application generation folder, and select Release from the shortcut menu.
   - From the Action menu, select Application > Release.

The Release confirmation message appears.

3. Click OK. If the Show Server Response option is enabled, the Server Response dialog appears informing you the Application is released.
4. Click OK. The state of the Application and all its jobs change to their current states.
Removing Applications from APPLWAIT

An Application that is in APPLWAIT state is waiting for a previous generation of the Application to complete. Use the UNWAIT command to remove the APPLWAIT state condition. The selected Application no longer waits for a previous generation to complete.

To remove an Application from APPLWAIT

1. In the Graphical View, select the generation of the Application you no longer want to wait.

2. Open the Unwait dialog using one of these methods:
   - In the left-hand pane, right-click the Application generation folder, and select Unwait from the shortcut menu.
   - From the Action menu, select Application > Unwait.
   - The Unwait confirmation message appears.

3. Click OK. If the Show Server Response option is enabled, the Server Response dialog appears informing you the Application is no longer waiting.

4. Click OK. The state of the Application and its workload objects change to their current states.
Locating Trouble within an Application

The Auto Trouble Locate feature displays failed workload in the Graphical View. When you open the Graphical View of a particular generation of an Application, the Auto Trouble Locate feature highlights the name of a job that is in the Trouble category. If multiple jobs meet these criteria, then it highlights the last job to experience a problem. As the Application processes, Workstation highlights the most recent job to enter into the Trouble category. This category contains failed jobs and jobs with other errors.

Do one of the following to activate Auto Trouble Locate:

- On the toolbar, click the Auto Trouble Locate button.
- From the menu bar, select Options > Auto Trouble Locate.

A check mark indicates the Auto Trouble Locate function is active.

Find Troubled Job feature

The Find Troubled Job feature highlights troubled jobs one by one.

To activate Find Troubled Job

1. In the Graphical View, right-click on the generation of the Application you want to locate the troubled job in.
   A drop-down list appears.
2. From the drop-down list, select Find Troubled Job or use the keyboard shortcut Ctrl + T.

   The Graphical View appears and the name of the troubled job is highlighted. Continue to use Find Troubled Job to highlight different jobs in the Application.
Application level rerun

You can rerun an entire Application, a group of jobs from an Application, and you can create a list of jobs to rerun by specifying a restart data set name. You can also choose to rerun an Application that has completed.

To rerun an Application

1. In the left-hand pane, right-click the Application generation folder for the Application you want to rerun.
2. From the drop-down menu, select **Rerun**.

   The **Rerun Application** dialog appears and lists all jobs the Application contains in the **Job Name** column. The option to rerun the entire Application is set by default.

3. To rerun the Application if it has already completed, select **Rerun even if completed**.
4. Click **Resubmit**.

To rerun multiple jobs

1. In the left-hand pane, double-click the Application generation folder to graphically display the Application.
2. Select one of the following methods to select and rerun multiple jobs:
• In the right-hand pane, select one job. Right-click the job and select **Resubmit > Resubmit this job with successors**. The Rerun Application dialog appears. The selected job displays with a check mark in the **Root Job** field. This indicates all successors of the selected job will run.

![Rerun Application Dialog](image)

• In the right-hand pane, draw a box around the group of jobs you want to rerun. Right-click any selected job and select **Rerun**. The Rerun Application dialog appears. The selected jobs display with no check mark in the **Root Job** field. This indicates just these jobs will run.

![Rerun Application Dialog](image)

• In the right-hand pane, press the **Shift** key and click the jobs. Right-click any selected job and select **Rerun**. The Rerun Application dialog appears. The selected jobs display with no check mark in the **Root Job** field. This indicates just these jobs will run. The result of this method is the same as the previous example.

![Rerun Application Dialog](image)
3. Click **Show only the jobs selected** button.
   The list of jobs is changed to show just the jobs selected for rerun.

4. Click **Simulate** to receive a confirmation of the jobs selected for rerun.

5. If you agree with the list, click **OK > Rerun**.
To rerun multiple jobs by specifying a restart data set

To rerun jobs by specifying a restart data set, you enter a LISTROOT command in Workstation’s Line Mode Interface. The LISTROOT command is used for taking a checkpoint at any point in time. The LISTROOT command saves a list of waiting jobs in an Application, jobs that have not been readied or completed yet.

Example

If your database gets corrupted during processing, and you issued a LISTROOT command at some point during the processing. You have the ability to rerun all the jobs from the point in time (the checkpoint) you issued the LISTROOT command.

The following is the syntax of the LISTROOT command:

```
LISTROOT APPLICATION(appl name.gen) RDSNAME(dsname) [EXPAND]
```

- `appl name` - Is the name of the application that the command applies.
- `gen` - Is the application generation number. Positive number is interpreted as the absolute generation number, negative or zero - as the number relative to the latest generation. The default is 0.
- `dsname` - Is the name of the data set that the list of root jobs will be written.
- `EXPAND` - Requests that all jobs be listed individually rather than implied by their roots.

1. In the left-hand pane, select the **LMI View** tab at the bottom.
2. Double-click the Workstation server connection. The Line Mode Interface appears.
3. In the text field, enter the LISTLOCK command.
4. Press **Enter**. There is no response to this command.
5. In the left-hand pane, select the **Graphical View** tab at the bottom.
6. Right-click the Application generation folder that contains the jobs you want to rerun.
7. From the drop-down menu, select **Rerun**.
8. In the **Rerun Application** dialog, select the **Data set** option.
9. Enter the name of the data set you specified in the LISTLOCK command.
10. Click **Simulate** to display the jobs to be rerun.
11. If you agree with the list, click **OK > Rerun**.

**Note:** To rerun an individual job, see “Resubmit (this job)” on page 464.
The following additional options are available on the Rerun Application dialog:

- **Show only the jobs selected** — Use this after you have selected the group of jobs you want to rerun. The list of jobs is changed to show just the jobs you have selected.

- **Select All** — Use this to select all the jobs listed, then deselect the jobs you do not want to rerun. This is useful when you want to rerun most of the jobs in the Application.

- **Encore Restart** — Select to restart the jobs under ESP Encore control.

The following fields are available:

- **User1 to User4** — Enter one or more user variables to tailor the JCL as it is submitted.

**Encore Statements tab**

The Encore Statements tab contains predefined ESP Encore statements. All the statements are optional. This tab is enabled when you select the **Encore Restart** check box. You can use ESP Encore statements to indicate special processing options. You can also use this tab to enter any other ESP Encore statement that is not predefined.

**To add a predefined statement**

1. Select the respective check box to add the BACKOUT, CLEANUP, and FORCE statements.

2. Select the respective radio button to add the MODE, AUTO-RESTORE, and HONOR CONDITION CODES statements.
   
   The statement appears in the ESP Encore statements window.

**To modify a predefined statement**

1. Select the predefined statement in the statements window to highlight it.
   
   The statement appears in the edit field.

2. Change the statement.

3. Click **Update**.
   
   The statement window refreshes. The statement remains in the edit field.

   **Note:** Alternatively, you can click **Add** to add the statement.

**To add a new statement**

1. In the edit field, enter any ESP Encore statement.

2. Click **Add**.
   
   The new statement appears in the statement list.
### Predefined statements

The following table describes the predefined ESP Encore statements:

<table>
<thead>
<tr>
<th>Field</th>
<th>Statement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backout</td>
<td>TYPE BACKOUT</td>
<td>Indicates all of the data sets created by the job are backed out. When used, the ESP Encore step executes and the remainder of the job is flushed.</td>
</tr>
<tr>
<td>Cleanup</td>
<td>CLEANUP RESTART(NO)</td>
<td>ESP Encore does not perform data set cleanup during the initial run of the job.</td>
</tr>
<tr>
<td>Cleanup</td>
<td>CLEANUP RESTART(YES)</td>
<td>ESP Encore performs data set cleanup during the initial run of the job.</td>
</tr>
<tr>
<td>Force</td>
<td>FORCE NO</td>
<td>The job does not run if errors are predicted by ESP Encore. This is the default.</td>
</tr>
<tr>
<td>Force</td>
<td>FORCE YES</td>
<td>The job runs despite errors predicted by ESP Encore.</td>
</tr>
<tr>
<td>Mode</td>
<td>MODE NORMAL</td>
<td>The job should run. This is the default.</td>
</tr>
<tr>
<td>Mode</td>
<td>MODE SCAN</td>
<td>ESP Encore performs its normal analysis, produces a report, and then causes the remainder of the job to be flushed. This is used to check for errors prior to the job’s submission.</td>
</tr>
<tr>
<td>Auto-restore</td>
<td>AUTOREST YES</td>
<td>During a job restart, ESP Encore performs automatic recovery of missing data sets. If a restarted step needs a data set which does not exist, then ESP Encore looks for an earlier job step which creates that data set. If such a step is found, then ESP Encore restarts that step also. If any intervening steps update that data set, then those steps are also restarted. If the job steps that precede the FROMSTEP do not match those of the restarted job, then ESP Encore does not attempt to restart any earlier steps.</td>
</tr>
<tr>
<td>Auto-restore</td>
<td>AUTOREST NO</td>
<td>ESP Encore does not perform automatic recovery of data sets. It predicts DATA SET NOT FOUND errors, unless FORCE=YES has been specified.</td>
</tr>
</tbody>
</table>
Display critical paths across Applications

**Dependency:** To use the Display Critical Path command, you require PTF 2839, which provides support for the LAPX command on ESP Workload Manager.

Use the Display Critical Path command to view critical paths across Applications. The command provides a list of critical jobs, the Applications the critical jobs belong to, the anticipated end time for each job and whether the critical job is an External job.

For more information about critical path analysis, refer to the *ESP Workload Manager User’s Guide*.

**To display the critical path for an Application**

1. In the Graphical View, right-click the Application generation you want to display the critical path for.
2. From the drop-down list, select **Display Critical Path**.
3. To locate a critical job, select the job from the list and click **Display Selected Job in Graph**. Workload Director opens the graphical view that contains the selected job and highlights the job.

**Note:** If you select Display All Jobs in Graph, Workload Director opens the graphical view for each Application and highlights the critical jobs.

<table>
<thead>
<tr>
<th>Auto-restore</th>
<th>Statement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>AUTOREST ALWAYS</td>
<td>ESP Encore always performs recovery of missing data sets. If the job steps that precede the FROMSTEP do not match those of the restarted job, then ESP Encore flushes the job and returns a condition code of 40.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Honor condition codes</th>
<th>Statement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>HONORCC ALL</td>
<td>During a job restart, ESP Encore honors any previously coded condition codes and bypasses any step that should have been bypassed based on the condition code parameter.</td>
</tr>
<tr>
<td></td>
<td>HONORCC NONE</td>
<td>ESP Encore does not honor any previously coded condition codes and does not bypass any step that should have been bypassed based on the condition code parameter.</td>
</tr>
</tbody>
</table>

**Field Statement Description**

- **Auto-restore**: AUTOREST ALWAYS
- **Honor condition codes**: HONORCC ALL
  - HONORCC NONE

---

**Auto-restore**: AUTOREST ALWAYS

- ESP Encore always performs recovery of missing data sets. If the job steps that precede the FROMSTEP do not match those of the restarted job, then ESP Encore flushes the job and returns a condition code of 40.

**Honor condition codes**: HONORCC ALL

- During a job restart, ESP Encore honors any previously coded condition codes and bypasses any step that should have been bypassed based on the condition code parameter.

- ESP Encore does not honor any previously coded condition codes and does not bypass any step that should have been bypassed based on the condition code parameter.
Controlling Jobs

This section describes how to use Workload Director to control jobs and their dependencies contained within Applications. It also explains how to insert and resubmit jobs, edit the procedural data sets used in Applications as well as how to edit sequential and partitioned z/OS data sets not used in Applications.

Viewing Details of a Job

In Workload Director’s Graphical and Custom Views, you can view details of a job within an Application. The details you see depend on how the job was defined and what state it is in. Normally, a field would be displayed only if it has a value associated with it. However, the exception to this is the value for Predecessors and Successors will be none.

For example, you may see some of the following details:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job Name</td>
<td>Name of the job</td>
</tr>
<tr>
<td>SAPJOBNAME</td>
<td>Name of the SAP job</td>
</tr>
<tr>
<td>Job ID</td>
<td>A number associated with a job</td>
</tr>
<tr>
<td>Job Type</td>
<td>Type of job, for example, PeopleSoft</td>
</tr>
<tr>
<td>Event Name</td>
<td>Name of the triggering Event</td>
</tr>
<tr>
<td>Application Name</td>
<td>Name of the Application that contains the job</td>
</tr>
<tr>
<td>subApplication Name</td>
<td>Name of the subApplication that contains the job</td>
</tr>
<tr>
<td>Agent Name</td>
<td>Name of the Agent associated with the job</td>
</tr>
<tr>
<td>Tag</td>
<td>Name used to tag jobs in an Application or subApplication</td>
</tr>
<tr>
<td>State</td>
<td>State the job is in, for example, MANHOLD</td>
</tr>
<tr>
<td>Conditions</td>
<td>Conditions that apply to the job</td>
</tr>
<tr>
<td>Hold Count</td>
<td>A number indicating how many predecessors must be run to release the job</td>
</tr>
<tr>
<td>Start Time</td>
<td>Time the job started executing</td>
</tr>
<tr>
<td>End Time</td>
<td>Time the job finished executing</td>
</tr>
</tbody>
</table>
To view details of a job

1. Ensure the Application appears in the right-hand pane, either in Graphical or Custom View.
2. Open the Job Details dialog using one of these methods:
   - Double-click the job.
   - Right-click the job, and select Details from the shortcut menu.
   - Select the job in the right-hand pane. From the Action menu, select Job > Details.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Detailed information about the current state of the job</td>
</tr>
<tr>
<td>User Status</td>
<td>Contains free form information about the job</td>
</tr>
<tr>
<td>Completion Code</td>
<td>A code that indicates if the job ran successfully or not</td>
</tr>
<tr>
<td>Predecessors</td>
<td>Jobs that run before this job</td>
</tr>
<tr>
<td>Successors</td>
<td>Jobs that run after this job</td>
</tr>
<tr>
<td>External jobs, Application ID</td>
<td>Home Application of the External job</td>
</tr>
<tr>
<td>External jobs, Scheduled From</td>
<td>Schedule criteria indicating a start point</td>
</tr>
<tr>
<td>External jobs, Scheduled To</td>
<td>Schedule criteria indicating an end point</td>
</tr>
<tr>
<td>Long name</td>
<td>Character string that provides an alias for the job</td>
</tr>
<tr>
<td>Overdue</td>
<td>The time when a job entered an overdue state</td>
</tr>
<tr>
<td>Avgruntime</td>
<td>The average run time for a job</td>
</tr>
<tr>
<td>Minruntime</td>
<td>The minimum run time for a job, rounded to minutes</td>
</tr>
<tr>
<td>Maxruntime</td>
<td>The maximum run time for a job, rounded to minutes</td>
</tr>
<tr>
<td>File name or Data set name</td>
<td>Name of the file or data set used in File or Data set trigger jobs</td>
</tr>
<tr>
<td>Job Profile</td>
<td>The name of the profile that stores job information.</td>
</tr>
<tr>
<td>Process ID</td>
<td>An OS/400 job id</td>
</tr>
</tbody>
</table>
3. On z/OS jobs additional Application information is available by clicking the More button. Also, step statistics are available by clicking the Step-level statistics button.

4. To close the dialog, click OK.

**Job commands**

There are numerous commands available at the job level. The following table provides a command, a link to a description of the command, and the job type the command is applicable to.

<table>
<thead>
<tr>
<th>Command</th>
<th>Job Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bypass and Unbypass, see page 451</td>
<td>z/OS, Link, Task, Data Set Trigger, File Trigger, UNIX, Linux, OS/400, Windows NT/2000, SAP, OpenVMS, Tandem, Applend, PeopleSoft, FTP, Database, External, External Scheduler and all Monitor jobs</td>
</tr>
<tr>
<td>Browse Online Documentation, see page 451</td>
<td>z/OS, Link, Task, Data Set Trigger, File Trigger, UNIX, Linux, OS/400, Windows NT/2000, SAP, OpenVMS, Tandem, Applend, PeopleSoft, FTP, Database, J2EE, Oracle Apps, External, External Scheduler and all Monitor jobs</td>
</tr>
<tr>
<td>Cancel, see page 477</td>
<td>Windows NT/2000, File Trigger, UNIX, OpenVMS, OS/400, and all Monitor jobs</td>
</tr>
</tbody>
</table>

The Job Details dialog appears.
<table>
<thead>
<tr>
<th>Command</th>
<th>Job Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Complete, see page 451</td>
<td>z/OS, Link, Task, Data Set Trigger, File Trigger, UNIX, Linux, OS/400, Windows NT/2000, SAP, OpenVMS, Tandem, Agent Monitor, Applend, PeopleSoft, FTP, Database, External, External Scheduler, and all Monitor jobs</td>
</tr>
<tr>
<td>Cross-Application Dependencies, see page 452</td>
<td>All job types</td>
</tr>
<tr>
<td>Details, see page 443</td>
<td>z/OS, Link, Task, Data Set Trigger, File Trigger, UNIX, Linux, OS/400, Windows NT/2000, SAP, OpenVMS, DataObject, Tandem, Agent Monitor, Applend, PeopleSoft, FTP, Database, External, External Scheduler, and all Monitor jobs</td>
</tr>
<tr>
<td>Display Blocking Jobs, see page 453</td>
<td>All job types</td>
</tr>
<tr>
<td>Drop Predecessors, see page 453</td>
<td>z/OS, Link, Task, Data Set Trigger, File Trigger, UNIX, Linux, OS/400, Windows NT/2000, SAP, OpenVMS, Tandem, Applend, PeopleSoft, FTP, Database, External, External Scheduler, and all Monitor jobs</td>
</tr>
<tr>
<td>Edit or Browse JCL, see page 454</td>
<td>z/OS jobs</td>
</tr>
<tr>
<td>Edit or Browse CopyJCL, see page 454</td>
<td>z/OS jobs</td>
</tr>
<tr>
<td>Edit or Browse ESP Procedures, see page 455</td>
<td>z/OS, Link, Task, Data Set Trigger, File Trigger, UNIX, Linux, OS/400, Windows NT/2000, SAP, OpenVMS, Tandem, Applend, PeopleSoft, FTP, Database, External, and all Monitor jobs</td>
</tr>
<tr>
<td>Expedite, see “Expedite a job” on page 456</td>
<td>UNIX, Windows NT/2000, and OS/400</td>
</tr>
<tr>
<td>Hold and Release, see page 456</td>
<td>z/OS, Link, Task, Data Set Trigger, File Trigger, UNIX, Linux, OS/400, Windows NT/2000, SAP, OpenVMS, Tandem, Applend, PeopleSoft, FTP, Database, External, External Scheduler, and all Monitor jobs</td>
</tr>
<tr>
<td>Command</td>
<td>Job Type</td>
</tr>
<tr>
<td>---------</td>
<td>----------</td>
</tr>
<tr>
<td>List Job History, see page 456</td>
<td>z/OS, Link, Task, Data Set Trigger, File Trigger, UNIX, Linux, OS/400, Windows NT/2000, SAP, OpenVMS, Tandem, Applend, PeopleSoft, FTP, Database, J2EE, OA, External, External Scheduler, SAP, data set and all Monitor jobs</td>
</tr>
<tr>
<td>List Resource Usage, see page 458</td>
<td>all jobs</td>
</tr>
<tr>
<td>Modify Resources, see page 458</td>
<td>z/OS, Task, Data Set Trigger, File Trigger, UNIX, Linux, OS/400, Windows NT/2000, SAP, OpenVMS, Tandem, Applend, PeopleSoft, FTP, Database, External, and all Monitor jobs</td>
</tr>
<tr>
<td>Process Verify, see page 460</td>
<td>Windows NT/2000, UNIX</td>
</tr>
<tr>
<td>Process Verify, see page 461</td>
<td>OS/400</td>
</tr>
<tr>
<td>Ready, see page 462</td>
<td>z/OS, Link, Task, Data Set Trigger, File Trigger, UNIX, Linux, OS/400, Windows NT/2000, SAP, OpenVMS, Tandem, Applend, PeopleSoft, FTP, Database, External, and all Monitor jobs</td>
</tr>
<tr>
<td>Reply, see page 460</td>
<td>OS/400</td>
</tr>
<tr>
<td>Request and Unrequest, see page 463</td>
<td>z/OS, Link, Task, Data Set Trigger, File Trigger, UNIX, Linux, OS/400, Windows NT/2000, SAP, OpenVMS, Tandem, Applend, PeopleSoft, FTP, Database, External, External Scheduler, and all Monitor jobs</td>
</tr>
<tr>
<td>Reset Times, see page 463</td>
<td>z/OS, Link, Task, Data Set Trigger, File Trigger, UNIX, Linux, OS/400, Windows NT/2000, SAP, OpenVMS, Tandem, Applend, PeopleSoft, FTP, Database, External, and all Monitor jobs</td>
</tr>
<tr>
<td>Restart using Encore, see page 495</td>
<td>z/OS</td>
</tr>
<tr>
<td>Resubmit (this job), see page 464</td>
<td>z/OS, Link, Data Set Trigger, File Trigger, UNIX, Linux, OS/400, Windows NT/2000, SAP, OpenVMS, Tandem, PeopleSoft, FTP, Database, External, and all Monitor jobs</td>
</tr>
<tr>
<td>Resubmit (this job with successors), see page 436</td>
<td>, z/OS, Link, Data Set Trigger, File Trigger, UNIX, Linux, OS/400, Windows NT/2000, SAP, OpenVMS, Tandem, PeopleSoft, FTP, Database, External, and all Monitor jobs</td>
</tr>
<tr>
<td>Command</td>
<td>Job Type</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Retrieve Spool File, see page 468</td>
<td>UNIX (all types), Windows NT/2000, SAP, PeopleSoft, FTP, Database, J2EE EJB and JMS Subscribe jobs, z/OS, OS/400, DB Stored Procedure, and DB SQL.</td>
</tr>
<tr>
<td>Set Job Object, see page 472</td>
<td>Windows NT/2000</td>
</tr>
<tr>
<td>Trigger Event, see page 475</td>
<td>z/OS, Link, Task, Data Set Trigger, File Trigger, UNIX, Linux, OS/400, Windows NT/2000, SAP, OpenVMS, Tandem, Data Object, Applend, PeopleSoft, FTP, Database, J2EE, OA, External, External Scheduler, and all Monitor jobs</td>
</tr>
<tr>
<td>Unwait, see page 467</td>
<td>z/OS, Link, Data Set Trigger, File Trigger, UNIX, Linux, OS/400, Windows NT/2000, SAP, OpenVMS, Tandem, Applend, PeopleSoft, FTP, Database, External, and all Monitor jobs</td>
</tr>
<tr>
<td>Update User Status, see page 467</td>
<td>z/OS, Link, Task, Data Set Trigger, File Trigger, UNIX, Linux, OS/400, Windows NT/2000, SAP, OpenVMS, Tandem, Applend, PeopleSoft, FTP, Database, External, and all Monitor jobs</td>
</tr>
<tr>
<td>JES Release, see page 477</td>
<td>z/OS</td>
</tr>
<tr>
<td>JES Cancel, see page 477</td>
<td>z/OS</td>
</tr>
<tr>
<td>JES Cancel Dump see page 477</td>
<td>z/OS</td>
</tr>
<tr>
<td>JES Cancel Purge, see page 477</td>
<td>z/OS</td>
</tr>
<tr>
<td>JES Display, see page 478</td>
<td>z/OS</td>
</tr>
<tr>
<td>JES Hold, see page 478</td>
<td>z/OS</td>
</tr>
<tr>
<td>JES Stop, see page 478</td>
<td>z/OS</td>
</tr>
<tr>
<td>JES Quiesce, see page 478</td>
<td>z/OS</td>
</tr>
<tr>
<td>JES Resume, see page 479</td>
<td>z/OS</td>
</tr>
<tr>
<td>JES Expedite, see page 479</td>
<td>z/OS</td>
</tr>
<tr>
<td>PS Hold Job, see page 480</td>
<td>PeopleSoft</td>
</tr>
<tr>
<td>PS Restart Job, see page 480</td>
<td>PeopleSoft</td>
</tr>
<tr>
<td>Retrieve Trace File, see page 480</td>
<td>PeopleSoft</td>
</tr>
<tr>
<td>PS Delete Job, see page 480</td>
<td>PeopleSoft</td>
</tr>
<tr>
<td>PS Cancel Job, see page 480</td>
<td>PeopleSoft</td>
</tr>
<tr>
<td>JobModify, see page 481</td>
<td>SAP</td>
</tr>
<tr>
<td>VariantRead, see page 482</td>
<td>SAP</td>
</tr>
<tr>
<td>Command</td>
<td>Job Type</td>
</tr>
<tr>
<td>---------------------------------------------------</td>
<td>-----------------------------------------</td>
</tr>
<tr>
<td>JobLogRead, see page 482</td>
<td>SAP</td>
</tr>
<tr>
<td>JobStatusCheck, see page 482</td>
<td>SAP</td>
</tr>
<tr>
<td>JobStatusGet, see page 483</td>
<td>SAP</td>
</tr>
<tr>
<td>JobDefGet, see page 483</td>
<td>SAP</td>
</tr>
<tr>
<td>JobCancel, see page 483</td>
<td>SAP</td>
</tr>
<tr>
<td>JobDelete, see page 483</td>
<td>SAP</td>
</tr>
<tr>
<td>Start ASAP, see page 484</td>
<td>SAP</td>
</tr>
<tr>
<td>Start Immediately, see page 484</td>
<td>SAP</td>
</tr>
<tr>
<td>GetGlobalAudit, see page 484</td>
<td>SAP</td>
</tr>
<tr>
<td>SetGlobalAudit, see page 484</td>
<td>SAP</td>
</tr>
<tr>
<td>JobSelect, see page 485</td>
<td>SAP</td>
</tr>
<tr>
<td>GetJobCount, see page 486</td>
<td>SAP</td>
</tr>
<tr>
<td>GetJobSpoolList, see page 487</td>
<td>SAP</td>
</tr>
<tr>
<td>SetJobClass, see page 487</td>
<td>SAP</td>
</tr>
<tr>
<td>JobCopy, see page 487</td>
<td>SAP</td>
</tr>
<tr>
<td>JobChildrenGet, see page 488</td>
<td>SAP</td>
</tr>
<tr>
<td>JobGetDump, see page 488</td>
<td>SAP</td>
</tr>
<tr>
<td>Monitor Children, see page 488</td>
<td>SAP</td>
</tr>
<tr>
<td>Job Stop, see page 489</td>
<td>Business Warehouse InfoPackage</td>
</tr>
<tr>
<td>InfoPackage Status, see page 489</td>
<td>Business Warehouse InfoPackage</td>
</tr>
<tr>
<td>InfoPackage Details, see page 489</td>
<td>Business Warehouse InfoPackage</td>
</tr>
<tr>
<td>Get Chain Log, see page 489</td>
<td>Business Warehouse Process Chain</td>
</tr>
<tr>
<td>Get Chain Status, see page 490</td>
<td>Business Warehouse Process Chain</td>
</tr>
<tr>
<td>Get Chain Processes, see page 490</td>
<td>Business Warehouse Process Chain</td>
</tr>
<tr>
<td>Interrupt Chain, see page 491</td>
<td>Business Warehouse Process Chain</td>
</tr>
<tr>
<td>Restart Chain, see page 491</td>
<td>Business Warehouse Process Chain</td>
</tr>
<tr>
<td>Get Message Details, see page 491</td>
<td>Business Warehouse Process Chain</td>
</tr>
<tr>
<td>Get Process Log, see page 491</td>
<td>Business Warehouse Process Chain</td>
</tr>
<tr>
<td>Start ASAP, see page 492</td>
<td>Batch Input Session (BDC)</td>
</tr>
<tr>
<td>Start Immediately, see page 492</td>
<td>Batch Input Session (BDC)</td>
</tr>
<tr>
<td>Job Cancel, see page 492</td>
<td>Batch Input Session (BDC)</td>
</tr>
<tr>
<td>Job Delete, see page 493</td>
<td>Batch Input Session (BDC)</td>
</tr>
<tr>
<td>Monitor Processes, see page 493</td>
<td>Process Monitor</td>
</tr>
<tr>
<td>Cancel a Data Archiving job, see page 494</td>
<td>Data Archiving</td>
</tr>
<tr>
<td>Command</td>
<td>Job Type</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>Delete a Data Archiving job, see page 494</td>
<td>Data Archiving</td>
</tr>
<tr>
<td>Monitor Children, see page 494</td>
<td>Data Archiving</td>
</tr>
<tr>
<td>Cancel Request, see page 502</td>
<td>Oracle Apps</td>
</tr>
<tr>
<td>Hold Request, see page 503</td>
<td>Oracle Apps</td>
</tr>
<tr>
<td>Remove Hold Request, see page 503</td>
<td>Oracle Apps</td>
</tr>
<tr>
<td>View Log, see page 503</td>
<td>Oracle Apps</td>
</tr>
<tr>
<td>View Output, see page 503</td>
<td>Oracle Apps</td>
</tr>
<tr>
<td>View Completion Details, see page 504</td>
<td>Oracle Apps</td>
</tr>
</tbody>
</table>

**Displaying job commands**

To display the job commands for any job type, use one of the following methods:

- In the right-hand pane, right-click the job.
- In the right-hand pane, click the job. From the **Action** menu, select **Job**.
  The shortcut menu appears. Select a job command from the shortcut menu.

**Show server response**

When you select job commands in Workstation, dialogs appear informing you of the response from the Workstation server. You can select whether to show or hide the server response.

**To show server responses**

From the **Options** menu, select **Show Server Response**.
A check mark indicates messages from the server will be visible.

**To hide server responses**

From the **Options** menu, select **Show Server Response** if there is a check mark.
This action will remove the check mark. When Show Server Response is not checked, server responses are not visible.
Command descriptions

**Bypass and Unbypass a Job**

Bypass a job to indicate that it is not required for a particular generation of an Application. ESP Workload Manager updates the status of the job to BYPREQ to indicate that a bypass has been requested. When the job’s predecessors are complete, the job is bypassed and the successor jobs are released. You can change a job from bypass status anytime before it actually becomes bypassed.

1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click **Bypass**.
   The Bypass confirmation message appears.
3. Click **OK**.
   If the Show Server Response option is enabled, the Server Response dialog appears informing you the job is bypassed.
4. Click **OK**.
   The status of the job changes to BYPREQ.

**Unbypass**

If you selected Unbypass, the Unbypass confirmation message appears.

1. Click **OK**.
   If the Show Server Response option is enabled, the Server Response dialog appears informing you the job is unbypassed.
2. Click **OK**.
   The BYPREQ condition is removed from the job.

**Browse Online Documentation**

The Browse Online Documentation command launches an application and displays a documentation file. This enables you to view a documentation file for the job the command is issued from. There are settings in the User Profile Options that must be completed, see “Online Documentation” on page 389.

1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click **Browse Online Documentation**.

**Completing a Job**

When you complete a job, you are informing ESP Workload Manager to consider it complete. A complete job is a job that won’t be run. ESP Workload Manager runs the job’s successors, as soon as the job is completed.
Note: You cannot uncomplete a job. If you mistakenly complete a job, you can insert another occurrence of it (qualified for uniqueness) with the required dependencies, although the job’s successors may have already been released.

1. In the right-hand pane, right-click the job. The shortcut menu appears.

2. Click Complete.
   The Complete confirmation message appears.

3. Click OK.
   If the Show Server Response option is enabled, the Server Response dialog appears informing you the job is marked as complete.

4. Click OK.
   The state of the job changes to COMPLETE.

Display job dependencies across Applications

Dependency: To use the Cross-Application Dependencies command, you require PTF 2839, which provides support for the LAPX command on ESP Workload Manager.

The Cross-Application Dependencies command provides a list of all predecessor and successor jobs of a selected job, as well as the Application names those jobs belong to. You can use this command to identify Applications that are connected by External jobs and to locate the External jobs in the Application graphical view.

1. In the right-hand pane, right-click the job. The shortcut menu appears.

2. Click Cross-Application Dependencies.
   The Cross Application Dependencies dialog appears listing all predecessor and successor jobs of the selected job.

3. To locate a predecessor (or successor) job in its Application graphical view, select the job and click Display Selected Predecessor in Graph (or Display Selected Successor in Graph). Workload Director opens the graphical view that contains the selected job and highlights the job.

Note: If you select Display All Predecessors in Graph (or Display All Successors in Graph), Workload Director opens the graphical view for each Application in the Predecessors (or Successors) list and cascades the views ending with the last Application on the list.
Display reasons a job is prevented from running

**Dependency:** To use the Display Blocking Jobs command, you require PTF 2839, which provides support for the LAPX command on ESP Workload Manager.

Use the Display Blocking Jobs command to locate problem (blocking) jobs that are preventing a particular job from running and view the reasons for those problem jobs.

When you issue the Display Blocking Jobs command against a job, ESP Workload Manager examines the chain of predecessor jobs and displays any jobs in the chain that are not in a PREDWAIT state, including jobs that are in another Application (external jobs).

**Note:** Use the Cross-Application Dependencies command to view a list of Applications that are connected by External jobs and the names of those jobs. For more information, see “Display job dependencies across Applications” on page 452.

1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click **Display Blocking Jobs**.

The Blocking Jobs dialog appears with a list of blocking jobs, the Application name each job belongs to, and the blocking reason.

The following blocking reasons may appear:

<table>
<thead>
<tr>
<th>Reason</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>IS RUNNING</td>
<td>The blocking job is executing.</td>
</tr>
<tr>
<td>HAS FAILED</td>
<td>The blocking job has failed.</td>
</tr>
<tr>
<td>IS EXTERNAL</td>
<td>The blocking job is an external job that has not started running and therefore ESP Workload Manager does not recognize it.</td>
</tr>
<tr>
<td>HAS NOT STARTED</td>
<td>The blocking job has not started and might be in RESWAIT.</td>
</tr>
</tbody>
</table>

3. To locate a blocking job in its Application graphical view, select the job from the list and click **Display Selected Job in Graph**. Workload Director opens the graphical view that contains the selected job and highlights the job.

**Note:** If you select **Display All Jobs in Graph**, Workload Director opens the graphical view for each Application in the blocking jobs list and cascades the views ending with the last Application on the list.

**Dropping Predecessor Dependencies**

Drop a job’s dependency on the completion of its predecessors. Drop one, some or all predecessors of a job.
1. In the right-hand pane, right-click the job. The shortcut menu appears.

2. Click **Drop Predecessors**.
   The Drop Predecessors dialog appears.

3. Select the predecessors you want to drop using one of these methods:
   - To drop one or more predecessors, use the Predecessor list box. Click the predecessor you want to drop. To select more than one predecessor not in a range, use **Ctrl+click**. To select a range of predecessors, use **Shift+click**.
   - To drop all of this job’s predecessors, check-mark the **Drop All Predecessors** box.

4. Click **OK**.
   If the Show Server Response option is enabled, the Server Response dialog appears informing you of the dependencies that have been dropped.

5. Click **OK**.
   The state of the job changes appropriately.

---

**Edit or Browse JCL**

Use these commands to edit or browse your job’s JCL from Workload Director. The Edit JCL function opens the JCL library that is used for job submission.

You can edit or browse your job’s JCL prior to job submission in an active Application.

**To edit JCL**

1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click **Edit JCL**.
   The Edit JCL dialog appears displaying the JCL.
3. Edit the JCL as required.
4. To save your changes to the mainframe, click **Upload**.
5. To leave the Edit JCL dialog without making any changes, click **Cancel**.

**To browse JCL**

1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click **Browse JCL**.
   The Browse JCL dialog appears displaying the JCL.

---

**Edit or Browse CopyJCL**

Use these commands to edit or browse the CopyJCL of your jobs from Workload Director.
These commands retrieve the COPYJCL only after JES processes the job.

**Note:** You can use a Find command to search through CopyJCL. You can also do a find and replace.

**To edit CopyJCL**

1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click **Edit CopyJCL**.
   The Edit CopyJCL dialog appears displaying the CopyJCL.
3. Edit the CopyJCL as required.
   **Note:** To search the CopyJCL, right-click in the text area and select **Find**. The **Replace** dialog appears, which you can use to search for a string or to find and replace a string.
4. To save your changes to the mainframe, click **Upload**.
5. To leave the Edit CopyJCL dialog without making any changes, click **Cancel**.

**To browse CopyJCL**

1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click **Browse CopyJCL**.
   The Browse CopyJCL dialog appears displaying the CopyJCL.

**Edit or Browse ESP Procedures**

Use Workload Director to edit or browse ESP Procedures.

**To edit a procedure**

1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click **Edit Procedure**.
   The Edit Procedure dialog appears displaying the procedure.
3. Edit the procedure as required.
4. To save your changes to the mainframe, click **Upload**.
5. To leave the Edit Procedure dialog without making any changes, click **Cancel**.

**To browse a procedure**

1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Select **Browse Procedure** from the shortcut menu.
   The Browse Procedure dialog appears displaying the procedure.
Expedite a job

**Dependency:** ESP System Agent, Release 7 (for Windows or UNIX jobs) or ESP System Agent for i5/OS, Release 7 (for OS/400 jobs)

Use the **Expedite** command to manually expedite a UNIX, Windows, or OS/400 job according to its expedite policy and state.

1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Select **Expedite** from the shortcut menu.
   
   The Expedite dialog appears.

Holding and Releasing jobs

You can hold a job prior to submission. ESP Workload Manager changes the condition of the job you hold to MANHOLD. When you are ready to submit the job, release it.

1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click **Hold**.
   
   The Hold dialog appears.
3. In the **Reason** field, enter a reason for holding this job. This is Optional. The reason appears in the Details dialog for the job in the User Status field.
4. Click **OK**.
   
   If the Show Server Response option is enabled, the Server Response dialog appears informing you the job is held.
5. Click **OK**.
   
   Workload Director adds a condition of MANHOLD to the job.

Release

If you selected **Release**, the Release confirmation message appears.

1. Click **OK**.
   
   If the Show Server Response option is enabled, the Server Response dialog appears informing you the job is released.
2. Click **OK**.
   
   The MANHOLD condition is removed from the job.

List Job History

Use this command to display the history for a tracked job. List Job History displays the job number, submission date and time, current status, and completion code.

1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click **List Job History**.
   
   The List Job History confirmation message appears.
3. Click **OK**.
   The job history report appears.
List Resource Usage

Use the **List Resource Usage** command to view a list of resources associated with a job and the resource properties. List Resource Usage displays the following properties:

- Resource Name
- Quantity
- Availability
- Max Availability
- Resource Type
- Absorbed By
- Needed By
- Used By

1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click **List Resource Usage**.
   The List Resource Usage dialog appears.
   - To view details for a single resource, click the **Details** button for the resource.
   - To view details for all resources listed, click **Show All**.

Modifying Resource Dependencies

A resource is any type of real or abstract object that affects a job’s ability to run successfully and can be quantified. A tape drive is an example of a resource. You can remove a job’s dependency on a resource, change the dependency or add a resource dependency.
1. In the right-hand pane, right-click the job. The shortcut menu appears.

2. Click **Modify Resource**.
   The Modify Resource dialog appears.

![Modify Resource Dialog]

**Note:** A resource name followed by **NOT** indicates an inverse or negative resource.

3. Select one of the following options:
   - To remove all resource dependencies, check-mark the **Drop All Resource** box, and click **Drop**.
   - To modify a resource, select the resource from the Resources list and click **Modify**. The Modify Resource dialog appears. You can change the quantity of the resource.
   - To add a resource, click **Modify**.
   The Add Resource dialog appears. You must specify a name and quantity.

4. Complete these fields as required to add a resource:
   - **Name** - The resource name can be up to 44 alphanumeric characters.
   - **Quantity** - Specify the quantity of the resource required to run this job.

5. Click **OK**.
   The state of the job changes to READY or it reflects any other dependencies still outstanding.

---

Controlling Jobs 459
**Note:** Resource Dependencies are not affected by the Ready command. Resources must be satisfied before a job can run. You cannot modify the resource dependencies of a job that is already waiting for resources (in RESWAIT state). Once a job is in a RESWAIT state, you can only drop resource dependencies.

6. Click the **Details** button to display information about the resource your job requires. The following information is displayed:

- The type of resource you have requested
- Other jobs that are waiting for the resource
- Jobs that are currently executing and holding the resource
- The amount of resources in use from the resource pool
- The amount of resources available in the resource pool

**Verifying whether a process is running on UNIX or Windows**

**Dependency:** ESP System Agent Release 7

You can issue the Process Verify command to verify whether a process is running on a UNIX or Windows job

- Is running
- Has executed and completed
- Has executed and failed

**Note:** ESP Agent must be running.

**To verify whether a UNIX or Windows job is running or has executed**

1. In Workload Director, right-click the job you want to verify and select **Process Verify**.

   The Process Verify dialog appears.
2. In the **Process ID** field, leave the number that is displayed to verify the selected job. If you cannot see a Job ID (this is the process ID for the job on the machine where the job runs), the job has not run through an EXEC state, so you cannot verify the selected process.

You can also enter the Job ID of any other job on that ESP Agent machine to verify if that process is running or has executed.

**Hint:** In Workload Director, you can view the **Job ID** in the **Job Details** dialog. To open the dialog, double-click the job.

3. Click **OK**.

The process status message appears in the following locations:
- Workload Director status bar
- Workstation trace.txt file

**Note:** To set a trace file, see “Trace File” on page 7.

**Process status messages**
- **Unable to catch or not child** — The job has executed and completed or the job has executed and failed.
- **Process is child and running** — The job is running.

### Verifying if an OS/400 job is running or has completed

**Dependency:** ESP System Agent for i5/OS, Release 7

You can verify if an OS/400 job
- Is running
- Has completed

**Note:** ESP Agent must be running.

#### To verify if an OS/400 job is running or has completed

1. In Workload Director, right-click the OS/400 job you want to verify and select **Process Verify**.
   
   The Process Verify dialog appears.
2. In the **Process ID** field, leave the number that is displayed to verify the selected job. If you cannot see a process ID (this is the process ID for the job on the machine where the job runs), the job has not run through an EXEC state, so you cannot verify the selected process.

You can also enter the process ID of any other job on that ESP Agent machine to verify if that process is running or has executed.

**Hint:** In Workload Director, you can view the process ID in the **Job Details** dialog. To open the dialog, double-click the job. The process ID format is jobnumber/username/processname.

The process status message appears in the following locations:

- Workload Director status bar
- Workstation *trace.txt* file

**Note:** To set a trace file, see “Trace File” on page 7.

**Process status messages**

- **ended in a normal manner** — The job has executed and completed.
- **executing at (agent name)** — The job is running.

**Readying Jobs**

A job is not ready for submission until all of its predecessor and time dependencies are satisfied. You need to mark a job Ready and remove all its dependencies (including time, predecessors, and manual hold).

1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click **Ready**.
   
   The Ready confirmation message appears.
3. Click **OK**.
   
   If the Show Server Response option is enabled, the Server Response dialog appears informing you the job is not held.
4. Click **OK**.
   
   The job is marked as Ready.

**Reply to an ESP Agent for OS/400 jobs**

You can use the Reply command against an OS/400 job to reply to a prompt from the ESP Agent.

**Note:** To issue the command, the job must be in an EXEC state with a condition of INTVRQ (intervention required).
1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click **Reply**.
   The Reply dialog appears and display a message from the ESP Agent prompting you for input.
3. In the **Message Reply** field, enter the required input.
4. Click **OK**.

**Requesting and Unrequesting Jobs**

Use the Request command to schedule jobs that run irregularly, but need to be included within an existing Application. Request a job anytime up to the time ESP Workload Manager submits the job. You can unrequest jobs that have been requested.

1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click **Request**.
   The Request confirmation message appears.
3. Click **OK**.
   If the Show Server Response option is enabled, the Server Response dialog appears informing you the job is requested.
4. Click **OK**.
   The condition of the job changes to REQUESTED. The job runs when all of its dependencies are met.

**Unrequest**

If you selected **Unrequest**, the Unrequest confirmation message appears. You can only unrequest jobs that have been REQUESTED.

1. Click **OK**.
   If the Show Server Response option is enabled, the Server Response dialog appears informing you the job is unrequested.
2. Click **OK**.
   The condition of the job changes to REQUEST.

**Viewing and Resetting Time Dependencies**

A job can have several types of time dependencies:

- When to submit the job
- When to consider the job late (overdue)
- When to abandon predecessor dependencies or submission of the job
- When to submit a job without its resources
You can view, remove, change or add time dependencies of a job.

1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click **Reset Times**.
   The Reset Times dialog appears.
3. Add or modify the time in the applicable fields.
   Examples of times are Now plus 10 minutes, 8am, 4pm today plus 1 workday.
   For an explanation of when to use the fields, refer to the table that follows.

<table>
<thead>
<tr>
<th>Field</th>
<th>Use to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do not submit before</td>
<td>Specify a job’s submit time.</td>
</tr>
<tr>
<td>Overdue if not started by</td>
<td>Specify the latest acceptable time by which the job must start before it is considered overdue.</td>
</tr>
<tr>
<td>Overdue if not completed</td>
<td>Indicate the time when a job should complete successfully.</td>
</tr>
<tr>
<td>Abandon predecessor dependencies at</td>
<td>Submit a job without its predecessor dependencies once it meets a specified time. This does not override a manual hold or a time dependency.</td>
</tr>
<tr>
<td>Abandon submission at</td>
<td>Specify the latest time this job can be submitted. If not submitted by this time, the job is bypassed.</td>
</tr>
<tr>
<td>Abandon resources at</td>
<td>Submit a job without its resources once it meets a specified time.</td>
</tr>
</tbody>
</table>

**Resubmit (this job)**

**To resubmit an individual job**

1. In the left-hand pane, double-click the Application generation folder to graphically display the Application.
2. Select the job you want to resubmit.
3. Right-click the job and select **Resubmit > Resubmit this job**.
   The Restart dialog appears.
4. At this point you have a few choices:
   - Click **Resubmit** to resubmit the job
   - Select the **Encore Restart** option to restart the job under ESP Encore control
   - Edit the system and ESP Encore statements

**Restart tab**

The following system statements appear on the Restart tab. They are all optional.
- **Dataset** — Enter or select from the drop-down list the data set from which the JCL should be submitted. Do not use quotation marks.
- **Member** — Enter the member containing the JCL. Specify up to eight alphanumeric characters. Do not use quotation marks.
- **User 1 to User 4** — Specify one or more user variables. These are used to tailor the JCL as it is submitted.
- **From Step** — Indicates the first step executed. This field is enabled when the Encore Restart option is checked.
- **To Step** — Indicates the last step executed. This field is enabled when the Encore Restart option is checked.
- **Exclude Steps** — Indicates the steps excluded when a range is specified. This field is enabled when the Encore Restart option is checked.
- **Job ID** — Displays the job number of the job.
- **Encore Restart** — Indicates to restart the job under ESP Encore control.
- **User variables are case sensitive** — Enable this option if you entered user variables and they are case sensitive.

### Encore Statements tab

The Encore Statements tab contains predefined ESP Encore statements. All the statements are optional. This tab is enabled when you select the **Encore Restart** check box. You can use ESP Encore statements to indicate special processing options. You can also use this dialog to enter any other ESP Encore statement that is not predefined.

#### To add a predefined statement

1. Select the respective check box to add the BACKOUT, CLEANUP, and FORCE statements.
2. Select the respective radio button to add the MODE, AUTO-RESTORE, and HONOR CONDITION CODES statements.
   The statement appears in the ESP Encore statements window.

#### To modify a predefined statement

1. Select the predefined statement in the statements window to highlight it.
   The statement appears in the edit field.
2. Change the statement.
3. Click **Update**.
   The statement window refreshes. The statement remains in the edit field.

**Note:** Alternatively, you can click **Add** to add the statement.
To add a new statement
1. In the edit field, enter any ESP Encore statement.
2. Click Add.
   The new statement appears in the statement list.

Predefined statements
The following table describes the predefined ESP Encore statements:

<table>
<thead>
<tr>
<th>Field</th>
<th>Statement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backout</td>
<td>TYPE BACKOUT</td>
<td>Indicates all of the data sets created by the job are backed out. When used, the ESP Encore step executes and the remainder of the job is flushed.</td>
</tr>
<tr>
<td>Cleanup</td>
<td>CLEANUP RESTART(NO)</td>
<td>ESP Encore does not perform data set cleanup during the initial run of the job.</td>
</tr>
<tr>
<td>Cleanup</td>
<td>CLEANUP RESTART(YES)</td>
<td>ESP Encore performs data set cleanup during the initial run of the job.</td>
</tr>
<tr>
<td>Force</td>
<td>FORCE NO</td>
<td>The job does not run if errors are predicted by ESP Encore. This is the default.</td>
</tr>
<tr>
<td>Force</td>
<td>FORCE YES</td>
<td>The job runs despite errors predicted by ESP Encore.</td>
</tr>
<tr>
<td>Mode</td>
<td>MODE NORMAL</td>
<td>The job should run. This is the default.</td>
</tr>
<tr>
<td>Mode</td>
<td>MODE SCAN</td>
<td>ESP Encore performs its normal analysis, produces a report, and then causes the remainder of the job to be flushed. This is used to check for errors prior to the job’s submission.</td>
</tr>
<tr>
<td>Auto-restore</td>
<td>AUTOREST YES</td>
<td>During a job restart, ESP Encore performs automatic recovery of missing data sets. If a restarted step needs a data set which does not exist, then ESP Encore looks for an earlier job step which creates that data set. If such a step is found, then ESP Encore restarts that step also. If any intervening steps update that data set, then those steps are also restarted. If the job steps that precede the FROMSTEP do not match those of the restarted job, then ESP Encore does not attempt to restart any earlier steps.</td>
</tr>
</tbody>
</table>
Removing Jobs from JANCWAIT

A job in JANCWAIT state is waiting for the same job to complete in a previous generation of the same Application (an ancestor). If you do not want this job to wait for an ancestor to complete, remove it from the wait state.

1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click Unwait.
   The Unwait confirmation message appears.
3. Click OK.
   If the Show Server Response option is enabled, the Server Response dialog appears informing you the job is unwaited.
4. Click OK.
   The state of the job changes to its current state.

Updating the User Status Field of a Job

The User Status field appears on the Details dialog for a job. Use this field to communicate information to other users. Enter text in the User Status field to notify other users of the reason for an action. For example, if you place a job on hold, you can enter the reason for the hold in the User Status field.

<table>
<thead>
<tr>
<th>Field</th>
<th>Statement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto-restore</td>
<td>AUTOREST NO</td>
<td>ESP Encore does not perform automatic recovery of data sets. It predicts DATA SET NOT FOUND errors, unless FORCE=YES has been specified.</td>
</tr>
<tr>
<td>Auto-restore</td>
<td>AUTOREST ALWAYS</td>
<td>ESP Encore always performs recovery of missing data sets. If the job steps that precede the FROMSTEP do not match those of the restarted job, then ESP Encore flushes the job and returns a condition code of 40.</td>
</tr>
<tr>
<td>Honor condition codes</td>
<td>HONORCC ALL</td>
<td>During a job restart, ESP Encore honors any previously coded condition codes and bypasses any step that should have been bypassed based on the condition code parameter.</td>
</tr>
<tr>
<td>Honor condition codes</td>
<td>HONORCC NONE</td>
<td>ESP Encore does not honor any previously coded condition codes and does not bypass any step that should have been bypassed based on the condition code parameter.</td>
</tr>
</tbody>
</table>
1. In the right-hand pane, right-click the job. The shortcut menu appears.

2. Click **Update User Status**.
   The Update User Status dialog appears.

3. In the **User Status** field, enter your text.

4. Click **OK**.
   If the Show Server Response option is enabled, the Server Response dialog appears informing you the user status is updated.

5. Click **OK**.
   The User Status field updates the details for the job.

### Spool File Retrieval

Use the Retrieve Spool File command to retrieve a job’s spool file. You can retrieve the spool file for a job whether the job is executing, completed or failed. Spool file retrieval is available for jobs submitted from any ESP Agent at Release 5 or higher.

#### z/OS jobs

Use the Retrieve Spool File command to view output spool files for a z/OS job in both JES2 and JES3 environments. You require authority to view the JES spool files.

The following Retrieve Spool File dialog appears for z/OS jobs.

- To view a specific spool file, select the file and click **Retrieve Selected**.
- To view all spool files, click **Retrieve All**.

**Note:** The Retrieve Spool File command for z/OS jobs corresponds to the ESP Workload Manager JESOUT command. For more information about JESOUT, see the *ESP Workload Manager Reference Guide.*
**SAP, PeopleSoft, FTP, Database, and J2EE jobs**

The following Retrieve Spool File dialog is applicable for the SAP, PeopleSoft, FTP, Database, and J2EE EJB and JMS Subscribe job types:

![Retrieve Spool File dialog](image)

**Windows and UNIX jobs**

The following Retrieve Spool File dialog is applicable for the UNIX (all types) and Windows NT/2000 job types:

![Retrieve Spool File dialog](image)

**Description of buttons**

**Retrieve All**

Click this button to retrieve the whole spool file. It is important to note this can be a very large file and may take considerable time. The Retrieve Next button retrieves 24k sections at a time.
Retrieve Next
Click this button to retrieve the first 24k from the spool file. Clicking Retrieve Next a second time retrieves the second 24k from the spool file. Clicking Retrieve Next a third time retrieves the third 24k from the spool file, and so on.

Retrieve Selected
Click this button to retrieve a portion of the spool file, according to the selection criteria entered on the left side of the dialog.

Stop Retrieval
Click this button to stop the retrieval process. This is useful when the whole spool file is being retrieved.

Append to the existing display
Check-mark this box to indicate the current display is to join on to the previous display. This can be used when retrieving 25k sections of the spool file, and when retrieving lines.

To search a portion of the spool file for a last match
1. To indicate you want to specify a text string and a range for the spool file retrieval, click the Selection Criteria button.
2. In the Line contains field, enter a text string. Lines that contain the exact string will be returned. This is a straight text string search, no wildcards.
3. In the Last match field, a check mark indicates only the last line (between the range) that satisfies the text entered in the ‘Line contains’ field will be returned.
4. In the Start of range field, indicate the start point where the spool file portion will be retrieved.
5. In the End of range field, indicate the end point where the spool file portion will be retrieved.
6. Select either Line, Bytes, KBytes or MBytes to indicate the start and end point format.
7. Click **Retrieve Selected**.

![Retrieve Spec File](image)

The display will contain the last line (Last match) between lines 12 and 120 that contains the text string ‘error’. If Last match is not checked, all lines in the specified range containing the text string ‘error’ will be displayed.

8. When finished, click **OK** to close the dialog.
To search \( x \) number of lines of the spool file

1. Select the Last number of lines to display button, to indicate you want to retrieve a certain number of lines from the spool file. This is mutually exclusive from searching for text within a range.
2. Enter a number in the text field.
3. Click **Retrieve Selected**.

The display will contain the last 100 lines of the spool file or less if the file is smaller.

**Setting Windows job object properties**

**Dependency:** ESP System Agent Release 7

You can modify the properties for a Windows job object that an active Windows job is associated with. To change a Windows job object properties, the job must be in EXEC state.

A Windows job object enables you to group processes together and control their attributes as a single entity. You can use a Windows job object to manage processing properties for a group of jobs such as processor usage, memory usage, and process priority.

**Note:** After all processes associated with a job object complete, the job object no longer exists.

**To set a Windows job object’s properties**

1. In Workload Director, right-click a Windows job and select **Set Job Object**.
2. In the **Set Job Object** dialog, define the following mandatory fields:
• **Job object name** — Name of the existing Windows job object that you want to modify.

The name you specify does not have to be the job object that the selected job is associated with. You can modify any existing Windows job object properties in the **Set Job Object** dialog by entering that Windows job object name.

Enter a value for *at least one* of the following fields. To use an existing property value, leave the field empty.

- **Job memory** — Maximum virtual memory in bytes allocated to all processes associated with the job object. If the total memory used for all processes associated with the job object exceeds this limit, the job that is trying to use memory fails. Select the unit: Bytes, Kilobytes, Megabytes, or Gigabytes.

- **Process memory** — Maximum virtual memory in bytes allocated to each process associated with the job object. If the memory used for a single process exceeds this limit, the job fails. Select the unit: Bytes, Kilobytes, Megabytes, or Gigabytes.

- **Job time** — Maximum CPU time in milliseconds allocated to all processes associated with the job object. If the total CPU time for all processes associated with the job object exceeds this limit, all jobs associated with the job object fail.

- **Process time** — Maximum CPU time in milliseconds allocated to each process associated with the job object. If the CPU time used for a single process exceeds this limit, the job fails.

- **Process priority** — Process priority for all processes in the job object
  - **High** — Processes that must be executed immediately. These processes can use nearly all available CPU time.
  - **Below normal** — Processes that have priority above the Idle level, but below the Normal level
  - **Normal** — Processes without special scheduling needs
  - **Above normal** — Processes that have priority above the Normal level, but below the High level
  - **Idle** — Processes that will run only when the system is idle

- **Process limit** — Maximum number of simultaneously active processes allowed in the job object

**Note:** Changing the Active process limit does not affect jobs that are already running. For example, a Windows job object has its Active process limit set to three, and two jobs associated with the job object are already running. If you change the limit to one, those two jobs will continue to run. However, if you insert a new Windows job into an Application and associate the new job with that Windows job object, the new job will not run. The job object has already reached its Active process limit of one.
Example: Modifying a Windows job object's process memory

In this example, a job named Sleep is executing and using 8 MB of memory.

Sleep is associated with a Windows job object named ProcJobObject. ProcJobObject has its process memory set to 20 MB and its priority set to High.

As Sleep is executing, ProcJobObject’s process memory is changed to 10 MB and its priority is changed to Idle. The process runs with a low priority and when the process reaches 10 MB, the process ends.
Example: Setting the process priority for a Windows job using the Set Job Object command

In the following example, the Sleep job is associated with the Windows job object named newJO and is in EXEC state. The priority for all processes in the newJO job object is increased to Above normal (the other job object properties are not changed).

![Set Job Object dialog box](image)

### Trigger Event

Use this command to trigger the Event associated with the Application of the jobs you are viewing in Workload Director.

1. In the right-hand pane, right-click any job in the Application you are viewing. The shortcut menu appears.

2. Click **Trigger Event**.
   
The Trigger Event dialog appears.

### Trigger Options

#### Schedule criteria

Use this field to indicate a time, and optionally a date, when the trigger is to occur. Choose to have the new time and date replace the next scheduled Event or execute in addition to the next scheduled Event. For information on using the Schedule Criteria Editor, see “Schedule Criteria Editor” on page 108.

Instead of scheduling a trigger, you can select the **Bypass next scheduled execution** check box to skip the next scheduled Event.
Start with job
Indicates one or more job names belonging to the Application generated by this Event. This requests that only those jobs specified are to be submitted. Use this field if you want to build an Application of certain jobs. This is useful if you want to run or rerun, part of an Application. Each job name specification can be an individual job name or can include a plus sign (+) to indicate this job and all its successors are to be selected.

ESP subsystem
Specifies the subsystem you want to trigger the Event on. This is the name defined to ESP Workload Manager and may not necessarily be the same as the SMF identifier. Check with your administrator or use the LSYS command to find the correct name to use.

Replace next scheduled Event
Enable this button to indicate this execution is to replace the next scheduled execution of the Event. This is used when you want to process an Event at a time different from its next scheduled time. Using REPLACE advances the execution time for an Event. For example, if you need to run an Event now instead of at 7 pm, trigger the Event with the REPLACE option.

When you use the REPLACE option, ESP Workload Manager selects jobs and resolves symbolic variables based on the replaced time and date. For example, if you have an Event that runs every Saturday and this week you want to run the Event on Friday instead, you can trigger the Event with the REPLACE option. ESP Workload Manager selects the jobs and resolves symbolic variables based on Saturday’s date.

Add new scheduled Event
Enable this button to indicate this execution is to be made in addition to the normal schedule. The normal schedule is not changed.

Bypass next scheduled execution
Enable this field if you want to bypass the execution of the next scheduled Event. This might be used when you trigger an Event in error, and you need to undo this operation or when you want to cancel one execution of an Event.

Submit Application on hold
This can be used to place an Application on hold when the Event being triggered generates the Application. No activity will take place in the Application until it is released. The Application can be released using the Workload Director component of Workstation.

Specify User Parameters to Pass to Event
Parameter 1 to 4
These four fields can be used to pass user information to the Event being triggered.

Parameters are case-sensitive
Enable this field to indicate the user parameter data is case-sensitive.
Cancel
Use this command to cancel a job.
1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click Cancel.
   The Cancel confirmation message appears.
3. Click OK.
   If the Show Server Response option is enabled, the Server Response dialog appears informing you the workload object is cancelled.
4. Click OK.

JES Release
Use this command to release an z/OS job from JES hold state.
1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click JES Release.
   The JES Release confirmation message appears.
3. Click OK.

JES Cancel
Use this command to cancel an z/OS job in the JES execution queue.
1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click JES Cancel.
   The JES Cancel confirmation message appears.
3. Click OK.

JES Cancel Dump
Use this command to cancel an z/OS job in the JES execution queue with a dump.
1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click JES Cancel Dump.
   The JES Cancel Dump confirmation message appears.
3. Click OK.

JES Cancel Purge
Use this command to cancel an z/OS job in the JES execution queue and purge the output.
1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click JES Cancel Purge.
   The JES Cancel Purge confirmation message appears.
3. Click OK.

JES Display
Use this command to display the JES status of a job.
1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click JES Display.
   The JES Display confirmation message appears.
3. Click OK.

JES Hold
Use this command to place a job in JES hold state.
1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click JES Hold.
   The JES Hold confirmation message appears.
3. Click OK.

JES Stop
Use this command to stop an executing job.
1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click JES Stop.
   The JES Stop confirmation message appears.
3. Click OK.
   Note: A job has to be programmed to respond to this command.

JES Quiesce
Use this command to quiesce an executing job.
1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click JES Quiesce.
   The JES Quiesce confirmation message appears.
3. Click OK.
**JES Resume**

Resume a job’s execution in its original service class.

1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click **JES Resume**.
   The JES Resume confirmation message appears.
3. Click **OK**.

**JES Expedite**

Use this command to manually expedite a job according to its expedite policy and state.

1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click **JES Expedite**.
   The JES Expedite confirmation message appears.
3. Click **OK**.
**PS Hold Job**
Place a PeopleSoft job on hold.
1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click **PS Hold Job**.
   The PS Hold Job dialog appears.
3. In the **Reason** field, enter a reason for holding the job.
4. Click **OK**.

**PS Restart Job**
Restart a PeopleSoft job using PeopleSoft.
1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click **PS Restart Job**.
   The PS Restart Job confirmation message appears.
3. Click **OK**.

**Retrieve Trace File**
Retrieve a trace file for a PeopleSoft job.
1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click **Retrieve Trace File**.
   The Retrieve Trace File confirmation message appears.
3. Click **OK**.

**PS Delete Job**
Delete a PeopleSoft job.
1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click **PS Delete Job**.
   The PS Delete Job confirmation message appears.
3. Click **OK**.

**PS Cancel Job**
Cancel a PeopleSoft job.
1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click **PS Cancel Job**.
   The PS Cancel Job confirmation message appears.
3. Click **OK**.

**JobModify**

Use the JobModify command to make changes to an ABAP Step parameter. You can modify a job only if it has not started. The parameters displayed on the JobModify dialog are based on the original job definition.

You can only modify a step. You cannot add a step.

To make changes to an SAP job definition the state of the job must be DEFINED. This means, you can see the Job ID when the JobModify dialog appears. Otherwise, you will receive the error message ‘Job does not exist’.

1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click **JobModify**.
   The JobModify dialog appears.
   The fields in the Steps section are filled in with details from the job definition.
3. Select the parameter and its value that you want to modify. The information is highlighted.
4. Enter your changes.
5. Click **OK**.

Refer to the following table for validation rules for Step parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th># of Characters</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABAP Name</td>
<td>40</td>
</tr>
<tr>
<td>VARIANT</td>
<td>14</td>
</tr>
<tr>
<td>Output Device</td>
<td>4</td>
</tr>
<tr>
<td>Step User</td>
<td>16</td>
</tr>
<tr>
<td>ABAP Language</td>
<td>1</td>
</tr>
<tr>
<td>Output Device</td>
<td>4</td>
</tr>
<tr>
<td>Authorization</td>
<td>12</td>
</tr>
<tr>
<td>Number of Copies</td>
<td>numeric 1-255</td>
</tr>
<tr>
<td>Archive Object Type</td>
<td>10</td>
</tr>
<tr>
<td>Archive Document Type</td>
<td>10</td>
</tr>
<tr>
<td>Archive Information</td>
<td>3</td>
</tr>
<tr>
<td>Print Immediately</td>
<td>Y/N/D (Yes/No/Default)</td>
</tr>
<tr>
<td>Delete After Print</td>
<td>Y/N/D (Yes/No/Default)</td>
</tr>
<tr>
<td>Archiving Mode</td>
<td>numeric 1-3 (Print/Archive/Both)</td>
</tr>
<tr>
<td>Print SAP Cover Sheet</td>
<td>Y/N/D (Yes/No/Default)</td>
</tr>
<tr>
<td>Print Selections Cover Sheet</td>
<td>Y/N/D (Yes/No/Default)</td>
</tr>
</tbody>
</table>
### VariantRead
View variant values for all steps within an SAP job.

1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click **VariantRead**.
   The VariantRead dialog appears.
3. In the **ABAPname** field, enter the ABAP name.
4. Click **OK**.

### JobLogRead
View the SAP system job log.

1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click **JobLogRead**.
   The JobLogRead dialog appears displaying the job log of the SAP job.
3. Click **OK**.

### JobStatusCheck
You can check the job status recorded in the SAP system data base and the actual job status. Corrections are made to any discrepancies found and the database is updated.

**Note:** The SAP Agent has an automatic monitoring component that periodically monitors the status of an SAP job. The JobStatusCheck command returns the same status as the automatic monitoring component.

1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click **JobStatusCheck**.
   The JobStatusCheck dialog appears.
3. Click **OK**.

<table>
<thead>
<tr>
<th>Parameter</th>
<th># of Characters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Lines</td>
<td>numeric (depends on the content, for example, 65)</td>
</tr>
<tr>
<td>Number of Columns</td>
<td>numeric 1-255</td>
</tr>
<tr>
<td>Spool Retention Period</td>
<td>numeric 1-9</td>
</tr>
<tr>
<td>Recipient</td>
<td>12</td>
</tr>
<tr>
<td>Success Message</td>
<td>alpha text</td>
</tr>
<tr>
<td>Failure Message</td>
<td>alpha text</td>
</tr>
</tbody>
</table>
JobStatusGet

View the job status recorded in the SAP system database.
1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click JobStatusGet.
   The JobStatusGet dialog appears.

Refer to the following table for a list of the SAP job status and the equivalent ESP Workstation job states:

<table>
<thead>
<tr>
<th>SAP Job Status</th>
<th>ESP Workstation Job State</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scheduled</td>
<td>Defined</td>
</tr>
<tr>
<td>Released</td>
<td>Submit</td>
</tr>
<tr>
<td>Ready</td>
<td>Submit</td>
</tr>
<tr>
<td>Active</td>
<td>Exec</td>
</tr>
<tr>
<td>Finished</td>
<td>Complete</td>
</tr>
<tr>
<td>Terminated</td>
<td>Failed</td>
</tr>
</tbody>
</table>

3. Click OK.

JobDefGet

View the SAP definition of an SAP job.
1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click JobDefGet.
   The JobDefGet confirmation message appears.
3. Click OK.

JobCancel

Cancel a running SAP job.
1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click JobCancel.
   The JobCancel confirmation message appears.
3. Click OK.

JobDelete

A job can be deleted when it is in any of these states:
- Scheduled
- Released
• Read
• Finished
• Cancelled
1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click JobDelete.
   The JobDelete confirmation message appears.
3. Click OK.

Start ASAP (as soon as possible)
You can start an SAP job if it is waiting for a manual start. With Start ASAP, the job is released as soon as possible after other scheduled jobs are completed.
1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click Start ASAP.
   The Start ASAP confirmation message appears.
3. Click OK.

Start Immediately
You can start an SAP job if it is waiting for a manual start. With Start Immediately, the job is released immediately.
1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click Start Immediately.
   The Start Immediately confirmation message appears.
3. Click OK.

GetGlobalAudit
You can initiate a query of the current global audit-level settings of all SAP jobs.
1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click GetGlobalAudit.
   The GetGlobalAudit dialog appears.
3. The global audit level of all SAP jobs is displayed.
4. Click OK.

SetGlobalAudit
Set the global audit level for an SAP job.
1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click **SetGlobalAudit**.
   The SetGlobalAudit dialog appears.
3. In the Level field, enter the level you want to set.
4. Click OK.

### JobSelect

You can select a set of jobs in the SAP system that match a specified selection criteria.

1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click **JobSelect**.
   The JobSelect dialog appears.
3. Enter the selection criteria. Refer to the following table for a description of the selection criteria.

<table>
<thead>
<tr>
<th>Criteria</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job Name</td>
<td>• Mandatory&lt;br&gt;• Specify up to 32 characters&lt;br&gt;• Can be specified using wildcards to select multiple job names containing the defined string. For example, <em>string</em> will select all job names containing the characters defined as string.</td>
</tr>
<tr>
<td>Job Count</td>
<td>• Optional&lt;br&gt;• Specify the batch job number up to 8 characters</td>
</tr>
<tr>
<td>Job Group</td>
<td>• Summary of jobs for a group&lt;br&gt;• Specify up to 12 characters</td>
</tr>
<tr>
<td>Job User</td>
<td>• Mandatory&lt;br&gt;• Specify up to 12 characters</td>
</tr>
<tr>
<td>From Date</td>
<td>• Specify the planned start date</td>
</tr>
<tr>
<td>From Time</td>
<td>• Specify the planned start time</td>
</tr>
<tr>
<td>To Date</td>
<td>• Specify the planned end date</td>
</tr>
<tr>
<td>To Time</td>
<td>• Specify the planned end time</td>
</tr>
<tr>
<td>No Date (Y/N)</td>
<td>• Y is defined as jobs without a start date&lt;br&gt;• N is the SAP default value</td>
</tr>
<tr>
<td>Criteria</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Event ID</td>
<td>• Specify the Event ID</td>
</tr>
<tr>
<td></td>
<td>• Specify up to 32 characters</td>
</tr>
<tr>
<td>Event Parameters</td>
<td>• Specify up to 65 characters</td>
</tr>
<tr>
<td>With Predecessors (Y/N)</td>
<td>• Y is defined as jobs start after predecessor</td>
</tr>
<tr>
<td></td>
<td>• N is the SAP default value</td>
</tr>
<tr>
<td>Scheduled (Y/N)</td>
<td>• Y is defined as jobs in the SCHEDULED state</td>
</tr>
<tr>
<td></td>
<td>• N is the SAP default value</td>
</tr>
<tr>
<td>Released</td>
<td>• Y is defined as jobs in the RELEASED state</td>
</tr>
<tr>
<td></td>
<td>• N is defined as all SAP jobs that are not in the RELEASED state</td>
</tr>
<tr>
<td>Ready (Y/N)</td>
<td>• Y is defined as jobs in the READY state</td>
</tr>
<tr>
<td></td>
<td>• N is the SAP default value</td>
</tr>
<tr>
<td>Running (Y/N)</td>
<td>• Y is defined as jobs in the RUNNING state</td>
</tr>
<tr>
<td></td>
<td>• N is the SAP default value</td>
</tr>
<tr>
<td>Finished (Y/N)</td>
<td>• Y is defined as jobs in the FINISHED state</td>
</tr>
<tr>
<td></td>
<td>• N is the SAP default value</td>
</tr>
<tr>
<td>Aborted (Y/N)</td>
<td>• Y is defined as jobs in the ABORTED state</td>
</tr>
<tr>
<td></td>
<td>• N is the SAP default value</td>
</tr>
</tbody>
</table>

4. Click **OK**. All jobs meeting the specified selection criteria are displayed.

**GetJobCount**

You can retrieve the number of SAP jobs with the entered job name.

1. In the right-hand pane, right-click the job. The shortcut menu appears.

2. Click **GetJobCount**.

   The GetJobCount dialog appears.

3. Click **OK**.
GetJobSpoolList

You can use the GetJobSpoolList command to return an image of output, produced by the selected ABAP, according to the specified Print parameters.

1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click GetJobSpoolList.
   The GetJobSpoolList dialog appears.
3. In the Step Number field, enter the number of the step to be displayed.
4. Click OK. All jobs meeting the specified selection criteria are displayed.

SetJobClass

Use the SetJobClass command to change the SAP class of an already defined job.

1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click SetJobClass.
   The SetJobClass dialog appears.
3. In the Job Class field, specify the job class for the SAP job.
4. Click OK. The Job Class for the chosen job is set.

JobCopy

You can copy an entire SAP job or copy the job starting from a certain step through to the end of the job. The JobCopy dialog is used to create a copy on the SAP system. This can be useful if you want to rerun an entire job or if an ABAP failed and you need to run the job from the step following the failed step.

1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click JobCopy.
   The JobCopy dialog appears.
3. In the Step Number field, enter the step number to start the copy from.
   If you leave Step Number blank, the entire job is copied.
4. In the Target Name field, enter a name for the copied version of the job.
   If you leave Target Name blank, the copy job will have the same job name as the original job and will be given a new job count (job number).
5. Click OK.

Note: The new job will be in Scheduled status on the SAP system. You can start the job in SAP GUI or use the Filter Panel in Workload Editor to list, then drag the copied job to the Workload Editor workspace. For more information on using the Filter Panel, see “Add SAP jobs from a list” on page 189.
**JobChildrenGet**

You can list the children of a job. Children jobs are jobs spawned by a parent job.

**To list a job’s children**

1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click **JobChildrenGet**.
   
   The JobChildrenGet dialog appears.
   
   If the job has children, the following information will be listed for each child job:
   
   - Job name
   - Job count
   - Status
   - Parent-child relationship
3. Click **OK**.

   **Hint:** A child job can spawn children jobs and thus become a parent job as well.

**JobGetDump**

When an SAP job fails, a dump of the job or the ABAP may be produced. You can view SAP job dumps from the Workload Director.

1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click **JobGetDump**.
   
   - If the selected job has a dump available, the JobGetDump dialog appears.
   - If the selected job does not have a dump, a message box will appear with the message, “The job doesn’t have a dump reference available”. Click **OK** to close the message box.
3. Click **OK**.
   
   The dump appears in the Confirm Command dialog.
4. You can scroll through the dump or copy and paste it into a text document.
5. Close the Confirm Command dialog.

**Monitor Children**

If the SAP Agent is configured to monitor children, you can dynamically monitor the children of a job. Children jobs are jobs spawned by a parent job.
To monitor the children of a job
1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click Monitor Children.
   The Monitor Children dialog appears.
3. Click OK to close the dialog.

Job Stop
Stop the Business Warehouse InfoPackage job from running.
1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click Job Stop.
   The InfoPackage Stop confirmation message appears.
3. Click OK.

InfoPackage Status
Retrieve the status of a Business Warehouse InfoPackage.
1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click InfoPackage Status.
   The InfoPackage Status confirmation message appears.
3. Click OK.
   The InfoPackage Status dialog appears.

InfoPackage Details
Retrieve the details of a Business Warehouse InfoPackage.
1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click InfoPackage Details.
   The Details dialog appears.
3. Click OK.

Get Chain Log
View a Business Warehouse Process Chain log.
1. In the right-hand pane, right-click the job. The shortcut menu appears.

2. Click **Get Chain Log**.  
The View BW Process Chain Job dialog appears.  

**Hint:** Because there may be numerous processes in a Process Chain job, the response may take several minutes. Once the response is received from the SAP system, the Process Chain log is displayed in a table.

Refer to the following table for an explanation of the columns in the Process Chain table:

<table>
<thead>
<tr>
<th>Column Heading</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MSG V1</td>
<td>Step Name</td>
</tr>
<tr>
<td>MSG V2</td>
<td>Variant Name</td>
</tr>
<tr>
<td>MSG V3</td>
<td>Log ID (used for monitoring on SAP)</td>
</tr>
<tr>
<td>MSG V4</td>
<td>Status Description</td>
</tr>
<tr>
<td>MSG V5</td>
<td>Technical Status Description</td>
</tr>
</tbody>
</table>

3. Click **OK**.

**Get Chain Status**  
Retrieve the status of the Business Warehouse Process Chain.  

1. In the right-hand pane, right-click the job. The shortcut menu appears.

2. Click **Get Chain Status**.  
The Get Chain Status confirmation message appears.

3. Click **OK**.  
The Get Chain Status dialog appears.

**Get Chain Processes**  
Retrieve the processes for the Business Warehouse Process Chain.  

1. In the right-hand pane, right-click the job. The shortcut menu appears.

2. Click **Get Chain Processes**.  
The Get Chain Processes confirmation message appears.

3. Click **OK**.  
The Connect to FTP dialog appears. You must establish an FTP connection to retrieve the processes.

4. In the **Connect to FTP** dialog, enter your username and password. The address and port fields are prefilled.
5. Click **OK**.
The Get Chain Processes server response appears.

### Interrupt Chain
Perform a chain interrupt on a Business Warehouse Process Chain.

1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click **Interrupt Chain**.
The Interrupt Chain confirmation message appears.
3. Click **OK**.
The Interrupt Chain server response appears.

### Restart Chain
Restart a Business Warehouse Process Chain.

1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click **Restart Chain**.
The Restart Chain confirmation message appears.
3. Click **OK**.
The Restart Chain server response appears.

### Get Message Details
Retrieve the message details for a Business Warehouse Process Chain.

1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click **Get Message Details**.
The Get Message Details dialog appears.
3. Enter the appropriate information in the **Message ID**, **Message Number**, and **Message Format** fields for the message you want to view. These fields are mandatory.
4. Click **OK**.
The Get Message Details server response appears.

### Get Process Log
Retrieve the process log for a Business Warehouse Process Chain.

1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click **Get Process Log**.
The Get Process Log dialog appears.
3. Enter the appropriate information in the Log ID, Process type, Variant, and Instance fields for the process you want to view. These fields are mandatory.

4. Click OK.

Start ASAP
Start a Batch Input Session (BDC) job if it is waiting for a manual start. With Start ASAP, the job is released as soon as possible after other scheduled jobs are completed.

1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click Start ASAP.
The Start ASAP confirmation message appears.
3. Click OK.
The Start ASAP server response appears.

Start Immediately
Start a Batch Input Session (BDC) job if it is waiting for a manual start. With Start Immediately, the job is released immediately.

1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click Start Immediately.
The Start Immediately confirmation message appears.
3. Click OK.
The Start Immediately server response appears.

Cancel a Batch Input Session
Batch Input Session (BDC) jobs run in two phases. First, the ABAP that creates a BDC session runs. Next, the created BDC session is processed. Before confirming a BDC job cancellation, check the Job Cancel dialog to be sure you know if you are cancelling only the first phase or both phases.

1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click Job Cancel.
The Job Cancel dialog appears.
3. Check the BDC Queue ID and BDC Name.
   • If there is no BDC Queue ID and no BDC Name in the Job Cancel dialog, then the ABAP that creates the BDC session is running. The Cancel command will only cancel the ABAP that creates the BDC session.
   • If the Job Cancel dialog has a BDC Queue ID and a BDC name, the BDC session has started. The Cancel command will cancel both phases of the job.
4. Click **OK**.

**Delete a Batch Input Session job**

A job can be deleted when it is in any of these states:

- Scheduled
- Released
- Read
- Finished
- Cancelled

1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click **Job Delete**.
   The Job Delete confirmation message appears.
3. Click **OK**.

**Monitor Processes**

Display the processes a Process Monitor job is monitoring.

1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click **Monitor Processes**.
   A table appears displaying information about the processes being monitored.
3. Click **Exit**.
   To stop a Process Monitor job, you can mark the job complete. For more information, see “Completing a Job” on page 451.

**Usage notes**

**Continuous Monitor**

If the Process Monitor was defined as continuous (an alert name was specified on the Agent Specifications tab), the processes that match the criteria specified on the Agent Specifications tab are displayed in the process monitor dialog.

**Note:** Each subsequent match for the criteria specified in the job details will replace the previous entry in the process monitor dialog. That is, only the most recent match is displayed.

Process Monitor jobs defined as continuous stay in a Monitor status in the Workload Director Graphical View until they are forced complete.

**Non-continuous Monitor**
If the Process Monitor was defined as non-continuous (no alert name was specified on the Agent Specifications tab), the first process that matches the criteria specified on the Agent Specifications tab is displayed in the process monitor dialog. If no process has yet matched the process monitor criteria, the process monitor dialog will remain empty until a match occurs.

Process Monitor jobs defined as non-continuous stay in Monitor status in the Workload Director Graphical View until one match is detected. When one match is detected, the Process Monitor job is marked Complete.

**Cancel a Data Archiving Job**

Cancel a running Data Archiving job.

1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click **Job Cancel**.
   
   The Job Cancel confirmation message appears.
3. Click **OK**.

**Delete a Data Archiving Job**

You can delete a Data Archiving job in the following states:

- Scheduled
- Released
- Read
- Finished
- Cancelled

1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click **Job Delete**.
   
   The Job Delete confirmation message appears.
3. Click **OK**.

**Monitor Children**

Monitor the children of a Data Archiving job.

1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click **Monitor Children**.
   
   A table appears displaying information about the job’s children.
3. Click **Exit**.
Restarting a job with ESP Encore

The Restart using Encore command is for z/OS jobs under ESP Encore’s control. ESP Encore is an advanced rerun/restart product that works with ESP Workload Manager to restart batch jobs. ESP Encore determines the restart point in failed jobs, makes the necessary adjustments to batch JCL, and performs the necessary data set cleanups for an error-free restart.

1. In the right-hand pane, right-click the failed job. The shortcut menu appears.
2. Click **Restart using Encore**.

   The ESP Encore dialog appears.

   ![ESP Encore dialog](image)

**Step Summary tab**

The Step Summary tab displays a job summary, a step summary, the DD names used in the steps, and the data sets referenced in the DD names.

Select a stepname and the DD names associated with the stepname are displayed. Selecting a DD name displays the data sets associated with the DD name. The DD name field displays up to 3,273 DD names.

Click the **Data Set Summary** button to list all the data sets used by the job.

Use the following buttons to indicate your restart preference:

- **let ESP Encore choose** — This is the default. Use this option to restart a job from the step selected by ESP Encore.
- **all steps starting with the step selected** — Use this option when restarting a job from a step you select and run to the end of the job.
• only the steps selected — Use this option to restart a single step or a range of steps.

To restart a job from the step selected by ESP Encore
1. Ensure no stepnames are selected.
   If a step is highlighted, press and hold the Ctrl key and click the step to deselect it.
   Optionally, you can right-click any step and select Deselect All from the menu.
2. Ensure the Let ESP Encore choose button is checked.
3. Click Resubmit.
The job is resubmitted under the control of ESP Encore.

To restart from a step and run to the end of the job
1. From the Step Summary, select the stepname to highlight it.
2. Click the all steps starting with the step selected button.
3. At this point you have a choice:
   • Click Resubmit to submit the job
     The job restarts at the selected step unless ESP Encore needs to run previous steps to recreate a data set required by the selected step.
   • Click the Restart Analysis button to view ESP Encore’s restart recommendations. For more information see, “About ESP Encore’s restart recommendations” on page 497.

To restart a single step
1. From the Step Summary, select the stepname you want to restart.
2. Click the only the steps selected button.
3. At this point you have a choice:
   • Click Resubmit to submit the job
     Only the selected step runs unless ESP Encore needs to run previous steps to recreate a data set required by the selected step.
   • Click the Restart Analysis button to view ESP Encore’s restart recommendations. For more information see, “About ESP Encore’s restart recommendations” on page 497.

To restart a range of steps
1. Press and hold the Ctrl key and select multiple steps. The same key combination is used to cancel the selection of multiple highlighted steps.
2. Click the only the steps selected button.
3. At this point you have a choice:
• Click **Resubmit** to submit the job

Only the selected steps run unless ESP Encore needs to run the previous step to recreate a data set required by the selected steps.

• Click the **Restart Analysis** button to view ESP Encore’s restart recommendations. For more information see, “About ESP Encore’s restart recommendations” on page 497.

Click **Encore Log** to display error log information.

**About ESP Encore’s restart recommendations**

ESP Encore’s restart recommendations display in the **Restart Action Summary**.

If you select the restart step, ESP Encore reports on the selected restart. If you do not select the restart step, ESP Encore recommends the step to restart, and reports on the actions it will take. See the following two examples.
The following example shows the results of a restart where the restart step is selected by the user. It shows ESP Encore predicts no errors for this restart and bypassing STEP005 is acceptable. If ESP Encore needed to run STEP005 to recreate a required data set, this would be indicated.

The following example shows the results of not choosing a restart step and letting ESP Encore do it. ESP Encore recommends a restart point, and lists the actions it will perform to ensure an error-free restart.
At this point you have a choice:

- Click **Submit** to submit the job
- Click the **Restart Execution Summary** button

For information on the Cleanup button, see page 500.

**About the ESP Encore Restart Execution Summary**

This dialog displays similar information to the job Restart Action Summary dialog, but with specific emphasis on the steps. It lists the steps in the job and reveals which steps ESP Encore restarts, and which steps it bypasses. ESP Encore provides a reason for each previously run step that is being restarted.

1. From the **ESP Encore Restart Execution Summary** dialog, you can double-click a stepname.
   
The Restart Step Details dialog appears. This dialog gives you information pertinent to the step.

2. Click **Exit** to return to the ESP Encore Restart Execution Summary. Then click **Exit** again to return to the Restart Action Summary.

3. Click **Resubmit** to submit the job.
Cleanup
The cleanup dialog notifies you of any action ESP Encore must perform on data sets.

To view the cleanup dialog
1. From the Restart Action Summary dialog, click Cleanup.
2. From the Cleanup Action Summary dialog, click Cleanup Summary.

Restart tab
The following system statements appear on the Restart tab. They are all optional.

- **Data set** — Enter or select from the drop-down list the data set name from which the JCL should be submitted. Do not use quotation marks.
- **Member** — Enter the name of the member containing the JCL. Do not use quotation marks.
- **User 1 to User 4** — Specify one or more user variables. These are used to tailor the JCL as it is submitted.
- **From Step** — Indicates the first step executed. This field is enabled when the Encore Restart option is checked.
- **To Step** — Indicates the last step executed. This field is enabled when the Encore Restart option is checked.
- **Exclude Steps** — Indicates the steps excluded when a range is specified. This field is enabled when the Encore Restart option is checked.
- **Encore Restart** — Indicates to restart the job under ESP Encore control.

Encore Statements tab
The Encore Statements tab contains predefined ESP Encore statements. All the statements are optional. The Encore Statements tab is enabled when the Encore Restart check box is selected. You can use ESP Encore statements to indicate special processing options. You can also use this dialog to enter any other ESP Encore statement that is not predefined.

To add a predefined statement
1. Select the respective check box to add the BACKOUT, CLEANUP, and FORCE statements.
2. Select the respective radio button to add the MODE, AUTO-RESTORE, and HONOR CONDITION CODES statements.
   The statement appears in the ESP Encore statements window.
To modify a predefined statement
1. Select the predefined statement in the statements window to highlight it. The statement appears in the edit field.
2. Change the statement.
3. Click Update.
The statement window refreshes. The statement remains in the edit field.

Note: Alternatively, you can click Add to add the statement.

To add a new statement
1. In the edit field, enter any ESP Encore statement.
2. Click Add.
The new statement appears in the statement list.

Predefined statements
The following table describes the predefined ESP Encore statements:

<table>
<thead>
<tr>
<th>Field</th>
<th>Statement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backout</td>
<td>TYPE BACKOUT</td>
<td>Indicates all of the data sets created by the job are backed out. When used, the ESP Encore step executes and the remainder of the job is flushed.</td>
</tr>
<tr>
<td>Cleanup</td>
<td>CLEANUP RESTART(NO)</td>
<td>ESP Encore does not perform data set cleanup during the initial run of the job.</td>
</tr>
<tr>
<td>Cleanup</td>
<td>CLEANUP RESTART(YES)</td>
<td>ESP Encore performs data set cleanup during the initial run of the job.</td>
</tr>
<tr>
<td>Force</td>
<td>FORCE NO</td>
<td>The job does not run if errors are predicted by ESP Encore. This is the default.</td>
</tr>
<tr>
<td>Force</td>
<td>FORCE YES</td>
<td>The job runs despite errors predicted by ESP Encore.</td>
</tr>
<tr>
<td>Mode</td>
<td>MODE NORMAL</td>
<td>The job should run. This is the default.</td>
</tr>
<tr>
<td>Mode</td>
<td>MODE SCAN</td>
<td>ESP Encore performs its normal analysis, produces a report, and then causes the remainder of the job to be flushed. This is used to check for errors prior to the job’s submission.</td>
</tr>
</tbody>
</table>
Cancel Request

Cancels an Oracle Applications job request.

1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click **Cancel Request**.
   
The Cancel Request confirmation message appears.
3. Click **OK**.
   The Cancel Request server response appears.

**Hold Request**

Holds an Oracle Applications job request.

1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click **Hold Request**.
   The Hold Request confirmation message appears.
3. Click **OK**.
   The Hold Request server response appears.

**Remove Hold Request**

Removes the Hold for a held Oracle Applications job request.

1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click **Remove Hold Request**.
   The Remove Hold Request confirmation message appears.
3. Click **OK**.
   The Remove Hold Request server response appears.

**View Log**

Retrieves and displays the job log of Oracle Applications job requests.

1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click **View Log**.
   The View Log confirmation message appears.
3. Click **OK**.
   The View Log dialog appears.

**View Output**

Displays output of Oracle Applications job requests. Some Oracle Applications jobs generate empty output files or no output files at all.

1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click **View Output**.
   The View Output confirmation message appears.
3. Click **OK**.
   The View Output dialog appears.
View Completion Details

Displays the completion details of Oracle Applications job requests.

1. In the right-hand pane, right-click the job. The shortcut menu appears.
2. Click View Completion Details.
   The View Completion Details confirmation message appears.
3. Click OK.
   The View Completion Details dialog appears.

Locating a Job within a Graphical View

Use a search to locate a job in an Application or to view a list of Applications that contain a specific job.

To locate a job in an Application

1. In the left-hand pane, double-click the generation of the Application you want to search.
2. Open the Locate Job in Graphical View dialog using one of these methods:
   • In the left-hand pane, right-click the Application folder, and select Locate Job from the shortcut menu.
   • From the Action menu, select Application > Locate Job.
   • Click Locate a job in graph icon on the toolbar.
3. In the fields provided, enter one or more of the following:
   • (Required) Job name (or a partial job name) or long job name
   • (Optional) Application name (or a partial Application name)
   • (Optional) Host name
   The more details you specify, the more narrowed the search results are.
4. Click **Search**.
   A selection list is displayed in the Search Results box.

5. In the **Search Results** box, click on the job you want to view.
   The job is highlighted.

6. Click **Locate**.
   The graph view is displayed, and the job is highlighted.

**Inserting Jobs**

All the job types on the job palette can be inserted into an Application:

**To insert a job into an Application**

1. In the Graphical View, double-click the generation of the Application you want to insert a job in.
   A view of the Application appears in the right-hand pane.

2. Open the Insert Job dialog using one of these methods:
   - From the **Action** menu, select **Application > Insert Job**, and then select the job type from the shortcut menu.
   - In the Graphical View, right-click anywhere outside the work flow diagram.
     From the shortcut menu, select **Insert Job**, and then select the job type.
The Insert Job dialog appears.

Note: The Insert Job dialog example is for an Applend job.

3. Add any predecessors and successors, as required.
   - To add a predecessor or successor, select the job from the Current Jobs list box. Click the **Add** button located under the Predecessor or Successor list box, depending upon where you want to put the job.
   - To remove a predecessor or successor, select the job in the appropriate list box, and click **Remove**.

4. Click **Define Job**.
   
The Job dialog appears for the job you have selected.
Note: The tabs vary depending on the type of job you insert.

5. On the General tab, complete these fields:
   - Mandatory. In the Name field, specify the name of the job to insert. Specify up to eight alphanumeric characters. Use the qualifier to make the job name unique.
   - In theQualifier field, specify the qualifier for the name of the job, if applicable. The qualifier is used together with the job name to make the name unique. Specify up to eight alphanumeric characters.

6. Complete the fields on the remaining tabs as required.

7. To close the Job dialog and accept all your selections, click OK.
   The Insert Job dialog reappears.

8. Click Simulate to view the Application with the additional job inserted.

9. Click OK.
   The Insert Job dialog reappears.

10. If the results are what you want, click OK.
    Workload Director inserts the job into the Application and displays the updated workflow in the right-hand pane.

**Edit or Browse Job Documentation**

The ESP Workload Manager job-documentation facility lets you create a centralized definition of each one of your jobs. A job-documentation entry is a member of a partitioned data set that resides on the mainframe. The member name is typically the same as the job name for the information it contains. If you want to browse your job documentation online, the member name must be the same as the job name. For more information, see “Browse Online Documentation” on page 451.
The type of information that is stored in a job-documentation entry is information you may require regarding restart instruction, job severity, ABEND codes, messages, and so on.

Job documentation entries can also contain instructions ESP Workload Manager will use when processing a job, such as the JCL library, job dependencies, and schedule frequency.

**Note:** You can use a Find command to search through job documentation. You can also do a find and replace.

**To edit a job documentation entry**

1. In the Graphical View, double-click the generation of the Application that contains the job whose documentation you want to update. A view of the Application appears in the right-hand pane.

2. Open the Edit Job Documentation dialog using one of these methods:
   - In the right-hand pane, right-click the job, and select **Edit Job Documentation** from the shortcut menu.
   - Select the job in the right-hand pane. From the **Action** menu, select **Job > Edit Job Documentation**.

   The Edit Job Documentation dialog appears.

3. Edit the job documentation as required.

   **Note:** To search the job documentation, right-click in the text area and select **Find**. The **Replace** dialog appears, which you can use to search for a string or to find and replace a string.

4. Click **Upload** to save your changes to the mainframe.

5. Click **Cancel** to leave the Edit Job Documentation dialog without making any changes.
To browse a job documentation entry
Follow steps 1 and 2 above, and this time select **Browse Job Documentation**.

**Edit Data Sets**

Edit sequential and partitioned data sets from the Workload Director. These are z/OS data sets that can be opened in a text editor.

You can also create a new partitioned data set member on the host. The partitioned data set must have existing members for your new member to be created successfully. The last three data sets referenced are retained in a drop-down list to the right of the Data Set field.

You cannot create a sequential data set.

**Note:** You can use a Find command to search through a data set. You can also do a find and replace.

**To edit a data set or data set member**

1. From the Graphical View, right-click on the IP address or host name. A drop-down menu appears.
2. From the drop-down menu, select **Edit Data Set.**
   The Edit Data Set dialog appears.

3. In the **Data Set** field, enter the name of the data set or the data set and member name that you want to edit.
   If you want to edit a member of a partitioned data set, put the member name in parentheses. See the following example.

   **Note:** CA does not recommend downloading a data set or data set member larger than 4 gigabytes.

4. Click **Download.**
   The data set or data set member is downloaded and appears in the text field on the Edit Data Set dialog. The data set or data set member is automatically locked when you download it, preventing others from opening it. The data set or data set member remains locked until it is uploaded or until you cancel out of this dialog.
Note: To search the data set, right-click in the data set text area and select Find. The Replace dialog appears, which you can use to search for a string or to find and replace a string.

5. Make changes as required.
6. Click Upload if you have made changes. The data set or data set member is automatically uploaded and unlocked.

To create a new data set member on the host
1. From the Graphical View, right-click on the IP address or host name. A drop-down menu appears.
2. From the drop-down menu, select Edit Data Set. The Edit Data Set dialog appears.
3. In the Data Set field, specify the name of the data set and data set member that you want to create. Put the member name in parentheses.
   Note: You cannot create a sequential data set from this dialog.
4. In the text field, type in the contents of the new data set member.
5. Click Create. The data set member is created on the host.

Browse Data Sets

You can browse data sets with multiple users accessing the same data set. The last three data sets referenced are retained in a drop-down list to the right of the Data Set field.

Note: You can use a Find command to search through a data set.

To browse a data set or data set member
1. From the Graphical View, right-click on the IP address or host name. A drop-down menu appears.
2. From the drop-down menu, select **Browse Data Set**. The Browse Data Set dialog appears.

![Browse Data Set Dialog](image)

3. In the **Data Set** field, enter the name of the data set or the data set and member name that you want to browse.
   If you want to browse a member of a partitioned data set, put the member name in parentheses.

4. Click **Browse**.
   The data set or data set member is downloaded and appears in the text field on the Browse Data Set dialog.

![Downloaded Data](image)
5. To search the data set, right-click in the data set text area and select **Find**. A Find dialog appears.

![Find dialog](image)

6. Click **Cancel** when you have finished.
Controlling subApplications

SubApplications are groups of workload objects that belong to an Application. You use subApplications to manipulate more than one job at a time. This section describes how to control subApplications.

SubApplications appear in the tree view (left-hand pane) as children to the parent Application.

To view subApplications in the tree view do one of the following:

- Click the **plus sign** (+) beside the Application folder that contains the subApplications.

  The subApplication folders appear.

- Double-click the Application folder containing the subApplications.

  The Application appears in the right-hand pane and the subApplication folders appear in the tree view.
To view the jobs in the subApplication

1. In the tree view, double-click the subApplication folder.
   The jobs in the subApplication are highlighted in the right-hand pane.

2. In the tree view, double-click the second subApplication folder.
   The jobs in the second subApplication are highlighted in the right-hand pane.
subApplication Commands

All subApplication commands are available by using one of the following methods:

- Right-click the subApplication folder in the tree view.

The following list displays:

This list contains the Show Jobs In This SubAppl command. This command is an alternative to double-clicking the subApplication folder to view the jobs.

- Right-click a subApplication job in the right-hand pane.

SubApplication commands appear in the bottom half of the list.

Holding and Releasing a subApplication

When you place a subApplication on hold, you place all jobs in the subApplication on hold to prevent them from running. Once you place a subApplication on hold, the state of each job within the subApplication changes to MANHOLD.

You remove the MANHOLD state for all the jobs within the subApplication by selecting the SubAppl Release command.

Requesting and Unrequesting a subApplication

Jobs belonging to subApplications with a state of ON REQUEST must be explicitly requested. They do not run automatically. Once requested, the state of each ON REQUEST job within the subApplication changes to REQUESTED. The jobs run when their dependencies are met.

You can request or unrequest all the jobs in a subApplication up until the time of submission.

Bypass and Unbypass a subApplication

Bypass all the jobs within a subApplication to indicate they are not required for a particular generation of an Application. ESP Workload Manager updates the status of each job to BYPASSED to indicate that a bypass has been requested. When the job’s predecessors are complete, the subApplication is bypassed, and the successor jobs are released.
A subApplication can be unbypassed anytime before it actually becomes bypassed.

**Completing a subApplication**

Completing a subApplication informs ESP Workload Manager to consider each job within the subApplication as complete. ESP Workload Manager runs the job’s successors, including those in other Applications. The state of each job in the subApplication changes to Complete.

You cannot uncomplete a subApplication.

**Readying a subApplication**

Typically, a job is not ready for submission until all of its predecessor and time dependencies are satisfied. Mark a subApplication Ready to remove all its jobs’ dependencies (including time, predecessors, and manual hold, but not including resources).

Resource dependencies are not affected by the Ready command. Resource dependencies must be independently satisfied or dropped before a job can run.

**Removing a subApplication from SANCWAIT**

Remove each of the jobs in a subApplication from a wait state by issuing a single SubAppl Unwait command. This has the same effect as unwaiting each job individually.
Working with Custom Views

You can create and save Custom Views to display only the information you want, in the format you want. The Custom View displays a text-based view of the workload. There are predefined Custom Views or you can create your own. Custom Views display information according to settings defined in three categories:

- Presentation
- Filter
- Font/Colors

Creating a Custom View

When you want to view a particular list of information for your workload, create a text-based Custom View. You select the presentation information from a list of fields. The Custom View displays the fields in column format as shown. You can specify the background and foreground colors, the type of display font, and the order of the fields. You can also apply a filter to the Custom View to limit the amount of information it displays.

You must assign a name to each Custom View you create.
To create a Custom View

1. Open the Custom View Configuration dialog using one of these methods:
   - From the Custom View menu, select New.
   - In the Custom View tree, right-click any existing Custom View, and select New from the shortcut menu. To display the Custom View, click the Custom View tab at the bottom of the Workload Director window.

The Presentation tab of the Custom View Configuration dialog appears.

The fields in the Available Fields list box retrieve and display information from the operating system and from ESP Workload Manager. The ESP Workload Manager fields are documented in the ESP Workload Manager User's Guide.

2. In the Presentation tab, move the fields you want to appear in the Custom View from the Available Fields list box into the Selected Fields list box. To move a field, select the field, and then click the right arrow (>). To move all the fields, click the double right arrow (>>).

Note: To move a field back from the Selected Fields list box, use the left arrows (<) and (<<).

3. The Move Up and Move Down buttons can be used to rearrange the fields in the Selected Fields list box. Click on the field to highlight it, then click the Move Up or Move Down button.

4. In the Custom View Name field, enter a name for the Custom View. This name will appear in the title bar for the Custom View.

5. Selecting the Flash Workload Director icon on Updates check box enables ESP Workstation to notify you when your Custom View receives workload updates.
6. To limit the amount of information that appears in the Custom View, use the **Filter** tab.
   For details, see “Applying a Filter to a Custom View” on page 522.

7. Optional. To sort the information, use the **Sort** tab.
   For details, see “Sorting Custom View Information” on page 521.

8. Optional. To select the display colors, use the **Colors Fonts** tab.
   For details, see “Changing the Display Colors” on page 528.

9. Optional. To select the type of display font, use the **Colors Fonts** tab.
   For details, see “Changing the Font of a Custom View” on page 529.

10. To save the Custom View, click **OK**.
Sorting Custom View Information

Sort the data the Custom View displays by field in ascending or descending order. You can sort using up to three fields. For example, you might sort by job name, then by status, and then by state.

To sort Custom View information
1. Right-click the Custom View you want to sort, and select Change Definition from the shortcut menu.
   The Custom View Configuration dialog appears.
2. Click the Sort tab.

3. In the Sort By drop-down list, select the field you want to sort by.
4. Select the type of order:
   - Ascending - To sort from A to Z, lowest to highest number or by earliest date.
   - Descending - To sort from Z to A, highest to lowest number or by latest date.
5. Optionally, use the Then By fields to select a second and third sort criterion.
6. Click OK.
   The Custom View appears in the new sorted order.
Applying a Filter to a Custom View

Apply a filter to a Custom View to limit the amount of information that appears for your workload. You can add, delete, and reorder the filter criteria. Each Custom View contains filter statements you set. The filter statements can be changed at any time. For examples, see “Custom View filter examples” on page 524.

To apply a filter to a Custom View

1. Right-click the Custom View you want to apply a filter to, and select Change Definition from the shortcut menu. The Custom View Configuration dialog appears.

2. Click the Filter tab.

3. In the Field Name field, select from the list of available fields. When you click inside the field name cell, a drop-down menu becomes available.
4. In the **Relationship** field, select one of the following operators that relates to the value you enter in the next step:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Use to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contains</td>
<td>Display partial and full matches of a value. For example, Application Name Contains <em>pay</em> displays all Applications that have names containing pay, payroll, ABCpayroll.</td>
</tr>
<tr>
<td>Is</td>
<td>Display exact matches of a value. For example, Application Name Is <em>payroll</em> displays only Applications named Payroll.</td>
</tr>
<tr>
<td>Is Not</td>
<td>Display everything that does not exactly match the value. For example, Application Name Is Not <em>payroll</em> displays all Applications with names that are not payroll.</td>
</tr>
<tr>
<td>Begins with</td>
<td>Display matches that begin with the value. For example, Application Name Begins with <em>Pay</em> displays all Applications that begin with Pay: Pay1, Payroll.</td>
</tr>
<tr>
<td>Ends with</td>
<td>Display matches that end with the value. For example, Application Name Ends with <em>roll</em> displays all Applications that end with roll: Payroll.</td>
</tr>
<tr>
<td>Does not contain</td>
<td>Display matches that do not contain the value. For example, Application Does not contain <em>pay</em> displays all Applications with names that do not have pay anywhere in the name.</td>
</tr>
<tr>
<td>Is Empty</td>
<td>Display matches that are empty (True) or not empty (False). For example, display all jobs that have a message in the User Status field.</td>
</tr>
<tr>
<td>Matches</td>
<td>Display matches for a pattern of characters. Use the hyphen (-) as a wildcard character to match zero or more characters. For example, a-t-mon will match AGENTMON.</td>
</tr>
</tbody>
</table>

5. In the **Value** field, enter a value. You can enter a portion of a word or the entire word. The value is not case-sensitive. For example, you can enter pay or PAY. If you specify Is Empty in the Operator field, you must enter true or false as the value.

**Note:** Do not use wildcards, such as the asterisk (*) or hyphen (-), to replace a string of characters in a value. For example, do not use pay- or pay*.

6. Optional. In the **And/Or** field, select an option from the drop-down menu.
7. Optional. Use the characters below in the Oper fields to add parentheses to a filter or to negate an expression.

<table>
<thead>
<tr>
<th>Character</th>
<th>Use to</th>
<th>Example</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>(</td>
<td>separate an expression</td>
<td>(Application Name is Payroll And Application Name Contains Cyber) And (Status is FAILED)</td>
<td>Displays only Applications named Payroll or that start with Cyber and that are in a Failed status.</td>
</tr>
<tr>
<td>^</td>
<td>to negate an expression</td>
<td>^ Application Name Is PAYROLL</td>
<td>Does not display any Applications named Payroll.</td>
</tr>
</tbody>
</table>

8. Use the following buttons, as required.

<table>
<thead>
<tr>
<th>Button</th>
<th>Use to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Criteria</td>
<td>Add a new criteria row to the table. The new row appears below the last criterion in the table.</td>
</tr>
<tr>
<td>Insert Criteria</td>
<td>Insert a row in the table. See “Insert criteria” on page 527.</td>
</tr>
<tr>
<td>Delete Criteria</td>
<td>Delete a row from the table. See “Delete criteria” on page 528.</td>
</tr>
<tr>
<td>Move Up</td>
<td>To move a row up in the table.</td>
</tr>
<tr>
<td>Move Down</td>
<td>To move a row down in the table.</td>
</tr>
</tbody>
</table>

9. Click OK.

**Custom View filter examples**

Create Custom View filters that are simple or complex. A simple filter might display Applications that have a specific name, such as Payroll. A more complex filter, for example, might display jobs that are waiting or jobs that are in trouble. The examples below show you the filter criteria you might use to display these different situations.
Applications with a specific name

Suppose you want to view only Applications with a specific name, for example, Applications named Verify. You might create a filter similar to the one below.

```
<table>
<thead>
<tr>
<th>Oper</th>
<th>Field Name</th>
<th>Relationship</th>
<th>Value</th>
<th>Oper</th>
<th>And/Or</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Application Name</td>
<td>is</td>
<td>verify</td>
<td></td>
<td>Or</td>
</tr>
</tbody>
</table>
```

The resulting filter criteria is:

```
Application Name is verify
```
Waiting jobs
Suppose you want to view all jobs that are in a wait state. You might create a filter using the same state names as the values:

- State is predwait - for jobs waiting for predecessors to complete.
- State is waiting - for jobs waiting for a specific time for submission.
- State is subdelay - for jobs that have delayed submission.

To simplify the filter, you can replace the two statements above that contain predwait and waiting with one statement: state contains wait.
Jobs in trouble
Suppose you want to create a view that indicates when jobs are in trouble. Jobs in the following states indicate trouble:

- Fail or Failed
- Inactive
- Monerror
- Suberror
- Syserror

You might create a filter for this situation similar to the one below:

![Custom View Configuration](image)

Insert criteria
Insert criteria into an existing filter anywhere within the filter criteria.

To insert criteria
1. Highlight a row by clicking it when the cursor changes to an arrow.
   Select the criteria row that will follow the criteria you want to enter.
2. Click **Insert Criteria**. A new row appears before the row you had selected.

<table>
<thead>
<tr>
<th>Oper</th>
<th>Field Name</th>
<th>Relationship</th>
<th>Value</th>
<th>Oper</th>
<th>And/Or</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Status</td>
<td>Contains</td>
<td>FAIL</td>
<td>Or</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Application Name</td>
<td>Contains</td>
<td></td>
<td>Or</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Status</td>
<td>Is</td>
<td>SUBERROR</td>
<td>Or</td>
<td></td>
</tr>
</tbody>
</table>

**Delete criteria**

Delete criteria from an existing filter.

**To delete filter criteria**
1. Identify the row in the table you want to delete.
2. Highlight the row by clicking it when the cursor changes to an arrow.
3. Click **Delete Criteria**.

**Changing the Display Colors**

Change the foreground and background colors that appear for a Custom View. The foreground color changes the font color.

**To change a Custom View’s colors**
1. Click the **Custom View** tab to switch to the Custom View.
2. Right-click the Custom View you want to change, and select **Change Definition** from the shortcut menu.
   - The Custom View Configuration dialog appears.
3. Click the **Color Fonts** tab.
4. Select one of the following options:
   • To use the colors representing the state of the job for the background color, select the Use State Colors check box.
   • To select a Font color and background color, remove the check mark in the Use State Colors box, and select a Foreground and Background color.

5. To save the color change, click OK.

Changing the Font of a Custom View

Change the font, font style, and font size that appears for a Custom View.

To change a Custom View’s font
1. Click the Custom View tab to switch to the Custom View.
2. Right-click the Custom View you want to change, and select Change Definition from the shortcut menu.
   The Custom View Configuration dialog appears.
3. Click the Color Fonts tab. The Color Fonts tab appears.
4. Click Font. The Font dialog appears.
5. Select the Font, Font style, and Size you want.
   A sample appears in the box labelled Sample.
6. Click OK.
   The Color Fonts tab appears.
7. To save the font change, click OK.

Adjusting the Columns in Custom Views

Make the following changes to adjust the columns in Custom Views:
   • Change the column width
   • Hide the line count column

Change the column width
Change the width of the columns that appear in a Custom View.
1. Position the cursor over the border in the column heading.
   The cursor changes from an arrow cursor to a size cursor.
2. Left-click, and hold the mouse button while dragging the border left or right. The Custom View size columns and position are saved in the User Profile when you close Workload Director.

**Show or hide the line count**
Show or hide the first column of a Custom View that displays the number of lines in the Custom View.

On the **Options** menu, ensure the **Show Custom View Line Count** option has a check mark.

### Opening a Custom View

Open a Custom View when you want a textual view of your workload or when you need to make changes to it.

**To open a Custom View**

1. Ensure you are in Custom View.
   Click the **Custom View** tab at the bottom of the left-hand pane.

2. In the Custom View, do one of the following:
   - Right-click the Custom View you want to display, and select **Open** from the shortcut menu.
   - Select the Custom View you want to open, and from the Custom View menu select **Open**.
   - Double-click the Custom View you want to display.

   The Custom View appears.

### Viewing the list of Custom Views

You can tell which Custom Views are open by looking in the tree view. Open Custom Views have a colored icon. Closed Custom Views are grayed out.

### Copying a Custom View

You can duplicate a Custom View you have created, and make changes to it. This copy feature can save you time when you want a new Custom View that is similar to an existing Custom View.
To copy a Custom View
1. Use one of the following methods:
   • In the Custom View, right-click the Custom View to copy, and select Make a Copy from the shortcut menu.
   • Select the Custom View to copy, and from the Custom View menu, select Make a Copy.

A copy of the Custom View appears.

2. To make changes to the copy, for example, to rename it, right-click the copy and select Change Definition from the shortcut menu.
   The Custom View Configuration dialog appears.

3. Make the desired changes, and click OK.

Closing a Custom View

When you no longer need to view a Custom View, close it.

To close a Custom View, click the Close button (x) in the upper-right corner of the Custom View window.

Note: If you click the Close button at the end of the title bar, you close Workload Director.

Deleting a Custom View

You can delete any Custom View.

To delete a Custom View
1. Make sure you are in the Custom View.
   To display the Custom View, click the Custom View tab at the bottom of the Workload Director window.

2. In the left-hand pane, do one of the following:
   • Right-click the Custom View you want to delete, and select Delete from the shortcut menu.
   • Select the Custom View you want to delete. From the Custom View menu, select Delete.
Printing Custom Views

Ensure the Custom View tab is selected at the bottom of the Workload Director. The following print tasks can be performed in Custom View:

- Print Preview
- Print
- Print all Custom Views
- Page Setup

Print Preview

The print preview feature allows you to view and print an overview of an Application.

To view a print preview of an Application

1. In the left-hand pane, double-click the Application folder you want to print a preview of.
   A Custom View of the Application appears in the right-hand pane.
2. On the File menu, click Print Preview.
   A preview of the Application appears in text.
3. Click Print. The Print dialog appears.
4. Select the print options you want, and click OK.
Print

To print one Custom View
1. In the left-hand pane, double-click the Application folder you want to print. A Custom View of the Application appears in the right-hand pane.
2. From the File menu, select Print. The Print dialog appears.
3. Select the print options you want, and click OK.

Print all Custom Views
You may want to have a printout of more than one Application. You can print all Custom Views that are opened. In the left-hand pane, an open Custom View is indicated by a colored icon beside the Application folder. All folders with colored icons will be printed.

To print all Custom Views
1. In the left-hand pane, double-click the Application folders you want to print. A Custom View of each Application appears in the right-hand pane.
2. From the **File** menu, select **Print All Custom Views**. A message appears indicating all the views have been sent to the printer. You do not need to click **OK** to acknowledge printing for each view. All the opened Custom Views are printed directly. With this method of printing, you will not have the option of setting options through a Print dialog.

**Page Setup**

Page setup features numerous page settings you can use. This provides flexibility for any custom printing you require. The preview screen allows you to see the changes as you select the different options.
Locating a Job within a Custom View

Locate a job within any Custom View or specify a partial job name to display a list of jobs that match the criteria specified.

To locate a job within a Custom View

1. Open the Custom View so you can see a textual view of your workload.
2. From the menu bar, select **Action > Locate Job in Custom Views**. The **Locate Job in Custom Views** dialog appears.

3. In the fields provided, enter one or more of the following:
   - Job name (or a partial job name)
   - Application name (or a partial Application name)
   - Host name
   - Custom View name (or a partial Custom View name)

   The more details you specify, the more narrowed the search results are.
4. Click **Search**.
   A selection list is displayed in the Search Results box.

![Locate Job in Custom Views](image)

5. In the **Search Results** box, click on the job you want to view.
The job is highlighted.

6. Click **Locate**.
The job is highlighted in the textual view.
You can monitor and control an SAP system by using the SAP Tools component of Workstation.

About the SAP Tools Interface

SAP Tools is a window into SAP systems that you control workload on. To launch SAP Tools, open the Workstation Toolkit and click SAP Tools. To get information on any field, press F1.

You can:

- List and trigger (raise) SAP events. For information, see “About SAP Events” on page 537.
- List and manage intercepted SAP jobs. For information, see “About Intercepted Jobs” on page 538.
- Monitor SAP jobs that were not submitted by Workstation. For information, see “About AdHoc Jobs” on page 541.
- View SAP system resource usage. For information, see “Determining Resource Usage on the SAP System” on page 544.

About SAP Events

The term ‘raising an event’ in SAP means the same as triggering an Event in Workstation. Events are usually triggered automatically based on schedule criteria. You may want to trigger an SAP event manually, for example when an event is not scheduled and you want to run it. You trigger SAP events manually from the SAP Tools interface.

To trigger an SAP event

1. Open the Workstation Toolkit and click SAP Tools. The SAP Tools interface appears.
2. From the Tools menu, click Events or click the Events icon on the toolbar.
3. Complete the SAP connection fields, Agent name is mandatory.
4. To get a refreshed list from the SAP system, click List Events.
5. Highlight the event you want to trigger.
6. Click Trigger Event.

Event Parameter is optional but a parameter may be required to trigger this event.
**About Intercepted Jobs**

Intercepted jobs are not started at the moment when their start conditions are fulfilled. They are deactivated to be restarted later. When intercepted, a job is set back to the status 'scheduled'.

The SAP system sets jobs as intercepted based on entries in the Interception Criteria Table. You can:

- View interception criteria by displaying the table contents
- Intercept jobs by modifying the table to add filter criteria
- Release jobs from intercepted status by issuing a start command
- Make a copy of a job that is intercepted
- Get the definition of a job that is intercepted
- Delete a job that is intercepted
- Get and check the status of the job that is on the table

**Hint:** Click F1 in any field for help information specific to that field.

**To display the list of intercepted jobs**

1. Open the Workstation Toolkit and click **SAP Tools**. The SAP Tools interface appears.
2. From the **Tools** menu, click **Intercepted Jobs** or click the **Intercepted** icon on the toolbar.
3. Complete the SAP connection fields, Agent name is mandatory.
4. Click **List Jobs**. The list of currently intercepted jobs appears.

**Note:** If you specify an asterisk in the Client field, intercepted jobs from all SAP servers will be displayed.
To issue commands against a job in the list
1. Select a job in the list to highlight, then right-click. A shortcut menu appears.
2. Select a command from the shortcut menu.

You can issue the following commands against jobs on the Intercepted Jobs list:
- **Start**—Start a job that has been intercepted.
  
  For more information, see “Start Immediately” on page 484 or “Start ASAP (as soon as possible)” on page 484.
- **Copy**—Make a copy of this job on the SAP system.
  
  For more information, see “JobCopy” on page 487.
- **Get Status**—View the status of this job.
  
  For more information, see “JobStatusGet” on page 483.
- **Check Status**—Check the status of this job.
  
  For more information, see “JobStatusCheck” on page 482.
- **Get Definition**—Get the definition for this job.
  
  For more information, see “JobDefGet” on page 483.
- **Delete**—Delete this job.
  
  For more information, see “JobDelete” on page 483.

**About the Modify Criteria Table**

The Interception Criteria Table describes the criteria the SAP system uses to intercept jobs. By modifying the table you can:

- Remove jobs from the table and issue a command to release them from intercepted status.
- Add jobs to the table to cause them to be intercepted.
- Change existing criteria (optionally using asterisks as wildcards) to modify the criteria used to intercept jobs.

**Note:** Only jobs that were defined on the SAP system (for example, using SAPGUI), can be intercepted using this method. SAP jobs created using Workstation cannot be intercepted from within Workstation.

**Hint:** Click **F1** in any field for help information specific to that field.
To modify the Interception Criteria Table

1. Open the Workstation Toolkit and click **SAP Tools**. The SAP Tools interface appears.

2. From the **Tools** menu, click **Intercepted Jobs** or click the **Intercepted** icon on the toolbar.

3. Complete the SAP connection fields, Agent name is mandatory.

4. Click **Modify Criteria**. The Modify Criteria Table appears.

5. Click **List Criteria**.

The list of criteria currently in use to intercept jobs appears. You can modify existing criteria, update the table, and add or delete criteria from the list.

- To intercept a job, you fill in the fields and click **Add**. An asterisk can be used as a mask. The new job appears in the list. For example, to intercept all jobs that start with LAM, type LAM*.

- To release a job from intercepted status, select it in the list to highlight. The fields describing the interception criteria are populated. Click **Delete**.

- To modify existing criteria, highlight the job in the list. The fields describing the interception criteria are populated. Make your changes in the appropriate fields. Click **Update**. For example, if jobs starting with LAM were previously being intercepted on client 800 and should now be intercepted on client 801, highlight the line that contains the string LAM* in the list. Replace 800 with 801 in the Client field and click **Update**.

- To send your changes to the server and update the table on the SAP system, click **Apply**.

- To cancel your changes and close the Modify Criteria Table dialog, click **Close**. Click **Apply** to ensure your changes are saved.

**Note:** If you deleted a job from the list, you must now issue the start command from the Intercepted Jobs dialog. Right-click the job and select **Start** from the shortcut menu.
About AdHoc Jobs

An AdHoc job is any job submitted outside of the control of Workstation. AdHoc jobs include jobs:

- Submitted manually
- Submitted by another scheduling product
- Submitted by another system

You can identify many characteristics for jobs you want to monitor, for example, job status or date ranges, and save those characteristics as a named filter.

To monitor AdHoc jobs

1. Open the Workstation Toolkit and click SAP Tools. The SAP Tools interface appears.
2. From the Tools menu, click AdHoc Jobs or click the AdHoc icon on the toolbar. The List of Filters dialog appears.
3. Highlight a filter name in the list and click Open. The AdHoc Jobs Monitor dialog appears.
4. Click Subscribe. The list of jobs that meet the filter criteria update every minute until you click Unsubscribe.

About AdHoc List of Filters

Hint: Click F1 in any field for help information specific to that field.

To display the AdHoc Jobs Monitor dialog, highlight a filter name in the list and click Open. On the AdHoc Jobs Monitor dialog, click Subscribe. The list of jobs that meet the filter criteria update every minute until you click Unsubscribe.

To define characteristics for a new filter, click Add. The Create a new filter dialog appears.

To edit an existing filter, highlight the filter in the list and click Update. The Edit Filter Properties dialog appears.

About AdHoc Jobs Monitor

Hint: Click F1 in any field for help information specific to that field.

The AdHoc Jobs Monitor will continue to update until you close the dialog or unsubscribe from the filter. The polling rate for the monitor is set in the Agent configuration file. For more information on the polling rate, ask your Agent Administrator.

To refresh the list of jobs at any time, click Refresh.
To freeze the screen updates at any time, click **Lock Screen**. To resume job monitoring, click **Unlock Screen**.

To edit the current filter from the AdHoc Jobs Monitor, click **Edit Filter**.

**To issue a command against an AdHoc job**

1. Select a job in the list to highlight, then right-click. A shortcut menu appears.
2. Select a command from the shortcut menu.

You can issue the following commands against jobs on the AdHoc Jobs list:

- **Start**—Start a job after deleting it from the list.
  
  For more information, see “Start Immediately” on page 484 or “Start ASAP (as soon as possible)” on page 484.

- **Copy**—Make a copy of this job on the SAP system.
  
  For more information, see “JobCopy” on page 487.

- **Get Status**—View the status of this job.
  
  For more information, see “JobStatusGet” on page 483.

- **Check Status**—Check the status of this job.
  
  For more information, see “JobStatusCheck” on page 482.

- **Get Definition**—Get the definition for this job.
  
  For more information, see “JobDefGet” on page 483.

- **Cancel**—Cancel this job.
  
  For more information, see “JobCancel” on page 483.

- **Delete**—Delete this job.
  
  For more information, see “JobDelete” on page 483.

- **Get Children**—List the children of this job, if any.
  
  For more information, see “JobChildrenGet” on page 488.

- **Get Spool List**—Get the spool list for this job.
  
  For more information, see “GetJobSpoolList” on page 487.

- **Read Log**—Read the job log for this job.
  
  For more information, see “JobLogRead” on page 482.
Creating a New Filter

To add an AdHoc job filter

1. Open the Workstation Toolkit and click SAP Tools. The SAP Tools interface appears.

2. From the Tools menu, click AdHoc Jobs or click the AdHoc icon on the toolbar. The List of Filters dialog appears.
   You can set up a new filter or edit an existing filter.

3. To define characteristics for a new filter, click Add. The Create a new filter dialog appears.

4. In the Filter Name field, enter a name for the filter.

5. Complete the rest of the dialog. The SAP Job Name and SAP User Name are required, wildcards are allowed.
   You can specify further filter criteria:
   • To specify categories of jobs such as event information, state or date ranges, click Advanced.
   • To specify more job-specific information such as the time jobs started, stopped or changed state and to specify which columns will appear in the AdHoc Jobs Monitor, click AdHoc Filter.

Editing a Filter

To edit an AdHoc job filter

1. Open the Workstation Toolkit and click SAP Tools. The SAP Tools interface appears.

2. From the Tools menu, click AdHoc Jobs or click the AdHoc icon on the toolbar. The List of Filters dialog appears.
   You can set up a new filter or edit an existing filter.

3. To edit an existing filter, highlight it in the list and click Update. The Edit Filter Properties dialog appears.

4. The fields describing the filter are populated. Make your changes in the appropriate fields, click Save.
   You can edit or specify further filter criteria:
   • To specify categories of jobs such as event information, state or date ranges, click Advanced.
   • To specify more job-specific information such as the time jobs started, stopped or changed state and to specify which columns will appear in the AdHoc Jobs Monitor, click AdHoc Filter.


**About Advanced Filter Criteria (AdHoc Jobs)**

**Hint:** Click F1 in any field for help information specific to that field.

Use this dialog to specify further filter criteria. You can specify categories of jobs such as event information, state or date ranges.

**About AdHoc Specific Filter Criteria**

**Hint:** Click F1 in any field for help information specific to that field.

Use this dialog to specify more job-specific information such as the time jobs start, stop or change state, and to specify which columns will appear in the AdHoc Jobs Monitor.

**Determining Resource Usage on the SAP System**

You can get a list of the following information about your SAP systems:

- Total processes
- Free processes
- Status

**Hint:** Click F1 in any field for help information specific to that field.

**To get a list of current resources on the SAP System**

1. Open the Workstation Toolkit and click **SAP Tools**. The SAP Tools interface appears.
2. From the **Tools** menu, click **Resources** or click the **Resources** icon on the toolbar. The SAP Resources dialog appears.
3. Complete the SAP connection fields, agent name is mandatory.
4. Click **List Resources**. The List of SAP Resources appears.
This chapter explains how to use the Report Manager to create history reports in Workstation. For information on other types of ESP Workload Manager reports, see the *ESP Workload Manager User’s Guide*.

This section contains the following topics:

- About history reports
- Creating a history report
- Report examples
- History reporting fields and operators
About history reports

With Workstation, you can create history reports that contain details about the progress of jobs. Information in the job history files, defined by the administrator or installer, provides the basis for the reports.

In the Report Manager, you set panel options to determine what information is included in your report and how it is displayed. Once you have set this information, you can generate a report. This report can be saved or printed.

The panel options that you set make up a report definition. You can save a report definition and reopen it to generate reports at later dates. You can also open a report definition to modify it. You can save these modifications in the place of the existing report definition or save them as a new report definition with a different name.

You can find the options for opening, saving, and printing reports on the File menu. Here you can also find the options for opening and saving report definitions. Alternately, you can use the icons on the quick access bar.

Note: You can report only on jobs, started tasks, and TSO users that the ESP Workload Manager administrator requests ESP Workload Manager to track. For more information on how to specify which of these ESP Workload Manager tracks, refer to the ESP Workload Manager Security guide.
The following is an example of a generated history report:

<table>
<thead>
<tr>
<th>JOBNAMEx</th>
<th>COMP CODE</th>
<th>EXECC START DATE</th>
<th>START DATE</th>
<th>END DATE</th>
<th>CPU TIME</th>
</tr>
</thead>
<tbody>
<tr>
<td>B</td>
<td>0 18.00.22</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>0:00</td>
</tr>
<tr>
<td>CYBBP01X</td>
<td>JCLERROR 23.30.02</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>0:00</td>
</tr>
<tr>
<td>CYBBP01X</td>
<td>JCLERROR 23.30.01</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>0:00</td>
</tr>
<tr>
<td>D</td>
<td>0 18.00.32</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>0:00</td>
</tr>
<tr>
<td>RPN014A</td>
<td>0 23.55.01</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>0:00</td>
</tr>
<tr>
<td>RPN014B</td>
<td>0 23.55.02</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>0:00</td>
</tr>
<tr>
<td>RPN014C</td>
<td>0 23.55.03</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>0:00</td>
</tr>
<tr>
<td>RPN014D</td>
<td>0 23.55.05</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>0:00</td>
</tr>
<tr>
<td>RPN014E</td>
<td>0 23.55.09</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>0:00</td>
</tr>
<tr>
<td>RPN014F</td>
<td>0 23.55.09</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>0:00</td>
</tr>
<tr>
<td>RPN014G</td>
<td>0 23.55.10</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>0:00</td>
</tr>
<tr>
<td>RPN014H</td>
<td>0 23.55.14</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>0:00</td>
</tr>
<tr>
<td>SWBEL67</td>
<td>0 13.16.05</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>0:00</td>
</tr>
<tr>
<td>SWBEL67</td>
<td>0 13.15.33</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>0:00</td>
</tr>
<tr>
<td>SWBEL67</td>
<td>0 13.15.30</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>0:00</td>
</tr>
<tr>
<td>SWBEL68</td>
<td>0 13.16.05</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>0:00</td>
</tr>
<tr>
<td>SWBEL69</td>
<td>0 13.15.33</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>0:00</td>
</tr>
<tr>
<td>SWBEL69</td>
<td>0 13.15.30</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>0:00</td>
</tr>
<tr>
<td>SWBEL70</td>
<td>0 13.16.05</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>0:00</td>
</tr>
<tr>
<td>SWBEL70</td>
<td>0 13.15.33</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>0:00</td>
</tr>
<tr>
<td>SWBEL76</td>
<td>0 13.16.05</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>0:00</td>
</tr>
</tbody>
</table>

For information on creating history reports, see “Creating a history report” on page 548 and “History reporting fields and operators” on page 567.

**Note:** This history report example is explained in more detail in “Report examples” on page 559.
You can create a history report using the ESP Workload Manager VSAM history files or using information from a database.

**Note:** To create a history report using a database, you must have the ESP Consolidated Server set to work with the database. The database option is packaged with SMP/E as function SEP5504 and PTF SU02827.

To create a history report, you open the Report Manager and use the panels to set report options. Once you have set all of the necessary options, you are ready to generate a report by clicking the **Generate Report** button.

When you create a history report, you use reporting fields to select what information is included in your report. The reporting fields are listed and explained in more detail in “History reporting fields and operators” on page 567.

This section contains information on the following topics:

- Opening the Report Manager
- Setting the General panel
- Setting the SQL panel
- Setting the Report Criteria panel
- Setting the Report Format panel
- Setting the Sorting panel
- Generating and viewing reports

### Opening the Report Manager

The Report Manager button is located on the Workstation Toolkit:

![ESP Workstation](image)

**Open the Report Manager using one of these methods**

- On the Workstation Toolkit, click the **Report** button.
- On the Workstation Toolkit menu bar, select **ESP Tools > Report Manager**.
Creating a history report 549

The Report Manager appears.

Setting the General panel

**Dependency**: To use the Database option to specify the report source, you require PTF SU02827.

In the General panel, you set basic report information. This information can include the server and history file to pull report information from, the time range of the report information, the report type, and the date format.

**To set the General panel**

1. In the Report Manager, click on the **General** tab.
2. To select a server other than the default from which to pull report information, select the required server from the **Server** drop-down list.
3. Select the report source:
   - To create a report using the ESP Workload Manager history reporting facility provided with the product, select the **History File** option.
• To create a report using information from a database, select the **Database** option. This option requires you have the ESP Consolidated Server set up to work with a database.

4. If you are using a history file as the report source, specify the history files you want to use for the report.
  • To select specific history files, enter the logical identifier of each history file in the **History File** field, separated by commas or spaces. For example, HIST1.
  • To select all history files you are permitted to access, leave the **History File** field blank.

5. In the **Start** field, enter the start of the report time range using one of these methods:
  • Enter the start range criteria.
  • Select the ellipsis button (...) to use the Schedule Criteria Editor. For more information, see “Schedule Criteria Editor” on page 115.

6. In the **End** field, enter the end of the report time range using one of these methods:
  • Enter the end range criteria.
  • Select the ellipsis button to use the Schedule Criteria Editor. For more information, see “Schedule Criteria Editor” on page 115.
  If you leave this field blank, the current date and time are used.

7. Select a report type from the **Report Type** drop-down list:
  • To create a report formatted with columns, select TEXT.
  • To create a report formatted with commas, select CSV.

  **Note:** The CSV (Comma Separated Value) format is designed for easy import into third-party tools, with which the report data can be displayed in formats such as pie charts or bar graphs.

8. To set a date format, select one from the **Date Format** drop-down list.

9. To set the total width of your report, select a character number from the **Report Width** drop-down list.

  If you select a total width that is less than the combined width of your columns, columns exceeding the total width are cut off.

You have now finished defining the General panel. Complete the next Report panel. For more information, see Setting the Report Criteria panel.
Setting the SQL panel

If you chose the Database option as the report source, you must complete the SQL panel. You enter SQL statements in the free format SQL box, to specify the data for your history report.

To specify an SQL query

Use the following guidelines:

• Type each SQL statement on a separate line.
• Do not type SQL at the beginning of each line.
• Start a new line by pressing Enter.

Note: You can use Copy, Cut, and Paste operations in the SQL panel.

Example: SQL query

![SQL query example]

Setting the Report Criteria panel

In the Report Criteria panel, you set which jobs are included in or excluded from your report by defining criteria statements. A criteria statement is made up of reporting fields, relationship operators, values, and AND/OR operators.

You can set multiple criteria statements. To continue a criteria statement from the previous line, set the first field to be blank. To create a new criteria statement, select CRITERIA in the first field.

You may write a single criteria statement if you are using only one type of operator (all AND operators or all OR operators). Use separate criteria statements for different operators.
Your report includes information on jobs that match one or more of your criteria statements. In other words, all separate criteria statements relate to each other with the OR operator, regardless of what operator you choose.

**Note:** All of the fields in this panel are optional. If you leave these fields blank, your report includes all of the jobs that meet your General panel specifications.

To set the Report Criteria panel

1. Click on the **Report Criteria** tab.
2. To start a new criteria statement, select CRITERIA from the drop-down menu.
3. From the **Field Name** drop-down list, select a reporting field that identifies the jobs you want or do not want in your report.
   For more information, see “History reporting fields and operators” on page 567.
   **Tip:** To speed up reporting field selection, click the drop-down list and press the first letter of your reporting field. The list displays fields starting with that letter. Scroll to select your reporting field.
4. Select an operator for the value from the **Relationship** drop-down list.
   For more information, see “Relationship operators” on page 572.
5. In the Value field, enter a value that is valid for the reporting field you selected.
   For more information, see “History reporting fields and operators” on page 567.
6. If you are continuing the criteria statement on the following line, select AND or OR from the **And/Or** drop-down list. If this is the only line or last line for the criteria statement, select NONE.
7. If you want to continue the criteria statement on the following line, click the **Add Criteria** button. If you do not want to continue the criteria statement, go ahead to step 9.

8. In your new row, change the first field to blank by selecting the blank item from the drop-down list, then repeat step 3 to step 7.

9. Continue adding criteria statements until you have identified all the jobs you want included in or excluded from, your report.
   - To add a new row at the bottom of your list, click the **Add Criteria** button.
   - To add a new row above an existing row, click on the row number and click the **Insert Criteria** button.
   - To delete a row, click on the row number and click the **Delete Criteria** button.
   - To change the list order, click on a row number and click the **Move Up** and **Move Down** buttons as needed.
   - To resize rows or columns, click between row numbers or column headers and drag smaller or larger.

You have now finished defining the Report Criteria panel. Complete the next Report panel. For more information, see Setting the Report Format panel.

### Setting the Report Format panel

In the previous panel, the Report Criteria panel, you identify which jobs are included in your report. In the Report Format panel, you determine what information is included from these jobs in your report.

You determine what information to include by selecting reporting fields. The order in which you arrange the reporting fields determines the column order of your generated report.
You can also set up page breaks in this panel. Page breaks are used to define the points in the report where you want to force a new page, insert blank lines or produce a subtotal.

To define the Report Format panel

1. From the Field Name drop-down list, select a reporting field that identifies the information you want in your report.

   The information the reporting field generates is displayed in a column in your report. For more information, see “History reporting fields and operators” on page 567.

   **Tip:** To speed up reporting field selection, click the drop-down list and press the first letter of your reporting field. The list displays fields starting with that letter. Scroll to select your reporting field.

2. To set the column width, select or enter a character number in the Length field.

3. To set a custom title name for the column, enter a title into the Title 1 field.

   If you do not define this field, the default field title is used for the column.

4. To set a second-line custom title name for the column, enter a title into the Title 2 field.
5. Continue defining criteria until you have identified all the information you want included in your report.
   • To add a new row at the bottom of your list, click the **Add Field** button.
   • To add a new row above an existing row, click on the row number and click the **Insert Field** button.
   • To delete a row, click on the row number and click the **Delete Field** button.
   • To change the list order, click on a row number and click the **Move Up** and **Move Down** buttons as needed.
   • To resize rows or columns, click between row numbers or column headers and drag smaller or larger.

6. If you want to set section breaks, set the **Section breaks** options.
   • In the **Field Name** field, select a reporting field to indicate where you want the section break to occur.
     This field must be selected in the **Fields to be displayed** section.
   • To set a Field Name character number, select or enter the number of characters in the **Length** field.
     Setting a character number inserts the section break only when the first few characters (up to the set character number) change, not when any letter in the Field Name changes.
   • To add line spaces after the section break, set the number of line spaces in the **Space** field.
   • To start a new page after the section break, select **EJECT** from the **Eject** drop-down list.
   • To set a subtotal after the section break, select **SUBTOTAL** from the **Subtotal** drop-down list.

You have now finished defining the Report Format panel. Complete the next Report panel. For more information, see “Setting the Sorting panel” on page 556.
Setting the Sorting panel

You can sort Report information using up to three fields. For example, you might sort by job name and then by status. In this case, jobs with the same name would be grouped together in order of status.

To set the Sorting panel

1. Click the **Sorting** tab.

2. In the **Sort By** drop-down list, select the field you want to sort by first.

   **Tip:** To speed up reporting field selection, click the drop-down list and press the first letter of your reporting field. The list displays fields starting with that letter. Scroll to select your job attribute field.

3. Select the type of order:
   - **Ascending** - To sort from A to Z, lowest to highest number or by earliest date.
   - **Descending** - To sort from Z to A, highest to lowest number or by latest date.

4. To select a second and a third field to sort by, repeat steps 3 and 4 for the **Then By** fields.
You have now finished defining the Sorting panel. If you are ready to generate your report, select the Generate Report button. To continue defining information in another panel, click on the tab for that panel.

Generating and viewing reports

Once you have finished creating a report definition by setting information in the reporting panels, you are ready to generate and view your report. To generate your report, click the Generate Report button. Your report may take some time to process.

If your report does not automatically appear after being processed, you may need to expand the generated report pane on the right side of the report window. To do so, hover over the right edge of the window until your cursor displays as a double-headed arrow crossed with two lines. Click and drag the cursor to the left to expand the window.

Tip: The double-headed arrow without the two crossing lines minimizes or expands the entire window, not the generated report pane.
You may print or save your generated report. If you save your report, it can be imported into third-party tools and used to create pie charts or bar graphs. For information on formatting a report for use in third-party tools, see “Setting the General panel” on page 549. You may also choose to save your report definition, so that it can be used to generate updated reports in the future. For more information on saving, printing, and opening generated reports and report definitions, see “About history reports” on page 546.
This section contains the following examples:

- Simple report
- Advanced Report
- AND/OR operator examples
- Section breaks and sorting example

Simple report

This example demonstrates how to create a report on all jobs in an Application called PAYROLL that have changed status since 8 am today.

In this example, the report panels are set as follows:

General panel:

```
Server: Iparsa:4515
History File: 
Start: Mar 25, 2003
```

Report Criteria panel:

```
<table>
<thead>
<tr>
<th>Criteria</th>
<th>Field Name</th>
<th>Relationship</th>
<th>Value</th>
<th>And/Or</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>CRITERIA</td>
<td>EQ</td>
<td>PAYROLL</td>
<td>None</td>
</tr>
</tbody>
</table>
```
Report Format panel:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Length</th>
<th>Title 1</th>
<th>Title 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>JOBNAME</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CMPC</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>EXECST</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>EXECSDATE</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ENDDATE</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CPU TIME</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Generated report results:

<table>
<thead>
<tr>
<th>JOBNAME</th>
<th>COMP</th>
<th>EXEC</th>
<th>START CODE</th>
<th>START DATE</th>
<th>END DATE</th>
<th>CPU TIME</th>
</tr>
</thead>
<tbody>
<tr>
<td>B</td>
<td>0</td>
<td>18.00.22</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>0:00</td>
<td></td>
</tr>
<tr>
<td>CYBBP01X</td>
<td>JCLERROR</td>
<td>23.30.02</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>0:00</td>
<td></td>
</tr>
<tr>
<td>CYBBP01X</td>
<td>JCLERROR</td>
<td>23.30.01</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>0:00</td>
<td></td>
</tr>
<tr>
<td>D</td>
<td>0</td>
<td>18.00.32</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>0:00</td>
<td></td>
</tr>
<tr>
<td>RPN014A</td>
<td></td>
<td>23.55.01</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>0:00</td>
<td></td>
</tr>
<tr>
<td>RPN014B</td>
<td></td>
<td>23.55.02</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>0:00</td>
<td></td>
</tr>
<tr>
<td>RPN014C</td>
<td></td>
<td>23.55.03</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>0:00</td>
<td></td>
</tr>
<tr>
<td>RPN014D</td>
<td></td>
<td>23.55.05</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>0:00</td>
<td></td>
</tr>
<tr>
<td>RPN014E</td>
<td></td>
<td>23.55.09</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>0:00</td>
<td></td>
</tr>
<tr>
<td>RPN014F</td>
<td></td>
<td>23.55.09</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>0:00</td>
<td></td>
</tr>
<tr>
<td>RPN014G</td>
<td></td>
<td>23.55.10</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>0:00</td>
<td></td>
</tr>
<tr>
<td>RPN014H</td>
<td></td>
<td>23.55.14</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>0:00</td>
<td></td>
</tr>
<tr>
<td>SWBEL67</td>
<td>0</td>
<td>13.16.05</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>0:00</td>
<td></td>
</tr>
<tr>
<td>SWBEL67</td>
<td>0</td>
<td>13.15.33</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>0:00</td>
<td></td>
</tr>
<tr>
<td>SWBEL67</td>
<td>0</td>
<td>13.15.30</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>0:00</td>
<td></td>
</tr>
<tr>
<td>SWBEL68</td>
<td>0</td>
<td>13.16.05</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>0:00</td>
<td></td>
</tr>
<tr>
<td>SWBEL68</td>
<td>0</td>
<td>13.15.33</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>0:00</td>
<td></td>
</tr>
<tr>
<td>SWBEL68</td>
<td>0</td>
<td>13.15.30</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>0:00</td>
<td></td>
</tr>
<tr>
<td>SWBEL69</td>
<td>0</td>
<td>13.16.05</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>0:00</td>
<td></td>
</tr>
<tr>
<td>SWBEL69</td>
<td>0</td>
<td>13.15.33</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>0:00</td>
<td></td>
</tr>
<tr>
<td>SWBEL69</td>
<td>0</td>
<td>13.15.30</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>0:00</td>
<td></td>
</tr>
<tr>
<td>SWBEL70</td>
<td>0</td>
<td>13.16.05</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>0:00</td>
<td></td>
</tr>
<tr>
<td>SWBEL70</td>
<td>0</td>
<td>13.15.33</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>0:00</td>
<td></td>
</tr>
<tr>
<td>SWBEL70</td>
<td>0</td>
<td>13.15.30</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>0:00</td>
<td></td>
</tr>
<tr>
<td>SWBEL76</td>
<td>0</td>
<td>13.16.05</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>0:00</td>
<td></td>
</tr>
<tr>
<td>SWBEL76</td>
<td>0</td>
<td>13.15.33</td>
<td>WED20030326</td>
<td>WED20030326</td>
<td>0:00</td>
<td></td>
</tr>
</tbody>
</table>
Advanced Report

This example demonstrates how to create a report on all jobs that failed between March 1, 2003 and March 31, 2003.

In this example, the report panels are set as follows:

General panel:
Report Criteria panel:

<table>
<thead>
<tr>
<th>Criteria</th>
<th>Field Name</th>
<th>Relationship</th>
<th>Value</th>
<th>And/Or</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>CRITERIA</td>
<td>EQ</td>
<td>-</td>
<td>AND</td>
</tr>
<tr>
<td>2</td>
<td>MXCMPC</td>
<td>NE</td>
<td>0</td>
<td>AND</td>
</tr>
<tr>
<td>3</td>
<td>ESPSUB</td>
<td>EQ</td>
<td>yes</td>
<td>AND</td>
</tr>
<tr>
<td>4</td>
<td>CMPC</td>
<td>NE</td>
<td>running</td>
<td>AND</td>
</tr>
<tr>
<td>5</td>
<td>MXCMPC</td>
<td>NE</td>
<td>running</td>
<td>OR</td>
</tr>
<tr>
<td>6</td>
<td>CRITERIA</td>
<td>EQ</td>
<td>-</td>
<td>AND</td>
</tr>
<tr>
<td>7</td>
<td>MXCMPC</td>
<td>EQ</td>
<td>sys-</td>
<td>AND</td>
</tr>
<tr>
<td>8</td>
<td>ESPSUB</td>
<td>EQ</td>
<td>yes</td>
<td>AND</td>
</tr>
<tr>
<td>9</td>
<td>CMPC</td>
<td>NE</td>
<td>running</td>
<td>AND</td>
</tr>
<tr>
<td>10</td>
<td>MXCMPC</td>
<td>NE</td>
<td>running</td>
<td>OR</td>
</tr>
<tr>
<td>11</td>
<td>CRITERIA</td>
<td>EQ</td>
<td>-</td>
<td>AND</td>
</tr>
<tr>
<td>12</td>
<td>MXCMPC</td>
<td>EQ</td>
<td>jcl-</td>
<td>AND</td>
</tr>
<tr>
<td>13</td>
<td>ESPSUB</td>
<td>EQ</td>
<td>yes</td>
<td>AND</td>
</tr>
<tr>
<td>14</td>
<td>CMPC</td>
<td>NE</td>
<td>running</td>
<td>AND</td>
</tr>
<tr>
<td>15</td>
<td>MXCMPC</td>
<td>NE</td>
<td>running</td>
<td>OR</td>
</tr>
<tr>
<td>16</td>
<td>CRITERIA</td>
<td>EQ</td>
<td>-</td>
<td>AND</td>
</tr>
<tr>
<td>17</td>
<td>MXCMPC</td>
<td>EQ</td>
<td>u****</td>
<td>AND</td>
</tr>
<tr>
<td>18</td>
<td>ESPSUB</td>
<td>EQ</td>
<td>yes</td>
<td>AND</td>
</tr>
<tr>
<td>19</td>
<td>CMPC</td>
<td>NE</td>
<td>running</td>
<td>AND</td>
</tr>
<tr>
<td>20</td>
<td>MXCMPC</td>
<td>NE</td>
<td>running</td>
<td>OR</td>
</tr>
<tr>
<td>21</td>
<td>CRITERIA</td>
<td>EQ</td>
<td>-</td>
<td>AND</td>
</tr>
<tr>
<td>22</td>
<td>MXCMPC</td>
<td>EQ</td>
<td>s****</td>
<td>AND</td>
</tr>
<tr>
<td>23</td>
<td>ESPSUB</td>
<td>EQ</td>
<td>yes</td>
<td>AND</td>
</tr>
<tr>
<td>24</td>
<td>CMPC</td>
<td>NE</td>
<td>running</td>
<td>AND</td>
</tr>
<tr>
<td>25</td>
<td>MXCMPC</td>
<td>NE</td>
<td>running</td>
<td>OR</td>
</tr>
<tr>
<td>26</td>
<td>CRITERIA</td>
<td>EQ</td>
<td>-</td>
<td>AND</td>
</tr>
<tr>
<td>27</td>
<td>MXCMPC</td>
<td>EQ</td>
<td>CCFAIL</td>
<td>AND</td>
</tr>
<tr>
<td>28</td>
<td>ESPSUB</td>
<td>EQ</td>
<td>yes</td>
<td>AND</td>
</tr>
<tr>
<td>29</td>
<td>CMPC</td>
<td>NE</td>
<td>running</td>
<td>AND</td>
</tr>
<tr>
<td>30</td>
<td>MXCMPC</td>
<td>NE</td>
<td>running</td>
<td>None</td>
</tr>
</tbody>
</table>
Report Format panel:

![Report Format panel with fields to be displayed](image)

- **Field Name** | **Length** | **Title 1** | **Title 2**
- JOBNAME |  | Job Name |
- APPLSYS |  | Application |
- APPLGEN |  | Gen # |
- EXECST |  | Start Time |
- EXECSDATE |  | Start Date |
- ENDT |  | End Time |

Sorting panel:

![Sorting panel with sort by field](image)

Sort By...

- **Field Name**: MXCMPC
- **Order**: Ascending
## Generated report results:

<table>
<thead>
<tr>
<th>JOB NAME</th>
<th>APPLICATION</th>
<th>GEN #</th>
<th>START TIME</th>
<th>START DATE</th>
<th>END TIME</th>
<th>END DATE</th>
<th>COMP CODE</th>
<th>MAX COMP CODE</th>
</tr>
</thead>
<tbody>
<tr>
<td>WORKDIR4</td>
<td>AGNTV200</td>
<td>386</td>
<td>11.16.58</td>
<td>TUE20030304</td>
<td>16.12.23</td>
<td>TUE20030304</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>BILLING9</td>
<td>AGNTV200</td>
<td>386</td>
<td>14.37.49</td>
<td>MON20030303</td>
<td>09.28.09</td>
<td>TUE20030304</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>WORKDIR7</td>
<td>UNAGTEST</td>
<td>87</td>
<td>08.31.49</td>
<td>TUE20030304</td>
<td>08.29.08</td>
<td>TUE20030304</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td><strong>SUBTOTAL (3)</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CHECK</td>
<td>UNAGTEST</td>
<td>90</td>
<td>10.22.56</td>
<td>TUE20030325</td>
<td>10.02.36</td>
<td>THU20030327</td>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td>EMAIL</td>
<td>PSAGTEST</td>
<td>31</td>
<td>11.21.31</td>
<td>FRI20030307</td>
<td>16.00.17</td>
<td>TUE20030311</td>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td>SKIPPARM</td>
<td>PSAGTEST</td>
<td>42</td>
<td>15.09.46</td>
<td>WED20030319</td>
<td>09.51.29</td>
<td>THU20030320</td>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td><strong>SUBTOTAL (3)</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>EPNL115E</td>
<td>EPNL115E</td>
<td>124</td>
<td>23.03.34</td>
<td>THU20030320</td>
<td>23.04.39</td>
<td>THU20030320</td>
<td>12</td>
<td>12</td>
</tr>
<tr>
<td>SETCC12</td>
<td>UNAGTEST</td>
<td>85</td>
<td>15.45.43</td>
<td>MON20030303</td>
<td>15.49.30</td>
<td>MON20030303</td>
<td>12</td>
<td>12</td>
</tr>
<tr>
<td>PAYJOB4</td>
<td>AGNTV200</td>
<td>386</td>
<td>14.25.42</td>
<td>MON20030303</td>
<td>09.28.09</td>
<td>TUE20030304</td>
<td>12</td>
<td>12</td>
</tr>
<tr>
<td>TEST3</td>
<td>PSAGTEST</td>
<td>35</td>
<td>11.03.21</td>
<td>THU20030313</td>
<td>10.00.40</td>
<td>MON20030317</td>
<td>12</td>
<td>12</td>
</tr>
<tr>
<td>HR999</td>
<td>PSAGTEST</td>
<td>35</td>
<td>11.03.21</td>
<td>THU20030313</td>
<td>10.00.40</td>
<td>MON20030317</td>
<td>12</td>
<td>12</td>
</tr>
<tr>
<td><strong>SUBTOTAL (5)</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AUTOR010</td>
<td>AUTOR010</td>
<td>6</td>
<td>15.28.31</td>
<td>WED20030312</td>
<td>15.28.42</td>
<td>WED20030312</td>
<td>SOC1</td>
<td>SOC1</td>
</tr>
<tr>
<td>IGN08001</td>
<td>IGN08001</td>
<td>91</td>
<td>11.57.31</td>
<td>WED20030305</td>
<td>11.57.38</td>
<td>WED20030305</td>
<td>SOC1</td>
<td>SOC1</td>
</tr>
<tr>
<td><strong>SUBTOTAL (2)</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>EPNL115E</td>
<td>EPNL115E</td>
<td>123</td>
<td>00.19.41</td>
<td>TUE20030318</td>
<td>00.20.54</td>
<td>TUE20030318</td>
<td>S222</td>
<td>S222</td>
</tr>
<tr>
<td>JTN005</td>
<td>JTN005</td>
<td>109</td>
<td>01.41.15</td>
<td>TUE20030304</td>
<td>01.41.27</td>
<td>TUE20030304</td>
<td>S222</td>
<td>S222</td>
</tr>
<tr>
<td><strong>SUBTOTAL (2)</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AIN002</td>
<td>AIN002</td>
<td>64</td>
<td>08.26.24</td>
<td>TUE20030318</td>
<td>08.26.25</td>
<td>TUE20030318</td>
<td>S806</td>
<td>S806</td>
</tr>
<tr>
<td>C</td>
<td>DEMO</td>
<td>156</td>
<td>14.21.26</td>
<td>TUE20030318</td>
<td>14.21.27</td>
<td>TUE20030318</td>
<td>S806</td>
<td>S806</td>
</tr>
<tr>
<td>CMN0114</td>
<td>CMN0114</td>
<td>18</td>
<td>03.13.02</td>
<td>THU20030313</td>
<td>03.13.02</td>
<td>THU20030313</td>
<td>S806</td>
<td>S806</td>
</tr>
<tr>
<td>D</td>
<td>PATROLL</td>
<td>174</td>
<td>16.04.13</td>
<td>THU20030313</td>
<td>16.04.13</td>
<td>THU20030313</td>
<td>S806</td>
<td>S806</td>
</tr>
<tr>
<td><strong>SUBTOTAL (4)</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AIN002</td>
<td>AIN001</td>
<td>82</td>
<td>06.29.47</td>
<td>FRI20030321</td>
<td>06.29.48</td>
<td>FRI20030321</td>
<td>135</td>
<td>CFAIL</td>
</tr>
<tr>
<td>AUTOR008</td>
<td>AUTOR008</td>
<td>4</td>
<td>14.12.24</td>
<td>WED20030312</td>
<td>14.12.36</td>
<td>WED20030312</td>
<td>146</td>
<td>CFAIL</td>
</tr>
<tr>
<td>DSPATH</td>
<td>PSAGTEST</td>
<td>38</td>
<td>09.51.37</td>
<td>TUE20030318</td>
<td>09.52.10</td>
<td>TUE20030318</td>
<td>S003</td>
<td>CFAIL</td>
</tr>
<tr>
<td><strong>SUBTOTAL (3)</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>EPNL1072A</td>
<td>EPNL1072A</td>
<td>152</td>
<td>22.41.46</td>
<td>THU20030320</td>
<td>22.41.46</td>
<td>THU20030320</td>
<td>JCLError</td>
<td>JCLError</td>
</tr>
<tr>
<td>JOBC</td>
<td>WS24002</td>
<td>429</td>
<td>12.07.29</td>
<td>TUE20030311</td>
<td>12.07.29</td>
<td>TUE20030311</td>
<td>JCLError</td>
<td>JCLError</td>
</tr>
<tr>
<td>JOBC</td>
<td>WS24002</td>
<td>427</td>
<td>12.06.20</td>
<td>TUE20030311</td>
<td>12.06.20</td>
<td>TUE20030311</td>
<td>JCLError</td>
<td>JCLError</td>
</tr>
<tr>
<td>SVN010A</td>
<td>SVN010A</td>
<td>110</td>
<td>16.59.04</td>
<td>THU20030320</td>
<td>16.59.04</td>
<td>THU20030320</td>
<td>JCLError</td>
<td>JCLError</td>
</tr>
<tr>
<td><strong>SUBTOTAL (4)</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>TOTAL (26)</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
AND/OR operator examples

Any of multiple criteria

The criteria statement in the following example selects jobs that either belong to the PAYROLL Application, have names that start with the letter C or consume more than 11 seconds of CPU time:

<table>
<thead>
<tr>
<th>Criteria</th>
<th>Field Name</th>
<th>Relationship</th>
<th>Value</th>
<th>And/Or</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>CRITERIA</td>
<td>APPLSYS</td>
<td>EQ</td>
<td>PAYROLL OR</td>
</tr>
<tr>
<td>2</td>
<td>JOBNAME</td>
<td>EQ</td>
<td>C</td>
<td>OR</td>
</tr>
<tr>
<td>3</td>
<td>CPUTIME</td>
<td>GT</td>
<td>0:11</td>
<td>None</td>
</tr>
</tbody>
</table>

All of multiple criteria

The criteria statement in the following example selects jobs that belong to the PAYROLL Application, have names that start with the letter C, and consume more than 11 seconds of CPU time:

<table>
<thead>
<tr>
<th>Criteria</th>
<th>Field Name</th>
<th>Relationship</th>
<th>Value</th>
<th>And/Or</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>CRITERIA</td>
<td>APPLSYS</td>
<td>EQ</td>
<td>PAYROLL AND</td>
</tr>
<tr>
<td>2</td>
<td>JOBNAME</td>
<td>EQ</td>
<td>C</td>
<td>AND</td>
</tr>
<tr>
<td>3</td>
<td>CPUTIME</td>
<td>GT</td>
<td>0:11</td>
<td>None</td>
</tr>
</tbody>
</table>

Combination of multiple criteria

The criteria statements in the following example select all jobs belonging to either the BACKUP or UPDATE Applications that failed due to a condition code.

<table>
<thead>
<tr>
<th>Criteria</th>
<th>Field Name</th>
<th>Relationship</th>
<th>Value</th>
<th>And/Or</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>CRITERIA</td>
<td>APPLSYS</td>
<td>EQ</td>
<td>BACKUP AND</td>
</tr>
<tr>
<td>2</td>
<td>CCFAIL</td>
<td>EQ</td>
<td>yes</td>
<td>OR</td>
</tr>
<tr>
<td>3</td>
<td>CRITERIA</td>
<td>APPLSYS</td>
<td>EQ</td>
<td>UPDATE AND</td>
</tr>
<tr>
<td>4</td>
<td>CCFAIL</td>
<td>EQ</td>
<td>yes</td>
<td>None</td>
</tr>
</tbody>
</table>
Section breaks and sorting example

The settings in the following example insert a subtotal and a new page when the first three characters of the first account number change, and also insert one blank line when the first two characters of the job name change.
This section contains a complete list of history reporting fields, their values, and explanations. It also contains information on the relationship operators used with reporting fields.

Reporting fields are used in the Report panels to select what information is included in your report. Specifically, reporting fields are used to select which jobs are included in your report (Report Criteria panel), what information from those jobs is included in your report (Report Format panel), and in what sort order the information is displayed (Sorting panel).

This section contains information on the following topics:

- History reporting fields and operators
- Relationship operators

### Reporting fields, values and explanations

The following are the reporting fields you can use for report definitions.

<table>
<thead>
<tr>
<th>Field</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACCOUNT</td>
<td>Specifies the job’s first account operand, can also be specified as ACCOUNT1.</td>
</tr>
<tr>
<td>ACCOUNT2</td>
<td>Specifies the job’s second account operand.</td>
</tr>
<tr>
<td>ACCOUNT3</td>
<td>Specifies the job’s third account operand.</td>
</tr>
<tr>
<td>ACCOUNT4</td>
<td>Specifies the job’s fourth account operand</td>
</tr>
<tr>
<td>AGENT</td>
<td>Specifies the Agent name as stated in the AGENT statement.</td>
</tr>
<tr>
<td>ALLOCQT</td>
<td>Specifies the allocation queue time. This is the total time the job spends in the allocation process (for example waiting for tape mount).</td>
</tr>
<tr>
<td>APPLGEN</td>
<td>Specifies the Application generation number (absolute).</td>
</tr>
<tr>
<td>APPLSYS</td>
<td>Specifies the Application name for jobs defined to an Application; can also be specified as APPL.</td>
</tr>
<tr>
<td>APPLTAG</td>
<td>Specifies the tag associated with a job in an Application.</td>
</tr>
<tr>
<td>ASID</td>
<td>Specifies the address-space identifier of an executing z/OS job.</td>
</tr>
<tr>
<td>AUTHSTR</td>
<td>Indicates job’s authority string that you can use to verify ownership of the job.</td>
</tr>
<tr>
<td>AVGRUNT</td>
<td>Specifies the average run time for a job.</td>
</tr>
<tr>
<td>CCFAIL</td>
<td>Indicates whether or not the job failed because of condition codes. The field has a value of YES if the job failed because of a condition code, and the value is NO otherwise.</td>
</tr>
<tr>
<td>Field</td>
<td>Explanation</td>
</tr>
<tr>
<td>------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>CLASSID</td>
<td>Specifies the ESP Workload Manager class to which you defined the Event.</td>
</tr>
<tr>
<td>CMPC</td>
<td>Specifies the job completion code, including return code, user abend code or system abend code.</td>
</tr>
<tr>
<td>COMPDATE</td>
<td>Specifies the job completion date. It is the date on which the job completed its last post-processing phase. If the job has no post-processing phases, the completion date is the same as the purge date.</td>
</tr>
<tr>
<td>COMPT</td>
<td>Specifies the job completion time. It is the time at which the job completed its last post-processing phase. If the job has no post-processing phases, it is the same as the purge time. COMPT is set equal to the ENDT field for distributed workload.</td>
</tr>
<tr>
<td>CPUTIME</td>
<td>Specifies the total CPU time, including both SRBTIME and TCBTIME.</td>
</tr>
<tr>
<td>DEXCP</td>
<td>Specifies the total EXCP count to DASD devices.</td>
</tr>
<tr>
<td>ENDDATE</td>
<td>Specifies the date at the end of execution.</td>
</tr>
<tr>
<td>ENDT</td>
<td>Specifies the time at the end of execution.</td>
</tr>
<tr>
<td>ESPSUB</td>
<td>Indicates whether or not the job was submitted by ESP Workload Manager. It has a value of YES if the job was submitted by ESP Workload Manager (either through an Event or as part of an Application); otherwise, it has a value of NO.</td>
</tr>
<tr>
<td>EXCP</td>
<td>Specifies the total EXCP count for the job during the execution phase.</td>
</tr>
<tr>
<td>EXEC#</td>
<td>Specifies the number of times the job has executed as part of a particular generation of an Application.</td>
</tr>
<tr>
<td>EXECJNO</td>
<td>Specifies the job execution number.</td>
</tr>
<tr>
<td>EXECNODE</td>
<td>Specifies the JES node name where an z/OS job is executing or waiting for execution (for example, LOCAPPL operand).</td>
</tr>
<tr>
<td>EXECQT</td>
<td>Specifies the elapsed time for the job during the execution.</td>
</tr>
<tr>
<td>EXECSDATE</td>
<td>Specifies the date at the start of the execution.</td>
</tr>
<tr>
<td>EXECST</td>
<td>Specifies the execution start time. For example, 08:26.</td>
</tr>
<tr>
<td>EXECSYS</td>
<td>Specifies the system the job executed on. This is not set until the job is purged regardless of your tracking options.</td>
</tr>
<tr>
<td>GROUP</td>
<td>Specifies the prefix of the Event associated with the job, if ESP Workload Manager submitted it.</td>
</tr>
<tr>
<td>INFOREC</td>
<td>Specifies the Info/System record number.</td>
</tr>
<tr>
<td>INPUTQT</td>
<td>Specifies the length of time the job was in the input queue.</td>
</tr>
<tr>
<td>Field</td>
<td>Explanation</td>
</tr>
<tr>
<td>-----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>INSYS</td>
<td>Specifies the system the job was submitted on. This is not set until the job is purged regardless of your tracking options.</td>
</tr>
<tr>
<td>JOBCLASS</td>
<td>Specifies the JES execution class.</td>
</tr>
<tr>
<td>JOBNAME</td>
<td>Specifies the name of the job.</td>
</tr>
<tr>
<td>JOBNO</td>
<td>Specifies the job number.</td>
</tr>
<tr>
<td>JOBQUAL</td>
<td>Specifies the ESP Workload Manager job qualifier.</td>
</tr>
<tr>
<td>LINES</td>
<td>Specifies the number of print lines.</td>
</tr>
<tr>
<td>LONGNAME</td>
<td>Specifies the character string used for a long job name.</td>
</tr>
<tr>
<td>MAXRUNT</td>
<td>Specifies the maximum run time for a job based on $x$ percent of the average run time for a job.</td>
</tr>
<tr>
<td>MINRUNT</td>
<td>Specifies the minimum run time for a job based on $x$ percent of the average run time for a job.</td>
</tr>
<tr>
<td>MSGFAIL</td>
<td>Indicates whether or not the job failed because of an ESP Workload Manager SYSMSGS command. The field has a value of YES if the job terminated because of the ESP Workload Manager SYSMSGS facility, and the value is NO otherwise.</td>
</tr>
<tr>
<td>MXCMPC</td>
<td>Specifies the maximum completion code for the job.</td>
</tr>
<tr>
<td>MXRC</td>
<td>Specifies the highest return code from any step in the job. This is a numeric field.</td>
</tr>
<tr>
<td>NCI</td>
<td>Specifies the number of card images submitted to the internal reader.</td>
</tr>
<tr>
<td>NETID</td>
<td>Specifies the network identifier for a job belonging to a DJC/ JES3 job network.</td>
</tr>
<tr>
<td>NSTM</td>
<td>Specifies the number of nonspecific tape mounts (scratch tapes) for the job.</td>
</tr>
<tr>
<td>ORIGNODE</td>
<td>Specifies the original JES node.</td>
</tr>
<tr>
<td>OUTSYS</td>
<td>Specifies the system the job was purged on. This is not set until the job is purged regardless of your tracking options.</td>
</tr>
<tr>
<td>OVDCOMP</td>
<td>Specifies the amount by which the job was overdue at the time of completion. The criteria for being late are defined by the DUEOUT OUTPUT statement in an ESP Workload Manager Procedure or in a job’s tracking model.</td>
</tr>
<tr>
<td>OVDEND</td>
<td>Specifies the amount of time by which the job was late in ending execution. The criteria for being late are defined by the DUEOUT EXEC statement in an ESP Workload Manager Procedure or in a job’s tracking model.</td>
</tr>
<tr>
<td>Field</td>
<td>Explanation</td>
</tr>
<tr>
<td>--------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>OVDSTART</td>
<td>Specifies the amount of time by which the job was late in starting execution. The criteria for being late are defined by the DUEOUT INPUT statement in an ESP Workload Manager Procedure or in a job’s tracking model.</td>
</tr>
<tr>
<td>PGMR</td>
<td>Specifies the contents of the programmer name field for the job.</td>
</tr>
<tr>
<td>PGN</td>
<td>Specifies the performance group number of an executing z/OS job. This applies only to jobs running in a compatibility mode system.</td>
</tr>
<tr>
<td>POSTQT</td>
<td>Specifies the elapsed time spent in post-output processing phases.</td>
</tr>
<tr>
<td>PRINTQT</td>
<td>Specifies the length of time the job remained in the print queue.</td>
</tr>
<tr>
<td>PRIORITY</td>
<td>Specifies the job execution priority.</td>
</tr>
<tr>
<td>PURGDATE</td>
<td>Specifies the date of job purge.</td>
</tr>
<tr>
<td>PURGT</td>
<td>Specifies the purge time. PURGT is set equal to the ENDT field for distributed workload.</td>
</tr>
<tr>
<td>RC</td>
<td>Specifies the return code from the last step executed in the job. This is a numeric field.</td>
</tr>
<tr>
<td>RDRON</td>
<td>Specifies the time at which ESP Workload Manager read the job into the system. RDRON is set equal to the EXECST field for distributed workload.</td>
</tr>
<tr>
<td>RDRONDATE</td>
<td>Specifies the date at job submit time. This field also includes the time for sorting purposes but not for display purposes.</td>
</tr>
<tr>
<td>RRJOB</td>
<td>Specifies the name of job being rerun or null.</td>
</tr>
<tr>
<td>RRJOBNO</td>
<td>Specifies the job number of the most recent execution of a resubmitted job. This field only has a value for a job that is being rerun by ESP Workload Manager (for example, a job that has been resubmitted via an explicit AJ command or the R line command in CSF). If the job is not a rerun, this field is set to zero.</td>
</tr>
<tr>
<td>SCHEDDATE</td>
<td>Specifies the scheduled date.</td>
</tr>
<tr>
<td>SCHEDT</td>
<td>Specifies the scheduled time.</td>
</tr>
<tr>
<td>SID</td>
<td>Specifies the SMF identifier of system that z/OS job is executing on.</td>
</tr>
<tr>
<td>SPTM</td>
<td>Specifies the number of specific (for example, non-scratch) tape mounts for the job.</td>
</tr>
<tr>
<td>SRBTIME</td>
<td>Specifies the CPU time consumed while in SRB mode.</td>
</tr>
<tr>
<td>SRVCLASS</td>
<td>Specifies the service class of an executing z/OS job. This applies only to jobs running in a goal mode system.</td>
</tr>
<tr>
<td>Field</td>
<td>Explanation</td>
</tr>
<tr>
<td>------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>STATUS</td>
<td>Specifies the job status. There are four possible values:</td>
</tr>
<tr>
<td></td>
<td>• INPUT — defines submitted jobs not yet started</td>
</tr>
<tr>
<td></td>
<td>• STARTED — defines jobs currently in execution</td>
</tr>
<tr>
<td></td>
<td>• COMPLETED — defines jobs that completed all phases of processing</td>
</tr>
<tr>
<td></td>
<td>• ENDED — defines jobs that completed execution but did not finish all phases of processing.</td>
</tr>
<tr>
<td>STEPS</td>
<td>Specifies the number of job steps.</td>
</tr>
<tr>
<td>SUB#</td>
<td>Specifies the submission number for a job in an Application.</td>
</tr>
<tr>
<td>SUBAPPL</td>
<td>Specifies the subApplication identifier.</td>
</tr>
<tr>
<td>SUBJOBNO</td>
<td>Specifies the job number on the system that submits the job. This is useful when a job is submitted on one system and routed to another system where a different JES job number is assigned.</td>
</tr>
<tr>
<td>SUNITS</td>
<td>Specifies the job service units, as defined by the SRM.</td>
</tr>
<tr>
<td>SYSABD</td>
<td>Specifies the system abend code or null.</td>
</tr>
<tr>
<td>SYSNAME</td>
<td>Specifies the name of the system in the Sysplex that z/OS job is executing on.</td>
</tr>
<tr>
<td>SYSPLEX</td>
<td>Specifies the name of the Sysplex that z/OS job is executing on.</td>
</tr>
<tr>
<td>TAPEM</td>
<td>Specifies the number of tape mounts for the job.</td>
</tr>
<tr>
<td>TAPEW</td>
<td>Specifies the maximum number of tape drives allocated to a job at one time. Note that SPTM and NSTM may not add up to TAPEW. SPTM and NSTM represent numbers of tape mounts. TAPEW counts the number of different tape drives that were used at one time. For example, if a job-step calls for three specific tapes, one at a time, on the same drive, then TAPEW will be one, but SPTM will be three.</td>
</tr>
<tr>
<td>TCBTIME</td>
<td>Specifies the CPU time consumed while in TCB mode.</td>
</tr>
<tr>
<td>TEXCP</td>
<td>Specifies the total EXCP count to tape drives.</td>
</tr>
<tr>
<td>TMODEL</td>
<td>Specifies the name of the ESP Workload Manager tracking model that was used to track the job.</td>
</tr>
<tr>
<td>TOTALQT</td>
<td>Specifies the total elapsed time for the job.</td>
</tr>
<tr>
<td>TRANSACT</td>
<td>Specifies the total time for which a transaction is active. In the case of a batch job, this is approximately equal to the total execution times for the programs contained in the job. It is measured in units of 1024 microseconds.</td>
</tr>
</tbody>
</table>
### Relationship operators

In the Report Criteria panel’s **Relationship** field, you can use the following operators. These operators relate to the value you insert in the Value field.

<table>
<thead>
<tr>
<th>Relationship operator</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>GE</td>
<td>Greater than or equal</td>
</tr>
<tr>
<td>LE</td>
<td>Less than or equal</td>
</tr>
<tr>
<td>LT</td>
<td>Less than</td>
</tr>
<tr>
<td>GT</td>
<td>Greater than</td>
</tr>
<tr>
<td>NE</td>
<td>Not equal to</td>
</tr>
<tr>
<td>EQ</td>
<td>Equal</td>
</tr>
</tbody>
</table>

If you want to compare a field to a null string, use a blank enclosed in single quotes, as in `'`.  

<table>
<thead>
<tr>
<th>Field</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>TRANSRES</td>
<td>Specifies the total time during which a transaction was resident in real memory. This is often identical to the transaction active time (TRANSACT), but may differ since it does not include any time during which the task was swapped out of real memory. It is measured in units of approximately one millisecond or more precisely, units of 1024 microseconds.</td>
</tr>
<tr>
<td>TRUSER</td>
<td>Specifies the user ID that triggered the Event. It resolves to the user ID that manually triggered an Event, and is blank otherwise.</td>
</tr>
<tr>
<td>UABEND</td>
<td>Specifies the user abend code or null.</td>
</tr>
<tr>
<td>WDFAIL</td>
<td>Indicates whether or not there was a WTO-detected JCL error. The field has a value of YES if the job terminated prior to starting execution, and the value NO otherwise. These errors are caused by such activities as an early (pre-execution) JCL error, certain security-system verification errors, and a cancellation of a job while it is on the JES input queue.</td>
</tr>
<tr>
<td>WOBTYPE</td>
<td>Specifies the short name of workload object types. For example, NT for Windows NT and A4 for OS/400 etc.</td>
</tr>
</tbody>
</table>
Appendix A: CLANG Examples

This section introduces you to the basic elements of CLANG. This section contains the following topics:

• Using control language in Procedures
• Using symbolic variables in Procedures
• Using expressions and strings in Procedures
• Using Event definition commands in Procedures
• Additional examples of using CLANG
  • Example 1: Scheduling a job on the last day of the month
  • Example 2: Taking different actions based on the status of CICS
  • Example 3: Using calendaring functions
  • Example 4: Calculating time periods
  • Example 5: Overriding a Procedure on a particular date
  • Example 6: Taking different action based on time
Using control language in Procedures

CLANG is an integral component of ESP Workload Manager’s Procedures and provides great power and flexibility. Its several language elements listed below, allow you to specify conditional processing requirements.

IF

Use IF to conditionally process an instruction or group of instructions depending on the evaluation of an expression. When you use an IF statement, the expression that follows it must return a true or false value. You can use any number of nested IF statements.

Example:

IF logical-expression THEN ...

THEN

Use THEN to indicate the Procedure processed only if the expression that follows the IF statement returns a true value. If a THEN statement continues to another line, use a line continuation character (- or +). If there is no continuation character, ESP Workload Manager ignores the THEN statement. You must begin and end a set of instructions with DO and ENDDO language elements.

Example:

THEN statement

ELSE

Use an ELSE statement only in conjunction with an IF statement when the expression that follows the IF statement returns a false value. If you do not include an ELSE statement after an expression returning a false value, ESP Workload Manager passes control on to the next line. You must begin and end a group of instructions with DO and ENDDO language elements. If an ELSE statement continues to another line, use a line continuation character (- or +). If there is no continuation character, ESP Workload Manager ignores the ELSE statement.

Example:

ELSE statement
DO

Use the DO statement in conjunction with THEN and ELSE statements to indicate the start of a set of statements. Use this statement to group a number of instructions together. You do not require a DO statement if you only have one instruction. DO must follow immediately after THEN or ELSE or begin the continuation line. Do not use a continuation character (- or +) on a DO statement.

Example:

```
DO
  statement
  statement
```

ENDDO

Use the ENDDO statement in conjunction with the DO statement to indicate the end of a set of statements. The following example shows how you should use DO and ENDDO.

Example:

```
DO
  statement
  statement
ENDDO
```

EXIT

Use EXIT to quit from your current point in a Procedure. ESP Workload Manager continues to process pending requests up to the point at which you use EXIT. ESP Workload Manager also processes any action statements in the calling Event or other Procedures invoked in the same Event. ESP Workload Manager ignores EXIT statements within the scope of a JOB statement during the generation of an Application. During Application processing, EXIT within the scope of a JOB statement causes ESP Workload Manager to process all statements up to the EXIT and submit the job.

Example:

```
EXIT
```
QUIT

Use QUIT to quit an entire process and the Event that invoked it. If you use QUIT, ESP Workload Manager does not process any pending requests from this or any other Procedure invoked by the same Event. ESP Workload Manager ignores QUIT statements within the scope of a JOB statement during the generation of an Application. During Application processing, QUIT within the scope of a JOB statement causes ESP Workload Manager not to process any statements for that job and does not submit the job, causing the job to fail with a SUBERROR. Therefore, any of the job’s dependencies are not released.

Example:

QUIT

JUMPTO

Use JUMPTO to search forward through the existing Procedure to find the next label of the name given in the JUMPTO statement. Use JUMPTO to skip over whole sections of a Procedure. You can use JUMPTO with or without an IF statement.

Example:

JUMPTO labelerror_handler

Note: After you specify DO, ENDDO, EXIT or QUIT you must specify your next statement on the next line. You cannot continue these statements.

CLANG examples

Example: Using the IF-THEN-ELSE construct

IF A=B THEN SEND 'A AND B ARE EQUAL' U(*)
ELSE SEND 'A AND B ARE NOT EQUAL' U(*)

If you want to use continuation characters and indentation, the above example might look like this:

IF A=B THEN -
SEND 'A AND B ARE EQUAL' U(*)
ELSE -
SEND 'A AND B ARE NOT EQUAL' U(*)

Example: Grouping instructions together using DO and ENDDO

DO
SUBMIT 'CYB.ESP.JCL(PAYJOB1)'
SEND 'PAYROLL IS RUNNING' CN(01)
ENDDO
Example: Using the QUIT and EXIT instructions

- If today is CHRISTMAS, ESP Workload Manager quits the Procedure and no instructions are processed.
- If today is not CHRISTMAS but it is a holiday, ESP Workload Manager sends a message and exits the Procedure at that point.
- If none of the above conditions are true, ESP Workload Manager sends a message indicating it will continue processing.

```
IF TODAY('CHRISTMAS') THEN QUIT
IF TODAY('HOLIDAY') THEN DO
SEND 'NO WORK TODAY' U(BOSS)
EXIT
ENDDO
SEND 'LET US CONTINUE PROCESSING' U(USER01)
```

Using symbolic variables in Procedures

You can use symbolic variables in a Procedure. The different types of variables are:

<table>
<thead>
<tr>
<th>Type of Variable</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Built-in variables</td>
<td>ESP Workload Manager provides a set of built-in variables for such information as the current date, time, and Event name. You can use these variables in a Procedure, but their values cannot be changed. Refer to the ESP Workload Manager Advanced User's Guide for a complete list of these variables.</td>
</tr>
<tr>
<td>User-defined variables</td>
<td>These are alphanumeric strings or integers that you can use in a Procedure to represent character strings, literal data, and numbers. When using an integer variable, you must first define the variable with an INTEGER statement before you use it. If the variable is stored in a global variable table, you can retrieve it using a VGET statement. <strong>Note:</strong> Regardless of the type of variable stored in a global variable table, you will obtain a character string when you retrieve the variable unless you insert an INTEGER statement before retrieving it.</td>
</tr>
</tbody>
</table>

When you want to use the value of a symbolic variable, you use the symbol-introducer character (default is the percent sign (%)) followed by the symbol name. For example: `%NAME`.

**Note:** Your installation may use a different symbol-introducer character. Check with your administrator to find out what symbol-introducer character is used at your site.
Example: Using symbolic variables

This example,

- Defines an integer variable called NUMBER and assigns it a value of 52.
- Assigns the value FRED to the variable called NAME.
- Sends a message to USER01 using these variables.

```
INTEGER NUMBER
NUMBER=52
NAME='FRED'
SEND '%NAME IS %NUMBER YEARS OLD TODAY' U(USER01)
```

The message ESP Workload Manager sends to USER01 looks like this.

```
FRED IS 52 YEARS OLD TODAY
```

Example: Retrieving a variable from a global variable table

This example assumes that a variable containing the number of runs and named NUMOFRUN has been previously stored in a global variable table named MYTABLE.

```
INTEGER NUMOFRUN
VGET NUMOFRUN TABLE(MYTABLE)
SEND 'THE NUMBER OF RUNS IS %NUMOFRUN' U(USER01)
```

Additional information

For additional information on symbolic variables, see the ESP Workload Manager Advanced User’s Guide.

For additional information on global variable tables, see “Appendix C: Using Global-Variable Tables” on page 601.

Using expressions and strings in Procedures

You can also use strings, expressions, and operators in your Procedures. This section outlines the syntax and use for each of these.

Using literal strings

A literal string is a group of characters enclosed in single quotes. You can embed symbolic variables in a string. ESP Workload Manager later substitutes the actual value of the variable into the string during processing.

When you want to enter text and have it appear exactly as you entered it, type it enclosed in single quotes.

```
'THIS IS A CHARACTER STRING'
```
When you want to enter a text statement containing a changing variable, such as the time (%ESPATIME), you could enter,

'THE TIME IS %ESPATIME'

ESP Workload Manager substitutes the actual system time in place of the symbolic-variable name %ESPATIME.

**Using expressions**

An expression is a variable, number or character string connected by operators. Expression evaluation is from left to right; this is modified overridden by parentheses and by operator precedence. You can modify this order using parentheses.

A logical expression resolves to the value one if true or zero if false. If an arithmetic expression resolves to zero, it is false. For any other value, the expression is true. If you do not enclose a logical expression in parentheses when you use an IF statement, ESP Workload Manager understands the THEN statement to be the terminator.

Some examples are shown below:

- In the first statement, ESP Workload Manager processes the THEN statement if NUM=100.
- In the second statement, ESP Workload Manager processes the THEN statement if VAR1 is less than VAR2 and NUM is equal to 100.

```
IF NUM=100 THEN ...
IF (VAR1 LT VAR2 AND NUM EQ 100) THEN ...
```

**Using operators**

You can use arithmetic operators, comparison operators, and logical operators in an expression.

**Arithmetic operators**

Numbers may be combined using the following arithmetic operators:

- Add
- Subtract
- Multiply
- Divide
- // Integer Divide
- ** Power
- Prefix - Negate the following term. Same as '0-term'
- Prefix + Take following term as if it was '0+term'

If you use / for division, ESP Workload Manager performs the division internally using floating-point arithmetic but the resulting value is an integer. If you use // for division, ESP Workload Manager disregards any remainder. For example, if A is an integer, then A = A/2*2 is always true, but A = A//2*2 is true only if A is even.
Comparison operators
The comparison operators return the value one if the result of the comparison is true or zero otherwise. You can use the following operators, in either their symbol or letter form, in an expression.

\[ \geq \text{ GE greater than or equal to} \]
\[ \leq \text{ LE less than or equal to} \]
\[ < \text{ LT less than} \]
\[ > \text{ GT greater than} \]
\[ = \text{ EQ equal to} \]
\[ \neq \text{ NE not equal to} \]

Logical operators
You can use the following logical operators in an expression:

\text{AND}
\text{OR}

Order of precedence
The order of precedence of the operators is (highest at the top):
\[ \neg \text{(not), prefix + (prefix plus), prefix - (prefix minus)} \]
\[ **\text{(power)} \]
\[ /\text{(divide), } // \text{(integer divide), } \ast \text{(multiply)} \]
\[ +\text{(plus), } -(\text{minus)} \]
\[ \geq \text{(GE), } \leq \text{(LE), } < \text{(LT), } > \text{(GT), } = \text{(EQ), } \neq \text{(NE)} \]
\text{AND}
\text{OR}

In the statement below \( (A = B \text{ or } C > D) \) is a valid expression, and GO is a valid character string that ESP Workload Manager assigns to the variable E. ESP Workload Manager assigns the value GO to the variable E if either \( A = B \) or \( C > D \).

\text{IF } (A = B \text{ OR } C > D) \text{ THEN } E = 'GO' \]

If the expression \( A = B \) is true, the entire logical expression is also true. This means that ESP Workload Manager does not have to evaluate \( C > D \). This order of precedence is useful for expressions such as \text{IF I not equal to 0 AND J/I > 4}. This expression does not cause an error since \( J \) is divided by \( I \) only if \( I \) is non-zero.

Using Event definition commands in Procedures
You can use the following commands in a Procedure:

<table>
<thead>
<tr>
<th>Command</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>INVOKE</td>
<td>Invokes another Procedure.</td>
</tr>
<tr>
<td>LIBSUB</td>
<td>Submits JCL from a Librarian data set.</td>
</tr>
</tbody>
</table>
### Additional examples of using CLANG

#### Example 1: Scheduling a job on the last day of the month

In this example, ESP Workload Manager selects a job if it is the last day of the month and the month has 31 days in it. The Procedure uses the ESPSDD built-in symbolic variable that represents the number of the scheduled day of the month.

The Procedure looks like this:

```
IF TODAY('LAST DAY OF MONTH') AND ESPSDD='31' +
THEN SELECT MONTHEND
```

Alternatively, if you normally use RUN statements for your jobs, the Procedure looks like this:

```
JOB MONTHEND
IF TODAY('LAST DAY OF MONTH') AND ESPSDD='31' +
THEN RUN TODAY
ENDJOB
```

#### Example 2: Taking different actions based on the status of CICS

In this example, ESP Workload Manager takes different actions based on whether or not CICS is active.

- If CICS is active on the current system, ESP Workload Manager jumps to a label called STOP. ESP Workload Manager issues an operator command, schedules a re-execution in five minutes, and exits this Procedure.
- If CICS is not active on the current system, ESP Workload Manager jumps to a label called GO and issues a command to trigger an Event.

The Procedure looks like this:

```
IF ACTIVE('CICS') THEN JUMPTO STOP
ELSE JUMPTO GO
STOP:
VS 'F CICS SHUTDOWN'
REEXEC IN(5)
EXIT
GO:
VS 'F ESP,TRIGGER PROD.NIGHTLY'
```
Example 3: Using calendaring functions

This example uses different CLANG functions. It accomplishes the following:

- Assigns the number of days to December 25 to the integer variable X
- Assigns the number of workdays between today and December 25 to the integer variable Y
- Assigns the number of days since July 20, 1969 to the integer variable Z
- Sends the above values back to your terminal
- Sends another message back to your terminal if today is a workday.

The Procedure looks like this:

```
INTEGER X, Y, Z
X = DAYS_TO('DEC25')
Y = DAYS_BETWEEN('TODAY', 'DEC25', 'WORKDAYS')
Z = DAYS_FROM('JUL20,1969')
SEND 'THERE ARE %X DAYS TO CHRISTMAS' U(*)
SEND 'THERE ARE %Y WORKDAYS TO CHRISTMAS' U(*)
SEND 'THERE HAVE BEEN %Z DAYS SINCE THE FIRST MOON WALK' U(*)
IF TODAY('WORKDAY') THEN -
SEND 'ANOTHER DAY OF HARD LABOR' U(*)
```

Example 4: Calculating time periods

This example calculates the number of days, from a specific time and date in the past. ESP Workload Manager sends the results back to your terminal.

The Procedure looks like this:

```
INTEGER X, Y
X = DAYS_BETWEEN('1PM JAN1,1994', 'NOW', 'HOURLY')
Y = DAYS_BETWEEN('JAN1,1994', 'TODAY', 'DAILY')
SEND 'IT'S BEEN %X HOURS SINCE STOP HOUR' U(*)
SEND 'IT'S BEEN %Y DAYS SINCE STOP DAY' U(*)
```

Example 5: Overriding a Procedure on a particular date

There may be occasions where you need to use an alternate Procedure for a specific date. One method is illustrated below:

```
DAILY: ESPPROC
IF TODAY('specific date') THEN -
   DO
   INVOKE 'PROD.ALT.ESPPROC(DAILYEX)'
EXIT
```
Using control language in Procedures

The first statement checks to see if today is a specific date. If so, ESP Workload Manager invokes an alternate Procedure. Otherwise, ESP Workload Manager processes the statements in the regular Procedure.

**Example 6: Taking different action based on time**

In this example, ESP Workload Manager takes different actions based on when a job becomes eligible for submission. The criteria are:

- If job THISJOB becomes ready for submission between 3 am and 3:59 am, ESP Workload Manager submits the job and sends a message indicating it is almost too late to run the job.
- If THISJOB becomes ready for submission at 4 am or later, ESP Workload Manager does not submit the job.
- Otherwise, if THISJOB becomes ready between midnight and 2:59 am, ESP Workload Manager sends a message indicating the job is on time.

The Procedure is shown below. The ESPAHH symbolic variable represents the actual two-digit hour.

```plaintext
JOB THISJOB
RUN DAILY
IF ESPAHH EQ '03' THEN DO
SEND 'IT IS ALMOST TOO LATE TO RUN THISJOB' U(OP1)
EXIT
ENDDO
IF ESPAHH GE '04' THEN QUIT
SEND 'THISJOB IS ON TIME' U(OP1)
ENDJOB
```
Appendix B: Built-in Functions

A function is a sequence of instructions that can receive data, process that data, and return a value. ESP Workload Manager provides a set of built-in functions.

This section contains the following topics:

- About Built-in functions
- Using calendaring functions
- Using functions for job selection
- Using functions for symbolic variables
- Using system activity functions
- Combining functions
About Built-in functions

To use a function, enter the function name directly followed by one or more arguments within parentheses, like this,

```
function(arguments)
```

There can be no space between the function name and the left parenthesis.

The built-in functions fall into the following categories

<table>
<thead>
<tr>
<th>Category</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calendaring</td>
<td>Tests schedule criteria and calculates time periods.</td>
</tr>
<tr>
<td>Job selection</td>
<td>Checks if a job has already been selected for submission.</td>
</tr>
<tr>
<td>Symbolics</td>
<td>Performs operations on symbolic variables.</td>
</tr>
<tr>
<td>System activity</td>
<td>Checks the status of activity on the system, including jobs and tape drives.</td>
</tr>
</tbody>
</table>

Summary by function

The following table summarizes the functions by category

<table>
<thead>
<tr>
<th>Category</th>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calendaring</td>
<td>DAYS_FROM</td>
<td>Calculates the number of days from a date.</td>
</tr>
<tr>
<td>Calendaring</td>
<td>DAYS_TO</td>
<td>Calculates the number of days away from a date in the future.</td>
</tr>
<tr>
<td>Calendaring</td>
<td>DAYS_BETWEEN</td>
<td>Calculates the number of units (days, weekdays, workdays) between two dates.</td>
</tr>
<tr>
<td>Calendaring</td>
<td>TODAY</td>
<td>Tests to see if today matches a specified schedule expression.</td>
</tr>
<tr>
<td>Calendaring</td>
<td>TOMORROW</td>
<td>Tests to see if tomorrow matches a specified schedule expression.</td>
</tr>
<tr>
<td>Calendaring</td>
<td>YESTERDAY</td>
<td>Tests to see if yesterday matches a specified schedule expression.</td>
</tr>
<tr>
<td>Job selection</td>
<td>SELECTED</td>
<td>Checks to see if a job has been selected.</td>
</tr>
<tr>
<td>Symbolics</td>
<td>DEFINED</td>
<td>Checks to see if a symbolic variable has been defined.</td>
</tr>
<tr>
<td>Symbolics</td>
<td>LENGTH</td>
<td>Returns the length of a symbolic variable.</td>
</tr>
</tbody>
</table>
Testing for a true condition

Each one of the SELECTED, TODAY, TOMORROW, and YESTERDAY built-in functions returns a true value (1) or a false value (0). To test for a true condition, you do not have to specify the true value, since this is the default. If you want to test for a false value, you must specify either =0, EQ 0 or use the word NOT.

In the following example, both statements have the same effect. Each checks to see if today is not Monday.

IF TODAY('MONDAY') EQ 0 THEN ...
IF TODAY('NOT MONDAY') THEN ...

Additional information

The following sections describe ESP Workload Manager’s built-in functions in detail and contain some examples of using these functions. For more examples, see “Appendix A: CLANG Examples” on page 573.
Using calendaring functions

This section explains the usage of calendaring functions.

**DAYS_TO**

The DAYS_TO function returns a positive number representing the number of days from a specified special day, holiday or any defined schedule criteria. If you do not use a year and the day you specified has passed, DAYS_TO assumes the next year and returns a positive number. If the date is in the past, ESP Workload Manager returns a negative number.

**Example: DAYS_TO**

If you want to determine the number of days to December 25 from the current day, and assign that number to an integer variable called X, enter:

```
INTEGER X
X=DAYS_TO('DEC 25')
```

**DAYS_FROM**

The DAYS_FROM function returns a positive number representing the number of days from a date in the past. DAYS_FROM assumes the current year if you do not specify one. If the date is in the future, ESP Workload Manager returns a negative number.

**Example: DAYS_FROM**

The following is an example of an expression containing the DAYS_FROM built-in function.

```
IF DAYS_FROM('AUGUST 1ST') GT 0 THEN
```

**DAYS_BETWEEN**

The DAYS_BETWEEN function returns a whole number representing the number of a specified unit of time (days, months, workdays, fiscal_months, and so on) between two given dates. You do not have to specify the dates explicitly; you can use a schedule expression instead.

```
DAYS_BETWEEN('first date','second date','restrictor')
```
The restrictor is an optional qualifier that defaults to DAYS. Examples of the following are other possible restrictors: HOURLY, DAILY, are WORKDAYS, and WEEKDAYS, WEEKLY, SATURDAYS, WEEKENDS, MONTHLY, YEARLYPLUS SAT. Your restrictor cannot be any unit of time less than hourly. The value that this function returns is the number of occurrences of the restrictor between the first date and the second date. If the first date is not prior to the second date, the function returns a value of zero negative number. The maximum value the function returns is 50000 for any restrictor other than DAYS.

**Example: Days_Between to calculate workdays**
If you want to know the number of workdays there are from January 30, 2001, up to but not including June 30, 2001, you would enter:

```
DAYS_BETWEEN('JAN 30 2001','JUNE 30 2001','WORKDAYS')
```

**Example: Days_Between to calculate weeks**
You could also determine the number of Saturdays from the 6th workday of the current month, up to but not including tomorrow, by typing:

```
DAYS_BETWEEN('6TH WORKDAY OF MONTH STARTING + TODAY','TOMORROW','SAT')
```

**TODAY**
The TODAY function compares the schedule expression that you specify to today’s schedule date. It returns a true or a false value, depending on whether the expression matches today. ESP Workload Manager returns a number code indicating the result:

- 1 = true
- 0 = false

In the following example, ESP Workload Manager only processes the instructions following the THEN statement if today is a Friday.

```
IF TODAY('FRIDAY') THEN ...
```

When the statement is false, ESP Workload Manager skips to the next ELSE statement or to the following line.

You can check if today is not Friday like this:

```
IF TODAY('NOT FRIDAY') THEN ...
```

**Example: TODAY**
The following are examples of the TODAY function:

- The first statement checks if today is Monday, Wednesday or Friday.
- The second statement checks if today is any day in June or July.
- The last statement checks if today is the second last workday of the month.
IF TODAY('MON WED FRI') THEN ...
IF TODAY('FIRST-LAST DAY OF JUNE JULY') THEN ...
IF TODAY('LAST WORKDAY OF MONTH LESS 1 WORKDAY') THEN ...

TOMORROW

The TOMORROW function compares the expression following the TOMORROW keyword to tomorrow’s date (for example, the day after the scheduled date). ESP Workload Manager returns a true or false value, depending on whether the expression matches tomorrow. ESP Workload Manager returns a number code indicating the result:

1 = true
0 = false

Examples: TOMORROW

The following are two examples using the TOMORROW function:

- In the first example, ESP Workload Manager only processes the instructions following the THEN statement if tomorrow is the last workday of the month.
- In the second example, ESP Workload Manager only processes the instructions following the THEN statement if tomorrow is a holiday.

IF TOMORROW('LAST WORKDAY OF MONTH') THEN ...
IF TOMORROW('HOLIDAY') THEN ...

When the statement is false, ESP Workload Manager skips to the ELSE statement or the following line.

YESTERDAY

The YESTERDAY function compares the schedule expression that you specify to yesterday’s date (for example, the day before the schedule date). ESP Workload Manager returns a true or false value, depending on whether the expression matches yesterday. ESP Workload Manager returns a number code indicating the result:

1 = true
0 = false

Example: YESTERDAY

In the following example, ESP Workload Manager only processes the instructions following the THEN statement when yesterday is the first workday of the month:

IF YESTERDAY('FIRST WORKDAY OF MONTH') THEN ...

When the statement is false, ESP Workload Manager skips to the ELSE statement or to the following line.
**Example: YESTERDAY**

In the following example, ESP Workload Manager only processes the instructions following the THEN statement when yesterday is a holiday:

```plaintext
IF YESTERDAY('HOLIDAY') THEN ...
```

When the statement is false, ESP Workload Manager skips to the ELSE statement or to the following line.
Using functions for job selection

**SELECTED**

The SELECTED function returns a true or false value that indicates whether a job name has been selected as a result of a previously processed SELECT or RUN statement. To return a true value, ESP Workload Manager must have selected the job in this Procedure or in another Procedure invoked by the same Event, prior to evaluating the function. This function does not return a true value for a job selected via a POSTREQ, PREREQ or COREQ statement.

ESP Workload Manager returns a number code for the value:

- 1 = true, the job name has been selected.
- 0 = false, the job name has not been selected.

The syntax is:

```
SELECTED('JOBNAME')
```

If the job you are checking for selection is a qualified job, you will need to include the qualifier, like this:

```
SELECTED('jobname.qualifier')
```

This function is useful for scheduling jobs with the same frequency because it can eliminate the need to specify complicated criteria multiple times. The function is also useful when you want to schedule a job whenever another job is not scheduled.

**Example: Selecting one job based on another**

You can use the SELECTED function to select job B whenever ESP Workload Manager selects another job such as job A.

```
IF SELECTED('A') THEN SELECT B
```

**Example: Selecting a job when another is not selected**

In this example, ESP Workload Manager selects job Z whenever it does not select job X. ESP Workload Manager selects Z on all days except for the 3rd, 13th, and 23rd day of the month.

```
JOB X
   RUN 3RD 13TH 23RD DAY OF MONTH
ENDJOB
JOB Z
   IF NOT SELECTED('X') THEN RUN TODAY
ENDJOB
```

The above results are valid only at Application generation time and not at Application process time.
Using functions for symbolic variables

This section explains the usage of symbolic functions.

**DEFINED**

The DEFINED function checks to see if a symbolic variable has been defined and returns the following values:

1 = true
0 = false

The syntax is:

DEFINED(variable)

**Example: Defining an undefined variable**

This example defines an integer variable called COUNT if it has not been defined.

IF NOT DEFINED(COUNT) THEN -
  INTEGER COUNT

**LENGTH**

The LENGTH function returns a number equal to the length of the variable following the LENGTH keyword in parentheses. The syntax is:

LENGTH(variable)

This function does not return a true or false value. Instead, it resolves to a whole number equal to the length of the named variable’s value.

**Example: Calculating the length of a symbol**

In this example, the LENGTH function assigns the length of a user-defined variable called LETTER to the integer variable SIZE. As a result, SIZE has a value of seven.

INTEGER SIZE
LETTER='OMICRON'
SIZE=LENGTH(LETTER)

**SUBSTR**

The SUBSTR function resolves to a partial string from the variable string that follows the SUBSTR keyword in parentheses. The syntax is:

SUBSTR(start,length,variable_name)
Example: Using a substring of a time variable
The ESPATIME built-in variable represents the actual time, 19.35.42, for example. This example assigns the number of minutes in the ESPATIME symbolic variable to the symbol MIN.

MIN=SUBSTR(4,2,ESPATIME)

Example: Extracting the last character of a variable length symbol
This example uses the LENGTH and SUBSTR functions to extract the last character of the scheduled month name. The LENGTH function calculates the length of the month name. The SUBSTR function extracts the last character.

INTEGER X
X=LENGTH(ESPSMONTH)
LAST_CHAR=SUBSTR(%X,1,ESPSMONTH)

For example, if the scheduled month is December:

• X=8, because there are eight characters in the word December
• LAST_CHAR=SUBSTR(8,1,'DECEMBER'), which resolves to R, the last character in the word December.
This section explains the usage of system activity functions.

**ACTIVE**

The ACTIVE function tests to see if a job or any address space is active on the current system and returns a value based on that test. ESP Workload Manager returns a number representing the result:

- address space identifier = true
- 0 = false.

*Note:* If you want to verify that a job or any address space is active on any system (within the same JES node), use the JOBONQ built-in function.

**Example: Checking if CICSPROD is active**

This example sends a message to console identifier 01 if CICSPROD is active on the current system.

```plaintext
IF ACTIVE('CICSPROD') THEN +
    SEND 'CICSPROD IS STILL ACTIVE' CN(01)
```

**JOBONQ**

Use the JOBONQ function to determine, by checking JES, whether a job or group of jobs are currently on any JES queue. To use the JOBONQ function, use the following syntax:

```
JOBONQ('jobname','prefix','criteria')
```

This function requires three operands: a job name, a prefix, and a search criteria.

<table>
<thead>
<tr>
<th>Operand</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>jobname</td>
<td>Specifies the name of the job or job name prefix. You can only use a job name prefix with the U criteria.</td>
</tr>
<tr>
<td>prefix</td>
<td>Specifies the prefix of the variables you want to generate. This operand is optional. For example, you can specify:</td>
</tr>
<tr>
<td>criteria</td>
<td>Specifies that the search criteria consists of any combination of the letter codes. If this operand is omitted, ESP Workload Manager looks in all queues.</td>
</tr>
</tbody>
</table>
Returning values

The following list contains all the acceptable search criteria codes

<table>
<thead>
<tr>
<th>Search Criteria Codes</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>I</td>
<td>Examine the input queue.</td>
</tr>
<tr>
<td>E</td>
<td>Examine the execution queue.</td>
</tr>
<tr>
<td>O</td>
<td>Examine the output queue.</td>
</tr>
<tr>
<td>H</td>
<td>Examine held jobs only.</td>
</tr>
<tr>
<td>U</td>
<td>Treat the job name as a user ID. The search includes any job with a name consisting of the job name plus one character.</td>
</tr>
</tbody>
</table>

JOBONQ variables

The JOBONQ function returns the count of jobs that meet the criteria. For each job, it generates a series of four variables beginning with the specified prefix (the second operand). The variables represent the job identifier (JOBID), job number (JOBNO), whether or not the job is on hold (JOBH), and the queue the job is in (JOBQ). The suffix increments from one to the number of jobs found.

Example: JOBONQ

The JOBONQ function in the following example verifies the existence of any job in the input queue (I) in hold status (H). ESP Workload Manager assigns the number of jobs that meet this criteria to the integer variable JOBCOUNT.

```plaintext
INTEGER JOBCOUNT
JOBCOUNT = JOBONQ('PAYROLL', 'Z', 'IH')
```

If JOBCOUNT is not equal to zero, meaning that at least one job called PAYROLL is in the input queue in hold status, ESP Workload Manager generates a set of variables for each job it finds. These variables all begin with the prefix Z.

For the first job it finds, the variables are

<table>
<thead>
<tr>
<th>Variable</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>ZJOBID1</td>
<td>JES job identifier. This is JOB followed by the five-digit job number (for example JOB01234).</td>
</tr>
<tr>
<td>ZJOBNO1</td>
<td>JES job number (for example 1234).</td>
</tr>
<tr>
<td>ZJOBH1</td>
<td>Equal to zero if JES is not holding the job or equal to one if JES is holding the job.</td>
</tr>
<tr>
<td>ZJOBQ1</td>
<td>Equal to I, E or O depending on whether the job is on the input, execution or output queue respectively.</td>
</tr>
</tbody>
</table>
When ESP Workload Manager finds more than one job, the variables it generates for the second job are: ZJOBID2, ZJOBNO2, ZJOBH2, and ZJOBQ2. ESP Workload Manager repeats this series with the last digit incrementing by one for additional jobs it finds.

If you use the U criteria, the JOBONQ function also returns the JOBN variable, with the appropriate prefix and suffix.

**Using JOBONQ with REEXEC**

You can also use the JOBONQ function in conjunction with the REEXEC statement to allow you to re-execute an ESP Workload Manager Procedure at a specified time or after a certain time interval. In the following example, ESP Workload Manager re-executes the Procedure if MYJOB is found on any queue.

IF JOBONQ('MYJOB') THEN REEXEC IN(5)

**TAPES**

ESP Workload Manager evaluates the TAPES function to check the status of tape drives on the system and compares the status to the resources required by the job. When you use the TAPES function at the job level for a job in an Application, you can verify the status of the tape drives before you submit a job.

**Note:** To check the status of tape drives, CA recommends you use resources. Resources provide you with easier, more efficient ways of defining tape requirements. For more information, refer to the *ESP Workload Manager User’s Guide*.

**Example: TAPES**

To use this function, enter TAPES followed by two operands from the lists below:

TAPES('xy')

ESP Workload Manager evaluates both operands (x and y) of the function and returns a whole number.

You can choose one of the following three options as the first operand:

<table>
<thead>
<tr>
<th>Option</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>Cartridge drives.</td>
</tr>
<tr>
<td>R</td>
<td>Reel-to-reel drives.</td>
</tr>
<tr>
<td>T</td>
<td>Total drives.</td>
</tr>
</tbody>
</table>

You can choose one of the following as the second operand:

<table>
<thead>
<tr>
<th>Option</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Available.</td>
</tr>
<tr>
<td>O</td>
<td>Online.</td>
</tr>
<tr>
<td>D</td>
<td>Defined.</td>
</tr>
</tbody>
</table>
The default is CA.

**Example: Checking available cartridge drives**

If a job in an Application requires two cartridge drives, you can use the TAPES function to check that two cartridge drives are available before you submit the job. If they are not, ESP Workload Manager can check again after two minutes:

```
JOB TAPEJOB1
IF TAPES('CA') < 2 THEN REEXEC IN(2)
```
Combining functions

You can combine built-in functions using the AND and OR logical operators. Specify the built-in function name each time you need to use it.

Examples
Some examples are shown below:

• Today is Friday, and today is not the last workday of the year.
  IF TODAY('FRIDAY') AND TODAY('NOT LAST WORKDAY OF YEAR') THEN

• Today is the last workday of the month, and CICS is active on the current system.
  IF TODAY('LAST WORKDAY OF MONTH') AND ACTIVE('CICS') THEN

• Yesterday was a holiday, tomorrow is Friday, and today is a workday.
  IF YESTERDAY('HOLIDAY') AND TOMORROW('FRIDAY') AND +
  TODAY('WORKDAY') THEN

• Today is Monday, Wednesday or Friday, and either yesterday was a holiday or
  tomorrow is a holiday.
  IF TODAY('MON WED FRI') AND (YESTERDAY('HOLIDAY') OR +
  TOMORROW('HOLIDAY')) THEN
Appendix C: Using Global-Variable Tables

Global-variable tables are a method of storing and retrieving global variables. The global variables are available across Applications. Global-variable tables can be executed in Application generate and process modes.

This section contains the following topics:

- About global-variables
- Global-variable table management
- Global-variable management
- Global-variable-trigger management
- Examples of global-variable usage
About global-variables

The global-variable table feature supports the creation of global variables, grouped into one or more tables. They may be copied to or retrieved from CLANG or REXX variables. The security of each global-variable table can be controlled individually.

One of the features of global-variable tables is the ability to set global-variable triggers. An Event can trigger when a designated global variable is changed. ESP Workload Manager passes the following variables to the Event:

- The designated global-variable name
- The name of the global-variable table containing the designated global variable
- The value of the designated global variable prior to the change
- The value of the designated global variable after the change
- The user ID of the user that made the change.

Update Access

In an environment where multiple operating-system images exist, update access is limited to the ESP Master unless ESP Sysplex is installed. This means that a job executing on an ESP Proxy cannot update a global variable. If ESP Workstation or ESPlmi is being used, they have to be executing on the same CPU as the ESP Master unless ESP Sysplex is being used.
Global-variable table management

To define a new global-variable table
Issue a VTDEFINE command with the new global-variable table name.

Example
In the following example, a table named MYTABLE is created.

VTDEFINE MYTABLE

To list global-variable tables
Issue a VTLIST command.

Example
The following example displays global variables, in verbose format, for all global-variable tables with a name starting with my.

vtlist my-

Global Variable Table MYNEXTT
Created at 11.26.42 on TUESDAY MAY 29TH, 2001 by CYBER01
Last update at 9.22.12 on TUESDAY JULY 24TH, 2001
Currently 1 variable, table size 352
PARM3='moretext'

Global Variable Table MYTABLE
Created at 11.26.28 on TUESDAY MAY 29TH, 2001 by CYBER01
Last update at 23.05.18 on SUNDAY JULY 22TH, 2001
Currently 2 variables, table size 392
ABC='1'
PARM1='text'

To delete a global-variable table
Issue a VTDELETE command with the global-variable table name.

Example
In the following example, the global-variable table named MYTABLE is deleted.

VTDELETE MYTABLE
Global-variable management

To store global variables in a global-variable table
Issue a VPUT command with the list of the global variables, the name of the global-variable table, and whether the type of the global variables is CLANG or REXX.

Example
In the following example, two CLANG global variables are stored in the global-variable table named MYTABLE.

\[
\begin{align*}
V1 &= \text{'ONE'} \\
V2 &= \text{'TWO'} \\
\text{VPUT} \ (V1, V2) \ \text{TABLE(MYTABLE)} \ \text{CLANG}
\end{align*}
\]

Note: Global variables must be defined before being stored using the VPUT command.

To set a global variable
Issue a VSET command with the name of the global variable, the name of the global-variable table, and whether the type of the global variables are CLANG or REXX. If the global variable does not exist, it will be created. You can make the setting of the global variable conditional on its previous value by using the OLDVAL operand.

Example
In the following example, the value of the global variable V1 in the global-variable table named MYTABLE is set to TORONTO, if the value of V1 is equal to CHICAGO.

\[
\begin{align*}
\text{VSET} \ V1 \ \text{TORONTO} \ \text{TABLE(MYTABLE)} \ \text{OLDVAL(CHICAGO)}
\end{align*}
\]

To increment global variables in a table
Issue a VINCR command with the list of the global variables, the name of the global-variable table, and whether the type of the global variables are CLANG or REXX.

Example
In the following example, a global variable V1 equal to 1 is stored, then V1 is incremented and another global variable V2 equal to 1 is created.

\[
\begin{align*}
\text{INTEGER} \ V1 \\
V1 &= 1 \\
\text{VPUT} \ V1 \ \text{TABLE(MYTABLE)} \ \text{CLANG} \\
\text{VINCR} \ (V1, V2) \ \text{TABLE(MYTABLE)} \ \text{CLANG}
\end{align*}
\]
To retrieve global variables from a table
Issue a VGET command with the list of the global variables, the name of the global variable table, and whether the type of the global variables is CLANG or REXX.

Usage notes
All retrieved global variables are considered character variables. If a global variable is numeric and you anticipate doing calculations with that global variable, you must declare it as an integer before using the VGET command.

Example
In the following example, two global variables V1 and V2 are stored in the global-variable table named MYTABLE. Those global variables are retrieved in a second Procedure.

Procedure 1:
INTEGER V1
V1=2
V2='TORONTO'
VPUT(V1,V2) TABLE(MYTABLE) CLANG

Procedure 2:
INTEGER V1
VGET (V1,V2) TABLE(MYTABLE) CLANG
V3=%V1*2
SE 'V2 = %V2 AND V3 = %V3' U(*)

Result of Procedure 2
V2 = TORONTO AND V3 = 4

To delete global variables in a table
Issue a VDEL command with the list of the global variables and the name of the global-variable table.

Example
In the following example, two global variables V1 and V2 are deleted from the global-variable table named MYTABLE.

VDEL (V1,V2) TABLE(MYTABLE)
Global-variable-trigger management

To define a global-variable trigger

Issue a VTRDEF command with the name of the global variable, the name of the global-variable table, and the name of the Event to trigger. You can make the global-variable trigger conditional to the new value of the global variable by using the WHEN parameter.

Examples

In the following example, Event CYBER.MINE will only be triggered if value of ABC changes to YES. If it changes to anything else, the Event will not be triggered.

Note: In this example, an ID is generated by ESP Workload Manager.

```
VTRDEF VARIABLE(ABC) TABLE(XYZ) EVENT(CYBER.MINE) WHEN('YES')
```

In this second example, the Event CYBER.MYEVENT is triggered when the global variable VT1 of the global-variable table MYTABLE changes.

```
VTRDEF ID(TR07) VARIABLE(VT1) TABLE(MYTABLE) + EVENT(CYBER.MYEVENT)
```

Built-in variables passed when an Event is triggered

The following built-in variables are available to an Event triggered by the change of a designated global variable:

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ESPVT VARIABLE</td>
<td>Specifies the name of the modified global variable.</td>
</tr>
<tr>
<td>ESPVT TABLE</td>
<td>Specifies the name of the global-variable table containing the modified global variable.</td>
</tr>
<tr>
<td>ESPVT OLD VALUE</td>
<td>Specifies the value of the modified global variable prior to modification.</td>
</tr>
<tr>
<td>ESPVT VALUE</td>
<td>Specifies the value of the modified global variable after the modification.</td>
</tr>
<tr>
<td>ESPVT USER</td>
<td>Specifies the user who made the modification.</td>
</tr>
</tbody>
</table>
To delete a global-variable trigger from a global-variable table

Issue a VTRDEL command with the ID of the global-variable trigger and the name of the global-variable table.

**Example**

In the following example, the global-variable trigger TR07 is deleted from the global-variable table named MYTABLE.

```
VTRDEL ID(TR07) TABLE(MYTABLE)
```

**Note:** If you delete a global variable that a global-variable trigger is monitoring, you also delete the global-variable trigger.
Examples of global-variable usage

Storing a generated symbolic variable

The following example stores the global variable NEWDATE in the global-variable table ACCTING. NEWDATE is generated from the date of the last day of the current month.

```
GENTIME XX LAST DAY OF MONTH
NEWDATE= '%%XXMM.%%XXDD.%%XXYY'
VPUT NEWDATE TABLE(ACCTING)
```

Storing a global variable outside ESP Workload Manager automation

The following example stores the global variable CICSDOWN in the global-variable table AUTOMATE. This is done in REXX outside of ESP Workload Manager.

```
/* Rexx */
cicsshutdown = 03:15:35
Queue "VSET CICSDOWN" cicsshutdown "TABLE(AUTOMATE)"
Queue "end"
"ESP"
```

Schedule jobs based on a global-variable value

The following example runs jobs REORG1 and BKUP1 at times specified by the global variables REORGTIME and BKUP1DATE from the global-variable table AUTOMATE.

```
APPL DATABASE
VGET REORGTIME TABLE(AUTOMATE)
VGET BKUP1DATE TABLE(AUTOMATE)

JOB REORG1
  DELAYSUB %REORGTIME
  RUN WEEKENDS
  RELEASE BKUP1
ENDJOB

JOB BKUP1
  RUN %BKUP1DATE
ENDJOB
```
Sharing a global variable across Applications

The following example shows the Application NJBKUP incrementing the global variable BKUPCNT. The Application FLBKUP1 uses the same global variable.

APPL NJBKUP
  JOB NJBKUP1.DONE LINK PROCESS
    RUN WEEKENDS
    AFTER NJBKUP1
    VINCR BKUPCNT TABLE(AUTOMATE)
  ENDJOB

APPL FLBKUP
  JOB FLBKUP1
    RUN WEEKENDS
    VGET BKUPCNT TABLE(AUTOMATE)
  ENDJOB

Taking action when a value changes—Trigger an Application

The following example shows three independent actions:

The global-variable trigger is defined to trigger the event PROD.ACCTOK when the value of the global variable ACCTOK from the global-variable table ACCTING becomes equal to YES.

VTRDEF VARIABLE(ACCTOK) WHEN(YES) TABLE(ACCTING)
  EVENT(PROD.ACCTOK)

The global variable ACCTOK is set to YES. This can be done in a batch, through TSO or in an ESP Workload Manager Application.

VSET ACCTOK YES TABLE(ACCTING)

The following is the target event and the corresponding Application:

EVENT ID(PROD.ACCTOK) SYSTEM(ESP) REPLACE
  INVOKE 'ESP.PROCS(ACCTOK)'
ENDDEF

APPL ACCTOK
  JOB ...
  ENDJOB
  JOB ...
  ENDJOB
Taking action when a value changes—Trigger an Application

The following example shows three independent actions:

The global-variable trigger is defined to trigger the event PROD.VARCHK when the value of any global variable in the global-variable table AUTOMATE changes.

```vtrdef variable(-) table(automate)
  event(prod.varchk)
```

The global variable ABENDCNT in the global-variable table AUTOMATE is set to 10. This can be done through TSO or in an ESP Workload Manager Application.

```vset abendcnt 10 table(automate)
```

The following is the target event and the corresponding procedure. The procedure is based on the symbolic variables ESPVTvariable and ESPVTvalue. These built-in-symbolic variables are set when a global-variable trigger is activated.

```event id(prod.varchk) system(esp) replace
  invoke 'esp.procs(varchk)'
enddef
```

```varchk proc
if %espvtvariable = 'abendcnt' & %espvtvalue = 5 then do
  some kind of appropriate action
enddo
if %espvtvariable = 'abendcnt' & %espvtvalue >= 10 then do
  some other kind of appropriate action
enddo
```
A
Agent Monitor, defaults and details ................. 234
alphabetical sorting in reports ....................... 556
AND/OR, report examples ............................ 565
AND/OR, using in reports ............................. 551
Applend, job details ..................................... 240
Application tab, Workload Editor ...................... 67
Applications
completing ................................................ 432
c conditions, defining .................................. 78
displaying with graphical overview ............ 403
downloading from host .............................. 327
generations ............................................. 68
generations, viewing ................................... 428
holding .................................................. 68
inserting jobs .......................................... 505
JES 3, specifying ....................................... 72
limiting display data .................................. 522
locating jobs within .................................. 504
locating trouble within ................................ 435
naming .................................................. 25, 67
releasing ................................................ 432
removing APPLWAIT state .......................... 434
rerunning .............................................. 436
saving ................................................... 36
scheduling when to run ................................ 38
setting automatic hide ................................ 417
setting minimal defaults .............................. 25
specifying Application to run ...................... 39
state categories ........................................ 412
summary of creating .................................. 65
uploading to host ..................................... 36, 327
using SAF ............................................. 69
viewing details ........................................ 429
viewing jobs within ................................... 430
viewing statistics ...................................... 430
Arithmetic
expression ............................................. 579
operations ............................................. 579
auto trouble locate feature .......................... 435
autosave ............................................... 59
Batch Input Sessions
add jobs from a list .................................. 56, 189
agent specifications .................................. 213
job commands ........................................ 449
blank lines, setting for reports ..................... 553
blocking jobs, reason ................................ 453
breaks, setting for reports .......................... 553
browse online job documentation .................. 451
Built-in functions
DAYS_BETWEEN ...................................... 588
DAYS_FROM .......................................... 588
DAYS_TO ............................................. 588
DEFINED .............................................. 593
LENGTH .............................................. 593
SELECTED .......................................... 592
SUBSTR .............................................. 594
TODAY ............................................... 589
TOMORROW .......................................... 590
YESTERDAY ......................................... 590
BW InfoPackages
add jobs from a list .................................. 56, 189
agent specifications .................................. 213
job command .......................................... 449
BW Process Chains
add jobs from a list .................................. 56, 189
agent specifications .................................. 213
job commands ........................................ 449
C
Calendar Manager
absolute calendar .................................... 335
changing an existing calendar ....................... 333
creating a new calendar ................................ 334
defining a holiday ..................................... 336
defining a special day ................................ 337
deleting of entries .................................... 331
logical calendar ........................................ 335
opening ................................................. 332
overview ............................................... 330
special day description ................................ 331
system calendar ....................................... 330
uploading calendar definitions ...................... 335
characters, supported ................................ xvii
CLANG, language elements .......................... 574
color, set state ........................................ 416
columns, setting for reports ......................... 553
Comma Separated Value, report format ............ 549
backup files ........................................... 59
ESP Encore
restoring a job .............................................. 495
resubmitting a job ......................................... 465
specifying .................................................. 72
statements ................................................. 440, 465, 500
ESP Procedure
expressions .................................................. 579
terminating with EXIT .................................... 575
terminating with QUIT .................................... 576
using CLANG .............................................. 574
Event Manager
bypassing next scheduled Event ....................... 380
cache a Procedure ....................................... 355
copying an Event ........................................ 345
creating an Event ........................................ 350
deleting an Event ........................................ 368
Event comments ........................................... 371
holding an Event ......................................... 367
listing Events ............................................. 344
monitoring ................................................... 351
opening ...................................................... 343
overview .................................................... 342
pending execution ....................................... 368
releasing an Event ....................................... 368
replacing next scheduled Event ....................... 380
resuming an Event ....................................... 368
scheduling .................................................. 362
simulating an Event ..................................... 43, 372
specifying CopyJCL ....................................... 369
specifying user parameters ............................. 380
suspending an Event ..................................... 368
temporary ESP procedure library .................... 356
triggering an Event ...................................... 45, 374, 379, 475
uploading an Event ..................................... 41
user profile options ..................................... 347
Event Monitor, SAP
agent specifications ..................................... 221
Events, listing ............................................. 344
EXIT statement .......................................... 575
Expression
comparing ................................................... 580
usage ......................................................... 579
external job
details ....................................................... 321
posting options .......................................... 68
External Scheduler, defaults and details ............ 322
F
File Trigger, defaults and details .................... 148
file, spool retrieval ...................................... 468
flowchart, overview ...................................... 22
free form text
panel editing ............................................. 137
text editing .............................................. 139
FTP dialog, connect ..................................... 64
FTP, defaults and details ................................ 249
G
generated reports
creating ..................................................... 548
formatting ................................................. 553
generating .................................................. 557
modifying format ........................................ 553
printing ...................................................... 546
saving ....................................................... 546
titles, setting ............................................. 553
viewing ...................................................... 557
global-variable tables
built-in variables
ESPVTOLDVALUE ......................................... 606
ESPVTABLE ............................................... 606
ESPVTUSER ............................................... 606
ESPVVALUE ............................................. 606
ESPVTVARIABLE ........................................ 606
defining tables ........................................... 603
defining variable triggers ............................. 606
deleting tables ............................................ 603
deleting variables ........................................ 605
incrementing variables .................................. 604
listing tables ............................................. 603
retrieving variables ..................................... 605
setting variables ......................................... 604
storing variables ......................................... 604
graphical view
applying a subscribe filter ................................ 408
changing ..................................................... 398
changing a subscribe filter ............................. 409
changing graph size ..................................... 398
changing line styles ..................................... 401
changing the orientation ............................... 402
creating a subscribe filter ................................ 406
deleting a subscribe filter ............................... 409
description ............................................... 392
filter description ........................................ 405
find from node .......................................... 33
operators for complex subscribe filters ............ 407
printing ..................................................... 422
set automatic subscription filters .................... 418
status bar ................................................... 395
subscribe filter criteria ................................ 407
using an overview ....................................... 403
view the current filter .................................... 410
H

history file, selecting ........................................ 549
history reports
about .................................................................... 546
blank lines, setting ............................................. 553
creating ............................................................ 548
creating report definitions .................................... 548
criteria statements ............................................. 551
CSV format .......................................................... 549
definitions, saving ............................................. 546
definitions, operators, AND/OR ........................... 551
deleting .............................................................. 550
definitions, page breaks, setting ......................... 553
definitions, printing ............................................ 546
deleting report definitions .................................... 546
deleting report definitions, modifying .................... 546
deleting report definitions, opening ....................... 546
deleting report definitions, saving ......................... 546
deleting reporting fields ....................................... 546
deleting saving report definitions .......................... 546
deleting saving reports ......................................... 546
subtotals, setting ................................................. 553
titles, setting ...................................................... 553
viewing ................................................................ 557
width settings ....................................................... 549

I

icons
description ......................................................... 60
placing onto workspace ....................................... 27
IF statement .......................................................... 574
inherit dependencies, specifying ......................... 72
InitConnection dependencies ............................... 397
installing
Workstation ....................................................... 2
IP monitor, defaults and details ................................ 293
issue commands ................................................... 108

J

J2EE, defaults and details ................................... 301
JES commands .................................................... 448

job
abandon submission ............................................ 120
attributes, displaying .......................................... 399
blocking ................................................................ 453
bypass and unbypass ............................................ 451
commands ............................................................ 445
completing ........................................................... 451
condition codes, defining ..................................... 102
conditional ........................................................... 111
controlling .......................................................... 443
delay job submission ............................................ 124
dependencies ......................................................... 29
documentation ....................................................... 389
dropping predecessors .......................................... 453
drop external ......................................................... 318
holding and releasing ............................................. 456
icons ................................................................. 411
inserting ............................................................. 505
locating ................................................................ 504
locating within a simulation graph ......................... 374
manually submitted ............................................... 112
names ................................................................ 97, 411
overdue ................................................................ 122
posting options ..................................................... 68
readying ............................................................... 462
relationships ........................................................ 23
release conditions .................................................. 31, 325
relying to a prompt from the ESP Agent .................. 462
requesting and unrequesting ................................... 463
specifying defaults ................................................. 93
specifying details ................................................... 34, 93
specifying on request ............................................. 111
state priority defaults ............................................. 414
state, colors .......................................................... 412
state, labels .......................................................... 412
state, setting state priority ..................................... 413, 414
two running at the same time ................................... 69
using NOTWITH and ENQUEUE ............................ 132
view in an Application ............................................ 430
viewing and resetting time dependencies ............... 463
viewing details ....................................................... 443

Job Control Language library
edit or browse .................................................... 454
overview ............................................................... 75
specifying ............................................................... 75
job dependencies, displaying across Applications .... 4
5
2
printing
  custom views ........................................ 532
  generated reports .................................... 546
  graphical views ....................................... 422
  report output ......................................... 546
  reports ................................................ 546

procedures
  cache .................................................... 355
  edit or browse ........................................ 455
  Process Monitor, SAP
  agent specifications ................................ 220
  job command .......................................... 449

Q
  QUIT statement .......................................... 576

R
  Refresh Event Scheduling command ................ 333
  regenerating reports ................................ 546
  relationship operators ................................ 572
  release conditions .................................... 31, 325, 420
  REPLY command ........................................ 462
  Report Manager
    about .................................................. 546
    General panel ....................................... 549
    history reports ...................................... 548
    opening ............................................... 548
    Report Criteria panel ............................. 551
    Report Format panel ................................ 553
    Sorting panel, reports ............................ 556
    reporting fields ..................................... 567
  reports
    about .................................................. 546
    blank lines, setting ................................ 553
    creating history reports .......................... 548
    creating report definitions ....................... 548
    criteria statements ................................ 551
    CSV format .......................................... 549
    definitions, modifying ............................. 546
    definitions, opening ................................ 546
    definitions, saving ................................ 546
    examples ............................................. 559
    format, setting ...................................... 553
    generating .......................................... 557
    modifying report definitions ...................... 546
    opening report definitions ......................... 546
    operators, AND/OR ................................... 551
    page breaks, setting ................................ 553
    printing .............................................. 546
    report definitions, modifying ..................... 546
    report definitions, opening ....................... 546
    report definitions, saving ......................... 546
    reporting fields ..................................... 567
    saving report definitions ......................... 546
    saving reports ....................................... 546
    subtotals, setting .................................. 553
    titles, setting ...................................... 553
    viewing ............................................... 557
    width settings ....................................... 549
  requirements, system ...................................... 2
  rerunning an Application .............................. 436
  rerunning multiple jobs ................................ 436
  resource usage, viewing ................................ 458
  resources
    Application level specification ................. 86
    enqueue, specifying ................................ 132
    job level specification ............................. 128
    negative .............................................. 128
    reserving ............................................. 131
    step-end release ..................................... 134
    restarting a job with ESP Encore ................ 495
    resubmitting a job ................................... 464
    run frequency, specifying ......................... 114
S
SAP
add jobs from a list ......................... 189
AdHoc jobs ......................................... 541
agent specifications ............................ 197
archiving parameters .......................... 210
Batch Input Sessions ................................ 190, 216, 449
BW InfoPackages ................................ 189, 213, 449
BW Process Chains ............................... 190, 215, 449
Data Archiving job ................................ 218, 449
defaults and details ............................ 195
Event Monitor job ................................. 221
filter button ........................................ 56
filter panel ....................................... 190
Intercepted jobs ................................ 538
job commands ...................................... 448
Job Copy job ....................................... 212
modify a variant .................................. 204
monitor children .................................. 198
printing parameters ................................ 208
Process Monitor job ............................. 220, 449
SAP GUI connection ............................. 9
SAP Tools interface .............................. 537
system resource monitoring .................. 544
view ABAPs ........................................ 200
view Variants ..................................... 201
web posting ........................................ 198
saving
  generated reports ......................... 546
  report definitions........................... 546
  report output .................................. 546
  reports ......................................... 546
schedule criteria editor ....................... 115
section breaks, setting for reports ........ 553
send a message ................................... 106
server responses, view ....................... 420, 450
Service monitor, defaults and details ...... 286
sorting order, reports ....................... 556
spool file retrieval ............................ 468
state categories, Applications .............. 412
state colors, set .................................. 416
state message ..................................... 395
state priority setting ........................... 413
statements
  application ...................................... 67, 70
  ENQUEUE ........................................ 132
  NOTWITH ........................................ 132
  statistics, show ............................... 430
subApplications
  bypassing and unbypassing ................. 516
  completing ..................................... 517
  holding and releasing ....................... 516
  notify when complete ....................... 68
  overview ....................................... 514
  readying ........................................ 517
  removing SANCWAIT .......................... 517
  requesting and unrequesting ............... 516
  specifying job ................................ 97
  view jobs within ............................. 515
  viewing ......................................... 514
  viewing commands ............................ 516
subscribe
  automatic ....................................... 419
  filter option .................................. 397
  InitConnection file ........................... 397
  no filter option ................................ 397
  view filter .................................... 410
subtotals, setting for reports ............... 553
symbolic variables
  built-in functions ............................ 593
  introducer character ......................... 577
  specifying library ............................ 354
  using in Procedures .......................... 577
system identifier, Event ....................... 352
system requirements ........................... 2
T
Tandem, defaults and details ................ 231
Task, defaults and details .................... 143
temporary ESP procedure library .......... 356
temporary library, specifying .............. 76
Text File monitor, defaults and details ... 288
THEN statement ................................ 574
time dependencies ............................. 463
time dependencies, specifying .............. 120
Toolkit, Workstation ........................... 4
Tools, SAP interface ............................ 537
trace file, using ................................. 7
trouble, locating automatically ............ 435
troubleshooting tool ........................... 7
U
Unicode .............................................. xvii
UNIX, defaults and details ................... 159
unsubscribe option ............................. 397
user profile ...................................... 8
user status, jobs .................................. 467
UTF-8 ................................................ xvii
values, for reporting fields ........................................... 567
variable trigger
   defining .................................................................. 606
   feature description ............................................... 602
variants, modifying .................................................. 204
viewing reports .......................................................... 557
viewing your jobs
   custom view .................................................................. 47, 392
   graphical view ................................................................ 46, 392
Windows Event monitor, defaults and details ...................... 280
Windows NT/2000, defaults and details ................................ 180
workflow diagram, creating ........................................... 27
workload
   display statistics ..................................................... 430
workload default tabs, Workload Editor
   Application .................................................................... 67
   Condition Codes ...................................................... 78
   Free Format Text ..................................................... 88
   Library ......................................................................... 75
   Notification .............................................................. 83
   Options ........................................................................ 71
   Resources ..................................................................... 86
Workload Director
   accessing workload .................................................. 386
   commands
      application ................................................................ 427
      job ........................................................................... 445
      subApplication ........................................................ 516
   custom view
      creating .................................................................... 518
      overview ................................................................... 392
   graphical view ........................................................... 392
   interface ....................................................................... 387
   line mode interface .................................................... 393
   locate
      job in a custom view .................................................. 535
      job in an application .................................................. 504
      trouble within an Application ..................................... 435
   menu bar ..................................................................... 388
   opening ....................................................................... 386
   options ........................................................................ 413
   overview ................................................................ ....... 383
   printing
      custom views ................................................................ 532
      graphical views ....................................................... 422
      release conditions .................................................... 420
      title bar ...................................................................... 388
      toolbar buttons ........................................................ 390
      view current filter .................................................... 410
Workload Editor
   job palette .................................................................... 60
   menu bar ..................................................................... 53
   opening ....................................................................... 52
   overview ................................................................ ..... 53
   specifying Application defaults .................................... 66
   specifying global defaults ............................................ 66
   specifying job defaults ............................................... 93
   specifying job details .................................................. 93
   toolbar ....................................................................... 56
   user profile options ................................................... 58
Workstation Toolkit
   description ................................................................... 4
   menu bar ..................................................................... 4
   opening Calendar Manager ........................................... 332
   opening Event Manager ............................................... 343
   opening Report Manager ............................................. 548
   opening Workload Director ......................................... 386
   opening Workload Editor ............................................. 52
z/OS, defaults and details ................................................... 94
z/OS, JES commands ...................................................... 448